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WYSIWYG Web Builder 
 

Introduction 
WYSIWYG Web Builder is an all-in-one software solution that can be used to create complete responsive 
web sites without coding. The acronym stands for "What You See Is What You Get," meaning users can 
visually design their pages, and the software generates the underlying code. It offers drag-and-drop 
functionality, customizable templates, and various tools for responsive design, animations, and form 
creation. Ideal for beginners and professionals alike, WYSIWYG Web Builder simplifies the web 
development process, allowing users to focus on design while the software handles the technical 
aspects. 
 
 
Key Features: 

• Drag & drop of HTML objects: Text, Lines, Images, Tables and much more! 

• Use Artificial Intelligence (OpenAI) to generate, improve or translate text and images. 

• Create a new unique website in just a few steps with the Website Wizard. 

• Responsive Web Design (breakpoints) based on CSS3 Media Queries. 

• Supports many CSS3 features: box-shadow, opacity, rounded corners etc. 

• Site Management. Easily add, edit, clone and structure your web pages. 

• Form wizard; create forms in less than 4 steps plus many Ready-to-use Forms! 

• Built-in form processing script with form validation tools and CAPTCHA. 

• Shape objects (Rectangle, Ellipse, Arrows, Signs, Stars, Talk Bubbles and more) with many fill 
effects such as solid, gradients patterns and glass. 

• Support for YouTube, Vimeo, JAVA, HTML5 Audio/Video, and other Plug-Ins. 

• Rollover images and Slide Show images (with many transition animations). 

• Rollover Text, displays a text banner over image on mouse over with animations. 

• Photo gallery object with photo frames and built-in light box slideshow support. 

• Ready-to-use Java scripts.  

• Navigation bar, Text Menu, Mega Menu, Tab Menu, Slide Menu, SiteTree and Menu bar. 

• Template support. More than 200 free templates available. 

• Publish your web site to any hosting. 

• Master objects and Master Frames. This allows you to re-use objects from other pages. 

• Layer Object for advanced layout possibilities: Modal, Sticky, Panel Fixed etc. 

• Free angle rotation for shapes and images 

• CSS3 animations and transitions. 

• Image tools: Contrast, Brightness, Flip, Rotate, Resample, Hue/saturation, Stencils and Crop. 

• Image effects: Grayscale, Negative, Sepia, Blur, Soften, Sharpen, Noise, Emboss and more!  

• Drawing tools: Line, Line + Arrows, Scribble, Polygon, Curve and Closed Curve. 

• Implement Events for Images, Shapes and form controls! 

• PHP Login Tools/Page Protection. 

• Content Management System functionality with plug-in support. 

• PayPal and other eCommerce Tools (Ecwid, Stripe, Snipcart, Paddle, Gumroad, WebMoney).  

• Site Search 

• Carousel functionality 

• News feed ticker object to integrate RSS feeds, Twitter, Flickr, Facebook etc. 

• and much more… 
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Getting started, a quick introduction 

 
WYSIWYG Web Builder is a Web site building tool that helps you design and build full-featured Web sites 
without having to learn HTML. When you preview or publish a page, Web Builder automatically 
generates the HTML code your Web browser needs to display pages.  
 

What is WYSIWYG Web Builder? 

WYSIWYG Web Builder operates on the principle of shielding the user from the complexities of HTML 
coding. It distinguishes itself by being not merely an HTML editor, but rather an HTML generator. In fact, 
you don't need to be aware that HTML is under the hood at all. The process is as simple as dragging and 
dropping images, text, and other elements onto your page, resulting in a fully functional webpage ready 
for publication! Think of it as a Desktop Publishing tool tailored for websites. 
 
Web Builder doesn't directly manipulate HTML code; instead, it employs its proprietary file format 
(.wbs) to store website information. In fact, it allows you to encapsulate your entire website into a single 
project. 
 
By sidestepping direct HTML usage, Web Builder unlocks a wide range of capabilities beyond the scope 
of typical HTML editors. It supports diverse features such as shapes, drawings, navigation bars, RSS 
feeds, blogs, photo galleries, pre-built JavaScript functionality, and a host of advanced elements to 
enhance your web development experience. 
 
WYSIWYG Web Builder supports multiple ways to create responsive web sites.  
 

• Fixed / Absolute Layouts (Adaptive Web Design) 
By default layouts are fixed using absolute positions. This means that you can place objects 
anywhere you like, so you have complete control over the layout. The downside of this layout 
mode is that it will be harder to make the page responsive because the layout will only look 
perfect on the screen size it was designed for. And because there is no 'structure' in the layout 
(objects can be placed anywhere in random order), there is no way for the browser to 
automatically re-position and/or scale the content based on the view port. So, to make sure the 
page content looks good on different viewports (screen sizes), you will have to implement 
breakpoints (different layout variations) of the same page. This design technique is also known 
as "Adaptive Web Design". 
 

• Flexible / Floating Layouts (Re-flow) 
You can implement flexible layouts by using Layout Grids and/or Flexbox. This makes it possible 
to create Bootstrap-like layouts. When using layout grids, the layout is controlled by the grids. 
Objects will automatically resize based on the available space in the viewport and the grid 
column size. The downside of using layout grids is that you have less control over the layout. All 
objects will be positioned and resized automatically. So, you are forced into a structured layout.  

 
Related tutorial: https://www.wysiwygwebbuilder.com/layout_modes.html 
 
 

Tip:  
For step-by-step instructions to the basic features of WYSIWYG Web Builder please visit the online 
tutorials: https://www.wysiwygwebbuilder.com/getting_started.html 
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Start Web Builder 

Click the WYSIWYG Web Builder icon to launch the application. 
 
After launching WYSIWYG Web Builder, the main screen will look something like this: 
 

 
 
By default, the Ribbon interface will be active, but if you prefer you can also switch to classic 
menu/toolbars in Tools -> Options -> User Interface. 
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Ribbon  

The Ribbon gives you quick access to all available tools. The Ribbon contains tabs to expose different 
sets of control elements, eliminating the need for many different icon-based tool bars. Some of these 
tabs are contextual and appear only when a certain type of object is selected, providing specific tools for 
items such as tables, text or images.  

 

 
 
You can minimize the Ribbon by right clicking the Ribbon. When the Ribbon is minimized, you will still be 
able to access all tabs of the Ribbon, but the tools will hide to free up some screen space.  
 

 
 
Online tutorial: 
https://wysiwygwebbuilder.com/ribbon.html 
 
 

Contextual Tabs 

Contextual Tabs only appear when needed. For example, if you select an image object then the Image 
Tools will be displayed. The tools will automatically hide if you deselect the object. 
 

 
 

 
Text Formatting Tools 
The text formatting tools are only active when you are in text edit mode. 
 

 
 
To insert text simply drag the text icon on the workspace. A new object with the text "Double click to 
edit' will be displayed on the page. To switch to text edit mode double click this text and the formatting 
tools will become active. For some of the tools you need to highlight the text before they can be used 
(just like in a regular text editor). 
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Quick Access toolbar 
You can put commands you use most often on the Quick Access Toolbar above the ribbon. Just like the 
Ribbon, this toolbar is fully customizable. 
 

 
 

File Menu 
The File Menu contains all file related commands like Open, Save, Close and Publish. 

 

 
 

Toolbox 
The toolbox can be used to add new objects to your web pages. To insert a new object, select one of the 
available items and draw a box to indicate the position of the object. The new object will now be 
inserted to the page. Another way to add objects to your page is by simply dragging them out of the 
toolbox onto the workspace. 
 

Tabs 
When you have opened multiple pages, you can use the tabs to switch between the pages. To close the 
active page, press the small 'x' in the upper right corner of the tabs strip. 
 

Workspace 
The center of the screen is the workspace, where you can drag and drop objects from the toolbox. This 
represents your web page. 
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Site Manager 
The Site Manager can be used to manage the structure of your web site. 
 

 
 
The Site Manager has its own toolbar to add, edit, clone or remove pages. There is also a button to open 
the properties of the selected page. For more information see also the “Site Manager” chapter later in 
this document. 
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Property Inspector 
Use the Property Inspector window to view and change the properties of selected objects.  You can also 
use the Property Inspector window to modify page properties. The changes will be visible immediately. 
The Property Inspector window displays different types of editing fields, depending on the needs of a 
particular property. These edit fields include edit boxes, drop-down lists, and links to custom editor 
dialog boxes. It is also possible to manually modify the size and position of the selected object by 
changing the Position and Size properties. 
 

 
 
The ID property 
The ID property of an object should be unique within the page. Normally Web Builder will give your 
object unique names automatically. However, if you use one of more master objects, then IDs may be 
duplicated, since the software cannot distinguish a master from a normal page. 
The Properties Inspector also gives you access to more advanced attributes like the ID of an object. This 
can be useful if you use master pages and want to give the items of the page a unique ID. We 
recommend giving objects on a master page names with a prefix like MasterPage_Text1. This will make 
sure that if the master page is used in another page, the ID of the objects is unique. 
 
Class 
Specifies the class name for the object. The value can be a style (created in the Style Manager) or a 
custom class. Some objects have a 'Predefined Style' option in the Style properties. This is basically the 
same property (Style = HTML class). However, for objects that do not support the predefined style, this 
property does not change the appearance in the workspace. In that case It just adds class="value" to the 
object's container. This may be useful for advanced users who want more control over the object's style 
or behavior.  
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Adding text to the page 
One of the first steps in creating a web page is often adding text. 
 

  
 
Select Insert -> Text from the menu and draw a box to indicate the position of the text. Then double 
click the box to start editing the text. Type some text and (press Enter to go to the next line). The box 
automatically changes its size to fit the text. 

 

 
 
Next, you can change the text attributes by highlighting the text you want to modify with the mouse and 
then choose the new attributes in the Format Tab. You can change font type, size, bold, italic, underline, 
text color, highlight color and many other attributes. Note that the formatting tools are also available in 
the context menu of the text editor. 
 

 
 
Click anywhere in the page to stop editing. 
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Adding an image to a web page 

Select Insert -> Image from the menu and draw a box to indicate the position of the image or select 
Image in the toolbox. The size of the box doesn’t matter; Web Builder automatically adjusts the box to 
fit the image after you place it. 
 

 
 
The Image File Open dialog appears so you can locate the image you want to place in the image box. 
Select the image you want to add and click Open to add it to the page. 
 
To resize the image, drag the borders (handles) of the image object. 
 

 
 

Rotate an image 
You can rotate image and shape objects. 
 
To rotate an object:  
1. Select the Rotate tool on the Ribbon or right click and select Rotate. 
2. Click to select the object, hover over one of its handles until you see the rotate pointer.  
3. Hold the mouse button down and drag in the direction in which you want to rotate the object, then 
release. Use the Shift key for 15° rotation intervals. 
 

 
 

Apply effects to an image 
In WYSIWYG Web Builder you can apply effects to images without having to open a separate image 
editor! A few of the available effects are Contrast, Brightness, Blur, Grayscale, Emboss, Negative, Sepia, 
Sharpen, Soften, Stencils and much more! 
 



WYSIWYG Web Builder 21   

16 

Linking your pages together 

Links are text or images that can be clicked to bring the user to another web file such as a web page, 
images or any other file. They are the essence of the World Wide Web as they link pages within sites 
and web sites to other web sites. To create a link in Web Builder, follow the instructions below. 
 

Linking text 
Highlight the text you want to link and select Insert -> Link from the menu bar, click the link button on 
the toolbar or press CTRL+K on your keyboard. This will display the Edit Link window. 
 

 
 
 

Linking an image and other objects 
Select the object you want to link and select Insert->Link from the menu bar, click the link button on the 
toolbar or press CTRL+K on your keyboard.  

 

 
 
 
Please read the chapter ‘Links’ of this document for more details about linking. 
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Saving your web site 

In WYSIWYG Web Builder you do not edit HTML pages directly. Instead, a project file is being used 
(.wbs) which stores all pages of your website within a single file. Every time you want to edit your 
website you open this project file. 
 
To save your web site (including all pages it contains), select File -> Save Web Site for the menu and 
enter a name for the project. Web Builder uses the extension .wbs (Web Builder Site) to save the project 
files, to save your page as HTML you'll need to Publish your pages. 
 

 
 
It is also possible to save the project as template, so it can be reused for other projects. 
 

 
Backup 
Project backup will create a full backup of the project, images and other files in zip format. 
The software also can automatically make backups, which is described later in this document. 
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Preview a web page 

Select Home -> Preview in Browser -> Default Browser (F5) to preview the current page in your default 
browser. It is also possible to change the browser that is used for previewing. Select Edit Browser List to 
add/edit the list of browsers that can be used to preview the pages you are working on. 
 

 
 
Depending on the preview scope, you can preview either a single page or the entire web site.  
 

 
 

Notes:  
Internal links do not work in Preview, unless you have set the Preview Scope to Entire Web Site! If you 
only preview a single page, your browser will not be able to find all the other (internal) pages unless you 
also generate them! 
 
It is not possible to preview pages that use PHP in your local browser. PHP pages can only be viewed 
through a web server with PHP support. 

 
Online Tutorials: 
https://www.wysiwygwebbuilder.com/preview.html 
https://www.wysiwygwebbuilder.com/preview_localserver.html 
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Publishing web pages 

The last step in the process of website creation involves publishing your web pages. To make your web 
content accessible on the internet, you'll require the services of a web server. These servers are 
commonly referred to as hosts, and they serve as platforms for the uploading and storage of various 
files, such as HTML documents, images, and multimedia content. Unless you happen to have your own 
dedicated web server, you'll need to seek out a hosting service to manage your web pages. There are 
numerous web hosting options available, including popular choices like: 
 
GoDaddy - Visit their website at https://www.godaddy.com/ 
1&1 - Check out their services at https://www.1and1.com/ 
 
Of course, there are many other hosting providers to explore as well. It's essential to select a web host 
that supports FTP (File Transfer Protocol) as this will greatly simplify the process of publishing your web 
pages using the built-in publish tool. 
 
 

Publish to a remote FTP server. 
Once you have registered to a web host, you will receive a server address, username and password. 
Enter this information into Web Builder by selecting: File -> Publish. Click Add and select Type ‘FTP 
Server’. Sometimes you also need to specify a remote folder. Common remote folder’s locations are: 
/www, /public_html, /html, but unfortunately this value can be different for each webhost, so consult 
your webhost's documentation for more details! If you have a firewall/router, select 'Use passive mode 
for transfers'. Click OK to save. Now you can publish each page simply by selecting Publish. 
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Publish to a Secure FTP server 
The following protocols are supported:  

• FTP with TLS/SSL (Port 990 - Implicit)  

• FTP with TLS/SSL (AUTH TLS - Explicit)  

• SFTP using SSH2 (Secure Shell)  
 
The available settings are the same as for standard FTP. Note however that usually web hosts use 
different ports for secure servers.  
The default port numbers are:  

• Port 990 for FTP with TLS/SSL (Port 990 - Implicit)  

• Port 21 fort FTP with TLS/SSL (AUTH TLS - Explicit)  

• Port 22 fort SFTP using SSH2 (Secure Shell)  
  
Clear control channel  
Reverts the FTP control channel from SSL/TLS to an unencrypted channel. This may be required when 
using FTPS with AUTH TLS where the FTP client is behind a DSL or cable-modem router that performs 
NAT (network address translation).  
If the control channel is encrypted, the router is unable to translate the IP address sent in the PORT 
command for data transfers. By clearing the control channel, the data transfers will remain encrypted, 
but the FTP commands are passed unencrypted.   
 
Log Level  
Specifies the log level, which determines the amount of detail recorded in the logs during publishing.  
 

• Warning  
Only warnings and errors will be logged.  
 

• Info 
Only basic information will be logged, like which files are transferred. 
 

• All 
Detailed logging. This includes the transfer protocol commands.  

  
Be aware that logging can affect performance. The more information that is logged, the longer 
processing will take, potentially slowing down the transfer. 
 
 

Publish to a local folder 
If your web host doesn't support FTP or you want to use your favorite FTP client to transfer the files to 
the server, you can use the option 'Publish to a local folder'.  Click Add to add a new location to the list. 
Enter a name for the location a select ‘Local Folder’ as type. Enter the folder where you want to publish 
the active document. Click OK to save the data and then click Publish to save the files to the specified 
folder. Now you can take these files from the local folder and publish them using your preferred FTP 
utility. 
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Pages to Publish 
Select which page or pages you want to publish. 
 

• Entire Web Site, publishes all pages of the web site (except the pages which have enabled 
'Don't Publish this Page' in Page Properties) 

• Select Page Only, publishes the select page, click Select to specify the page to be published. 

• Select Page and Sub Pages, publishes the selected page and all of its subpages (if any). 

• Publish pages using the selected master page. This will publish all files using the selected 
master page. This can be useful if you have made some changes to a master page and quickly 
want to re-publish all pages that are using that master page. 

 
 

What to do in case of publishing errors?  
• Make sure your ftp address (host) is correct. 

• Is your username and password ok?  

• Make sure the remote folder is correct (very important!) 

• If the files don't show up on your website you've probably specified, the wrong remote folder. 

• Does your firewall block the FTP connection of Web Builder?  

• Enable 'Use passive mode for transfers'  

• Increase the connection timeout to 120 seconds (Tools -> Options -> Publish)  

• If the transfer takes a long time, then you've probably used (very) large images. 
https://www.wysiwygwebbuilder.com/forum/viewtopic.php?t=1918 

• If your website doesn't look to be updated, select 'Refresh' in your browser multiple times! 

• For a list of all possible error codes and their descriptions go 
here:https://support.microsoft.com/default.aspx?scid=kb;EN-US;193625 
 

Why aren't my images displayed on the published page?  
• Did you upload the images to the web server? 

• By default, Web Builder places all images in a sub folder called images; you can change this 
through Tools -> Options -> Publish -> Image Sub Folder. If you leave this field empty, the 
images will be published in the same folder as the published page.  

• Some web hosts do not support sub folders, so make sure you have permission to create 
folders on the server. If not, then you must tell Web Builder to publish the images in the same 
folder as the HTML.  

• Make sure the image names are valid; most web servers are case-sensitive and/or do not 
support special characters in the filenames of images. 

• Do your image filenames contain whitespaces or other special characters? Image names with 
spaces can cause problems in some browsers and/or web servers, use underscores or dashes to 
connect words instead of spaces. 

 

Tip:  
For Frequently Asked Questions or other support please visit: 
https://www.wysiwygwebbuilder.com/support.html 
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WYSIWYG Web Builder Options 

File 

New Web Site 
Creates a new empty web site project. 
All pages of a web site will be saved in one file. 
 
New Web Site from Template 
Creates a new web site based on a template. Templates can later be used by you (or someone else) to 
use a basis for a new page or web site. When you save a web page to a template it will include all images 
and other objects in the template file, so there is no need to copy these files separately.  
 

 
 
This can be useful if you want to transfer your work to another computer. WYSIWYG Web Builder 
Templates have the .wtp extension and are saved in the sub folder \My Document\WYSIWYG Web 
Builder\system\templates. To add a new category to the template selection window, you can organize 
your templates, simply create a new folder and put the template files in this folder. The name of the 
folder will then be displayed in the Category dropdown list. You can also download templates created by 
other Web Builder users from web site: https://www.wysiwygwebbuilder.com/templates.html 
 
Website Wizard 
With the assistance of the 'Website Wizard,' you can effortlessly initiate a new project. You have the 
flexibility to begin with a template as the foundation for your new project or customize its content and 
style through a step-by-step process. Moreover, there are options available to harness AI-driven content 
generation, tailored to your specified description, and incorporate (random) stock images relevant to 
your selected category. These features empower you to craft a distinct and unique website every time 
you utilize the wizard. The generated website will exhibit fresh variations with each run of the wizard! 
 
Online tutorial: https://wysiwygwebbuilder.com/website_wizard.html 
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Open Web Site 
Opens an existing web site project.  
 
Close 
Close the active page. Closing the last open page will also close the web site project! 
 
Close Web Site 
Close the active web site project. 
 
Save Web Site 
Save the active web site project.  
 
Save Web Site As 
Save the active web site project with a new name. 
 
Save Web Site as Template 
Save the active web site project to a template. 
See ‘New Web Site from Template’ for more details about templates. 
 
Save As HTML Document/ Export HTML 
This option triggers the Publish window. If you really want to export the active HTML page only, then 
hold down the SHIFT key on your keyboard. To generate more than one file at a time, please use the 
Publish option. 
 
Export to Quick 'n Easy Web Builder. 
Save a copy of the project in Quick 'n Easy Web Builder format. 
 
Quick 'n Easy Web Builder (https://www.quickandeasywebbuilder.com/) is a web design tool for Mac 
and Linux inspired by WYSIWYG Web Builder. The projects created with QnEWB and WWB are not 
compatible. However, this option makes it possible to export the project in a format that can be opened 
by Quick 'n Easy Web Builder. 
 
Note that Quick 'n Easy Web Builder is a different product, you will need a separate license. 
 
Know limitations: 
Quick 'n Easy Web Builder was created with different development tools on different platforms 
(Mac/Linux), so not all features work the same. For example, the text object uses a completely different 
text editor component. This means that not all features can be exported to QWB format. 
 
The following objects will not be exported: 
- Bulleted list 
- Clip Art 
- CMS tools 
- Curved Text 
- ListView (jQuery UI) 
- Marquee 
- Text Art 
- ToolTip (jQuery UI) 
- Extensions  
 
Note about text: 
- Styles in text. The styles in the style manager will be exported but you will need to reapply the styles to 
the text. 
 
For a feature comparison overview of WYSIWYG Web Builder and Quick 'n Easy Web Builder please go 
to: https://www.quickandeasywebbuilder.com/forum/viewtopic.php?f=30&t=40257
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Project backup in zip 
This will create a full backup of the project, images and other files in zip format. 
Note that the images and other files will only be included if they are stored in the project folder. 
Therefore, the option "Let WYSIWYG Web Builder manage images and other files used by a project' 
should be enabled. 
 
Preview in Browser 
Preview the active web page in your default Browser. 
Depending on the preview scope (Tools -> Options -> Misc), you can preview either a single page or the 
entire web site. It is also possible to change the browser that is used for previewing. Go to File -> 
Preview in Browser -> Edit Browser List to add/edit the list of browsers that can be used to preview the 
pages you are working on. 
 

Tip: You can also use the menu item 'Preview entire web site' to toggle between single page and entire 
website preview. 

 
 

Note: You cannot preview PHP pages directly in your browser. PHP can only be viewed via a web server 
with PHP support! 

 
 
Publish 
Publish the active page, a group of pages or the entire web site. You can choose to publish to a local 
folder or a remote FTP server. Check out the chapter ‘Publish’ of this document for more details. 
 
Site Summary 
The summary contains statistics about the web site project for informational purposes.  

• Created, the date the project was created. 

• Last Modified, the date the project was last modified 

• Total Editing Time, the total editing time in minutes (starting in version 18). 

• Project Size, the size of the project file (wbs) 

• Pages, the number of pages in the project 

• Images, the number of images in the project and total file size. 

• Video, the number of video files in the project and total file size. 

• Audio, the number of audio files in the project and total file size. 

• Downloads, the number of downloads (linked files) in the project and total file size. 

• Extensions, the number of extensions used in the project. 

• Fonts, the number of different fonts in the project. 
 
Exit 
Quits the application. 
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Home 

Paste 
Insert Clipboard contents. 
 
In text editing mode hold down the SHIFT key while using this command to paste without formatting. 
This can be useful when you are pasting text from MS Word which may include invalid control 
characters. 
 
Paste in Place 
Paste in Place is a method of pasting something in the workspace in the exact position that it was in 
when you copied it. 
 
Format painter 
Use the Format Painter to quickly copy formatting (color, font, border) from one object to another. Note 
that it does not work for individual text, only the container object. First select the object from which you 
want to copy the format. Then click the 'Format painter' button in the Ribbon and select another object. 
To apply the same formatting to multiple objects, you can double-click the 'Format painter' button and 
then select other objects.  To cancel the format-painter tool select the button again or click on an empty 
area in the workspace. 
 
Currently the following properties will be copied: 

• alignment 

• background color 

• background image 

• background texture 

• background mode 

• border color  

• border radius 

• border style 

• border width 

• box shadow 

• font size 

• font style 

• gradient color 

• gradient style 

• margin 

• opacity 

• padding 

• pattern style 

• text color 

 
Cut 
Cut the selection and put it on the Clipboard. 
 
Copy 
Copy the selection and put it on the Clipboard. 
 
Delete 
Erase the selection. 

 
Select All 
Select the entire document (all objects). 
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Undo 
Undo the last action. You can undo up to 255 actions. 
 
Redo 
Redo the previously undone action. 
 
Find 
You can search for words or characters on the active page or your entire website. On the Edit menu, 
click Find. In Find in, select Current Page or Entire Web Site. In Find what, type the characters or words 
you want to find, and then click Find Next. To find additional instances of the same text, continue to 
click Find Next. 
 

 
 
 
Replace 
You can search for and replace words or characters with text that you specify. 
On the Edit menu, click Replace. In Find in, select Current Page or Entire Web Site 
In Find what, type the characters or words you want to find.  
In Replace with, type the text you want to replace it with.  
Click Find Next, and then click Replace. To replace all instances of the text, click Replace All. 
 

 
 
 
Properties 
Edit properties of the selected object.  
 
HTML 
View generated HTML of the selected object or insert your own HTML code! 
Please note that this option is for advanced users only. Inserting invalid HTML code may cause 
unexpected results. 
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Don't Publish Assets (context menu only) 
If this option is enabled then Web Builder will not publish the assets (images, scripts, movies) for this 
object. For example, a media player will not publish the associated media file(s).  
This can be useful if a file already exists on the server, so it does not need to be published again. 
Note that it will still generate the HTML code for the object! 
 
Restore Original Size (context menu only) 
Can be used to restore an image or flash object to its original size. 
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View 
 
Full Screen mode: Normally, when you edit a webpage in WYSIWYG Web Builder, some of the screen is 
taken up with toolbars, a menu bar, a status bar, and other windows. To temporarily hide all this 
extraneous information to solely work on your page, click "View" and select "Full Screen Mode". 
Everything will disappear except your currently edited page. To go back, press the F11 key or click the 
Full Screen toolbar button. 
 
Refresh: The 'Refresh' option to reloads all images of the current page. This can be useful if you have 
edited images outside of Web Builder. 
 
Object Manager: Show or hide the Object Manager window.  
 
Properties Inspector: Show or hide the Properties Inspector window.  
 
Site Manager: Show or hide the Site Manager window.  
 
Toolbox: Show or hide the toolbox. 
 
Grid: Show or hide grid. 
 
Snap to grid:  Enable or disable snap to grid. Use the Snap to Grid feature to align objects exactly. Web 
Builder creates a "magnetic" attraction between the selected object and the grid.  
 
Snap to ruler guides: Enable or disable snap to ruler guides. 
 

Rulers: Show or hide rulers. 

 

Ruler Guides: Show or hide ruler guides. You can add ruler guides by clicking Ruler Guides -> Add 

Horizontal/Vertical user guide or simply drag a new guide from the ruler bar. 
 

Object Outlines: Show or hide object borders. 

 
Zoom 
You can zoom in to see parts of your web page close-up, or zoom out to see more of the page. You can 
either select one of the predefined zoom percentages or enter a custom value in the zoom toolbar. 
 

Notes: 
The quality of the zoomed page strongly depends on the zoom level. You will get the best quality for 
100%, 200%, 300%, 400% etc. But a zoom level of 150% will introduce rounding errors. 
You cannot edit text when a page is zoomed in or zoomed out. 

 

 



WYSIWYG Web Builder 21   

29 

Easy Mode: When Easy Mode is enabled, it loads a simplified environment where you can create your 
website using blocks only. This option is aimed at new users (or existing users) that just want to quickly 
create a website, without the need to have full control over the layout. It may also be beneficial for 
newcomers to get familiar with the user interface, before transitioning to the regular environment. 
 

 
 
The main difference with the regular environment is that you work exclusively with blocks instead of 
individual objects. Consequently, there's no object toolbox or insert menu to navigate. You're limited to 
inserting blocks, rather than individual objects, and the available options have been condensed for a 
more straightforward workflow. You cannot drag & drop, insert, delete or copy/paste individual objects 
(to maintain layout integrity). But you can edit the properties of objects, just like in the regular version. 
Also, objects can be hidden. Blocks can be inserted, removed, copy/pasted and re-arranged. 
 
Online tutorial: 
https://wysiwygwebbuilder.com/easymode.html 
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Page 

 
New Page 
Adds a new page to your web site. The new page is automatically opened so you can start editing it right 
away. The new page (with a unique page name) with be added to the Site Manager tree. 
 
New Page from Template 
Create a new page based on a template. Pick any page from a template and insert it into the current 
project. The new page (with a unique page name) with be added to the Site Manager tree. Template 
functionality is described later in this document. 
 
Edit Page 
This will display a list of all the pages on your website. To open/edit the page, simple select the page 
name. 
 

 
 
Clone Page 
To make an exact copy of the active page, select Clone Page from the menu. A new item (with a unique 
name) will be added to the Site Manager. 
 

Note: 
'Clone Page' will duplicate the page and all objects on that page. To reduce the number of duplicated 
objects within your website you should consider using master pages. 

 
Delete Page 
Delete the active page from your web site. You cannot remove the last page in your web site. 
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Rename Page 
Rename the active page. Note that the Site Manager must be visible to be able to rename your page. 
The name of the page will be highlighted in the Site manager, where you can change its name. 
 

 
 
 

Note: When you have linked to the page you are renaming (from any page within the web site), Web 
Builder automatically updates all the links for you so you don't have to redo all the internal links. 

 
 
Notes about page names 
While building your web site, Web Builder saves the project file with the .wbs extension. This is a project 
file used by Web Builder to simplify the building process. One project file can contain multiple web 
pages. Once your pages are ready you must export or publish them as HTML.  
The name of the output HTML file is taken from the name you have specified in the Site Manager. 
So, if you named the page index then the output file will be called index.html. If the page needs another 
extension like .php, you can configure this in the Page Properties. 
 
Here are some guidelines how to name your web pages: 

1. Do not add .html or .htm extension to the page name. Web Builder will automatically add the 
.html extension (or .php, .asp) when it publishes (or exports) the HTML code. 

2. Always name your homepage: "index", this is the most common name for a homepage. 
3. Always use lowercase filenames, most web servers are case sensitive and might fail to find your 

page if you have called it "Index" or "INDEX" 
4. Use alpha numeric characters only. Do not use space or other special characters in the name, 

keep them simple like: 
"page1" or "my_products" 

5. Use underscores or dashes to connect words. 
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Import HTML Page 
Although Web Builder is NOT an HTML editor, you can import existing HTML pages. 
Select Page -> Import -> Import HTML Page from the menu to display the Import HTML page window. 
You can either select an HTML page from your local drive or specify a URL of an online website. 
Click OK to start importing the page. Web Builder will automatically copy all images to your local drive. 
 
Important notes about importing HTML: 

• WYSIWYG Web Builder is not an HTML editor, but an HTML generator! Web Builder imports the 
HTML by rendering the contents of an existing page and then attempts to convert the layout to 
Web Builder's internal object format. 

• The import feature currently only imports text, images, form elements and body attributes (link 
colors, background images, meta tags). Tables, scripts, style sheets and multimedia 
components are not imported. But in most cases, this is good enough to get you started. 

• Web Builder does not parse style sheets, so is some cases the text may look different than the 
original page.  

• Web Builder currently doesn't support framesets. If you want to import a web page that is 
using frames, you'll have to import all individual pages separately. 

• It is very difficult to support all different types of HTML. Even the popular browsers will 
interpret HTML differently, so don't expect miracles. If a page fails to be imported it probably 
contains code that Web Builder doesn't understand, and you still have to start from scratch. 

• Importing web pages created with WYSIWYG Web Builder will give the best results! 
 
Import page from another project 
This option makes it possible to import page from another WYSIWYG Web Builder project.  
 
Page HTML 
In this window, the HTML generated by Web Builder is displayed. To insert your own code, select the 
appropriate Tab. Select if the code should be inserted at the Start of Page, Between Head tag, Inside 
Body tag, Beginning of Body, End of body or End of page. The custom code will be displayed in blue. 
 
 

Warning:  
When you insert code in the Page HTML window, make sure you do not include the <HTML>, <HEAD> or 
<BODY> tags! WYSIWYG Web Builder already generates these tags. 
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• Start of Page 
The HTML will be inserted before all other code on the page. 
 
<-- your html --> 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" 

"https://www.w3.org/TR/html4/loose.dtd"> 

<html> 

<head> 

… 

 

• Between <head></head> tags 
The HTML will be inserted between the <head></head> tags. 
 
<head> 

... 

<-- your html --> 

</head> 

 

• Inside <body> tag 
The HTML will be inserted inside the <body> tags. 
 
<body attribute=value> 

 

• After <body> tag 
The HTML will be inserted after the <body> tags. 
 
<body> 

<-- your html --> 

 

... 

</body> 

 

• Before </body> 
 
<body> 

... 

 

<-- your html --> 

</body> 

 

• End of page 
 
<body> 

... 

</body> 

<-- your html --> 

 

• Inside <html> tag 
 
<html your html> 
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Page Properties 
Set or edit the properties of the active page.  
The property window of a page is subdivided into these categories: 
 

• General 

• Style 

• Meta Tags 

• Miscellaneous 

• Events 
 
 
Multi-Page Properties  
The Multi-Page Properties tool can be used to modify selected properties for multiple (selectable) pages 
at once. For example, to quickly change the master page for a group of pages. But also, background 
properties, meta tags, page extension etc. Only the modified value(s) will be applied to all selected 
pages, other values will not be affected. 
 
 
Site Properties 
Change the page properties of all pages within the current web site project. These values will also be 
used as the defaults for new pages. You can also launch the property categories individually (General, 
Formatting, Meta Tags, Internet Explorer and Misc). This can be useful if you only want to update the 
Formatting properties, without also affecting the meta tags and other categories for all pages. 
 

Note: 
Some properties like page size, title and extension are unique for each page, so these cannot be 
changed for all pages at the same time. To prevent you from accidental changing them and overwriting 
the properties of all pages, these properties have been disabled. 

 
 
Site HTML 
Insert (Page) HTML code that will be included on all pages. 
To include HTML code only for specific pages, use Page HTML. 
To include HTML code on multiple pages, but not on all pages you can use Master Frames.
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User defined variables 
This option can be useful to get global variables (also known as Site Variables) for the project, for 
example to quickly update the copyright or other value that regularly changes. 
The variables will be replaced during publishing by the specified value. You can use this variable 
anywhere in the page, text or property values. 
 
Example: 
Name: $COPYRIGHT$ 
Value: Pablo Software Solutions 
This will replace any instance of '$COPYRIGHT$' in the project by 'Pablo Software Solutions'. 
 
Site variables can be inserted manually (by typing the variables) or via the context menu of most text 
input fields. 
 
The following variables are set automatically: 
 
$PAGE_NAME$  
will be replaced by name of the page (without file extension). 
 
$PAGE_TITLE$  
will be replaced by the page title as specified in the page properties. 
 
$PAGE_FILENAME$ 
will be replaced by the filename of the page (with file extension). 
 
$PAGE_DATE_MODIFIED$ 
inserts date of the last update. 
 
$PAGE_DATE_PUBLISHED$ 
inserts publish date 
 
$DATE_YEAR$, $DATE_MONTH$, $DATE_DAY$ 
insert year, months, day as numbers 
 
$DATE_TIME$ 
inserts publish time HH:MM:SS 
 
The default format for modified and publish dates is YYYY-MM-DD , but this can be changed via site 
variable $DATE_FORMAT$ 
 
For example:  
%Y-%m-%d, 1999-03-28 
%A, %B %d, %Y results Friday, March 19, 1999 
 
More information about format codes can be found here: 
https://learn.microsoft.com/en-us/cpp/c-runtime-library/reference/strftime-wcsftime-strftime-l-
wcsftime-l 
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The following built-in variables are available (for advanced users): 
 
$PARALLAX_SPEED$ 
Specifies the speed at which the parallax effect runs. 0.0 means the image will appear fixed in place, and 
1.0 the image will flow at the same speed as the page content. The default is 0.3.  
 
$GOOGLEFONTS_PREFIX$  
This makes it possible to overwrite the 'http:' prefix used for Google web fonts. You can replace it with 
'https:' or leave the value empty. Default is 'http:' 
 
$VIMEO_PREFIX$  
This makes it possible to overwrite the 'http:' prefix used for the Vimeo URL. You can replace it with 
'https:' or leave the value empty. Default is 'http:' 
 
$PROJECT_CSS$ 
Normally, the name of the global style sheet is based on the project name (e.g. projectname.css).  
This system variable makes it possible to specify a different name. For example: globalstyles 
 
$FORMERROR_EMAIL$ 
Customize form error message. The default text is: The specified email address is invalid! 
 
$FORMERROR_FILESIZE$ 
Customize form error message. The default text is: The size of $key (file: $upload_SrcName[$i]) is bigger 
than the allowed \" . $max_filesize/1024 . \" Kbytes! 
 
$FORMERROR_URL$ 
Customize form error message. The default text is: URLs are not allowed! 
 
$CAPTCHA_ERROR$  
This can be used to specify a custom captcha error message.  
The default text is: CAPTCHA verification failed. 
 
$FORMERROR_HONEYPOT$ 
Customize form honeypot error message. The default text is: Spam detected. 
 
$SKROLLR_FORCEHEIGHT$ 
This option applies to scroll transitions: CSS3 Animations and Transitions 
Makes sure the document is high enough that all key frames fit inside. For example, you specified an 
offset of 1000, but the content only makes the document 500px high. skrollr will ensure that you can 
scroll down the whole 1000px 
Default is: 'false' 
 
$SKROLLR_MOBILECHECK$ 
This option applies to scroll transitions: CSS3 Animations and Transitions 
This option can be used to enable checks for mobile devices. Default is: false. which means that scrolling 
transitions are enabled on mobile devices. 
Important note: Some (older) mobile browsers do not provide 'real' scrolling events, but only trigger a 
start and finish event so any scrolling effect only takes place when the user has stopped moving the 
page so the animation would happen all at once at the end. 
 
$SKROLLR_SMOOTHSCROLLING$ 
This option applies to scroll transitions: CSS3 Animations and Transitions 
Smooth scrolling smoothens animations. When you scroll down 50 pixels, the animations will transition 
instead of jumping to the new position. Default is: 'false' 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/sitevariables.html 
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Google Analytics 
Insert Google Analytics code in <head> section of the current page.  
This option is a shortcut to Page HTML. 
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Smart Content 
Smart Content allows you to quickly and easily update text and images on your page based on a chosen 
category. This feature is especially useful when previewing templates with content relevant to your 
project. For instance, if you've downloaded a template with generic web design images but want to see 
how it looks with content tailored to the 'Real Estate' category, Smart Content lets you make these 
changes in just a few clicks. 
 

 
 
Replace with Stock Photos: Instantly swap all the images on the page with relevant stock photos in just 
one click. 
 
Replace Text with Category Text: Quickly replace existing text with content tailored to your chosen 
category. 
 
You also have the option to use AI for text replacement, offering even more personalized results. 
Additionally, you can choose whether to apply changes to the entire page or only to selected elements. 
The category can be set in the page properties or via the dropdown menu. 
 
Online tutorial:  
https://wysiwygwebbuilder.com/smartcontent.html 
 
 
Swatch Colors 
Selecting a color swatch from the list automatically applies its colors to all items on the page, enabling 
you to quickly change the overall style of the page. The colors will be matched based on their tint and 
type (text, background etc.). The option "Create Swatch from image" extracts the 12 most dominant 
colors from an image and generates a new Swatch based on those colors. 
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Adjust 
The Color Adjustments Tools can be used to quickly adjust the colors of the entire page. Brightness, 
Contrast, Grayscale, Hue, Saturation, Invert colors, Invert luminance, temperature, tint. You can also 
replace a specific color on the page.  
 

 
 
These tools are ideal for quickly changing colors on the page without the hassle of manually adjusting 
each one. For instance, if you find a template you like but want to use different colors, these options 
make it easy to customize your design. You can also adjust page colors to match those in a selected 
image. This tool automatically creates a cohesive color scheme by pulling tones directly from the image, 
ensuring your design looks visually harmonious. 
 
Online tutorial:  
https://wysiwygwebbuilder.com/coloradjustmenttools.html 
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Page Properties - General 
 
Title 
Enter the title of the web page. This title will be displayed in the title bar of the browser's window and 
search engine results. 
 
Menu Name 
This name will be used for the item names in navigation bars and menu bars which have enabled the 
option 'Synchronize with Site Manager'. By default, the page name (as specified in the Site Manager) 
and the button name are the same, but this field allows you to use an alternative name for the item. 
 
Page Width 
Specifies the workspace width of the page. 
 

Notes: 
1. This value is not used by the browser, it's only an internal value used by Web Builder to indicate 

the available workspace and to control the scrollbars when your screen size is not large enough 
to display the content of the page. 

2. The Center in browser option uses this value to calculate the absolute center of your page, so if 
you've designed your page for a resolution of 800x600, make sure this value is set to 800 or 
else your page will not be centered! 

 
Page Height 
Specifies the workspace height of the page. 
 

Note:  
This value is not used by the browser, it's only an internal value used by Web Builder to indicate the 
available workspace and to control the scrollbars when your screen size is not large enough to display 
the content of the page. 

 
Target screen size 
This option helps you determine the optimal page size for a specific screen resolution. It controls the 
page width/height properties. For example, if you select '800x600', then the page width/height will be 
set to 770x600, because you will have to leave some space for the vertical scrollbar, so you can't use the 
full 800 pixels for the page content. 
 
File extension 
Normally your web page will be published using the .html extension. In some cases, it might be 
necessary to specify another extension like .php of .asp in case your page uses PHP or ASP. 
 

Notes:  
If you set the file extension to something other than .html, then your browser may not be able to 
preview the page. To preview PHP or ASP page, you must publish the page to a web server which can 
handle these page types! 
 
After changing the file extension, you will need to re-publish all page’s link to it, otherwise the links will 
still refer to the old page name. 
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Document Type 
The doctype declaration is an instruction for the web browser about what version of the markup 
language the page is written in.  
 

• HTML 4.01 Transitional 
The generated output will be HTML and compliant to the HTML 4.01 specification of W3C. 
 

• XHTML 1.0 Transitional 
The generated output will be XML and compliant to the XHTML 1.0 specification of W3C. 
 

• HTML5 (default) 
The generated output will be HTML and compliant to the HTML 5 specification of W3C. For 
some features (like HTML5 events, CSS3 styles. this option needs to be selected) 
 

Select document type 'None' if you don't want to include the doctype declaration in the page output. 
The generated output will be HTML 4.01 Transitional in that case. 
 
Center page in browser window 
Enabling this option will center the published page in the browser window. This option is for use in 
combination with fixed/absolute layouts only, not with layout grids/flexbox. 
 
Here are a few tips for the designing your pages so they are displayed in the center of the browser: 

• Set the Page properties to 800x600. 

• Enable the Guide Borders and set them to the same size.  

• Make sure all page contents stay between the guide borders. 

• Enable 'Center to browser' in Page Properties. 
 

For more details see also: https://www.wysiwygwebbuilder.com/forum/viewtopic.php?t=153 
 
Center page horizontally and vertically (DEPRECATED) 
 Center the web page both horizontally and vertically in the browser window.  
This option should not be used for responsive websites. 
 
Align to left, but include page width/height 
This option may be useful for designers who want to use their pages for eBay listings. The width and 
height attributes for the page will be added to the page style. 
 
Set Page width and height to 100% 
This option is for use in combination with the ‘Full screen’ floating layer mode.  
 
Related tutorial: 
https://www.wysiwygwebbuilder.com/fullscreen.html 
 
Don't Publish this page 
Enable this option if you don't want this page to be published if you select Publish Entire Web Site. 
Possible reasons for this can be: 

1. This page is currently not part of the website or still under construction 
2. The page is only used as part of your other pages eg. Master Page. 
3. The page has not changed so there's no need to publish it again. 

 
Don't synchronize this page in Navigation Objects 
When this option is enabled, the page will not appear in navigation objects which automatically 
synchronize with the Site Manager. 
 
Don't Include this Page in the Search Index. 
When this option is enabled, the page will not be included in the search index. 
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Don't Include this Page in the Site Map. 
When this option is enabled, the page will not be included in the site map. 
 
Character Set 
The character set tells the browser how to interpret and display the characters on your webpage. 
Depending on the language of the text on the page it might be necessary to force the browser to 
another character set. The most commonly used character sets are: ISO-8859-1 (ANSI) and UTF-8 
(UNICODE). 
  
Page Language 
Specifies the language (Content-Language) of the page. Search engines may use this tag to categorize 
pages by language. 
 
Direction 
Specifies the text direction for the content on the page. This can be either property set to 'left-to-right' 
or 'right-to-left'. 
 
 
Make Default 
Saves the current values as defaults for new pages.  
 

Note:  
You can also update the page properties for all pages at once using Page -> Site Properties! 
Or use multi-page properties to only edit specific properties for multiple pages. 
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Properties - Icons 
 
Favorites Icon 
You can use favorites icons (also known as shortcut icons or favicon) to display your logo or some other 
small graphic on the Favorites menu, address or page tabs of your browser. They are a great way to add 
brand recognition to your Web site. A shortcut icon must be square in size, and at least 16 x 16 pixels. 
Consider creating both a 16 x 16-pixel icon as well as a 32 x 32-pixel icon since on high-DPI displays, the 
browser may stretch the icon to fit the available space. To create the icon, use an icon editor, such as 
Axialis IconWorkshop, IcoFX or Microangelo Toolset and save the icon in the .ico file format.  
 
Optionally, you can specify dedicated image for 32 and 64 pixels in PNG format. 
 
 
Apple Touch Icon  
Like the Favorites Icon, the Apple Touch Icon is a file used for a web page icon on the Apple iPhone, iPod 
Touch, and iPad. When the user bookmarks the web page or adds the page to their home screen, this 
icon is used.  
Apple Touch Icons are also supported by most Android devices.  
 
Unfortunately, different devices require different image sizes. So, that is why we have now added the 
ability to configure multiple sizes. 
 
Common sizes: 
152x152 (iPad) 
167x167 (iPad Retina) 
180x180 (iPhone Retina) 
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Properties - Scrollbars 
 
Modern browsers, like Chrome, Edge, Safari and Opera support the ability to modify the look of the 
browser's scrollbar. For example, you can create a thinner scrollbar or change the color of the track/bar 
and handle. 
 

 
 
Scrollbar Track 
Specifies the background color and width of the track (progress bar) of the scrollbar. 
 
Scrollbar Thumb 
Specifies the border, radius and colors of the draggable scrolling handle. 
It's also possible to change the color of mouse over. 
 
Reset 
The reset button can be used to reset all settings to their defaults. This means that no custom colors will 
be used. 
 
 
Online tutorial: 
https://wysiwygwebbuilder.com/customscrollbars.html 
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Properties - SEO 
 
Search Engine Optimization 
Search engine optimization (SEO) is the process of improving the volume or quality of traffic to a web 
site or a web page from search engines. The theory is that the earlier (or higher) a site appears in the 
search results list, the more visitors it will receive from the search engine. These values may help 
improve your SEO, however modern search engines use more advanced techniques to index your 
website. 
More details: https://en.wikipedia.org/wiki/Search_engine_optimization 
 
Robots 
The Robots Meta Tag is used to tell search engines whether to index and/or crawl a page or not.  
 
Revisit after 
The Revisit Meta Tag is used to tell search engines when to come back next. 
 
Expires after 
The Expires Meta Tag is used to tell search engines when the page and content is no longer valid. 
 
Canonical URL 
If you have different pages with similar content (for example, a page with both a mobile and a desktop 
version), Google sees these as duplicate versions of the same page. Google will choose one URL as the 
canonical version and crawl that, and all other URLs will be considered duplicate URLs and crawled less 
often.  
More information: https://support.google.com/webmasters/answer/139066?hl=en 
 
hreflang 
The hreflang attribute tells Google which language you are using on a specific page, so the search engine 
can serve that result to users searching in that language. The links will also be added to the site map. 
More information: https://support.google.com/webmasters/answer/189077?hl=en 
 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/seo_assistant.html 
 
  



WYSIWYG Web Builder 21   

46 

Properties - Style 
 
Background mode 
Specifies the background mode. 
  

• Transparent 
The background of the page will be transparent. Note that normally this means that page will 
be white, because you cannot look through the browser window... 
 

•  Solid 
Use a solid background color. 
 

• Image 
Use an image as background. 
 
Repeat 
Sets the tiling attributes for the background image. Possible options are: 
- repeat in both directions 
- repeat in horizontal / vertical direction 
- do not repeat  
- space, the background-image is repeated as much as possible without clipping.  
- round, the background-image is repeated and squished or stretched to fill the space (no gaps). 
 
Horizontal Align 
Sets the horizontal position for the background image.  
 
Vertical Align 
Sets the vertical position for the background image.  
 
Background image size (this is the drop-down option at the right of 'repeat') 
Specifies the size of the background image. 
 
empty (default) 
The background-image has the default size and scrolls with the content. 
 
fixed 
A fixed background is a background image that will stay in one place while the rest of your text 
and images scroll over the top of it.  
 
cover  
Scale the background image to be as large as possible so that the background area is 
completely covered by the background image. Some parts of the background image may not be 
in view within the background positioning area. 
 
contain  
Scale the image to the largest size such that both its width and its height can fit inside the 
content area. 
 
parallax 
The image scrolls slower than the content in the foreground, creating the illusion of 3D depth.  
 
For advanced users: 
The default speed is 0.3. You can change this by adding a Site Variable with the name 
$PARALLAX_SPEED$ 
The speed at which the parallax effect runs. 0.0 means the image will appear fixed in place, and 
1.0 the image will flow at the same speed as the page content. 
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percentages 
For example: '100% 100%' will stretch the images to 100% of the object's width/height. Other 
values like '50% 50%' are also possible. 
 
pixels 
For example: '320px 250px' will display the image in the specified size. 
 

• Gradient 
Use a (two-color) gradient as background. 
The gradient can either be horizontal or vertical. By default, a background image will be 
generated for the gradient effect. However, you can also use CSS3 gradients by enabling the 
option 'Use CSS3 gradients instead of images' in Tools -> Options -> HTML.  
 

• Multi-color gradient 
Use a (multi-color) gradient as background. WYSIWYG Web Builder includes many predefined 
multi-color gradient styles, but you can easily create your own style with the Gradient 
Manager.  
 

• Pattern 
Use a pattern as background. A new image will automatically be generated for the pattern.  
 

• Texture 
Use a texture as background. A new image will automatically be generated for the texture. 

 
Background-clip 
The 'background-clip' property is an advanced option and it is available in Property Inspector and the 
Style Manager. It specifies the painting area of the background. This may be useful in combination with 
transparent borders.  'border-box' clips the background to the border box. When using a transparent 
border, the background will be visible behind the border. 'padding-box' clips the background to the 
padding box (excluding the border). The background behind the border will be transparent. 
 
Link Color 
This specifies the default, unvisited links color. 
 
Visited Link Color 
This specifies the color of a visited link. 
 
Active Link Color 
This specifies the color of an active link. 
 
Hover Link Color 
This specifies the color of all hover links of the active page. 
 
Underline mode 
Specifies whether links will always be underlined or only when the mouse is over the link. 
 

Note: You can also control the colors of links by using Link Style Sheets. For more information, see the 
description in the chapter ‘Links’. 

 
Default Font, Size and Color 
Specifies the default font, font size and text color that will be used for text you enter in the page. 
 
Theme 
Specifies the (ThemeRoller based) theme for the page. This theme will be applied to all theme enabled 
objects like jQuery UI widgets. Besides jQuery UI widgets you can also enable theming for the menubar, 
navigation bar, tab menu, slidemenu, horizontal line. This way you can give your page a uniform look 
and feel. Themes can be created and edited with the Theme Manager. 
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Page Properties - Meta Tags 
 
Author 
The author meta tag is used to indicate who the author of the web page is.  
 
Keywords 
The keyword meta tag can be important when it comes to some search engines.  
When these auto robot search engines index your site, some will look for a keyword meta tag to use as 
index words.  
When someone uses their search engine and searches on a word that is in your keyword meta tame list, 
your site will be included in the output search results. 
 

Tip:  
The keywords are typically separated by a comma (,) 

 
Description 
The description meta tag can be important when it comes to some search engines.  
There are many search engines that will index your site automatically.  
Some of these search engines allow for a short description to be placed in their web page.  
If the search engines are looking in your web page for a description meta tag, it will use this description 
in the search index.  
 
Categories 
Specifies to which Categories the page belongs to. This meta tag is used by the SiteTree object to 
categorize pages. Example: downloads, products, fun, business, personal etc. 
 
Tip: You can assign multiple categories to a page. The categories should be separated by a comma (,) 
 
Generator 
Typically, the name of the application used to create the page. 
 
User defined 
Here you can insert your own custom meta tags. These will be inserted before all other meta tags right 
after the <head> tag. 
 
Example: 
<meta http-equiv="Cache-control" content="no-cache"> 

<meta name="expires" content="tue, 01 Jun 2028 19:45:00 GMT"> 

 
 

Open Graph Meta Tags 
These settings make it easy to add Open Graph meta tags to a page to enable it to become a "rich" 
social object.  For instance, Facebook uses this information to work out how to preview shared content 
in a user's Facebook profile. 
The following properties are supported: og:url, og:title, og::description, og::image and og::type 
https://developers.facebook.com/docs/sharing/webmasters#markup 
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Twitter Cards 
With Twitter Cards, you can attach rich photos, videos and media experiences to Tweets, helping to 
drive traffic to your website. If you add Twitter Card meta tags to your webpage, users who Tweet links 
to your content will have a “Card” added to the Tweet that’s visible to their followers.  
This is very similar to sharing a link on Facebook which automatically displays a preview with title, 
summary, and thumbnail of your page content when using Open Graph Meta Tags.  
 
More information:  
https://developer.twitter.com/en/docs/tweets/optimize-with-cards/overview/abouts-cards 
 
 
The following Card types are supported: 

• Summary 
The Summary Card can be used for many kinds of web content, from blog posts and news 
articles to products and restaurants. It is designed to give the reader a preview of the content 
before clicking through to your website. 
 

• Summary with large image 
The Summary Card with Large Image features a large, full-width prominent image alongside a 
tweet. It is designed to give the reader a rich photo experience, and clicking on the image 
brings the user to your website. 
 

• Player 
Video clips and audio streams have a special place on the Twitter platform thanks to the Player 
Card. By using the Player option (and following the Twitter Developer Policy), you can deliver 
your rich media to users across the globe. 
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Properties - Miscellaneous 
 
Master Page 
In this section you can specify the master page or master frame of the page. 
 

• Master Frame 
Specifies the page used for the Master Frame. The idea behind a master frame is that the page 
will have a common 'frame' and the content of this page will be put inside the Content Place 
Holder of specified Master Frame when the page is being previewed or published. The footer 
and (right) sidebar of the master frame will automatically be moved based on the size of the 
content. Or in other words: the content place holder will expand. Online tutorial: 
https://wysiwygwebbuilder.com/master_frame.html 
 

• Master Page 
In addition to a Master Frame you can now also use another page as master page. This does not 
require a content place holder. Basically, the master page will be used as 'background' of the 
content page and you place all other objects on top of this. Online tutorial: 
https://wysiwygwebbuilder.com/master_page.html 

 
To remove a previous selected name, click the 'Remove' button. 
 
Redirect 
The Redirect property redirects the user to another page after a specific delay. 

• Do no redirect 
Disables the redirect feature.  

• Web Site 
Redirect the user to an external page.  

• Internal page 
Redirect the user to a (internal) page of your website. 

 
Redirect URL 
Specifies the URL where the user will be redirected to. 
 
Redirect Delay 
Specifies the redirect delay. 0 (zero) means no delay. 
 
Lightbox 
Specifies the lightbox script that will be used for internal features like 'Open link in Lightbox' or the 
lightbox functionality in YouTube, Vimeo and HTML5 video. Additional lightboxes can be downloaded 
here: https://wysiwygwebbuilder.com/free_extras.html 
 
Preloader 
A preloader (also known as loading screen) is what you see on some sites before the main content of the 
web page is loaded. WYSIWYG Web Builder can display a (semitransparent) overlay with animated gif 
when the website loading is in progress. It will disappear right after the page loads. 
A collection of standard preloader images is included, but you can also add your own animations by 
adding a custom gif image to the 'preloader' folder. 
 
This folder is normally located in Documents\WYSIWYG Web Builder\system\preloader\ 
 
The background property specifies the color of the overlay background (not the background color of the 
GIF!). The background color supports alpha transparency. 
 
Online tutorial:  
https://www.wysiwygwebbuilder.com/preloader.html 
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Properties - Advanced 
Overflow 
These properties specify whether content is clipped when it overflows the browser window.  
‘Overflow-x’ determines clipping at the left and right edges, ‘Overflow-y’ at the top and bottom edges.  
 

• none 
The overflow attribute will not be added to the page HTML. In this case scroll behavior may be 
different for each browser type.  

• visible 
This value indicates that content is not clipped, i.e., it may be rendered outside the browser 
window.   

• hidden 
This value indicates that the content is clipped, and that no scrolling mechanism should be 
provided to view the content outside the browser window.   

• scroll 
This value indicates that the content is clipped and that if the browser displays scrollbars.  
This avoids any problem with scrollbars appearing and disappearing in a dynamic environment 
where pages have different sizes.   

• auto 
The behavior of the ‘auto’ value is browser-dependent but should cause a scrolling mechanism 
to be provided for overflowing boxes.  

 
 
Layout Mode 

• CSS layout 
The recommended layout mode. This mode will use CSS (absolute positions) to create the best 
possible layout. All objects will be individually positioned, so you can overlap objects and place 
them anywhere you like. It also results in very clean HTML code.  

• Table Layout (not recommended!) 
This mode uses (invisible) tables to position objects on the page.  It does not allow objects to 
overlap! This technique was used by web designers before CSS was supported by all browsers. 
Note that today, all browsers do support CSS and table-based layouts are considered old 
fashioned technology. However, table layouts can be useful for Newsletters because email 
clients usually do not support CSS. See ‘Creating Newletters’ later in this document for more 
details. 
 

Use z-index for object order 
By default, all objects use the 'z-index' attribute to set the position in the z-order of the page. If for some 
reason, you do not want this, then you can disable this option. Do not change this value unless you 
know what you are doing! 
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Disable CSS media query 
When this option is enabled, then breakpoints/media queries will not be published. This may be useful 
for testing purposes. 
 
Disable HTML/CSS/JavaScript formatting 
This option disables beautify and minify options for the current page. This may be useful for testing 
purposes or when you have added code to the page which does not support formatting. 
 
Disable custom code 
When this option is enabled, then custom code with not be included in the published page. This makes it 
possible to test the page without custom code. For example, in case something does not work, you do 
not have to remove all code. 
 
Disable scroll events on small screens 
This option adds the ability to disable scroll events on small screens (e.g. phones).  
 
Disable scroll transitions on small screens 
This option adds the ability to disable scroll transitions on small screens (e.g. phones).  
'Minimum width' specifies the width at which the scroll events/ transitions will be disabled. 
 
Disable CSS animations and transitions on small screens 
This option will disable all CSS animations and transitions on small screens (e.g. phones).  
'Minimum width' specifies the width at which the scroll events/ transitions will be disabled. 
 
Note that this will only work for CSS animations / transitions. JavaScript animations will not be affected. 
 
Exclude browsers 
This option adds the ability to disable scroll events and transitions on specific browsers. 
Multiple browsers are separated by a pipe character. For example: 
Android|iPhone|iPad|iPod|BlackBerry 
 
Technical details: Exclude browsers uses the following JavaScript function to detect browsers: 
 
(/Android|iPhone|iPad|iPod|BlackBerry/i).test(navigator.userAgent || navigator.vendor); 
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Insert 
 
Most of the menu items are also available through the Toolbox. More details about the available objects 
can be found in WYSIWYG Web Builder objects later in this document. A few additional choices are 
available in the Insert Tab: 
 
Select 
The Select object is used to select objects. To select multiple objects, drag a selection box around them, 
or hold down the Shift key while you click them one at a time. 
 
Symbol 
Insert a symbol (special character) into a text object. This option is only enabled when you are in text 
edit mode. 
 

 
 
Link 
Opens a link dialog for the selected object or text. 
Check out chapter ‘Links’ for more details. 
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Format 

 
Most formatting tools apply to text only. WYSIWYG Web Builder allows you to make all the same 
attribute changes you can make in (for example) MS Word. To edit the formatting of text you must first 
double click the text object to go into edit mode, then highlight the text you want to modify with the 
mouse and select formatting option. 
 
Font Family 
Font type is the font family of text, such as Comic Sans, Times New Roman, and Courier New.  
To change the font type, select the font you want from the Font Type List Box on the toolbar.  
 
Font Style 
The style of the text can either be bold, italics, or underline.  
To change the font style, select one or more of the Style Icons on the toolbar. 
 
Font Color 
The color of the text can also be changed.  
To change the font color, select the Text Color Icon on the toolbar.  
The Color Dialog Box appears. Choose the color you want and click OK. 
 
Background Color 
To change the background color of the selected text, click the Background Color Icon on the toolbar.  
The Color Dialog Box appears. Choose the color you want and click OK. 
 
Change Case -> Sentence case 
Capitalizes the first letter of each sentence of the selected text. 
 
Change Case -> Lowercase 
Sets all selected text to lowercase. 
 
Change Case -> Uppercase 
Sets all selected text to uppercase. 
 
Change Case -> Capitalize Each Word 
Capitalizes the first letter of each word of the selected text. 
 
Change Case -> Toggle case 
Toggles the case of each letter of the selected text. 
 
Decrease indent 
Decrease the left margin (indent) of the current text line. 
 
Increase indent 
Increase the left margin (indent) of the current text line. 
 
Letter spacing 
Sets the amount of additional space between letters in the text. 
 
Line height 
Sets the distance between lines in the object. 
 
Font Size 
To change the font size, select one of the available HTML font sizes. 
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Text Alignment 
You can change the alignment of the selected text object by using one of the alignment buttons: Left, 
Center, Right or Justify. 
 
Remove formatting 
Sometimes it can be useful to remove all formatting from a piece of text at once. Highlight the text and 
select Remove Formatting to reset all styles to its default values. Formatting removed from the text 
include bold, italic, underline, subscript, superscript, strikeout, text color and background color. 
 
Remove link 
Removes the link that was assigned to the selected text. 
 
Search in Google 
When you are editing text, this command will search the selected word on Google. Your computer must 
be connected to the Internet.  
 
Look Up in Dictionary 
When you are editing text, this command will look up the selected word on the website: 
https://dictionary.reference.com/  
Your computer must be connected to the Internet. 
 
Styles 
In the Style Manager you can manage the styles of a project. By using styles, you can modify the style of 
the entire website all in one place. 
 

General Styles 
In the General Style page HTML/CSS styles can be defined, such as text header styles (H1, H2, 
H3 ...) or form element styles. See also: Style Manager. 

 
Link Styles 
By default all links in your webpage use the default HTML link colors as defined in the Page 
Properties. But by using link styles you can set the style of individual links. 
a) Create a new style 
b) In the (text) link properties select the style. The style will be applied when you preview or 

publish the page. 
 

Gradient Styles 
Use the Gradient Style Manager to add/edit and remove global (multi-color) gradients effects. 
Gradient effect can be used by Shapes, ClipArt, TextArt and other drawing tools. 
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Web safe fonts 
Web safe (or "web safe", "safe for the web") fonts are fonts that are common among all versions of 
Windows, Mac, and Linux. We recommend using web safe fonts if you want your web pages to look the 
same on all computers. 
 
List of web safe fonts: 

• Arial 

• Courier 

• Courier New 

• Georgia 

• MS Serif 

• Palatino Linotype 

• Times New Roman 

• Trebuchet MS 

• Verdana 
 
You can enable the option Tools -> Options -> Fonts ->Display web safe fonts only', so WYSIWYG Web 
Builder will only display web safe fonts. This may also increase the speed of the user interface, because 
not all fonts need to be loaded into memory every time you want to select a different font. 
 
 
Using @font-face 
For a long time, it was only possible to use a selected number of web safe fonts in your web designs.  
However now you can use any font by enabling WYSIWYG Web Builder's 'Use @font-face for non-web 
safe fonts' option (Tools -> Options -> HTML)! If you enable this option, you will be able to use any type 
of true type font even if it's not web safe by using a new CSS3 feature called @font-face. WYSIWYG Web 
Builder will automatically generate the necessary code and upload the font to the server. It will even 
generate a secondary (eot) font file required to make this feature work with IE! 
 
 
Online tutorial:  
https://www.wysiwygwebbuilder.com/webfonts.html 
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Table 
The Table Menu contains all the operations related to creating and modifying tables. Tables have 
columns and rows of cells that can contain text (images, forms, or other page elements are not 
supported now). Tables are useful for the layout of data; they can be used to simulate columns of text. 
When you type text in a table cell it expands horizontally and vertically to accommodate the text that is 
typed or inserted. You can edit, format, and specify properties (background color or image) for the text, 
as well as for the table cell, row, column, or table itself. You can easily resize cells, columns, rows, or the 
entire table by dragging the borders.  
 
Insert Table 
Draw a box where you want to position the table. 
The Insert Table dialog appears. 
Enter the number of cells and rows required.  
Enter layout and size details and click on OK  
   
Insert Rows or Columns 
Select this option if you need to insert additional rows and columns after a table has been created. 
Specify if you want to insert Rows of Columns and enter the number of rows/columns to be added. 
To insert a column to the left of a selected column, choose Left of selection. 
To insert a column to the right of a selected column, choose Right of selection. 
To insert a row above a selected row, choose Above Selection. 
To insert a row below a selected row, choose Below Selection. 
 
Merge Cells 
Merge two or more adjacent cells. This command is only available when two or more adjacent cells are 
selected on the same row. 
 
Split Cell 
Split the selected cell into columns. 
 
Delete Column 
Select this option to delete the selected column. 
 
Delete Row 
Select this option to delete the selected row. 
 
Table Column Width 
Set the column width for the selected column. 
 
Table Row Height 
Set the row height for the selected row. 
 
Sort 
Sort text (Ascending/Descending) of a table column or row. 
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Table Properties 
 
Border Size 
Enter how wide you want the border to be, in pixels. 
 
Cell Padding 
Enter how much space you want between the contents and inside edges of cells, in pixels.  
 
Cell Spacing 
Enter how much space you want between the cells in the table, in pixels. 
 
Background color 
Specifies the color of the form background. If set to 'Automatic' the webpage background will be used. 
 
Background image 
Specifies the optional background image. 
 
Border color 
Specifies the color of the table's borders. If set to 'Automatic' the table will have a 3d border. 
 
Hover rows color 
Enable a hover state on table rows. 
 
Striped row color 
Add zebra-striping to the table rows. 
 
Header row 
This will output the first row as header cells (<th> instead or <td>). 
 
Size mode 

• Pixels, the size of table cells is in pixels. This will get the best 'pixel perfect’ result. However, 
when using the table in responsive layouts, it cannot be resized in breakpoints. 

• Percentages, the size of cells is in percentages. The cell sizes will be approximately based on the 
design time dimensions. Using this option makes it possible to resize the table in breakpoints. 
However, the cell sizes will still have the same percentages relative to the table size. 

• Automatic, when using this mode, the table cells will be automatically sized based on their 
content. This makes it possible to use a table in layout grid layouts. 

 
Table Styles gallery  
The 'Table Styles' gallery (in the Ribbon). This allows you to quickly update the style of your tables. You 
may know this feature from MS Office. 30 predefined styles are currently available. 
 
Sort 
Sort text (Ascending/Descending) of a table column or row. If you sort a column, then the other columns 
will be moved too. Also, the style of the cells will be included, not only the text, so cells keep their own 
styling.  
 
Import data from text file 
A quick way to get data from a comma separated text file into the table. Data should be separated with 
a comma. 
 
Table HTML 
View generated HTML of the table. You can also insert your own HTML code! 
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Cell Properties 
 
Background Color 
Specifies the color of the text background. If set to 'Automatic' the webpage background will be used. 
 
Background Image 
Specifies the optional background image. 
 
Repeat 
Sets the tiling attributes for the background image. 
Possible options are: 

• Repeat in both directions 

• Repeat in horizontal direction 

• Repeat in vertical direction 

• Do not repeat 
 
Horizontal Align 
Sets the horizontal position for the background image.  
 
Vertical Align 
Sets the vertical position for the background image.  
 
Cell HTML 
View generated HTML of the selected cell. You can also insert your own HTML code! 
 
 

Table Tips:  
1. While resizing the table hold down the Ctrl-key to resize the last column/row of a table with 

affecting the size of the other columns/rows. 
2. To select multiple cells, hold down the Ctrl-key while selecting the cells. 
3. To select the whole row, move the mouse cursor to the left border of the first cell. 
4. To select the whole column, move the mouse cursor to the top border of the first cell. 
5. To change the properties of multiple cells in one action, first select the cells and then click Cell 

Properties. 
6. To center an image in the middle of a cell, open Cell Properties, specify the background image, 

set Repeat to 'Do not repeat' and set Horizontal/Vertical Align to 'Center'. 
7. To change the font and size of multiple table cells: Select multiple cells -> hold down the SHIFT 

key and click cell properties. 
 
 

Using a Table as an object container 
Since version 12 is it now also possible to add other objects to table cells. When you drag an object 
inside a cell then it will automatically become an object container (just like a layer or layout grid). Any 
text that was in the table cell will no longer be visible (until you remove the object again). 
Multiple objects can be inside a single cell, and they will be floating, just like in a layout grid. Note 
however that tables are not meant to be used for layout purposes. The main reason why this 
functionality was added is to make it possible to add images to the table. 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/tables.html 
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Arrange 

The arrange menu contains all operations related to the layout of the current page. 
 
Align 
Lefts 
Align the left edges of the selected objects with the dominant object. 
  
Centers 
Align the centers of the selected objects with the dominant object. 
 
Rights 
Align the right edges of the selected objects with the dominant object.  
 
Tops 
Align the top edges of the selected objects with the dominant object.  
 
Middles 
Align the middles of the selected objects with the dominant object.  
 
Bottoms 
Align the bottom edges of the selected objects with the dominant object.  
 
Space Evenly 
Across  
Evenly spaces the selected controls horizontally. 
 
Down 
Evenly spaces the selected controls vertically. 
  
Center in Page 
Vertical / Horizontal 
Centers the controls vertically or horizontally within the web page.  
 
Make same size 
Width 
Resize the selected objects to have the same width as the dominant object. 
 
Height 
Resize the selected objects to have the same height as the dominant object. 
 
Both 
Resize the selected objects to have the same size as the dominant object. 
 
Arrange 
Move to Front         
Move object to front of the page. 
 
Move to Back 
Move object to back of the page. 
 
Move Forward 
Move object to next position in z-order. 
 
Move Back         
Move object to previous position in z-order. 
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 Group 
You can group multiple objects, so that they stick together when you move them. When you select one 
object from a group, the other objects will automatically be selected too. Grouped objects cannot be 
edited until you ungroup them. 
 
Ungroup 
Ungroup objects. 
 
Merging Objects 
By using this option, you can merge multiple objects into a single image! This can be useful for merging 
multiple (layered) shapes into a single image to reduce the number of published images and speed up 
loading times. This option will basically convert any object (or group of objects) into an image. So if this 
is used for objects like forms, buttons, menus then they will lose their original functionality, since they 
will be published as a static image. 
 

Tip:  
You can also use this option on a single object. This can be useful to convert an image or shape to 
another image format. 
 
For example, let's say you have applied a shadow effect to an image. The output format of the image 
will then be PNG. Now select 'Merge' from the menu. The image will be converted to an 'merged 
object', you can now select another output format like jpg which will result in a smaller output image). 
Q: But wait.... what will happen to the transparency of the shadow?  
A: The merged object will make a 'snapshot' of the background objects and use that as background 
image! 

 
 
Merge Objects 
Merge the currently selected objects. In the properties of this object, you can specify the output format 
of the image. 
 
Split Objects 
This option will split previous merged objects. 
 
Save as Block 
Save the selected object(s) as Block, so you can reuse them later in the same (or another) project. 
Blocks are ‘building blocks’ that make it possible to quickly create a website by dragging predefined 
blocks to the workspace. Blocks Once the block has been dragged to the page you can fully customize 
the behavior and appearance of the content. 
 
Rotate 
This command will activate the rotate mode. You can rotate images and shape objects. 
For more information see also: Rotation 
 
Lock/Unlock 
This will 'lock' the selected objects, so that they cannot be moved or resized accidentally. Note that this 
will also prevent you from editing the objects’ properties unless you enable the option 'Allow locked 
objects to be edited' in the Tools -> Options -> Advanced configuration. To unlock the object again, 
repeat the same command. 
 
Lock All 
This will lock all objects in the active page. 
 
Unlock All 
This will unlock all objects in the active page. 
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Guide settings 
 
Snap to ruler guides 
Enable or disable snap to ruler guides  
 
Show Table Cell Outlines (if border = 0) 
When this option is enabled, Web Builder will draw table cell outlines even if the border is zero. 
 
Show Guide Borders 
Guide borders can be useful when designing a web page for specific resolutions. If you make sure all 
objects stay between the guide border, the final page will fit in the desired window size. 
 
Show smart guides when objects are aligned 
Smart guides are dynamic guidelines that appear when you move objects into alignment with each 
other. 
 
Lock page size (no automatic page adjustment) 
Normally Web Builder will automatically update the page size if you place an object outside the page 
borders. When this option is enabled, the page width will be locked even if you place objects outside the 
border.  If you want a larger workspace you will need to update the page width/height manually in that 
case (using Page Properties). 
 
Show Grid 
Show or hide grid. 
 
Snap to grid 
Enable or disable snap to grid. Use the Snap to Grid feature to align objects exactly. Web Builder creates 
a "magnetic" attraction between the selected object and the grid.  
 
Grid Spacing 
Specifies the spacing between the grid dots. 
 
Show Tooltips while resizing and moving objects and guides 
Enable this option if you want to see the current position (while moving) or size (while resizing) of the 
current object in a tool tip above the mouse cursor. 
It also works while moving ruler guides! 
 

Note:  
This option may cause objects to render a little bit slower during moving/resizing because the tooltip 
needs to be updated constantly. 

 
 
Edit Points 
This option can be used for Polygons and Curves to add, edit and remove nodes. 
To start editing nodes, first select Polygon or Curve and then select 'Edit Points' from the menu. 
To edit existing nodes simply hold the left mouse button and drag it to its new position. 
To add a new node, click anywhere on the line and drag the point to the desired position. 
To remove a node, hold down the CTRL key and click the node with the left mouse button. 
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Ruler guides 
Horizontal and vertical ruler guides are used to align objects on the page.  
Typically, ruler guides are placed on the page by dragging them from the horizontal and vertical rulers or 
by specifying precise positions using the 'Format Ruler Guides' dialog box.  
Alternatively, you can use the menu option 'Add Horizontal Ruler Guide' or 'Add Vertical Ruler Guide' to 
insert a new guide. 
  
To move the ruler guide, position the mouse pointer over the guide, until you see the vertical or 
horizontal Adjust pointer and then drag the guide to its new position.  
 
You can remove a single ruler guide or all ruler guides from a page. Position the mouse pointer over the 
ruler guide you want to delete until you see the adjust pointer and then drag it back to the ruler. Or you 
can use the 'Format ruler guide' dialog box to delete the ruler. 
 
To remove all ruler guides in a page, select the Arrange menu, point to Ruler Guides, and then click Clear 
All Ruler Guides.  
 
Objects which are placed close to a guide "snap to" the guide for easy alignment. 
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Tools 

 
Asset Manager 
The Asset Manager can be useful to modify the location of one or more assets (images, movies, sounds 
etc.) without the need to open the properties of each item. You can select which group of items will be 
displayed in the Asset Manager (Filter). 
 
To change the location of only 1 asset, simply select the item, click the 'Update' button and select the 
new location. To change the location of multiple assets, select the items, click the 'Update' button and 
select the new location. This means that you can update the location of all assets with just a few clicks! 
 
It is also possible to move assets to another location. In that case a copy of the assets will be made to 
the specified location and update the path in the editor. Note that the original file will not be deleted! 
 
Another useful feature of the Asset Manager is the ability to show all orphan files in the project folder.  
Select Filter -> Orphan files to display a list of all the assets no longer used by the current project. Now 
you can select and remove those files from the project folder. 
 
Linked files, displays a list of the downloads in the project. 
Extensions, displays a list of all the extensions used in the project. 
Copy, Copy the file list to the clipboard. 
 

Backup Manager 
Each time you save your project the software will automatically create a backup of the previous version 
of the project. The backup behavior can be configured in Tools -> Options -> Backup 
 
The Backup Manager can be used to easily restore and delete automatically created backups. The 
Backup Manager will display the time and date of the backup and the filename. The back upped files will 
have file names like: myproject_01.wbs, myproject_02.wbs, myproject_03.wbs. The highest numbered 
file will always be the latest backup.  
 
To restore a backup, select the filename and click 'Restore'. The file will then be moved back to the 
project folder and renamed to its original name. 
 

Notes:  
- The Backup Manager will override the current version of the project! 
- A backup cannot be restored if the project is currently in use. So close the project before using the 
Back Manager. 
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Page Weight 
The Page weight tool helps you determine the estimated size and download time of a page. 
The tool will list all files which are part of page and their sizes. By selecting the connection speed, you 
can get an idea how long it will take to download the complete page. Note that some files (like scripts, 
images) are used by multiple pages. They will be downloaded only once by the browser. 
 
 

Link Manager 
This option scans your documents for links and displays them in a list. 
You can choose to edit them or press the Verify button to validate their current state. 
 
Possible states: 
Not verified  - not verified yet 
Validated URL  - URL is valid 
URL not found  - URL is not valid (or currently not reachable) 
 
This tool can be handy when you want to verify all your links, so you don't have to verify them one by 
one. 
 

 
Image Converter 
The Image Converter is a wizard that can be used to convert or compress images used by the project, 
but it also be used for external images! 
 

 
 
Convert to jpg, png or webp format, set the maximum image dimensions and / or use compression to 
shrink the size of the images. It is also possible to remove meta data. When the tool is used for images 
used by the project, you can first preview the result before applying the new images to the project 
(automatically). 
 
Online tutorial 
https://www.wysiwygwebbuilder.com/imageconverter.html 
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SEO Assistant  
This tool helps you make your web pages more search engine friendly. The SEO Assistant scans the page 
for missing image descriptions, keywords, sitemap.xml/robot.txt, header tags, broken links, mobile 
support and more. Double clicking one of the reported issues will either open the properties (meta tags, 
sitemap etc.) to fix the issue or select the object in the workspace. 
  
Here is a list of common issues and solutions. Note that these are just recommendations.  
 
Page has no description 
Add a description in the meta tags section of the page properties. 
 
Page has no keywords 
Add keywords in the meta tags section of the page properties. 
 
Page has no language 
Set the page language in page properties. 
 
Page is not mobile friendly 
Add breakpoints or use flexible layout to make the page mobile friendly. More information about 
making your website responsive is available here: Responsive Web Design - Design Techniques 
 
Web site has no sitemap.xml/ robots.txt 
Enable 'Generate sitemap' and/or 'Generate robots.txt' this project.  
 
Page has no header tags 
Add headings (h1, h2 etc) to the page. Heading tags can be added via the heading object or via styles. 
 
Navigation does not have structured data 
Enabling structured data (https://schema.org/SiteNavigationElement) for navigation objects may 
improve SEO ranking. This option can be activated in Tools -> Options -> HTML 
 
Image has no description 
Describe the appearance and function of the image on a page 
 
Link seems to be broken 
This warning will be displayed when the software cannot access the specified link. 
Note that you can also verify all links in the project via the Link Manager in the Tools menu. 
 
Link is not secure 
This warning will be displayed when the link uses https:// instead of https:// 
 
Image too large (> 750KB) 
Large images will impact the performance of the page. Make sure images are optimized before adding 
them to the page. The maximum size trigger can be customized via the context menu. 
 
Form control has no label 
Use a label object to describe the purpose of the form control. 
Labels are an accessibility feature that allows screen readers (as used by blind and other users) to voice 
the input prompt to the user. The label should describe in sufficient detail what input is required from 
the user. Missing labels will make a form inaccessible for many users. 
 
Note: 
The SEO assistant is regularly updated to keep up with the latest web design rules. So, it may be a good 
idea to run the tool every once and a while to make sure your websites stay search engine friendly. 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/seo_assistant.html 
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Site Map 
The sitemap tool creates an XML sitemap that can be submitted to Google and other search engines to 
help them crawl your website better.  
 
A Sitemap is an XML file that lists the URLs for a site. It allows webmasters to include additional 
information about each URL: when it was last updated, how often it changes, and how important it is in 
relation to other URLs in the site. This allows search engines to crawl the site more intelligently.  
  
It's important that you specify the full URL to your website, for example 
https://www.wysiwygwebbuilder.com/  
This URL must begin with the protocol (such as http) and end with a trailing slash. You can specify the 
change frequency and priority for each page on your website. 
 
Change frequency 
How frequently the page is likely to change. This value provides general information to search engines 
and may not correlate exactly to how often they crawl the page.  
Valid values are: always, hourly, daily, weekly, monthly, yearly, never  
 
The value "always" should be used to describe documents that change each time they are accessed. The 
value "never" should be used to describe archived URLs. 
 
Please note that the value of this tag is considered a hint and not a command. Even though search 
engine crawlers consider this information when making decisions, they may crawl pages marked 
"hourly" less frequently than that, and they may crawl pages marked "yearly" more frequently than 
that. It is also likely that crawlers will periodically crawl pages marked "never" so that they can handle 
unexpected changes to those pages. 
 
Priority 
The priority of this page is relative to other pages on your site. Valid values range from 0.0 to 1.0. This 
value has no effect on your pages compared to pages on other sites, and only lets the search engines 
know which of your pages you deem most important so they can order the crawl of your pages in the 
way you would most like. 
The default priority of a page is 0.5. 
 
Please note that the priority you assign to a page has no influence on the position of your pages in a 
search engine's result pages. Search engines use this information when selecting between pages on the 
same site, so you can use this tag to increase the likelihood that your more important pages are present 
in a search index. 
 
Also, note that assigning a high priority to all the pages on your site will not help you. Since the priority 
is relative, it is only used to select between pages on your site; the priority of your pages will not be 
compared to the priority of pages on other sites. 
 
The final step is to tell Google where it can find your sitemap.  
https://www.google.com/webmasters/tools/docs/en/sitemap-generator.html#submitting  
 
The location of the sitemap will be something like:  
https://www.yourwebsiteurl.com/sitemap.xml 
 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/sitemap.html 
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Robots.txt  
Robots.txt is a text file with instructions for search engine crawlers. It defines which areas of a website 
crawlers are allowed to search.  You can configure whether to allow /disallow the entire website or 
configure the rules for each folder individually. 
 
Generate robots.txt 
Specifies whether to generate robots.txt file when the website is published. The file will be published in 
the root of the website. 
For example: https://www.yourwesbite.com/robots.txt 
 
Rule 
This sets the rule for the entire website. This can be overridden for each page and folder. 
 
Allow all, allow robots to index all pages and folders on the web site. 
Disallow, disallow robots from indexing all pages and folders on the web site. 
 
Pages and Folders 
Under 'Pages and Folders' you can override rules for individual pages and folders.  
First select the page in the site tree and then select one of the rules from the drop-down list: 
 

• not set 
The page will use the rule as configured in the 'General' section. 
 

• allow index 
Tells a search engine to index a page. 
 

• disallow index 
Tells a search engine not to index a page. 
 

• allow follow 
Even if the page isn’t indexed, the crawler should follow all the links on a page and pass equity 
to the linked pages. 
 

• disallow follow 
Tells a crawler not to follow any links on a page or pass along any link equity. 

 
Asset Folders 
In WYSIWYG Web Builder, assets (like images, pdf, videos, css, etc.) can be published to a different 
folder. These folders can also be included / excluded for indexing. This can be useful if you do not want 
your documents (PDF) or images to be included in search results. 
 
Asset folders can be configured in Tools -> Options -> Publish 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/robots_txt.html 
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Customize 
This command will display the Customize window. This option is for advanced users only and allows you 
to customize almost every menu, toolbar or keyboard shortcut of the application. Users who are familiar 
with Microsoft Office products will probably recognize most of the available settings. 
 

Translate Text 
This is part of the AI tools, but also available as separate tool. Translate selected objects or create a 
translated copy of the whole page! 
 
Online tutorial: https://wysiwygwebbuilder.com/translation.html 
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General Options 
Create blank document at startup 
Enable this option to create a new empty project when the application starts up. 
 
Application window maximized at startup. 
Enable this option to maximize the application window at startup. 
 
Open the most recent used file at startup 
Specifies whether to open the most recent used project at startup 
 
Open the most recent used page of the project 
This will open the page that was active when you last saved the project. 
 
Show splash screen 
Enable this option to display the splash screen/copyrights image at startup. 
 
Allow locked objects to be edited. 
Locked objects cannot be moved or resized, but you can still edit their properties. 
 
Check for updates online at startup. 
This option will connect to the Web Builder website to check if there is a new version of the software 
available. 
You can also check for updates in the Help menu: Menu -> Help -> Check for updates online. 
 
Show page extensions in Site Manager. 
Enable this option to display the extension of the page (html, php, asp etc.) in the Site Manager. 
 

Note:  
You must restart the application before the page extensions will be displayed. 

 
Automatically check for duplicated IDs when page is loaded. 
Enable this option to automatically check for duplicated IDs when page is loaded, published or 
previewed.  If the software finds duplicated IDs, then it will show a message with a link to Error Reports. 
 
Use ctrl+click+drag to duplicate objects 
Enable/disable ctrl+click+drag (duplicate objects) functionality. 
 
Text Box 
Initial Text: Specifies the initial text of a text object. Default: Double click to edit 
 
Do not show initial text, but directly go into edit mode when created. 
If you enable this option, then the initial text (Double click to edit) will not be displayed. You can directly 
start typing text into the box. 
 
Synchronize MySQL settings between login objects 
When this option is enabled, any updates made to MySQL properties will automatically apply to all login 
objects. Additionally, new login objects created in the project will inherit the same settings as existing 
objects. This eliminates the need to configure each object individually, streamlining the process and 
ensuring consistent settings across all login objects. 
 
Enable 'Use Theme' as default for new objects 
Specifies whether to enable theme support for all newly created objects. 
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Responsive Web Design 

Keep inline styles with Responsive Web Design  
This option applies to Responsive Web Design only. This is an advanced option. Do not change this 
option if everything works correctly!  
 
When using Responsive Design Design/breakpoints, the software will move all inline styles of objects to 
the <style> section in the header of the page. This makes it possible to use CSS3 media queries to 
control the position, size and visibility of objects for different breakpoints. 
However, in some cases this may affect the behavior of an object or extension. If you enable this option 
then the software will not touch inline styles, but adds ‘!important’ to overwrite the position, size and 
visibility of objects with media queries. 
 
Use 'Include visibility' as default for new objects in Responsive Web Design. 
This option sets the default value for 'Include visibility' in Responsive Web Design. 
A description of the 'Include visibility' option is available here. 
 
Automatically scale new objects in other breakpoints  
Normally when you insert a new object, it will be inserted at the same position and with the same size 
as the default view (for fixed/absolute layouts).   
When this option is enabled, new objects will automatically scale and reposition in other breakpoints 
relative to the breakpoint size. It will also scale the font size of some objects when possible.  
 
Notes: 
This option was mainly designed for fixed/absolute layouts. When you use layout grids or flex box the 
layout is flexible based on width of the browser window. Also, if you do not want the text to scale 
automatically, you can disable this option. 
 
The font-size of the Text object can only be scaled when 'Enable responsive fonts' is enabled. 
 
Hide new objects on other breakpoints (Responsive Web Design) 
When this option is enabled then new objects will be set invisible in other breakpoints. This is usually 
the best option because new objects generally do not have the same position of different breakpoints. 
You can use the Object Manager to make the object visible in other breakpoints. 
 
Default breakpoints 
Configure default breakpoints (and font sizes) for new pages. It's also possible to set the default value 
for 'Activate breakpoints when browser window is smaller/larger' than the device width. 
 
Unsplash Access Key 
By default, Unsplash requests will be made via the WYSIWYG Web Builder's Unsplash account. The 
number of requests per hour in limited to 250 for each user. If need more than 250 requests then you 
can specify a (private) Access Key, so the application will use own your Unsplash account instead. In that 
case, all requests will go directly to the Unsplash website instead of via WYSIWYG Web Builder's proxy. 
 
To get an Access Key, you will need to create a developer account on the Unsplash website: 
https://unsplash.com/oauth/applications 
 
Disclaimer: 
WYSIWYG Web Web Builder uses the standard Unsplash API to get the information about the images 
from the Unsplash website. Like most third-party APIs, the Unsplash API is regularly updated. This means 
that in the future this functionality may suddenly stop working. Of course, we will do our best to make 
sure the software is always up to date, so if Unsplash no longer works then please check the website for 
an update. 
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HTML Options 
Generate external CSS style sheets for page specific styles. 
Enable this option to generate a separate CSS file with the styles used by a page. The name of the file 
will be the same as the page name. So 'index.html' will generate an ‘index.css' file. 
Inline styles will not be part of the style sheet! So, for the best results your objects should make use of 
styles created in the Style Manager. 
 
Generate single CSS style sheet for global styles. 
Enable this option to generate a single CSS file with all styles created in the Site Manager. All pages will 
refer to this file. 
The global style sheet will not contain page specific styles (like menu bar styles). 
 
Optimize inline styles (experimental) 
This is an option which attempts to clean up the HTML code by moving inline styles to the page's style 
sheet.  
 

Note:  
This option will process all HTML elements on the page, however not all (third party) extensions may 
support this behavior.  So please test all functionality of your website before using this! 

 
Web Fonts (@font-face) 

• Do not use @font-face (default) 
No code will be generated to support non-web safe fonts. 
 

• Automatically use @font-face for non-websafe fonts. 
If you enable this option, you will be able to use any type of true type font even if it's not web 
safe by using a new CSS3 feature called @font-face. WYSIWYG Web Builder will automatically 
generate the necessary code and upload the font to the server. It will even generate a 
secondary (eot) font file required to make this feature work with IE! 
 

• Manually specify @font-face fonts. 
In some cases it's necessary to manually configure @font-face. For example, if it's not possible; 
to automatically determine the filename associated with a specific font or if you want to use 
separate files for each format. Enabling this option allows advanced users to manually link font 
files to a specific font. 

 
 

Use CSS3 gradients instead of images (when possible). 
Enable this option to generate CSS styles for background gradients instead of images. This reduces the 
number of images generated for the page. Keep in mind however that not all browsers (especially 
Internet Explorer!) do support CSS3 gradient yet. Also note that not all gradient styles are yet supported, 
for in some case images still will be used. 
 
Publish navigation icons as SVG image.  
This will output the icons as embedded SVG (scalable vector image) instead as font and reduces the 
overall size of the website if you only use a few icons. 
This option applies to icons used in: Breadcrumbs, Cards, Mega Menu, Overlay Menu, Panel Menu, 
Responsive Menu, Tabs, Themeable Menu and Toasts. 
 
Dark Color Scheme 
Normally, the dark color scheme is activated by the browser based on the user's preference (prefers-
color-scheme). In that case, dark colors will automatically be used.  
But it is also possible to switch between dark / light mode manually via events. For more details, see this 
online tutorial: https://wysiwygwebbuilder.com/darkcolorscheme.html 
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Include page name in automatically generated ID attributes. 
This option will add the page name to automatically generated ID when a new object is added to the 
page. So for example 'Image1' it will become 'indexImage1'. Where 'index' is the name of the page. 
This can be useful when you use lots of master pages in which case it will prevent duplicated ID 
attributes within a page. 
 

Note:   
This option does not change your existing ID's only for newly created objects! 

 
Enable HTML encoding (based on the selected character set). 
This will save the document encoded with the selected codepage. This is a new feature in version 7.5 in 
an attempt to generate (even) better W3C compliant HTML documents. This option should be enabled 
unless you are experiencing problems with character display in browsers. 
 
Include custom HTML comments in output 
You can choose to exclude comments from custom HTML. Previously, comments were always included 
in the generated HTML. With this option, you can disable comment inclusion — comments will remain 
visible in the workspace, but they will no longer appear in the final HTML output. 
 
Enable URL encoding to prevent web unsafe file names. 
Specifies whether to use URL encoding for file names. In general, you should not use white spaces or 
other non-alphanumeric characters in file names, because it may confuse web servers and browsers 
(especially in combination with JavaScript). If you enable this option, then the software will encode file 
names to prevent possible problems with invalid file names. Of course, it's still better to make sure your 
filenames are valid before adding them to your website. 
 
Use shared folder for assets (pages in folders will not have their own asset folder) 
Enabling this option will share the asset target folder(s) for the entire website (including pages in sub 
folders!). This means that sub folders in the Site Manager no longer use a separate asset folder. 
Note that you can set the target folder for specific file types in Publish & Preview. If this option is 
disabled, then each folder you create in the Site Manager will have its own asset folder. 
 
Use HTML5 Semantic Tags 
When this option is enabled the application will automatically output semantic HTML5 tags instead of 
divs. For example, page header <header> page footer <footer>, navigation <nav>,. 
 
Enable Cache Busting for external CSS and JS files 
To speed up load times, Web browsers are designed to cache CSS and JS files. The cached files are 
stored on the visitor’s computer, so the next time they visit a site, these files will be loaded faster.  
However, this may cause issues if you have made changes to the website, but the browser still loads the 
previous (cached) version of the files. When cache busting is enabled, unique suffixes will be added to 
the file paths of the CSS and JS files. This forces the browser to re-load the files from the server. 
 
Note that this only applies to dynamically generated CSS and JS files: global style sheet (eg. project.css), 
page specific CSS file (eg. page.css) and page specific JS file (eg. page.js). 
If you want to disable caching of HTML files, then this either needs to do in the server configuration or 
via Meta tags. 
 
Include width and height attributes in images to prevent Cumulative Layout Shifts 
Specifies whether to include width and height attributes (width="800" height="600") in <img> tags in 
addition to CSS. This helps the browser to allocate the correct amount of space in the document while 
the image is loading. 
This may be useful to improve Google's lighthouse 'Best Practice' scores.  
 
Include structured data in navigation objects for improved SEO ranking 
Specifies whether to include structure data (https://schema.org/SiteNavigationElement) in navigation 
items. This may help search engines to better understand the structure of the menus on the page. 
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Generate external JS file for page specific scripts. 
Enable this option to generate a separate JS file with the script used by a page. The name of the file will 
be the same as the page name. So 'index.html' will generate an ‘index.js' file. 
 
Move JavaScript to the end of the page 
This will place all scripts at the end of the page and may result in better performance because the 
JavaScript will be executed after the rest of the page has been loaded. This is also known as 
"Unobtrusive JavaScript". 
 
Load built-in JavaScript files asynchronously 
Specifies that built-in scripts will be executed asynchronously as soon as they are available. 
Note that this is only useful when 'Generate external JS file for page specific scripts' is enabled, because 
otherwise local scripts may be executed before the external scripts, they depend on have been loaded! 
 
More information: 
https://www.w3schools.com/tags/att_script_async.asp 
 
Formatting 

• Default 
The HTML will be published "AS IS". No formatting will be applied. 
 

• Beautify 
Formats the HTML code so it looks better and is easier to read. If you select this option, then 
the size of the page will slightly increase because of the extra white spaces added to the page. 
But in general, this does not affect the performance in the browser. 
 

• Minify 
This option reduces the size of the generated HTML and may improve the performance of the 
page. However, HTML becomes more difficult to read. 

 

Notes:  
-  Formatting will affect all HTML on the page. Including custom code and code generated by extensions!  
-  PHP and JavaScript will not be formatted.  
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Files & Folders  
In the System Folder option, you can configure where the software will store all user specific data, like 
extensions, templates, publish settings, gradients etc. 
 

Important: 
If you change the System Folder then this will also change the location where WYSIWYG Web Builder 
looks for extensions, templates, publish setting etc. So, if you change the folder then make sure you also 
move all files to the new folder! 

 
If you enable Let WYSIWYG Web Builder manage images and other files used by a project, then Web 
Builder will make a backup copy of all assets (images, movies, sounds) which are part of your website to 
a folder relative to the project file, so all files will be stored in one place. The name of the folder will be 
the same as the project name. This means that if your project is called 'mywebsite', then all assets will 
be stored in the sub folder 'mywebsite'. Copying or moving your project to another computer is now as 
easy as copying the project file and its sub folder to another PC! 
 
In the Preview Folder field you can change the default folder which is used for the preview files. This can 
be useful if you want the files to be copied to a folder of your local web server in case you generate PHP 
or ASP pages. 
 
If the option Remove preview files is enabled, Web Builder will remove all previously generated files the 
next time you select the preview option. This prevents old files will be left behind and only new files 
exists in the preview folder.  
 

Warning: This will remove all files from the specified folder! (not only the files that were previously 
generated by Web Builder). 

 

Publish Options 
Connection Timeout, increase this value if you experience timeouts while connecting to the FTP server. 
Default is 30 seconds. 
 
Enable Logging, enable logging when you have problems while publishing your web site. The log might 
contain useful information about the problem. 
 
Images name prefix. Some objects such as shapes, navigation bar buttons will be published as 
(dynamically generated) images. These images do have a unique name within the website (e.g. 
img0001.gif, img0002.gif). With this option you can control how the images will be named. For example, 
if you specify wbimage as prefix, the images will be named 'wbimage0001.gif' or 'wbimage0002.png' 
It is also possible to make the name of the page part of the filename by enabling the option Use page 
name for image prefix, this makes it easier to keep track of which images belong to a specific page 
 
Target folder for File Types 
WYSIWYG Web Builder can publish the images, scripts, swf, pdf, css and other files it generates to a 
separate folder on the web server. This will keep your web site organized. 
If the web server does not support sub folders, then remove all file types from the list. In that case all 
files will be published to the same folder as the HTML files. 
 

Note: The folders are relative to the folder of the HTML page. So, if you have created folders in the Site 
Manager then each folder will have its own sub folders for the files! 

 
Preview Scope, this option specifies the preview scope of Web Builder. Select Current Page to only 
preview one page or Entire Web Site if you want to test your complete web site. 
 

Tip:  
Holding down the SHIFT key while previewing will 'invert' the current preview scope. 
This means that if 'Current Page' is selected then holding de SHIFT key will preview the Entire Website'. 
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Remove PHP code during preview 
Many of the advanced features of WYSIWYG Web Builder use PHP code. As you may know, browsers 
cannot interpret PHP code and usually will display errors or nothing at all! Previewing the layout of such 
a webpage on a server is not always convenient, so that's why we introduced this option. If this option is 
enabled then all PHP code will be removed during preview, so you can view the layout. Of course, you 
will still be to publish the page to a PHP enabled web server to fully test the (dynamic) behavior of the 
page. 
 

Note:  
During preview the software will rename the page's file extension from .php to .html.  
This means that if other pages link to this page, then the browser will not find the page since it has a 
different extension. 

 
Hide file extension for internal links (for advanced users only!) 
Remove the extension from internal links. Instead of 'page1.html', the application will use 'page1' in 
navigation objects and links. 
 
Note that the generated files will still have extensions otherwise they will not be recognized as 
HTML/PHP files on the server! You will need to configure the server to hide the extensions on the server 
via .htaccess. 
 
For example: 
 
PHP EXTENTION REMOVAL 

RewriteEngine On 

RewriteCond %{REQUEST_FILENAME} !-f 

RewriteRule ^([^\.]+)$ $1.php [NC,L] 

 

HTML EXTENTION REMOVAL 

RewriteEngine On 

RewriteCond %{REQUEST_FILENAME} !-f 

RewriteRule ^([^\.]+)$ $1.html [NC,L] 

 
 



WYSIWYG Web Builder 21   

77 

User Interface 
 
Language: Use this option to specify the language used for the user interface. Default is English. Before a 
certain language is available from the dropdown list, you need to install the appropriate language 
module. Visit the website of WYSIWYG Web Builder to check for the available languages. 
 
User Interface 
Specifies whether to use the classic menu and toolbars or the Ribbon interface. 
 
Docking algorithm for resizable bars: Default or Visual Studio 2005 style. When Visual Studio 2005 style 
is selected, so called Dock Markers are displayed when you reposition windows like the Site Manager or 
Toolbox. 
 
Display web safe fonts only 
You can enable this option so WYSIWYG Web Builder will only display web safe fonts.  
 
Display rotate handle for rotatable objects 
Specifies whether to display rotate handles in the workspace to provide quicker way to rotate objects.  
 
Color picker 
By default, the color picker displays a standard color palette with 140 standard web colors. With the 
'Swatch colors' option (inspired by the MS Office color picker) you can configure a custom color palette 
of 12 colors. The light and dark variants of these colors will be generated automatically. 
 
Color box shape 
Defines the shape of the color swatches in the color picker. You can choose between square or ellipse. 
 
Render visual effects  
Control whether visual effects like filters, shadows, backdrop) will be rendered in the workspace 
Disabling this option can help to improve performance on slower computers. 
 
Tab 'Close' button 
Specifies the appearance and behavior of the close button on the page tabs. 

• None, No close button on the tabs. 

• Active Tab, Close button is displayed on the active tab only. 

• Highlighted Tab (Compact), Close button is displayed on the active and highlighted tabs.  The 
space for the close button on the non-active tab is not reserved. 

• Highlighted Tab, Close button is displayed on the active and highlighted tabs. 

• All, Closed button is displayed on all tabs. 
 

New Page Label 
The 'New Page' tab is a quick way to add new pages.  
By default, the new page tab only contains the ‘+’ sign, but you can change the text of the tab in Tools -> 
Options -> User Interface. If you leave the field empty, then the new page tab will be hidden 
 
Automatically Hide Scrollbars 
When a scrollbar is inactive (the mouse cursor is not located inside it), only compact (thin) thumb box 
will be drawn. When you move the mouse inside the scrollbar, the bar will be fully drawn. 
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Extensions 
 
Automatically download missing extensions 
This will automatically try to download missing extensions when you load a project. 
 
Manage extensions per project 
You can maintain a separate set of extensions for each project instead of using a single global list.  
When enabled, the application creates a dedicated extensions folder inside each project directory: 
Documents\WYSIWYG Web Builder\projectname\extensions 
 
Any new extension you add while a project is active will be copied into that project’s extensions folder 
rather than the global system folder. Likewise, removing an extension will only remove it for the current 
project. 
If a project does not yet have its own extensions folder, one will be created automatically the next time 
the project is loaded, and all extensions from the global folder will be copied into it. 
 
Note: If you choose not to enable this option, the application will to use a global extensions list which is 
the same for each project. 
 
Enable live HTML rendering of extensions 
Some extensions use 'live HTML rendering' which means they create a live preview of the generated 
HTML code for the extension. 
And although this may be useful to get an idea what the final page will look like, it also can use lots of 
system resources (memory /processor time), especially when you are using many extensions in the 
same project. 
Disabling this option can reduce the memory usage and loading time of projects. It  will have no affect 
on the generated output. 
 
Enable debug logging (use for test purposes only!) 
If you enable this option then extensions will create a log file with information that can be useful for 
debugging. This may help you or the developer of the extension to trace/solve problems. 
The log file will be created in the extensions folder and it has the same name as the extension 
(extensionname.log). 
 
The following information will be logged: 
• Loading/uploading with version number. 
• Properties, variables and values 
• Dataset XML transformation (user input applied to XSL template) 
• Gallery XML transformation 
• Menu XML transformation 
• Copying files to publish folder. 
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Backup 
Backup folder: WYSIWYG Web Builder can automatically make backups of your projects, before 
overwriting a previous version of the project. 
Backup folder specifies the folder where the backup will be stored.  
 
Total number of site backups. Specifies the number of backups to keep before overwriting them with 
newer versions. Enter 0 if you do not want Web Builder to create backups. 
Web Builder will name the backups like this: 
myproject_01.wbs,  myproject_02.wbs, myproject_03.wbs 
The highest numbered file will always be the latest backup. If the maximum number of backups is 
reached, the oldest backup will be deleted, and all other backups will be renamed. 
 
Auto backup 
Enable this option to automatically make backup copy of your project every 5, 15, or 30 minutes. This 
may help you restore your work if your computer crashes unexpectedly. 
The name of the backup will be myproject_autobackup.wbs and it will be stored in the backup folder. 
 
Make a backup of the project on the server. 
Enable this option to automatically make a backup of the project on the server. This may be useful if 
your computer crashes or your local projects become corrupted. In that case you will always have a 
backup copy on the server. 
 
AutoSave 
This automatically saves the active project at the specified interval. 
Note that this does not work for new 'untitled' projects, because the project must have a filename 
before it can be saved. 
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Artificial Intelligence  

The AI tools in WYSIWYG Web Builder are implemented using the OpenAI API. You will need an OpenAI 
API key to use this functionality. If you do not already have an OpenAI account, then you can create it 
here: https://platform.openai.com/signup 
 
You can create an OpenAI API key for free. New users get free $5 worth of free tokens. These tokens 
expire in 3 months. After the quota has passed, you can choose to enter billing information to upgrade 
to a paid plan and continue your use of the API on pay-as-you-go basis. 
 
Model 
The OpenAI API is powered by a diverse set of models with different capabilities and price points. Select 
one of the pre-defined models or enter a valid model name in the input box. 
More information about the available models: https://platform.openai.com/docs/models/overview 
 
Translation 
In this section, you can control which elements on the page will be translated when you use the 
'Translate Page' command. This makes it possible to exclude navigation, SEO, and extensions. 
Also, it's important to note that translating rich text will remove all formatting from the text. This is 
because translated text usually has a completely different structure than the text in the original 
language. So, that is why you can also exclude rich text from the translation. 
 
Stability AI 
As an alternative for image generation and manipulation it's also possible to use Stability AI.  "Stability 
AI" offers a wide range of extra options compared to Open AI (dali-e3).  
 
Stability AI add the following additional Ai image tools: 

• Image Erase 
The Erase tool removes unwanted objects, such as blemishes on portraits or items on desks. 

• Image Search and Replace 
The Search and Replace tool is a specific version of inpainting that does not require a mask. 
Instead, users can leverage a search prompt to identify an object in simple language to be 
replaced.  

• Image Search and Recolor 
The Search and Recolor tool provides the ability to change the color of a specific object in an 
image using a prompt.  

• Image Upscale 
Image Upscale can be used to improve the quality of existing images. There are 3 modes: 
Creative, Fast and Conservative. 

• Image to Video 
Generate a short video (approximately < 5 seconds) based on an initial image.  

• Sketch to Image 
Sketch to Image converts a simple drawing into a dynamic image. Use the prompt to define 
further details of the output image. 

• Create a new image with the same style 
This tool extracts stylistic elements from an input image and uses it to guide the creation of an 
output image based on the prompt.  

• Image Remove Background 
This feature also works with Stability AI API key, so there is no need for remove.bg key. 

 
Also, when Stability Inpainting and outpainting tools of Stability AI are currently much better than those 
of OpenAI. 
 
When you specify an API key for Stability AI  
You can get an API key here: https://platform.stability.ai/ 
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ComfyUI (for advanced users only!) 
WYSIWYG Web Builder integrates with ComfyUI, allowing you to generate unlimited high-quality images 
using AI directly on your local computer. ComfyUI is a powerful and popular open-source tool that 
supports AI models like Stable Diffusion and Flux, enabling you to create stunning images. Best of all, it's 
completely free, meaning there are no usage fees or limitations, unlike many paid online services, 
allowing you to create as many high-quality images as you want without any additional costs. 
 
For detailed instructions on installing, configuring, and using ComfyUI, please refer to the online tutorial. 
https://wysiwygwebbuilder.com/comfyui.html 
 
Automatically use fill 'smart content' for new blocks 
Enable this option to automatically fill newly added blocks with ‘smart content’ (text and images) based 
on the selected category. See also ‘smart content’. 
 
Background Removal 
In this section, you can specify the API key that is required for the 'Remove Background' tool for images 
which is powered by remove.bg. 
https://www.remove.bg/dashboard#api-key 
 
Note: if you use Stability AI then you do not need this. 
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Extension Manager 
Extensions (also called add-ons or plugins) are components which enhance the functionality of 
WYSIWYG Web Builder. Extensions can be accessed through the Toolbox or via the Insert menu just like 
the standard objects.  Some extensions are simply components with few parameters while others are 
almost complete applications by themselves! See also: 
https://www.wysiwygwebbuilder.com/extensions.html 
You can even create your own extensions with the Extension Builder tool:  
https://www.wysiwygwebbuilder.com/extension_builder.html 
 
Many users have already made some incredible custom extensions. Check out the full list here: 
https://www.wysiwygwebbuilder.com/forum/viewforum.php?f=42 
  
The Extension Manager helps you organize extensions. In the Extension Manager you can install/remove 
and update extensions. You can also search for extensions in the online gallery. The Installed Extensions 
page displays all extensions which are currently installed. If you no longer need a specific extension, you 
can remove it by clicking the 'Uninstall' button. 
 

Note:  
Please make sure that none of your projects uses the extension if you decide to remove a specific 
extension, otherwise you will no longer be able to load that project until you re-install the extension. 

 
The Online Gallery page displays all extensions available for download and installation. If a new version 
of an extension that you already have is available online, then you have the choice to update it. Each 
time you open this window, Web Builder will ask if you wish to download the most recent list from the 
website. Normally you will have to do this only once a week.  
  

Notes:  
The built-in Extension Manager only works correctly if the software can access our web server! If for 
some reason your firewall or virus scanner blocks access to the Internet connection, then you will not be 
able to use this feature. To fix this problem make sure WYSIWYG Web Builder is on the exception list of 
your firewall/virus scanner!  
  
If you've recently purchased your license, it's possible that your registration information is not yet in the 
online database. IT MAY TAKE SEVERAL HOURS BEFORE YOU CAN DOWNLOAD THE EXTENSIONS! Please 
be patient. 
 
See also: https://www.wysiwygwebbuilder.com/restricted.html 

 
The Manual Install page allows you to manually install extensions. Click the 'Install' button to select an 
extension file (*.wbx) or zip file. You can also drag & drop one or more extensions from Windows 
Explorer on this window! You can also manually install extensions by copying the .wbx file to the 
extensions folder: C:\Users\Your Name\Documents\WYSIWYG Web Builder\system\extensions 
Where 'Your Name' is the name of your personal folder on the computer. 
  
Related FAQ topic: 
https://www.wysiwygwebbuilder.com/forum/viewtopic.php?t=7234 
 
 

Disclaimer: 
Extensions are made available as an extra service for registered users. They are not an official part of the 
software. Pablo Software Solutions will not offer support for third party extensions and is in no way 
responsible for proper functioning of these extensions. All extensions are provided "AS IS" for those who 
find them useful. Of course we will do our best to make sure they work properly. 
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Search Index 
WYSIWYG Web Builder has basic built-in 'search engine' functionality, so visitors can search for specific 
words within your website.  
To make this feature available to non-advanced users we decided to use JavaScript as it does not require 
you to setup database and indexing service on the server. The downside is that it can be slower for 
larger websites (> 100 pages). 
 
Generate Search Index 
Enable this option to create the search index during publishing. 
 

Note:  
The search index is required if you want to use the 'Site Search' object on your website! 

 
Name of Index File 
Specifies the name of the search index file. Since this is a JavaScript file, it must have the .js extensions. 
 
Create Index from 
This option specifies how the search index will be created. 
 

• Page Content 
The search index will be created from the content of the page. In this case WYSIWYG Web 
Builder will extract all text from the pages.  

• Meta tags 
The search index will be created from the meta tags you've specified content in Page 
Properties.   

• Text Only 
This will only index the text which result in a smaller/faster search index. In most cases this 
mode will be sufficient. Note that will also decrease the time required to create the search 
index during publishing. 

 
Exclude Stop Words from Index 
Enable this option to exclude stop words. 
WYSYWYG Web Builder includes a predefined list of stop words in the file 'search.dat'. 
To make your own list of 'exclude' words simply copy the file to 'My Documents\WYSIWYG Web 
Builder\system\search.dat and Web Builder will use this file instead. 
 
 

Note:  
Stop Words are words which do not contain important significance to be used in Search Queries. 
Usually, these words are filtered out from search queries because they return vast amounts of 
unnecessary information. 

 
Use absolute links 
Enable this option if you want to use the search engine in sub folders. In that case absolute links must be 
used otherwise the links in the search results will not be using the correct path (because there is only 
one search index at the root of the website). 
 
Example: 
https://www.yourwebsite.com 
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Error Report 
The Error Report tools will analyze the current page and check for errors like duplicated IDs, invalid 
filenames or other common problems. Here's a list of possible problems which are currently detected by 
error report tool: 
 
Invalid filename 
Names must contain only ASCII letters (a-z,A-Z), digits (0-9), underscore, dot and dash. 
  
Empty ID 
Make sure all objects have a valid ID. 
  
Duplicate ID 
All objects must have a unique ID property within the context of the page. This includes the objects on 
master pages! 
  
Invalid HTML 
Custom HTML may not contain <html> <head> or <body> tags. 
  
Invalid page extension 
The page contains a form which requires PHP. Set the page file extension to 'php' (in Page properties) 
  
Success page not specified 
The success page property of the form cannot be empty. 
  
Error page not specified 
The error page property of the form cannot be empty. 
  
Invalid page title 
The page does not have a meaningful title. The page title is either empty or has the default 'untitled 
page' value. 
 
Invalid page name 
The 'index' page should not have uppercase characters in its name.  'Index' or 'INDEX' is invalid. 
 
Form is using 'mailto:' 
Using 'mailto:' in forms is unreliable. Please consider using the built-in form processor instead. 
 
Text is not optimized 
The text is not optimized for all browsers. Consider using one of the compatibility options. 
 
Object is outside the view port 
The object's outline is outside the page boundaries. If the object is hidden then first unhide it, move it 
inside the page boundaries and hide it again. 

 
 



WYSIWYG Web Builder 21   

85 

Theme Manager 
WYSIWYG Web Builder has supported themes for a long time, however previously they were only useful 
for jQuery UI widgets. The Theme Manager has recently been updated to support almost all objects. 
Unlike jQuery UI widgets which require a large CSS set. The new themes only have a small footprint. 
 
The Theme Manager offers options for managing themes. You can add, edit, or remove themes with 
ease. To create a new theme, simply click the 'Add' button. For tweaking an existing theme, hit 'Edit' to 
make desired adjustments. Alternatively, 'Clone' allows you to replicate the selected theme as a 
foundation for a new one. Use the 'Remove' button to remove a theme from your collection. 
 
There is also an option to import CSS themes generated by the jQuery UI theme roller website 
(https://jqueryui.com/themeroller/). This will only import the color scheme, because there is no way to 
extract style data from images. 
 
The "Theme" property (Page Properties -> Style) specifies the theme for the page, it applies to all theme 
enabled objects on the page. You can activate theme support for individual objects by using the 'Use 
Theme' property. When this option is turned on, it will supersede the local object color settings. 

 

 
 
How are themes different than styles? 
A 'theme' is basically just a simplified version of a style, with only a small subset of properties (text color, 
background color/gradient/images and borders). It provides a quick way to entire style of the page. 
Unlike styles, you can only use one theme per page. A theme affects multiple items of an object. For 
example, the header, content, button etc. Unlike styles where you would need a different style for each 
item. Themes are global. This means that if you edit a theme then it will affect all projects! 
 
 
Online tutorial: https://wysiwygwebbuilder.com/themes.html 
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In Page Properties you can select the theme for a page (which then will be applied to all objects on that 
page). And although the Theme Manager was designed to create themes for jQuery UI widgets, other 
objects also support the themes! For example, you can select 'Use page theme' in the menu bar, 
navigation bar, tab menu and many other objects. 
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Global Replace 

The Global Replace tool can be used to quickly change the color, font, URL or filename for all objects (or 
a selection) on the page or entire website.  
 
Pages 
Specifies whether to replace values on the current page only on the entire website. 
 
Breakpoints 
Specifies whether to replace values in all breakpoints or in the current breakpoint only. 
 
Objects 
Specifies the object categories the find/replace will apply to. 
For example: only replace a color value for form elements. 
 
Property 
Specifies what to replace: 

• Color 
Replace a color value with another value. 

• File 
Replace a filename. The tool will automatically list all filenames currently in use. 

• Font Name 
Replace the font name. The tool will automatically list all font currently in use. 

• Font Size 
Replace the font size. 

• URL 
Replace an URL. The tool will automatically list all URLs currently in use. Also supports tel, 
email, facetime, SMS and skype links! 

• (ID) 
Rename the ID of objects.  

• Internal Link 
Replace internal links 
 
Tip: to add a prefix to all IDs of a page, set the old value to * (wildcard) and the new value to 
the prefix. This can be useful to quickly add a prefix to the IDs of master pages/master frames. 
See also: How to prevent duplicate IDs 

 
Note that this action cannot be undone! 
 
Global Replace cannot replace data in extensions. 
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Google Fonts 

Adding Google Fonts to your website has never been easier. Google Fonts no longer must be manually 
downloaded/installed from the Google website; The Google Font Manager takes care of this! 
Fonts that are installed via the Font Manager will be added to the ‘web safe fonts list and the necessary 
CSS code will be generated automatically when you preview or publish the website. 
 
Font can have different variants, like light, medium, bold, regular etc. The available variants can be 
enabled per font. 
 

Note:  
To be able to preview or use fonts they need to be downloaded to your computer. When you select a 
font for preview, it will be downloaded from the Google Servers to a local folder \WYSIWYG Web 
Builder\system\downloads. 
 
The application includes a file googlefonts.json which contains the name and (server) location of all 
Google Fonts that were available at the time this version of WWB was released. If you are an advanced 
user then you can edit this file to add or remove fonts (at your own risk!). 
 
If you install the font then it will be copied to the \WYSIWYG Web Builder\system\fonts folder, also an 
entry will be made in the googlefonts.dat file with information about the font (filename, font family, 
subsets, etc.) By keeping the fonts in a sub folder, it will be easier to copy/move your entire WWB 
configuration to another computer or make complete backups. 
 
Fonts that you install via the Font Manager will only be available to WYSIWYG Web Builder. If you wish 
to make them available for other applications, then you will need to manually install the fonts from the 
Google Fonts Website.   
 
Clicking in the font dialog will display a context menu: 
Open file location is a shortcut to the font download folder. This may be useful, for example, to install a 
font on your computer. Clear font cache will delete all downloaded fonts from the cache folder. This will 
not delete installed fonts! 

 
 
Online tutorial:  
https://www.wysiwygwebbuilder.com/webfonts.html 
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WYSIWYG Web Builder Objects 
In WYSIWYG Web Builder you create your website by dropping objects on the page.  
There are several ways to insert objects: 
 

Insert Tab 
To insert a new object, select one of the available items and draw a box to indicate the position of the 
object. The new object will now be inserted onto the page. To change the properties, double the object 
or select Edit -> Properties from the menu bar. It’s also possible to call the object’s properties using the 
keyboard shortcut ‘Alt+Enter’. 
 

 
 

Toolbox 

Another way to add objects to your page is by simply dragging them out of the toolbox onto the 
workspace. 
 

 
 

Context Menu 
Right click on the page to display the context menu. 
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Style 
Many objects have a style section in the properties window, here you can set the appearance of the 
object. Note that not all options do apply to all objects. For example, some objects do not have 
background or text properties. 
 

 
 
Predefined Style 
Here you can select one of the global site styles. This option will overwrite all custom style settings for 
the object. You can add or edit styles in the Style Manager. 
Note that the <h1> ... <h6> are generally only used for text! 
 
Use Theme 
You can activate theme support for individual objects by using the 'Use Theme' property. When this 
option is turned on, it will supersede the local object color settings. 
 
To enable theme support for all newly created objects, activate 'Enable Use Theme as default for new 
object in Tools -> Options -> General -> Theming 
 
Please see the ‘Theme Manager” chapter for more details. 
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Background 
Background mode 
Specifies the background mode. 
 

• Transparent 
The background of the object will be transparent. 
 

• Solid 
Use a solid background color. 
 

• Image 
Use an image as background. 
Repeat; Sets the tiling attributes for the background image. Possible options are: Repeat in 
both directions, repeat in horizontal direction, repeat in vertical direction and do not repeat. 
Horizontal Align; Sets the horizontal position for the background image.  
Vertical Align; Sets the vertical position for the background image.  
 

• Gradient 
Use a (two-color) gradient as background. This option supports many different gradient styles 
like linear, ellipse, glass, glossy etc. By default, a background image will be generated for the 
gradient effect. However, you can also use CSS3 gradients by enabling the option 'Use CSS3 
gradients instead of images' in Menu -> Tools -> Options -> HTML. Keep in mind however that 
not all browsers support CSS3 yet. 
 

• Multi-color gradient 
Use a (multi-color) gradient as background. WYSIWYG Web Builder includes many predefined 
multi color gradient styles, but you can easily create your own style with the Gradient Style 
Manager. Just like the standard gradient option it supports many different gradient styles like 
linear, ellipse, glass, glossy etc. By default, a background image will be generated for the 
gradient effect. However, you can also use CSS3 gradients by enabling the option 'Use CSS3 
gradients instead of images' in Menu -> Tools -> Options -> HTML. 
 

• Pattern 
Use a pattern as background. A new image will automatically be generated for the pattern.  
 

• Texture 
Use a texture as background. A new image will automatically be generated for the texture.  
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Border 
Style 
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
For many objects you can also set the individual style, width, color and radius for each side of the 
border! Select 'Individual style for each side' and then click 'Settings'.  
 
Width 
Specifies the thickness of the border around the banner. Set this to 0 (zero) for no border. 
 
Color 
Specifies the color of the border around the banner.  
 
Radius 
Defines the degree to which border corners will be rounded. 
 
Online tutorial: 
https://wysiwygwebbuilder.com/borders.html 
 
 

Text 
Font 
Specifies the font family of the text, such as Comic Sans, Times New Roman, and Courier New.  
 
Font weight 
Specifies the weight of the text: Normal or Bold 
 
Font Style 
Specifies the style of the text. Normal or Italic 
 
Size 
Specifies the size of the text. 
 
Color 
Specify the color of the text. 
 
Alignment 
Specifies the alignment of the text. Left, Center, Right or Justify 
 
Decoration 
Specifies the text decoration: none, underline or line-through. 
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Bookmark 
Text and images can be set as bookmarks (also called "anchors") that can be linked to within a page. For 
example, if a page has several new items, the news titles for each item can be set as bookmarks and a 
row of links can be added to the top of the page that will each skip down to those bookmarked sections. 
This method of using bookmarks allows visitors to your site to quickly access information by not having 
to scroll down the page to view the information they want. 
 

 
 
You can create a Bookmark by using the Bookmark tool from the Insert menu and place it anywhere in 
the page. Make sure you give the bookmark a unique name. Once you have placed the bookmark icon 
on your page, it can be selected from the Bookmark dropdown list.  
 
Enable Smooth Scrolling 
Enable this option to animate the page scrolling. This effect is often used in modern websites. The 
Duration specifies the timing of the animation. Easing can be used to create ‘bounce effects’. 
 
Menu Name 
Specifies the text that will be used for the automatically generated menu items when the option 
'Synchronize with Bookmarks' is enabled. 
 
Events 
The following events are unique to WYSIWYG Web Builder. They make it possible to trigger actions 
based on the scroll position of the page. For example, you can start animations or show/hide objects 
when the bookmark scrolls into (or out of) the viewport. 
 
onscrollreveal 
Fires when the bookmark is completely visible in the view port of the browser. 
 
onscrollrevealpartial 
Fires when the bookmark is partially visible in the view port of the browser. 
 
onscrollhide 
Fires when the bookmark is scrolled out of the browser's view port. 
 
You can read more about bookmarks in the ‘Links’ chapter. 
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Bulleted List 

You can add a bulleted list to your web page to set apart a list of items from the rest of the page pf text. 
The bulleted list is a combination of ordered (numbered) lists and unordered lists and supports the 
following styles: Circle, Disc, Square, Numeric (1, 2, 3), Lower Alpha (a, b, c), Upper Alpha (A, B, C), Lower 
Roman (i, ii, iii), Upper Roman(I, II, III) and custom images. 
 

  
 
To insert a bulleted list into your page, select Insert -> Bulleted List. Next select the initial number of 
items and the bullet style. Note that you can always change the bullet style to something else according 
to the object's properties. 
 
Other properties of the bulleted lists include Font, size, color and spacing and padding for the individual 
items. 
 

How do I edit the text of an item? 
Double click the item to edit the text. Formatting of the text works the same way as in a regular textbox. 
 

 
How do I insert a new item? 
Right click the bulleted list to display the context menu and select Insert Item. 
 

 
How do I remove an item? 
Right click the bulleted list to display the context menu and select Delete Item. 
 

 
How do I select the next item using the keyboard?  
Use the Tab key to go to the next item 
 

 
How do I change the space between the bullet and the text? 
When you move the mouse cursor between the bullet and the text you can drag the (invisible) border to 
increase or decrease the spacing. 
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Horizontal Line 

The Line object is used to insert a horizontal line across the page. 
Besides the standard styles like solid, dotted, dashed, double and groove, the object also supports many 
unique styles, like stars, curls, curves, waves etc. It is also possible to add text to the line. You can even 
add an icon! 
 

 
 
Line Color 
Specifies the color of the line. 
 
Mode 
Specifies the line mode: 

• default 
display a line only 
 

• icon 
add an icon to the line. The icon can be positioned at the left, center or right side. 
 

• text 
add text to the line. The text can be positioned at the left, center or right side. 

 
Spacing 
Specifies the spacing between around the text or icon. 
 
Box Shadow 
Configure box shadow (also called drop shadow) for the object. This feature requires a CSS3 enabled 
browser. 
 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/line.html 
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Heading 

This object provides a quick and easy way to add headings (<h1>, <h2>) without using styles. Each 
heading object can have its own fonts/size/color! 
 
Note that you can also use Styles to insert headings into the standard text objects, but in that case all 
headings in the project will have the same style. 
 
A heading object also can output the heading as paragraph <p>. This can be useful if you want to use 
specific heading features that are not available for standard text like 'text shadow', 'text stroke' or 
variable fonts. 
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Image 
To add images, use the Image object. Drag the object to the page and a file dialog will pop up to select 
the image. Web Builder supports jpg, gif, bmp and png files. 
 

 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/add_images.html 

 
Filename: enter the path and filename of the image/picture or select Browse to find an image on your 
local drive. You can also specify absolute URLs: https://www.yourwebsite.com/image01.jpg 

 
Description 
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled. 
 
Title 
In modern browsers this title appears as a ToolTip when you move the mouse over the image. 
 
Reflection 
Specifies the amount of reflection.  
 
Lazy loading 
Enable this option to delay the loading of images until they are visible in the view port. This will speed 
up the page loading. It also prevents loading large images in mobile devices because only the visible 
images will be downloaded. 
 
Shadow 
Specifies whether to enable a shadow effect. box-shadow is used for creating shadows around entire 
elements. drop-shadow is specifically designed for adding shadows to the non-transparent regions of 
images with transparency, allowing the shadow to follow the shape of the image. 
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Object-fit 
Specifies how the image should be resized to fit its container. This requires a modern browser! For 
example, Internet Explorer does not support this property! https://caniuse.com/#feat=object-fit 
 

• fill  
The image is sized to fill the element's content box. If necessary, the object will be stretched or 
squished to fit.  
 

• contain 
The image is scaled to maintain its aspect ratio while fitting within the element's content box.  
 

• cover 
The image is sized to maintain its aspect ratio while filling the element's entire content box.  
The object will be clipped to fit.  
 

• none 
The image is not resized.  
 

• scale-down 
When the container is smaller than the image, it will be scaled down.   

 
 
Image Tools and Filters 

In WYSIWYG Web Builder, you can apply effects/filters to images without having to open a separate 
image editor! Built-in tools include: 
 
Rotate 
Rotate the image 90 degrees left or right.  
 
Flip 
Flip the image horizontally or vertically. 
 
Contrast 
Adjust the contrast of the image.  
 
Brightness 
Adjust the brightness of the image.  
 
Resample 
Re sampling an image will change the number of pixels and therefore the physical file size of an image. 
Re sampling will be done based on the current size of the image on the page. If the size is smaller than 
the original size, the physical file size is decrease. If it's larger, the file size will increase! 
 
Crop 
By cropping an image, you can remove areas of the image that you don't want to use. While in crop 
mode drag the handles of the cropping box to resize and include the part of the image that you want to 
keep. Click Crop again to remove the area outside of the cropping box. 
 
Slice 
The slice tool is used for "Slicing" up your images into many smaller pieces you will not notice anything 
on your page because when it is previewed all the piece show as one. The logic behind slicing is that 
your images will load faster, and it can also help to stop users from trying to steal your images if the try 
to they won’t get one large image but just one small piece of it. 
 
Hue/Saturation 
Adjust the hue or saturation of the image.  
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Auto thumbnail 
Use this option to quickly create a smaller thumbnail-sized version of the image. A link to the original 
full-size image will be added. 
 
Set Transparent Color 
You can create a transparent area in most images except in animated GIF images.  
Select the image you want to create transparent areas in.  
On the image toolbar or menu click 'Set Transparent Color'.  
In the image, click the color you want to make transparent.  
The Set Transparent Color option is available for images that don't already have transparency 
information. The image will be converted to the PNG format and will be published with a different 
name. 
 
Add/Replace stencil 
Stencils offer a creative way to transform the appearance of your images by converting them into 
various shapes. Essentially, stencils replace the alpha channel (transparency) of your image with the 
transparency from the selected stencil, allowing for a customized, reshaped look. You can create your 
own stencils and place the stencils in the sub folder ‘stencils’ of the program.  
 
Filters 
There are many built-in filters. For example: Blur, Buttonize, Colorize, Droste Effect, Emboss, Inner Bevel 
Frame, Glow, Grayscale, Mosaic Tiles, Negative, Oil Painting, Old Photo, Polaroid Stack, Sepia, Sharpen, 
Texture, Tilt Shift, Water Reflection and much more! 
 
Tips for using filters: 

1. You can apply multiple effects to an image. 
2. Effects are non-destructive, which means they are not applied to the original image. A copy of 

the original image will be published to your website using a unique name (.png format). 
3. Effects are applied to the image 'on-the-fly' when the images are loading into workspace and in 

the order, you've added them. So, for example if you apply Brightness 3 times, the images will 
be processed 3 times the next time you load your page.  

4. Resample can be used to decrease the size of the published image and therefore can increase 
the loading speed of your website. Of course, resampling will also reduce the quality of the 
image. 
 

Watermark  

Watermark Tool is a powerful feature that allows you to quickly and easily protect your images with a 
visible watermark.  With the many watermarking options available, you're able to personalize your 
images in a variety of ways including text size, color, and position. 
 
Support types: 

• None 
The watermark tool will be disabled. 

• Standard 
The text will be rendered at the top of the image. 

• Inverted 
The watermark effect will be inverted. 

• Embossed 
This option will use an emboss effect for the text. 

• HTML overlay 
Adds a text overlay to the image (instead of merging the text with the image).   

• HTML overlay (hover) 
Adds a text overlay to the image which is displayed on mouse over. 
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Marquee 
The Marquee object is used to introduce text that scrolls. 
 

 
 
Text 
Enter the text to scroll. Text can include formatting and links. 
 
Direction 
This attribute controls the direction of scrolling. 
 
Repeat 
Number of times to repeat the scrolling (0=Continuously). 
 
Delay 
This controls the delay (in milliseconds) between the successive displays that give the impression of 
animation. 
 
Amount 
This controls the amount of movement (in pixels) between the successive displays that give the 
impression of animation. 
 
Behavior 
This attribute controls the behavior of the displayed text. 

• scroll 
indicates that the content should scroll off the edge of the marquee area, then reappear on the 
other side. 
 

• slide 
same as scroll, however the text stops scrolling when it reaches the edge of the object 
 

• alternate 
makes the text bounce back and forth. 
 

• star wars 
Implements Stars Wars-like 3D scrolling. 

 
Pause scrolling on mouse over 
Specifies whether to pause scrolling on mouse over. 
 
 

Note:  
The unofficial <marquee> tag has been replaced with CSS3 animations for better compatibility with 
(modern) browsers. W3C compliant! 
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Text 

This object allows you to add text to the web page, drag the object to the page and double click it to 
start typing your text.  Use the Format Toolbar to change the font, size, color and other properties of the 
text. For the available formatting options please see Format Tools. To insert a link in the text, use the 
Link option. You will need to highlight text before you can change the formatting. 
 

 
 
Include text in ALT attribute 
If text has been converted to an image then search engines will not be able to 'see' this text.  
Select this option if you want the original text to be included in the alt attribute. 
 
Output format 
Unfortunately, there is no way to make text look the same in all browsers. Each browser uses its own 
text rendering engine, and they are all slightly different. And although WYSIWYG Web Builder uses pixels 
to specify the font size, this still causes different results in different browsers.  To help you optimize your 
text so that it looks as good as possible is all browsers, we have added a few options to control the way 
the text is outputted in HTML.  
 

• Default /Classic Mode 
All code will be inside one div. This should be ok for most layouts with not too much text. 
 

• Use <div> for each line (DEPRECATED) 
Each line will be embedded inside its own <div> with its own styling. This gives more accurate 
results on some occasions. 
 

• Use <div> with position for each line (DEPRECATED) 
Each line will be embedded inside its own div and includes position/size. Text will be split up 
the text into multiple <div> elements. This will result in better layouts, but also increases the 
amount of generated code. 
 

• Include line-height in text styles 
Calculates the line-height for each font (based on the rendering in the workspace) and add it to 
the CSS style. In many cases this will give very accurate results in various browsers with 
minimum code. 

 
Important note: 
The 'Use <div> for each line' options have been deprecated and they will be removed in a future version 
of WWB.  Please use Include line-height in text styles instead. It generates cleaner code and works with 
responsive layouts. 
 
See also for the latest tips and tricks for optimizing text: 
https://www.wysiwygwebbuilder.com/forum/viewtopic.php?f=10&t=34318 
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Shortcut Keys 
The text editor supports the following shortcut keys: 
 
 
Keys Operations  Comments  

Ctrl + A Select all  

Ctrl + E Center alignment  

Ctrl + J Justify alignment  

Ctrl + R Right alignment  

Ctrl + L Left alignment    

Ctrl + C Copy    

Ctrl + V  Paste    

Ctrl + X  Cut    

Ctrl + Z  Undo    

Ctrl + Y Redo    

Ctrl + '+' 
(Ctrl+Shift+'=') 

Superscript    

Ctrl + '='  Subscript    

Ctrl + ' (apostrophe) Accent acute  After pressing the short cut key, press the appropriate  
letter (for example a, e, or u). This applies to English,  
French, German, Italian, and Spanish keyboards only.   

Ctrl + ` (grave) Accent grave See Ctrl+' comments.  

Ctrl + ~ (tilde) Accent tilde See Ctrl+' comments.  

Ctrl + ; (semicolon) Accent umlaut See Ctrl+' comments.  

Ctrl + Shift + 6 Accent caret (circumflex) See Ctrl+' comments.  

Ctrl + , (comma) Accent cedilla See Ctrl+' comments.  

Ctrl + Shift + ' 
(apostrophe) 

Activate smart quotes  

Backspace  Delete previous character  

Ctrl + Backspace Delete previous word.  

Ctrl + Insert Copy    

Shift + Insert Paste    

Insert  Overwrite   

Ctrl+Left Arrow Move cursor one word to the 
left. 

 

Ctrl+Right Arrow Move cursor one word to the 
right. 

 

Ctrl+Up Arrow Move to the line above.  

Ctrl+Down Arrow Move to the line below.  

Ctrl+Home Move to the beginning of the 
textbox.   

 

Ctrl+End Move to the end of the textbox  

Ctrl+Delete Delete the next word or selected 
characters. 

 

Shift+Delete Cut the selected characters.  

Esc Stop editing text. Leave edit 
mode. 

 

Alt+0xxx (Number 
Pad) 

Inserts Unicode values if xxx is 
greater than 255. 

When xxx is less than 256, ASCI range text is inserted  
based on the current keyboard.  Must enter decimal values. 

 
Lorem Ipsum 
Lorem ipsum is a placeholder text (filler text) commonly used to demonstrate the graphic elements of a 
web site, such as font, typography, and layout, by removing the distraction of meaningful content.  
WYSIWYG Web Builder has a simple built-in Lorem Ipsum Text generator to add place holder text to the 
text object. You can either insert complete paragraphs or a specific number of words.  
The text will be loaded from a file called loremispum.txt in the application folder. If you like you can edit 
or overwrite this file with your own custom text (for advanced user only!).  
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Responsive Text 

This is a simplified text object. It only supports one type of font, color etc. per object.  
This makes the object easier manageable in complex layout (for example when using style or dark 
mode). Unlike the standard text object, styles/classes apply to the entire object, not just the selected 
text. Also, the object produces cleaner HTML output, because it does not use any inline styles.  
 

 
 
Main differences between standard text and responsive text: 
 
Text 

• multiple styles, colors, font-family, font-size. 

• optionally responsive (different font sizes in breakpoints) 

• more output options (like output as image, font-size fine tuning) 

• supports images and emojis. 

• uses inline styles for formatting individual characters. 
 
Responsive Text 

• one style, color, font-family, font-size 

• responsive by design (different font sizes in breakpoints) 

• easier style setup, the style applies to the entire object 

• no inline styles -> optimized HTML/CSS output. 
  
 
 
Online tutorials: 
https://www.wysiwygwebbuilder.com/add_text.html 
https://www.wysiwygwebbuilder.com/responsive_text.html 
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Form Wizard 
Creating forms has never been so easy! Create complete forms in just a few steps. One of the many 
ways in which you can interact with people who visit your website is to get feedback from them through 
forms. Creating a form from scratch can be rather difficult, so we've implemented the Form Wizard to 
make this task a little easier. 
  

Step 1: How do you want to create the new form? 
The WYSIWYG Web Builder Form Wizard has 3 methods to create a form: 

1. Create a new form based on a template 
This option allows you to select a template form, which you can use as the basis for own form. 
 

2. Create a new form from scratch using the wizard 
Manually insert controls and labels to the form. 
 

3. Create a blank form so you can add controls later 
Insert a blank form to your page with no controls on it. Basically, this is the same as manually 
inserting an empty form area.   
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Step 2: Select a template form 
We've included several ready-to-use forms to get you started. Please take your time to study the 
properties of each of these forms to get an idea how we've implemented them, so you can use this 
knowledge to create your own forms. For some forms you will need to modify the pre-defined values 
such as the specified email address or website URL.  
 
There are 2 form processor templates where external websites are used to process the form data. 
Before you can make use of the services of these websites you will need to register first! 
https://www.formbuddy.com/ 
https://www.mailmyform.com/ 
 
These examples can be useful if your website does not support PHP or any other type of form 
processing. 
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Step 3: Add Control to the form 
In this step you can insert controls to the form. Each control can have a label which will be displayed in 
front of the control. Click Add and select one of the items from the drop-down menu to insert a new 
control. In most cases the wizard will ask you to enter a label name. 
 
To modify the properties of the controls, select it in the list and click Edit to show the control's 
properties. You can re-arrange the items using the Move Up and Move Down buttons.  
  

  
 
 

Tip:  
Make sure your form contains a Submit button. Without this button the user will not be able to submit 
the entered data! 
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Step 4: Where should the data be sent to? 
When the user presses Submit, the browser sends the form data to a web server, so we need to specify 
where the data should be sent to. One of the possibilities is 'Submit the data to an email address', 
although this is a very common method, it doesn't work reliably for all visitors to your site. Whether or 
not a visitor can use this method depends on the mail client installed on their computer. And 
unfortunately, there's no way to test if that's the case for each of your visitors. We do not recommend 
using this method! 
 

 
  
Instead of using the Submit the data to an email address ("mailto") method, try using a remotely hosted 
CGI script like PHP, ASP or remote hosted solutions like Formspree. This lets you access a CGI script run 
off of their servers. You build your form as you normally would, but now you select Submit data to a 
script on an external server and fill in the URL of the remote CGI script. The CGI script translates your 
form into an email message and sends it on to the address you provide. 
 
Alternatively, you can create your own form processor and make the form processor script part of your 
Web Builder website. In that case select Submit data to a page within your website. 
 
In the tutorial section of our website you can find an example how to implement this using PHP: 
https://www.wysiwygwebbuilder.com/forms_php.html 
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Note: 
Some form templates use their own form processor script (usually added as a separate HTML object). In 
that case please do not change the predefined values unless you know what you are doing! 
  
Templates that use a custom form processor include: 
Dictionary lookup 
Form processor: ASP 
Form processor: Godaddy 
Form processor: Tell a friend 
Form processor: Formspree 
Tell a friend 
All PayPal templates 
All search templates 
  
Important: 
Some form templates use hidden fields to specify an email address or website.  
Make sure you replace these values with your own information!!! You can change the values of the 
hidden fields at any time later through the form's properties. 

 
 
Use Built-in PHP form processor to send data to an email address. 
Enable this option if you want to use the built-in form processor.  
For more details about this feature in the Form chapter. 
 
Encoding type 
The required encoding type depends on the form processor script, so please consult the documentation 
of the CGI script for more info. In case you have selected a pre-defined form, the correct encoding type 
will be selected. 
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Form 

A form provides a way for you to collect information from the people who view your web pages. A 
viewer enters data or makes choices among several options and then submits the form. The results can 
be sent to you by email. If your web server has the right software, you can save the form results in a 
database. 
 

 
 
The Form Area object is a container for FORM objects like buttons, edit boxes and checkboxes. You can 
add any standard form object to a form, including single- and multiple-line text fields, check boxes, radio 
buttons, scrolling lists, and drop-down lists.  
 
You should place form objects inside a form to make them work as part of the form. 
 

How do I create a form in WYSIWYG Web Builder? 
1. Drag the Form object to the page and a draw a box to indicate the position of the form. 

 
2. Design your form by adding some Form controls to the form, for example: 

Button, Image Button, Advanced Button, Checkbox, Radio button, Editbox, Text Area or  
Combobox/Select. You can also make text and images part of the form. You'll notice that all 
objects become a part of the form, so when you change the position of the form all those 
objects move along. 
 

3. Make sure your form contains a Submit button (push button). Without this button the user will 
not be able to submit the entered data. 
 

4. Once you have designed your form, you may need to set some properties. Select the form and 
choose Edit -> Properties from the Web Builder menu. The most important thing you need to 
do is specify the form action. For example, to send the entered data to your email address, 
when the user presses the submit button: mailto:yourname@yourdomain.com 

 

Note:  
Much more information about forms is available in the Frequently Asked Questions section of the 
website, in the online tutorials and in the support forum: 
https://www.wysiwygwebbuilder.com/support.html 
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Form name 
Enter a name for the FORM. This name is primarily used for advanced scripting. 
 
Action 
Required attribute, specifying the URL of a CGI script which processes the form and sends back 
feedback. There are two methods to send form data to a server. GET will send the form input in an URL, 
whereas POST sends it in the body of the submission. The latter method means you can send larger 
amounts of data, and that the URL of the form results doesn't show the encoded form.  
 
Example: 
mailto:yourname@yourdomain.com 
This will email the results to your email address using the visitors default email client. 
 

Note:  
We do not recommend using the HTML’s ‘mailto’ feature. It is unreliable and its behavior strongly 
depends on the type of browser and user preferences. When possible, use the built-in PHP form 
processor or create your own processing script. 

 
If your web server supports PHP, then you can use the built-in PHP form processor which is probably 
the easiest way to implement form processing. Read more details about this later in this document. 
You can also write a simple form handling routine in PHP as explained in this tutorial: 
https://www.wysiwygwebbuilder.com/forms_php.html 
 
If your server is not PHP-enabled, then you should contact your web host and ask them for the details 
on processing forms. Some servers offer server-side scripts that you can use, and if this is the case you'll 
need instructions setting this facility up. Alternatively, you can use a remotely hosted solution like 
www.formbuddy.com or www.mailmyform.com.  
These services let you access a CGI script run off their servers. You build your form as you normally 
would, but now you fill in the URL of the remote CGI script.  
The CGI script translates your form into an email message and sends it on to the address you provide. 
 
Accept Charset 
Specify which character will be accepted by the form. This can be useful for Unicode languages. This 
value is also used by the built-in form processor. Common values supported by most browsers are ISO-
8859-1 or UTF-8. 
 
Encoding type 
Here you can specify an encoding type. The default of "application/x-www-form-urlencoded" is most 
widely supported.  An alternative is "text/plain", which is typically used in combination when the Action 
attribute points to a mailto: URL. If a browser supports both, the contents of the form are sent in plain 
text to the indicated recipient. 
 
Use Built-in PHP form processor script. 
After the user has entered the information in the form, you probably want to process it somehow. By 
default, a HTML form does do anything with the data, so you need to implement a form processing 
script. One of the great features of WYSIWYG Web Builder is that it has a built-in form processor. This 
implements all the basic features of a form processor like sending an email, saving it to a file on the 
server or even store it in a MySQL database. Enable Use Built-in PHP form processor script option if you 
want to use the built-in form processor.  This feature automatically generates a PHP script that will 
process the fields of your form and send it to an email address you specify. The form processing script 
will be inserted into the same page, and you will be able to select a 'thank you' or successful page that 
will be displayed after the user has submitted the data. 
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Email address 
The email address where the results of the form will be sent to. You can only specify one email address 
in this field. You can leave this field empty if you do not want to send an email. 
 
More-button 
Click the 'More' button to specify multiple email addresses (CC/BCC). Use commas to separate email 
addresses.  The 'From email' field will set the 'from' address of email sent messages to the specified 
email address. If you leave the field empty, then it will work like in previous versions: either the 'email' 
input will be used (if it exists) or the 'to' address. 
The 'From name' allows you to set the name of the sender. It is also possible to use a PHP variable. For 
example, S_POST[‘name’] where ‘name’ is the name of the input field. 
'Reply to' can be used to specify an alternative reply address. 'Reply To' can be a fixed email address, in 
which case you must use quotes: 
 'yourname@email.com'  
or a PHP variable:  
$_POST['email'] 
 
The default value is $mailfrom. This is a built-in variable and means that if 'From email' has been 
configured that this will be used or else the email address entered by the user. 
 
Subject 
The subject of the email message. 
 
Message 
A short message that will be added to submitted data. 
By default the message will be sent in plain text, but it's also possible to format the text. Click the 'Edit' 
button to change the format of the message. Select 'Rich text' to use the built-in editor to format the 
text (click the 'Edit' button to open the editor) or select 'HTML' to insert your own HTML code for the 
message (for advanced users!). 
 
Success page (required) 
The page that the user will be redirected to after the data has been submitted (after the 'submit' button 
has been pressed). 
 
Error page (required) 
The page that the user will be redirected to if an error occurs while processing the data. 
 
Write form data to a .csv file. 
This option will save the submitted form data to a comma separated data file on the web server. You 
open this file in Microsoft Excel, a text editor or import into a database. 
 
Note that the data file must exist on the server, and it must be writable! 
WYSIWYG Web Builder has a very useful option to automatically create this file for you and set the 
appropriate permissions. Simply click the 'Create' button next to the filename field and follow the 
onscreen instructions. 
 

Step 1 
Enter the name of the data file. For example, 'formdata.csv' 
 
Step 2 
Select the publish location where the file will be created. Web Builder will list all profiles you've 
created in the publish manager. 
 
Step 3 
Web Builder will connect to the selected location and display the folder structure on the web 
server. Select the remote folder and click 'Finish' to create the data file. 
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Upload files to a folder on the server. 
If this option is enabled the built-in form processor will upload files to a folder on the server instead of 
sending them as attachment via email. The files will be saved with a unique filename. The location of the 
uploaded file(s) will be included in the email message. 
 
Database (for advanced users) 
You can use this option in combination with the built-in form processor to store form data in a MySQL 
database on the server. The generated PHP script will attempt to automatically create the table and 
fields based on the settings you configured, so you do not have to worry about creating it yourself. 
The database fields will be in the same order and use the same name as in your form design. 
 

Note:  
To view or process the submitted form data you will need a separate tool, like the standard MySQL 
admin tool. Please consult the documentation of your web host for more details. 

 
Write form data in a MySQL database, specify whether to write form data in a MySQL database.  
Database, specifies the MySQL database name. 
Table, specifies the MySQL database table name. 
Username, specifies the MySQL username. 
Password, specifies the MySQL password. 
Server, specifies the MySQL database server. 
 

Auto responder 
We have added some basic auto responder functionality to the form processor. This allows you to send 
a (thank you or confirmation) message to the user. 
  
From 
Specifies the 'from' email address for the email message. 
 
Subject 
Specifies the subject for the email message. 
 
Message 
Specifies the body text for the email message. 
 
Input field name 
Specifies the name of the email input field. The default is 'email'. Which means that the form should 
have an input field named 'email' to collect the email address. 
 

Miscellaneous 
Enable Include IP address in form data to include the IP address of the computer form where the form 
was submitted in the message. The option Process variables in Success Page makes it possible to 
include form results in success page. This allows you to use variables in the text (or other parts of the 
success page) which will be replaced by the submitted values of the form. 
  
Example: on the success page add a text object with this text: 
 
The following data has been submitted to the online form: 

Name: $name 

Email: $email 

Website: $website 

 
Where name, email and website are the names of the form fields plus dollar sign. So, if the field name is 
'name' then the variable name will be '$name'.  
 
Enable server sided validation 
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This adds extra security to the form by also validating the input on the server side (using PHP), so even if 
JavaScript is disabled in the browser or the form has been modified (by spammers/hackers), the 
submitted will still be validated. This feature uses the same settings as the JavaScript (client side) 
validation.  
 
 
Do not allow URLs in form data 
This option may help to prevent spam by blocking messages that include links. 
 
 
Set envelope-from address for PHP mail() with the -f option 
Setting an envelope-sender address avoids mail bounces annoying your system administrator. 
If the mail sent by the form cannot be delivered, it will be rejected to the address specified as the "from" 
address.  
https://php.net/manual/en/function.mail.php 
 
 
Include timestamp in form data 
Specifies whether to include the time stamp in the form data.  
 
 
Include browser information in form data 
Specifies whether to include the browser information in the form data. 
 
 
End Of Line 
Specifies the end of line character in messages LF or CRLF. 
 
 
Honeypot field 
Anti-spam honeypot is a hidden form field that bots can’t avoid filling, but it’s invisible to human users. 
If the hidden field is filled in, it’s a sign of spambot activity and can be blocked. If the field is not filled in, 
it indicates that the form was filled in by a human user as intended. The name of the Honeypot Anti-
Spam field name can be set in Form Properties -> Advanced -> Miscellaneous. 
Make sure the field name is not the same as one of your existing input fields! 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/forms_antispam.html 
 
 
Akismet anti-spam protection 
Akismet provides robust anti-spam protection, effectively blocking spam submissions in contact forms. 
Akismet works by analyzing comments or form submissions using a large database of known spam 
patterns and behaviors. It checks things like the content, user IP, and other metadata against its 
database. If the submission matches patterns typically seen in spam, Akismet flags it as spam. It's 
essentially a real-time spam filter that learns and improves over time based on the data it processes. 
Akismet offers free (non-commercial) and premium pricing plans. 
 
Get your API key here:  
https://akismet.com/signup/ 
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Adding custom code to the form processor (for advanced users!) 
It is possible to add additional code to the form processor, this can be useful for inserting CC/BCC 
headers or to send another email, store to database etc. 
 

Step 1 
First make sure the option 'Use Built-in PHP form processor to send data to an email address' is 
enabled. 
 
Step 2 
Right click the form and select 'HTML' from the context menu. 
 
Step 3 
Notice that one of the tabs is called 'Custom Form Processing', here you can type your own 
code. 
The code will be inserted just before the PHP mail() function: 
 
$body .= '--'.$boundary.'--'.$eol; 

 

// your code will be inserted here! 

 

mail($mailto, $subject, $body, $header); 

header('Location: '.$success_url); 

exit; 

 

  
Important notes about the built-in PHP form processor: 
 

• If the form contains an editbox named 'email', then this email address will be used as the 'from' 
address for the message. This field name is case sensitive! So do not call it Email or eMail. 
 

• If the form contains one or more 'file upload' objects, then the script will automatically 
attached these files to the email message. 
 

• You MUST change the file extension on the page to PHP (in Page Properties), because PHP will 
be added to the page. 
 

• You cannot preview/test a PHP page on your local computer unless you have a PHP web server 
installed. PHP scripts can only be tested once the page has been published to the server. 
 

• Your hosting account must support PHP and the mail() function must be enable, otherwise it 
will not work. 
 

• You can have only one form per page. 
 

• The z-order of the objects on the form determines the order of the items in the email message. 
You can change this order by using the Arrange tools or select 'Arrange Objects' in the form's 
context menu. 

 
 
See also this online tutorial: 
https://www.wysiwygwebbuilder.com/forms.html
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Hidden Fields 

You can also add hidden fields that are not rendered but whose values are submitted with a form. 
Generally hidden fields are used to store information between client/server exchanges that  
would otherwise be lost due to the stateless nature of HTTP.  
 

 

Events 
For more information about events please read the ‘Events’ chapter of this document. 
 

 

Web Storage 

Web storage is a new feature of HTML5. It allows you to store field values between sessions or/and 
pages.  This can be useful if you want to transfer values from one form to another. 
Enable this option and WYSIWYG Web Builder web builder will automatically store and retrieve all 
values for you! 
Note that the ID of the objects will be used as the key for the value, so if you want to retrieve the values 
in another form (on another page) then it must have the same ID. 
 
Local storage stores data with no time limit. 
Session storage stores data for one session. 
 
Note:  
Web storage only works if your website is online. It works in all modern browsers. 
 
  

Set Tab Order in Forms 
The option 'Set Tab Order' can be used to quickly set the Tab order in forms. 
Here's how it works: 
1) First select the form. 
2) Next select the 'Set Tab Order' option in the menu (also available in the context menu of the form). 
3) Web Builder will now display the current index of each form element that supports the tab index 
attribute. If the tab index is not set yet, it shows 'Not Set'. 
4) Now click each object in the desired order. The new index will automatically be displayed. 
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Advanced Button 

 

 
 
Inserts an Advanced Button object on a form. The Advanced Button gives you more control over the 
appearance and behavior than a standard button. You can change the background color, use different 
fonts for the text or even activate JavaScript. 
 
Name 
Name of the button. 
 
Value 
Initial value of the button. 
 
Button Type 
Normal: Normal (Push) buttons have no default behavior.  
Submit: When activated, a submit button submits a form.  
Reset: When activated, a reset button resets all controls to their initial values.  
OnClick: With this option you can associate a client-side script to the button.  
 
OnClick action 
Here you can specify which action if associated with the button OnClick event: 

• Navigate to the specified URL; enter an URL as OnClick value 

• Open a new window and load the specified URL Close the current browser window; enter an 
URL as OnClick value 

• Reload; reload the current page (same as Refresh in the Internet Browser). 

• Go to the previous page; the same as Back in the Internet Browser. 

• Go to the next page; the same as Forward in the Internet Browser. 

• Execute Java Script function; specify a script function you've defined elsewhere in the page. 
 
OnClick value 
Depending on which OnClick action you've selected you enter the associated value here. 
For example, to Navigate to the specified URL you enter an URL. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Disabled 
The disabled option disables the control for user input. Disabled controls do not receive focus.  
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
 
Title 
Specifies the tooltip displayed by the browser 

 

Events 
For more information about events please read the ‘Events’ chapter of this document. 
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CAPTCHA 

 

       
 
The CAPTCHA object was designed to work in combination with (PHP) forms. It helps to stop spammers 
from submitting form data automatically. CAPTCHA (an acronym for "Completely Automated Public 
Turing test to tell Computers and Humans Apart,") dynamically generates an image with (random) 
letters and numbers. The letters, because they're part of an image and not text, are difficult for a 
spambot or another computer program to read. Yet, a person has little trouble reading the letters in a 
captcha image. 
 
There is also built-in support for Google’s reCAPTCHA v2,  reCAPTCHA v3 and hCAPTCHA! 
 

Tip:  
The CAPTCHA object must be part of a form. And because it uses PHP, it can only be used/tested on a 
web server with PHP support! To be able to generate the CAPTCHA image the GD-library (version 2) 
must be enabled in your PHP setup. In some cases, an error message may be displayed on your website. 
The message is will look something like this: 
Warning: imagepng(): Unable to open './captcha.png' for writing in /../../captcha.php on line x 
This problem may occur when the captcha script is placed in a folder on the website. The solution is to 
change the properties of that folder after publishing. The correct properties are 757 or 777. You can use 
the built-in FTP client to change the permissions of the folder. 

 

 
CAPTCHA image 
Type 

• default 
Displays random characters 
 

• math 
Displays a (random) mathematical challenge, instead of characters. 
 

• reCAPTCHA v2 
Use  Google’s reCAPTCHA v2 
 

• reCAPTCHA v3 
Use  Google’s reCAPTCHA v3, also known as 'Invisible reCAPTCHA' 
 

• hCAPTCHA 
hCaptcha is a free, private and secure CAPTCHA service that helps protect your forms against 
spam. It works along similar lines to Google’s version but offers more methods of identifying 
and blocking bots. 

 
Site Key and Secret Key 
To get reCAPTCHA keys, you’ll need to sign up at: https://www.google.com/recaptcha 
 
To get hCAPTCHA keys, you’ll need to sign up at: https://hCaptcha.com/?r=4c00f060adf9 
 
The keys are unique to your domain and sub-domains and will not work for other domains  
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Width / Height 
Specifies the width and height of the image. 
 
Text Color 
Specify the color of the text. Select 'Random' to use a random color for each character. 
It's also possible to set the transparency of the text, so the background will shine through. 
 
Background Effect 

• solid 
Use a solid background color  

• random 
Generate a random background with polygons and lines in different colors which is more 
difficult to read by spam bots. 

• noise 
Generate a random background noise effect. 

• dots & lines 
Generate a random background with dots and lines  

 
Enable wave effect. 
This will apply a wave filter to the image to make it harder to read for spam bots. 
 
Enable rotation 
Specifies whether to use randomly rotated characters. 
 
Enable text shadow 
Adds shadow to the text, making it even more difficult to read for spam bots (but also for humans...). 
 
Include characters 
Specify which characters will be used in the image. Avoid using confusing characters and numbers (For 
example: l, 1 and i) 
 
Secret Key/ Site Key 
Enter your Site and Secret reCAPTCHA key here.  

 
Editbox Offset 
Specifies the offset between the image and the editbox. 
 
Tips:  
If you enter a negative value, then the editbox will be positioned below the image! 
It's also possible to hide the standard editbox (set offset to -99). This allows you to create your own 
input control to give you more control over the size, position and styling. 
 
Access key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Tab Index 
You can set the tab order of the form fields using tabindex attribute. Usually, the first tabindex starts 
with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the 
element is skipped when the user tabs around the form. 
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Checkbox 

 

 
 
Checkboxes are on/off switches that may be toggled by the user. Use Check boxes if want to allow more 
than one item to be selected. 
 
Name 
Specify the name of the checkbox. 
 
Value 
The value of the checkbox when it's switched on. 
 
Initial state 
Initial state of the checkbox. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Disabled 
The disabled option disables the control for user input. Disabled controls are skipped in tabbing 
navigation. The value of disabled controls will not be submitted with the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 
Style 
Default, uses the default browser style. This style cannot be customized. 
jQuery UI, uses a jQuery UI chekcbox 
Bootstrap, uses Bootstrap checkbox 
 
 

Validate 
For more information about validation please read the ‘Form validation’ chapter. 
 

Events 
For more information about events please read the ‘Events’ chapter of this document. 
 

Note:  
This control is normally part of a form. 
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Select 

  
 
Used to allow users to select from several different options. 
 
Name 
Enter an identifier for the field. 
 

Note:  
It's important to note that the element name must be in the form name[] for multiple selects! This way 
you'll receive the selected values in an array (this is a PHP feature). 

 
Type 

• Combobox 
This will make the object a drop-down list. Only a single line is displayed at once. 

• Listbox 
This will make the object a standard list box. Multiple lines are displayed at once. 

• Datalist (HTML5).  
A datalist is a combination between a combobox and an editbox. The user can select data from 
a list or enter the value manually. 

 
Allow multiple selections 
Allows the user to select multiple items at the same time. 
 
Elements 
You can Add, Edit and Delete items that will appears in the list. 
 
Add 
Add a new item to the list. 
 
Edit 
Edit an existing item in the list. 
 
Delete 
Remove the selected item from the list. 
 
Import 
This option allows you to quickly import lists of predefined data. Select from many predefined values 
(countries, states, months, days etc.) or import from an external file. 
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Import from external file 
The file with items must have two items per line, separated by a semi colon: Item Text;Item Value 
 
For example: 
Afghanistan;Afghanistan 
Albania;Albania 
 
Move Up 
Moves the selected item up one position in the list. 
 
Move Down 
Moves the selected item down one position in the list. 
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
that the elements appear in the HTML code. However, sometimes you want the tab order to flow a little 
differently. In that case, you can number the fields using tab index attribute. 
Usually, the first tab index starts with value '1'. To exclude an element from the tab order, set the value 
of tab index to 0. In that case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 
Focus state 
Removes the default outline styles and applies a box-shadow (with customizable color) in its place. 
 
Floating label 
With floating labels, you can insert the label inside the input field, and make it float/animate when you 
click on the input field. This option uses the 'Title' for the label. 

 
Validate 
For more information about validation please read the ‘Form validation’ chapter. 
 

Conditions 
For more information about conditions and calculations please read the ‘Form Conditions’ chapter. 
 

Events 
For more information about events please read the ‘Events’ chapter of this document. 
 

Note:  
This control is normally part of a form. 
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Select Multi 

A Select Multi object implements a searchable multi-select combobox with removable labels (“chips”), 
keyboard support, and an optional clear action. 
 

 
 
Choose multiple values from a searchable dropdown. Selected items appear as removable labels. 
Supports keyboard navigation (↑/↓, Enter), Esc to close, and Tab to commit/close.  
 
Optional features include a clear button, max selection limits, “hide selected” in the menu and user 
additions. 
 
The Select Multi component provides all the standard features of a regular Select control, such as 
setting the name, title, tab index, placeholder, access key, and managing the list of items (add, edit, 
remove, import, but also includes enhanced options specifically designed for multi-selection behavior. 
 
Clearable 
Allows users to remove all selected values with a single clear action. 
 
Allow Additions 
Enables users to enter and add custom values that are not already in the list. 
 
Hide Selected 
Removes already selected items from the dropdown list so users only see unselected options. 
 
Maximum Selections 
Limits the number of items a user can select; once the limit is reached, selection is restricted and a 
custom “Max items” message can be displayed. 
 
Custom Messages 
Define the text shown when no results are found or when the selection limit is exceeded. 
 
Styling Options 
Configure hover background, focus color, full-width behavior, and label appearance. 
 
Online tutorial 
https://www.wysiwygwebbuilder.com/selectmulti.html 
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Input 

Single-line field that can be used to add name/e-mail address fields. 

 

 
 
Name 
Enter a name for the input field. 
 
Initial Value 
Value that is initially display in the input field. 
 
Place holder 
Specifies a short hint to help the user to fill out the input field. The text will disappear as soon as the 
user enters some text. 
 
Max. Length 
Specifies the maximum number of characters a user can enter in the editbox. 
 
Type 

• text 
A plain text field.  

• password 
Makes the editbox a password field so any text entry is displayed as asterisks.  

• color (HTML5) 
The browser displays a visual color picker.  

• date (HTML5) 
The browser displays a date picker.  

• datetime (HTML5) 
Input field is for precise, absolute date and time stamps.  

• datetime-local  (HTML5) 
Input field is for local dates and times.  

• email  (HTML5) 
Input field is for email addresses.  

• month  (HTML5) 
The browser displays a month picker.  

• number (HTML5) 
The browser displays a visual spin box.  

• range  (HTML5) 
The browser displays a range selector.  

• search (HTML5) 
The browser displays a search input field.  

• tel (HTML5) 
The browser displays a telephone input field.  

• time  (HTML5) 
Input field is a time input field.  

• url (HTML5) 
Input field is for web addresses.  

• week  (HTML5) 
The browser displays a week picker.  

 
Note: Different browsers will have different behavior. Some input types may not be fully supported by 
all browsers. 
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Disabled 
The disabled option disables the control for user input. Disabled controls do not receive focus. Disabled 
controls are skipped in tabbing navigation. The value of disabled controls will not be submitted with the 
form. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. Pressing the access 
key gives focus to the element. 
 
Auto complete 
Specifies whether the input field should have auto complete enabled (if available in the browser). 
 
Spellcheck 
The HTML5 spellcheck attribute specifies whether the element is to have its spelling and grammar 
checked or not. 
 
Read only 
The read only option prevents the user from changing the value of the field, but not from interacting 
with the field. The user can still highlight the text for copying for example. Read-only elements receive 
focus but cannot be modified by the user. Read-only elements are included in tabbing navigation. Read-
only elements will be submitted with the form. 
 
Tab Index 
You can set the tab order of the form fields using tabindex attribute. Usually, the first tabindex starts 
with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the 
element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser. 
 
Focus state 
Removes the default outline styles and applies a box-shadow (with customizable color) in its place. 
 
Floating label 
With floating labels, you can insert the label inside the input field, and make it float/animate when you 
click on the input field. This option uses the 'Place Holder' text for the label. 
 
 

Note:  
This control is normally part of a form. 



WYSIWYG Web Builder 21   

125 

Input group 

The Input Group object functions like a standard input/edit box but provides additional flexibility. It 
allows you to place text, icons, or buttons on either side or both sides of the input field.  
 

 
 
This is useful for: 

• Adding contextual labels such as $, https://, or kg 

• Displaying icons to provide visual cues 

• Adding buttons that act as links or trigger actions (e.g., copy, paste, search, etc.) 
 
Text 
Specifies the text displayed inside the left or right section of the input group. 
Use this to add prefixes (e.g., “$”) or suffixes (e.g., “.00”) to the input field. 
 
Icon 
Selects an icon to display beside the text. 
Icons can be chosen from any supported icon library (e.g., Font Awesome, Material Icons). 
 
Text Color 
Defines the color of the text and/or icon displayed in the left or right section. 
 
Background Color 
Sets the background color for the selected section. 
This allows you to visually distinguish prefixes or suffixes from the main input field when needed. 
 
Hide Border 
Enables or disables the separator line between the input field and the left/right section. 
Useful when you want the prefix or suffix to visually blend with the input field. For example, when 
displaying only an icon or creating a seamless look. 
 
Action 
Allows you to assign functionality to the left or right section. 
You can attach a link or define event handlers (such as onClick) to trigger other actions when the section 
is interacted with. 
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File Upload 

 

 
 
This object provides a means for users to attach a file to the contents of the form. The element is 
rendered as a text field and an associated button, though in some browsers it may appear differently. 
For example: the text of the 'browse' button will be 'Choose' in Opera and 'Browse' in IE/FireFox. Also, 
there is no way to control the size of the button or edit field through HTML. 
 

Notes: 
When using the built-in PHP form processor, the generated script will automatically take care of 
attaching the selected file(s) to the email message after the form has been submitted.  
 
Most hosting services limit upload size to between 2 and 4 Mb. While you can control the upload limit 
by adding an hidden field called 'filesize' with the size in kB, it will nevertheless comply with the limits 
imposed by the hosting providers. 
 
If you choose not to use the built-in form processor, then you must implement a script to handle file 
uploads yourself! 

 
Name 
Enter a name for the input field. 
 
Disabled 
The disabled option disables the control for user input. Disabled controls do not receive focus. The value 
of disabled controls will not be submitted with the form. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Title 
Specifies the tooltip displayed by the browser. 
 
 
 

Note:  
This control is normally part of a form. 
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Flipswitch 

 

 
 
A "Flip Switch" (also known as Toggle switch) can be used as alternative for a checkbox. Inspired by the 
iPhone checkbox.  
It is possible to use different colors (text/background/border) for checked/unchecked, add animations, 
conditions and events. See also: Checkbox 
 

 
Dark Color Scheme Toggle 
The flipswitch can also be used to toggle between light and dark color scheme by using 
'darktheme_switch' for the ID property.  
Not only does this change the color scheme but it also stores the current state and reloads it when you 
revisit the page (or another page that includes the flipswitch) later! 
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Button 

 

 
 
The push button will usually be used as submit or reset button on a form.  
If the push button isn't part of a form, it doesn't do anything by default.  

 
Name 
Name of the button. 
 
Value/Label 
Caption of the button. 
 
Button Type 
Submit: When activated, a submit button submits a form. A form may contain more than one submit 
button.  
Reset: When activated, a reset button resets all controls to their initial values.  
Normal: Normal (Push) buttons have no default behavior.  
Each push button may have client-side scripts associated with the element's event attributes.  
When an event occurs (e.g., the user presses the button, releases it, etc.), the associated script is 
triggered.  
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Tab Index 
You can set the tab order of the form fields using tabindex attribute. Usually, the first tabindex starts 
with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the 
element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 
 

Note:  
This control is normally part of a form. 
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Radio button 

 

 
 
Radio buttons are like checkboxes except that when several share the same name, they are mutually 
exclusive: when one is switched "on", all others with the same name are switched "off".  
 
Group Name 
The Radio Button will be part of this group. 
Radio buttons with the same group name will force the user to select one choice. 
 
Value 
Value of the radio button when it is selected. 
 
Initial state 
Initial state of the radio button. 
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Title 
Specifies the tooltip displayed by the browser 
 
Style 

• Default 
uses the default browser style. This style cannot be customized. 
 

• jQuery UI 
uses a jQuery UI checkbox 
 

• Bootstrap 
uses Bootstrap checkbox 

 
 

Note:  
This control is normally part of a form. 
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Range 

 

 
The 'Range' object implements a slider-like control for entering numbers. It can be used as a value input 
field in forms. You can set a min and max value and steps to define the number intervals.  
 
The object also supports events and conditions. With conditions, the range can be linked with another 
input field, for example an editbox to display the selected value. 
 
Name 
Enter an identifier for the field. 
 
Value 
Value that is initially display in the field. 
 
Minimum Value 
Specifies the minimum value of the range. 
 
Maximum Value 
Specifies the maximum value of the range. 
 
Step 
Specifies the number intervals. For example: 0.5 or 2 
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus. Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Tab Index 
Specifies the tab index. 
 
Title 
Specifies the tooltip displayed by the browser. 
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TextArea 

 

 
 
A Text Area is a multi-line form field where the user can enter large amounts of text.  
 
Name 
Enter an identifier for the input field. 
 
Initial Value 
Value that is initially displayed in the field. When the form is submitted the new or edited text is 
entered. 
 
Disabled 
The disabled option disables the control for user input. Disabled controls do not receive focus.  Disabled 
controls are skipped in tabbing navigation. The value of disabled controls will not be submitted with the 
form. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Spellcheck (HTML5) 
The HTML5 spellcheck attribute specifies whether the element is to have its spelling and grammar 
checked or not. 
 
Read only 
The readonly option prevents the user from changing the value of the field, but not from interacting 
with the field. The user can still highlight the text for copying for example. Readonly elements receive 
focus but cannot be modified by the user. Readonly elements will be submitted with the form. 
 
Tab Index 
You can set the tab order of the form fields using tabindex attribute. Usually, the first tabindex starts 
with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that case the 
element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser. 
 
Floating label 
With floating labels, you can insert the label inside the input field, and make it float/animate when you 
click on the input field. This option uses the 'Place Holder' text for the label. 
 
 

Note:  
This control is normally part of a form. 
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File Publisher 

This component automatically uploads the specified files to your web site and creates the folders once 
you publish this page. The files will be published to the same location as the page itself. You can use 
drag & drop to rearrange items. 
 
This object can be helpful if you want to include extra files which are part of the page (like scripts or 
multimedia files). 
 

 
 
Add Files  
Add one or more files to the tree.  
 
Add Folder 
Insert a complete folder and all files it contains from your local disk. 
 
New Folder 
Adds a new folder name to the tree.  
 
Properties 
Modify the properties (folder name or file location) of the selected item. 
 
Remove 
Remove the selected item from the folder tree. 
 
Remove All 
Remove all items from the folder tree. 
 
Do not include files in Asset Manager 
If the option ‘Let WYSIWYG Web Builder manage images and other files used by a project’ in Options is 
enabled, then all files will be copied to the project folder by Web Builder’s Asset Manager. You can 
disable this behavior for this extension by enabling this option.
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Lottie Animation  
Display lightweight, scalable, and interactive Lottie animations on your websites. Visit 
https://lottiefiles.com/ for a huge list of free and commercial animations. Lottie Animations can be 
triggered automatically, on click, on hover or on scroll. It is also possible to animate frame by frame 
based on the scrollbar position (parallax). Animations can be used as standalone element or as 
background / foreground in layers and layout grids. 
 
Filename 
Specifies the filename of the animation. This can be either a file on your computer or URL. For example: 
https://assets3.lottiefiles.com/packages/lf20_RItkEz.json 
 
Trigger 
Specifies when the animation is played. 

• none 
Animation is paused 

• on load 
Animation is played on page load. 

• on hover 
Animation is played on mouse over 

• on click 
Animation is played on click. 

• scroll 
Animation is played when the object scrolls into view. The viewport range slider can be used to 
specify the exact position (in percentages).  

• scroll continuous 
The animation will be controlled by the position of the scrollbar. So, if you scroll down the 
page, the animation will be played frame by frame. 

 
Loop 
Specifies whether to loop the animation. 
 
Show Controls 
Specifies whether to show controls. 
 
Play Mode 
Specifies the play mode: normal or bounce. 
 
Speed 
Specifies the animation speed. For example: 1 or 2.5 or 0.25 
 
Full Width 
For use in layout grids only. Specifies whether the animation is full width. 
 
Position 
Specifies how the animation is displayed inside its container. 
Relative, the animation will be displayed as standard inline element. 
Absolute, the animation will be displayed as background or foreground of its container. For example, 
when it's inside a layer or layout grid. The z-index determines whether the animation is in the 
background (z-index = -1) or foreground (z-index > 1) 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/lottieanimation.html 
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Rive Animation  
A Rive animation is an interactive, vector-based animation created with the Rive design tool. Unlike 
traditional animations, Rive lets designers build real-time, responsive animations that can react to user 
input (like clicks, taps, or game logic). They’re lightweight, can run in apps, games, or on the web, and 
are often used for UI animations, icons, characters, and interactive effects. 
 
Rive is often viewed as the spiritual successor to Flash, but built for a far more dynamic and modern 
workflow. While Rive and Lottie share similar goals, they differ in capability — Lottie plays pre-rendered 
motion graphics, whereas Rive uses a real-time animation engine that enables interactive, state-driven 
animations that respond to user input and app logic. 
 

 
 
Filename 
Specifies the filename of the animation. This can be either a file on your computer or URL.  
For example: https://www.yourwebsite/riveanimation.riv 
 
A huge selection of Rive animations can be found here: 
https://rive.app/marketplace/ 
 
You can also create your own animations with Rive Editor: https://rive.app/editor 
 
Trigger 
Specifies when the the animation is played. 
Animations can be triggered on page load, hover, click, scroll, or through events. 
• none, animation is paused 
• on load, animation is played on page load. 
• on hover, animation is played on mouse over 
• on click, animation is played on click. 
• scroll, animation is played when the object scroll into view. The viewport range slider can be used to 
specify the exact position. 
 
State Machine 
The name of the state machine you want to run. 
State machines are created inside the Rive file and define how the animation reacts to user actions 
(hover, click, events, etc.). 
You can see the available state machines in the Rive Editor or in the list provided by the animation’s 
developer. 
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Preview Image 
This will be displayed in the workspace as a place holder, instead of the Lottie logo. 
Note that this image will not be published. It is only used during design time. 
 
Full Width 
For use in layout grids only. Specifies whether the animation is full width. 
 
Maximum Width 
Specifies the maximum width when full width is true. 
 
Position 
Specifies how the animation is displayed inside its container. 
Specifies how the animation is displayed inside its container: 
relative, the animation will be displayed as standard inline element. 
absolute, the animation will be displayed as background or foreground of its container. For example, 
when it's inside a layer or layout grid. The z-index determines whether the animation is in the 
background (z-index = -1) or foreground (z-index > 1) 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/riveanimation.html 
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Plyr Video Player 

This object was previously called Flash Video Player. However, most browsers no longer support Flash, 
which makes using Flash Video unreliable in modern websites. The video player now uses Plyr which is a 
responsive, customizable HTML5 video player. 
 

 
 
Video 
Specifies the video to be played. 
 
Image 
Specifies the 'teaser' image. This will be displayed if the video is not playing. 
 
Title 
Specifies the title of the video. This will be displayed in the player if the user clicks the 'Info' button. 
 
Description 
Specifies the description of the video. This will be displayed in the player if the user clicks the 'Info' 
button. 
 
Auto start 
To play the movie automatically when the site visitor opens the page, select Auto Start. 
 
Loop 
To replay the movie when it ends, select Loop. 
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HTML 
This object can be used to insert custom HTML code or JavaScript. 
When you add HTML using this object it will be placed at the location where you positioned the object.  
 
Description 
This is used for display in Web Builder only. It can help you identify the code block you've added. 
 
The Type property specifies how and where the HTML code will be inserted in the page. 
 

• Do not use <div> 
Select this option to insert the HTML code “AS IS”, without size and position information. 
 

• Use <div> to set position and size of the HTML 
Select this option to insert the HTML code inside a DIV container with size and position.  
<div style:left:10px;top:10px;width:200px;height:200px;position:absolute"> 

<-- your html --> 

</div> 

 

• Start of Page 
The HTML will be inserted before all other code on the page. 
<-- your html --> 

 <!doctype html> 
<html> 

<head> 
 

• Between <head></head> tags 
The HTML will be inserted between the <head></head> tags. 
<head> 

... 

<-- your html --> 

</head> 

 

• Inside <body> tag 
The HTML will be inserted inside the <body> tags. 
<body attribute=value> 

 

• After <body> tag 
The HTML will be inserted after the <body> tags. 
<body> 

<-- your html --> 

... 

</body> 
 

• Before </body> 
<body> 

... 

<-- your html --> 

</body> 
 

• End of page 
<body> 

... 

</body> 

<-- your html --> 

 

• Inside <html> tag 
<html your html> 

 

• CSS in media query 
This option makes it possible to add breakpoint specific CSS styles. This can be useful if you 
need different styles in breakpoints. 
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Overflow 
This overflow can be used to control the overflow behavior of the layer. 
 

• None 
The content of the HTML object is fully visible. No clipping will occur. 

• Hidden 
The content is clipped, but the browser does not display a scrollbar to see the rest of the 
content. 

• Scroll 
The content is clipped, but the browser displays a scrollbar to see the rest of the content. 

• Auto 
If the content is clipped, the browser will display a scrollbar to see the rest of the content. 

 
HTML 
Enter your custom HTML code here. 
 
Notes:  

1. For most objects you can also add extra HTML before, inside of after the automatically 
generated HTML.  Select an object and select Edit -> HTML from the Web Builder menu. 
 

2. To add extra HTML before, inside of after the HEAD and BODY tags, select View -> Page HTML 
from the Web Builder menu. 
 

3. If you need to add 'global' HTML to your page, it is better to add it using the Page HTML option. 
 
 
Beautify HTML 
Available via the context menu (right click).  
This option automatically reformats and properly indents the selected HTML code for improved 
readability. 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/add_html.html 
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Java 
Java applets are an efficient way to add sound and animation, such as scrolling messages and other cool 
effects, to a page. Java applets are platform-independent applications with compact file sizes.  
Most browsers are Java-compatible, so site visitors don’t need special plug-ins to run a Java applet. 
The Java Object makes it easy to insert Java Applets to your page and set their properties.  
To choose appropriate properties settings, you should be familiar with Java before you add these types 
of application files to your site.  
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Inline Frame 

Inline Frame or an iframe allows you to open new pages inside main pages. Inline frames are also 
referred to as Floating frames.  
 
Name 
Used to set a name for the inline frame. 
 
Link to 
Web Site: display a page from an external web site. Syntax: https://www.google.com 
 
Internal Web Page: display one of the pages of your web site. 
Click 'Select' to choose a page. The Select Page window will show all the pages which are part of the 
current web site project. 
Web Builder will automatically create to correct (relative) URL when you publish your pages. 
 
Show border 
Used to specify whether to have a border for the inline frame or not.  
 
Scrollbars 
Used to specify whether the inline frame should have scrolling capability or not.  
Possible values: If Needed, Never or Always. 
 
Description  
This text will be displayed by browsers which do not support inline frames. 
 
Enable Safari Mobile fix 
This implements a workaround for inline frames ignoring the specified height on the iPhone/iPad. 
 
 

Lightbox 
The Lightbox option makes it possible to display another page in a lightbox (using FancyBox) after 
clicking on a preview image. You can specify the preview image, lightbox title and width/height of the 
lightbox. 
 

 Box Shadow 
Configure box shadow (also called drop shadow) for the inline frame. This feature requires a CSS3 
enabled browser. It will not work in combination with the lightbox feature. 
 
 
 
See also this online tutorial: 
https://www.wysiwygwebbuilder.com/iframe.html 
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Layer 

Layers can be used to create advanced layouts. A layer is a container for other objects.  
Objects can be dragged and dropped on a layer just like on a form. 
 
Some of the useful features of layers are:  

• 0...100% transparency  

• Show/Hide a layer (and all its contained objects) using the layer manager or through events. 

• Position and size a layer relatively  

• Position a layer absolute to the right and/or bottom border of the browser window  

• Several background repeat and alignment options.  

• Sticky layer mode, keeps a layer visible at all times. 
 
Opacity   
Change the transparency (0 - 100%) of the layer (and all its children). 
 
Box Sizing 
The box-sizing property is used to tell the browser what the sizing properties (width and height) should 
include. Should they include the border-box or just the content-box (which is the default value)? be 
The 'border-box' option is especially useful for full width layers, where you usually want the border 
inside the view port. With content-box the border size will be added to the total width (> 100%). 
 
Semantic HTML5 
Specifies whether to use semantic HTML5 tags instead of generic <div>. Available options: <article>, 
<aside>, <footer>, <header>, <nav>, <section>. 
 
Overflow 
This overflow can be used to control the overflow behavior of the layer. 
 

• None 
The content of the layer is fully visible. In this case the size of the layer cannot be smaller than the 
content. 

• Hidden 
The content is clipped, but the browser does not display a scrollbar to see the rest of the content. 

• Scroll 
The content is clipped, but the browser displays a scrollbar to see the rest of the content. This can 
be useful to create scrollable content without the need for an inline frame! 

• Auto 
If the content is clipped, the browser will display a scrollbar to see the rest of the content. 

 
 

Note:  
To create/update the content of the layer, you must resize it in the designer so all objects will be visible. 
After you've created/updated the layout you can resize the layer to the desired size.  
You cannot scroll the contents of the layer inside Web Builder. 
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Layer Mode 
The Layer has several modes. The Default mode, Sticky Layer Mode and a Header/Footer mode. 
In Default mode the layer will be positioned on the location where you've placed it during design time. 
If Sticky Layer mode keeps a layer visible (top/bottom/left/right) at all times. This can be useful if you 
want to keep a menu or image visible even if the page scrolls. Animation is also an option! 
 
The Header/Footer mode can be useful if you are using the layer as a header or footer for your page 
usually in combination with the 'relative horizontal resizing' option. 
Normally the 'relative horizontal resizing' (and the other relative options) will add the code after the 
<body> container resulting in a higher z-index. Selecting 'Header/Footer' mode will insert the code 
before the <body> container, so the layer will be behind all other content. 
 
There is also the Docking layer mode which allows you to dock a layer to a specific side of the screen or 
in the center of the screen. The main difference between this mode and the sticky layer mode is that 
Docking layer mode does not use JavaScript, instead uses standard CSS techniques. It's just another way 
for you to use layers and this mode can also be useful for full page headers and footers. 
 
With Anchored Layer you can anchor one or more sides of the layer to the sides of the page. For 
example, if you enable 'Anchor Left' and 'Anchor Right' then then the layer will stretch if you resize the 
browser window (the offset to the left and right page border will remain the same). 
But you can also anchor just one border (or all). 
 
Floating Layer mode is for advanced usage. It will make the layer 'float' instead of having a fixed 
position. If multiple floating layers are placed on the page, then they will be placed next to each other 
(from left to right) depending on the available screen space. If the layer does not fit on the current row 
then it will be wrapped to the next row. This feature may be useful (for advanced users) to create 
responsive websites. 
 
The option Floating mode can be used to control the 'float behavior': 

• Default 
The layer will be positioned to the right side of the previous floating object. If the object does 
not fit on the current row, then it will move to the next row. 

• Clear Left 
The layer will be forced to the next row. The layer can have other objects on the right side of 
the row (unless the next floating object is also set to clear left). 

• Full Width 
The layer will use the full width (100%) of the page. No other objects can be on the same row. 
This mode can be useful for headers or footers. 

• Full Screen 
This will set the width/height of the layer to 100% of the current view port. This can be useful 
for creating full screen/single page web sites. Important: you must also set the page alignment 
to 'Set page width and height to 100%' otherwise the layer does not use 100% of the browser 
window height!!! 
Related online tutorial: https://www.wysiwygwebbuilder.com/fullscreen.html 

• Modal Layer mode will position the layer on top of everything. Other items on the page will be 
disabled until you close the layer. Enable backdrop, specifies whether the background overlay 
is enabled. Close on escape, specifies whether pressing the 'esc' key will close the modal layer. . 

 
Modal Type, jQuery UI (as in previous version of WWB) or Bootstrap. Unlike the jQuery UI option 
Bootstrap is responsive, so the layer can have a different size in breakpoints! Also, Bootstrap uses the 
title of the layer in the header. 
 
A Panel Layer is initially invisible but can slide from the right or left side of the page by using events 
(show/hide). Display specifies the relationship of the panel to the page contents. "Push" pushes the 
page over and "overlay" displays the layer over the content. Dismissible, specifies whether the panel 
can be closed by clicking outside onto the page. 
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Default Mode 
Relative horizontal / vertical position 
Instead of using absolute coordinates, the position of the layer will now be relative to the page size. 
This property only has an effect when the page is displayed in the browser! 
 
Relative horizontal / vertical sizing 
Instead of using absolute dimensions, the width/height of the layer will now be relative to the page size. 
This property only has an effect when the page is displayed in the browser! 
 
Right  
Sets the position of the object relative to the right edge of the page. This will replace the 'left' attribute. 
 
Bottom  
Sets the bottom position of the object in relation to the bottom of the page. This will replace the 'top' 
attribute. 
 
Alignment  
Specifies the alignment of the content of the layer if Relative horizontal sizing is enabled. 
 

• Left 
The content will be left aligned (default). 

• Center 
The content will be centered. 

• Right 
The content will be right aligned. 

• Center in browser window (floating full screen only) 
This option will center the content both horizontally and vertically in the viewport. This option 
is only useful for floating full screen mode. Note that when the viewport is smaller than the 
content then the browser will add scrollbars! To prevent this, you can add breakpoints to 
optimize the layout for smaller viewports. 

• Stretch content (DEPRECATED, please use layout grid instead!) 
This will position and size child object relative to the layer. 

 
Dividers 
Shape dividers are SVG based shapes that can be used to separate the sections of a page. 
There are more than a dozen shapes you can choose from, but you can also add custom shape SVG files.  
Shapes dividers can be added at the top or bottom (or both) of a layer. The Orientation property 
determines which side is currently edited. For example, if you want to set a divider at the bottom first 
select 'bottom' and then set the properties.  If the type is set to none, the divider will be disabled. 
The color specifies the color of the shape. The width specifies the width in percentages, this can be 
useful if you only want to display a smaller part of the shape, for example 200%, clips the left and right 
part of the shape. The height is in pixels.  Shapes can be flipped horizontally/vertically. This makes it 
possible to use shapes that were designed to be used at the top, also at the bottom (flip vertically). 
The arrangement property controls whether the shape will be displayed underneath the content or on 
top of content.  
 
Shapes dividers are SVG files and are stored in the folder 'dividers' of the application folder. 
 
Online tutorial: https://www.wysiwygwebbuilder.com/shape_dividers.html 
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Rollover Layer 

A RollOver Layer works just like the RollOver image, but instead of just images you can now use any type 
of objects. In addition to fixed mode (where you can place object anywhere you want), the object also 
supports floating mode so it can be used in Layout grids. 
 

 
 
Online demos: 
https://www.wysiwygwebbuilder.com/support/wb12tryouts/wb12_rolloverlayer.html 
https://www.wysiwygwebbuilder.com/support/wb16tryouts/wb16_rolloverlayer_cards.html 
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Layout Grid 

The Layout Grid can be used to create flexible multi column layouts that automatically adapt to the 
screen size. A grid can have up to 12 columns, with sizes in percentages. Objects that are dragged onto a 
grid will automatically become floating, which means that they are placed next to each other (from left 
to right) depending on the available space. If the object does not fit on the current row, then it will be 
wrapped to the next row. Some objects (like images, text, blog, photo gallery) can be full width, so they 
always take up the entire row and stretch or shrink when the page size changes. For smaller (mobile) 
screens all columns are stacked based on the defined breakpoint. This is a great new way to create 
flexible and responsive (Bootstrap-like) layouts! 
 

 
 
Layout 
The grid can be configured as fixed or fluid layout. A fixed grid will have fixed columns based on the 
design time width of the grid. The layout will be centered in the viewport. A fluid grid uses the full width 
of the browser window, and all columns will be resized accordingly. 
 
Gutter Width 
The gutter width specifies the spacing on each side (left/right) of a column. 
 
Padding 
Padding (top/bottom) can be used to create spacing at the top or bottom of the layout grid. 
 
Breakpoint 
The breakpoint specifies at which viewport width when the layout will be switched to mobile/stacked 
layout. 
 
Maximum Width 
Specifies the maximum width of the layout grid in the browser window. This can be useful to prevent 
items from being stretched too wide. If the browser window is wider than the specified width, then the 
grid will be centered. 
 
Column Height 
The column height specifies whether the height of the grid columns is variable, fixed or full screen. 

• Auto 
the column height depends on the content inside the grid. 
fixed  
the column height is fixed. If the column has a background, then the entire column will be 
filled. 

• 100vh  
the column height is 100% of the viewport height (full screen). 
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Semantic HTML5 
Specifies whether to use semantic HTML5 tags instead of generic <div>. Available options: <article>, 
<aside>, <footer>, <header>, <nav>, <section>. 
 
Grid System 
This specifies grid system to be used. 

• Default 
This will use a Bootstrap-like grid. This grid is compatible with all modern browsers. 
 

• Flexbox 
When this option is enabled, the grid will use CSS flexbox layout. This results in cleaner code 
and enables some extra features like vertical alignment and entire column will be filled with the 
background.  
Note that this is a relative new CSS feature, it is not supported by older browsers (< IE11). 
https://caniuse.com/#feat=flexbox 
 

• CSS Grid 
This will use CSS's native Grid Layout. Note that this is only supported by modern browsers. It is 
not supported by Internet Explorer and older mobile browsers! 
https://caniuse.com/#search=grid%20layout 
 

 
Overflow 
The 'overflow' property determines what happens when columns do not fit in the current row. For 
example, if you have more columns in the default view than in breakpoints. Overflow columns can be 
hidden, 100% or have custom value. 
Note: the breakpoint value overrides the overflow value. This means that even if you have set columns 
to overflow, they will not be visible for stacked columns (if the viewport is lower than the breakpoint). 
If you need different behavior, then set the breakpoint value to a low level (so it won't be triggered) and 
implement a breakpoint with custom overflow values. 
 
Position 
The position of a layout grid can either be floating (default) or fixed. When fixed, the layout grid will be 
fixed to the top of the page. This can be useful to create a page header which is always visible. 
 
In version 15 we have added the following position options: 

• Footer (fixed) 
This makes it possible to use a the Layout Grid as fixed footer. This also works with master 
pages. 
 

• Footer (floating) 
This makes it possible to use a Layout Grid as floating footer. The layout grid will always be the 
last item on the page. This also works with master pages. 
 

• Sticky 
A sticky Layout Grid is treated as relatively positioned element until it reaches the top, at which 
point it is sticks to the top. Supported browsers: https://caniuse.com/#feat=css-sticky 
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Adding objects 
To add objects to the layout grid, simply drag & drop the object inside a column. The column will 
highlight to indicate where the object will be added. Note that the mouse cursor needs to be inside the 
column. 
 
Related online tutorials: 
https://www.wysiwygwebbuilder.com/layoutgrid_part1.html 
https://www.wysiwygwebbuilder.com/layoutgrid_part2.html 
https://www.wysiwygwebbuilder.com/layoutgrid_advanced.html 
 
 

Notes:  
Although you cannot drag a form to a layout grid, the grid itself can be a form! 
Also, a Layer and Carousel can be set to ‘floating’, so they can be used together with layout grid on the 
same page. 
 
Do not use 'Center in browser window' (page properties). This option should only be used for fixed 
content. 
 
You cannot change the size or position of the layout grid. The grid's size depends on its contents. The 
grid's position is 'floating' and it will be automatically positioned after the previous floating object. 
 
You can set the background of individual columns in the properties: Select the column and click 'Edit'. 
Note however that the background will only be applied when the column has content. If the column has 
empty space, then this space will not have a background. This is standard HTML/CSS behavior. As a 
workaround, you can enable the option 'Fixed height' which will give the columns a fixed height. 

 
 
Layout Grid Management Tools 
When you select a Layout Grid, the Ribbon will now display a dedicated 'Format' context tab to quickly 
modify properties of the Layout Grid, like background, border and arrange tools. 
 

 
 
Style 
Easily set the background, alignment, and padding of the selected Layout Grid column directly from the 
Ribbon or menu. This eliminates the need to first open the Layout Grid properties, select the column, 
and then click "Style.". 
 
Delete 
Quickly remove the selected Layout Grid column (including the content). 
 
Insert 
Quickly insert a new Layout Grid column. 
 
Move Left / Move Right 
Quickly change the order of Layout Grid columns (including the content). 
 
Increase / Decrease 
Quickly change the size of the selected column. 
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Flex Container 

Flexbox is a new CSS layout mode that introduces a powerful way to lay out, align and distribute objects. 
Flexbox consists of flex containers and flex items. 
Flex items (the objects inside a flex container) can be laid out horizontally or vertically, aligned and 
distributed in various ways. It is also possible to stretch or shrink objects to fill the available empty 
space. Besides the settings in the flex container, each object also has its own flexbox settings which can 
be set via Menu -> Arrange -> Flexbox. 
 
Flex Direction 
The flex-direction property specifies the direction of the flexible items inside the flex container.  
 

 
 

• row 
The default value of flex-direction is row (left-to-right, top-to-bottom). 

• row-reverse 
The flex items will be laid out right to left. 

• column 
The flex items will be laid out vertically. 

• column-reverse 
Same as column but reversed. 

 
Note that if you change the direction of the page in the Page Properties to right-to-left (rtl) then all 
directions will be reserved! 
 
 
Flex wrap 
The flex-wrap property specifies whether the flex items should wrap or not, if there is not enough room 
for them on one flex line. 
 

 
 

• nowrap 
The flexible items will not wrap. 

• wrap 
The flexible items will wrap if necessary. 
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Justify content 
The justify-content property horizontally aligns the flexible container's items when the items do not use 
all available space on the main-axis. 
 

 
 

• flex-start 
Items are positioned at the beginning of the container. 

• flex-end 
Items are positioned at the end of the container. 

• center 
Items are positioned at the center of the container. 

• space-between 
Items are positioned with space between the lines. 

• space-around 
Items are positioned with space before, between, and after the lines. 

 
 
Align items 
The align-items property vertically aligns the flexible container's items when the items do not use all 
available space on the cross-axis. 
 

 
 

• flex-start 
Items are positioned at the top of the container. 

• flex-end 
Items are positioned at the bottom of the container. 

• center 
Items are positioned at the center of the container (vertically). 

• stretch 
Items are stretched to fit the container. 
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Align content 
The align-content property modifies the behavior of the flex-wrap property. It is like align-items, but 
instead of aligning flex items, it aligns flex lines. 
 

 
 

• flex-start 
Lines are packed toward the start of the flex container. 

• flex-end 
Lines are packed toward the end of the flex container. 

• center 
Lines are packed toward the center of the flex container. 

• space-between 
Lines are evenly distributed in the flex container. 

• space-around 
Lines are evenly distributed in the flex container, with half-size spaces on either end. 

• stretch 
Lines stretch to take up the remaining space. 

 
Size 
The size mode determines whether the height of the container will be included. 

• undefined 
When the size is undefined then the height will be determined by the flex items (content). 

• fixed 
When the size is fixed then the design-time height will be used. This can be useful if you want 
to vertically align objects. 

 
Maximum width 
Specifies the maximum width of the flex container in the browser window. This can be useful to prevent 
items from being stretched too wide. If the browser window is wider than the specified width, then the 
flex container will be centered. 
 
To limit the background, border, and shadow within a specific width, you can enter a negative value 
(e.g., -1024). This forces these elements to stay within the specified maximum width. 
 
Related tutorial: 
https://www.wysiwygwebbuilder.com/flexbox.html 
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Flex Grid 

The Flex Grid is a new way of creating flexible layouts based on CSS Grid Layout 
(https://www.w3schools.com/css/css_grid.asp). The CSS grid layout allows web developers to create 
complex responsive web layouts more easily and consistently across browsers. 'CSS Grid Layout' is a 
two-dimensional grid system that is native to CSS. It does not rely on floats or other hacks. This results in 
clean code and reliable code. 
 

 
 
Note: To prevent confusion with the existing (Bootstrap-based) ‘Layout Grid’ object, we have named the 
new object ‘Flex Grid’, because it’s a combination of CSS Grid Layout and Flexbox. 
 
The idea behind the Grid Layout is to divide a webpage into columns and rows. The columns and rows 
have named areas where you can drag & drop objects to. The definition of the layout can be different in 
breakpoints. Each grid area supports its own padding, (flexbox) alignment, border and background 
styling. 
 
The Flex Grid has a grid editor so you can visually define the layout (grid areas) and behavior of the grid. 
 
Easy Mode 
Many users have asked for an easier way to control the flexgrid without having to deal with flexbox. 
In "Easy Mode, the flexgrid behaves just like the Layout grid.   
To make this possible, Easy mode will automatically set the following settings: 

• block elements (full width = true) will be set to flexgrow=1, flexshrink=1, flexbasis=100% 

• inline-block (full width = false) will be set to flexgrow=0, flexshrink=0, flexbasis=empty 

• Each flex item will be set to:  
flex direction = row 
wrap mode = wrap 
justify content will be replace with horizontal alignment: left / center / right 
align-items will be replaced with vertical alignment: top / middle / bottom 
align-content: not used 

 
Note that you can always switch back to 'advanced mode' in case you do know how to use flexbox and 
need more control. 
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Grid Editor 
Double click the flex grid to open the grid editor. 
 
Columns / Rows 
Specifies the number of rows / columns in the grid. 
 
Column / Row gap 
Specifies the size of the gap between the rows / columns in a grid layout. 
 
Maximum width 
Specifies the maximum width of the flex grid in the browser window. This can be useful to prevent items 
from being stretched too wide. If the browser window is wider than the specified width, then the grid 
will be centered. 
 
To limit the background, border, and shadow within a specific width, you can enter a negative value 
(e.g., -1024). This forces these elements to stay within the specified maximum width. 
 
Examples 
This drop-down menu has a few example layouts, which can be used as template for your own layouts. 
Selecting an item in the list will overwrite the current settings. 
 
Enable Visual Grid editor 
The visual flex grid editor provides a user-friendly interface for effortlessly arranging grid items in 
specific row or column structures. You can easily add rows and columns using the '+' and '-' buttons 
located at the right and bottom of the grid, respectively. When you hover over an item, controls appear, 
allowing you to manage its appearance within the grid. Adding new grid items is as simple as clicking the 
'+' button, while existing items can be resized using arrow buttons. Furthermore, removing an item is 
quick and convenient with the 'Delete' button. 
 

 
 
 
 
The following properties will be displayed depending on the current selection in the grid editor: 
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Item Properties 
Clicking a cell inside the grid will display the properties of the selected area (header, footer, sidebar etc). 
 
Name 
Specifies the name of the selected area. This name must be unique for each area.  
For example: header, footer, sidebar, content, navigation. 
Only contiguous grid cells can have the same name. So, there cannot be two sidebars (left / right) with 
the same name. A grid item can also be empty. To create an empty grid item, use a dot as name.  
 
Column start 
Specifies on which column-line the item will start. 
 
Column end 
Specifies on which column-line the item will end. This value must be greater than the start value. 
 
Row start 
Specifies on which row-line the item will start. 
 
Row end 
Specifies on which row-line the item will end. This value must be greater than the start value. 
 
Align Content, Align Items, Justify Content, Flex Wrap, Flex Direction 
Basically, each grid item is a flex container, so it supports the same alignment properties as the Flex 
Container object! For a description of these properties please see: Flex Container. 
Related tutorial: https://www.wysiwygwebbuilder.com/flexbox.html 
 
Show Labels 
Specifies whether to display the names of the grid items in the workspace. This does not affect the 
published page. 
 

Column Properties 
Clicking in the horizontal header of the grid will display the properties of the selected column. 
The width of the column is either a single value or a range (min/max). Enable useminmax() to activate 
the range. 
 
Sizes can be set in pixels, percentages or the ‘fr’ unit. The Min value can have a different size unit as the 
Max size. For example, the minimum value can be in pixels and the maximum value a flex factor (fr). 
 
‘fr’ stands for ‘fraction of available space’. You can think of this as percentages for available space after 
you've taken off fixed-sized and content-based columns/rows. This allows you to create layouts that 
previously were not possible with standard HTML/CSS! For example, when using 1fr, 40px, 20%, the 
right column is 20%, the center column is 40px and the remain space (left column) is used by 1fr. The 
row height is usually defined in ‘pixels’ or ‘auto’, where the height is defined by the content. 
 
Move Left 
Move the selected column to the left.  
 
Move Right 
Move the selected column to the right. 
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Row Properties 
Clicking in the vertical header of the grid will display the properties of the selected row. 
The height of the row is either a single value or a range (min/max). Enable useminmax() to activate the 
range. 
 
Sizes can be set in pixels, percentages, the ‘fr’ unit or auto. 
The row height is usually defined in ‘pixels’ or ‘auto’, where the height depends on the content. 
 
Move Up 
Move the selected row up.  
 
Move Down 
Move the selected row down.  
 
Related online tutorials: 
https://www.wysiwygwebbuilder.com/flexgrid_part1.html 
https://www.wysiwygwebbuilder.com/flexgrid_part2.html 
 
 
 

Flex Grid Management Tools 
When you select a Flex Grid in the workspace, the Ribbon will now display a dedicated 'Format' context 
tab to quickly modify properties of the Flex Grid, like background, border and arrange tools (move up, 
move down, move to top, move to bottom). These options are also available via the menubar. 
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Embedded Page 

Embedded Page (also known as ‘Master Objects’) is a useful feature, which allows you to re-use objects 
from another page (from your web site) in the current web page. An embedded page is basically a 
pointer to the objects of another page (e.g. the 'Master Page"). These objects will be embedded in the 
page exactly as they are on the original page. You can even use multiple master page objects on a single 
page! Let's say you have a certain layout which is the same for all your pages and you don't want this 
copy/paste it between all your pages; then simply create the layout once in page and insert the layout of 
that page in all your other pages using the embedded page object. When you want to update the layout, 
you will only have to do this once on the original page. 
 
Here is an example: 

1. Create a new website, Web Builder automatically adds the first page called 'index'. 
2. Insert a new page using the Site Manager and rename it to 'master_page’. 

 

 
 

3. Now let's add a navigation bar to the master page. Insert -> Navigation -> Navigation bar. 
 

 
 

4. Switch back to the index page (click on the index tab) and insert a ‘Embedded Page’ object. 
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5. Double click the object you have just inserted to select a page. Next click the Select-button to 
display the Select Page window and choose master_page from the list. Click OK to return to the 
page. 
 

 
 
You will notice that the navigation bar of your master_page now has become a part of the 
index page. If you go back to the master page and you modify something in that page, it 
automatically is updated in the index page as well. Of course, this feature is not limited to 
navigation bars only; you can add any element to the master page. 

 
Notes: 

1. Place all objects on the master page aligned to the left and top border, so you do not have any 
margins. 

2. If you use the master_page only for master page purposes and not as standalone page, you can 
enable 'Don't Publish this page' in Page Properties, so the page won't be published when the 
entire website is published. 

3. In contrast to inline frames, when using the Embedded Page object, all objects from that page 
are merged in the current page as if they are really a part of the page. You must however edit 
them in the master page. 

4. Embedded Page objects do not clone the properties of a page! Only objects on the master page 
will be cloned.  

5. Since the objects are cloned "AS IS", make sure the IDs of objects on the master page are 
unique. You can change the ID in the Properties Inspector. It's good practice to give them a 
prefix, like ‘master_’. This will prevent duplicated IDs on a page.  

6. Forms do not work on a master page.  
7. Layer can be used on a master page. However, you cannot use internal links on that layer. 
8. The embedded page should be in the same folder as the pages that are using it. This is 

especially important if you are using internal links because the links will be relative to the 
master page so if the page is in another folder, then they are not valid. 

9. The option 'Use hover state style to indicate the current page' in navigation tools will not work 
in combination with embedded pages, because there will be only one set of images for that 
object. The same images will be used on all pages. 

 
 
Embed as a layer 
When the "Embed as a layer" is selected, all the elements that make up the master page are, in fact, on 
a layer. This layer will block access to any page elements "beneath" it (in the z-order). If the master 
objects layer is on top of a button or link, visitors to your site will not be able to click on the button or 
link even if it is visible.  
 
When the "Embed as a layer" box is unchecked, the elements that make up the master page are 
inserted as individual objects on the page (not on a layer). You can then access any objects "beneath" 
the embedded objects (if they are visible). 
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Content Place Holder 

The Content Place Holder object should be inserted on a Master Frame page. It defines where the 
content of the page will be inserted. 
 
Overflow 
Specifies what will happen if the content of the page is larger than the size of the content placer holder. 

• Expand 
The place holder will automatically expand so that the content will fit without the need for 
scrollbars. All objects below and on the right side of the place holder will be repositioned. 

• Hidden 
Content that does fit inside the place holder will be hidden. 

• Scroll 
Scrollbars will be added if the content does not fit inside the place holder. 

 
Align 
Specifies how the content of the page will be aligned inside the place holder if it's smaller than the size 
of the content place holder. 
 

Master Frames 

A Master Frame is a design concept where your website has a constant frame and only the inner part of 
the page’s changes. In WYSIWYG Web Builder you only must design the frame once and then reuse it in 
all other pages. You can even automatically expand the layout if the content is larger than the content 
place holder! If the content is smaller than the place helper there is also an option to center, it in the 
area. 
 
A master frame page can be any page in your website. To indicate the position where the content of the 
master frame must go, you must insert a Content Place Holder object to the master frame page. 
During preview/publish this content place holder will be replaced with the actual content of the page. 
 
To indicate that a page must use the master frame, you must configure it in the Miscellaneous settings 
of the Page Properties. 
 
The master frame and content page will be merged into one page when it is preview/published. 
Note that the footer has been automatically repositioned because the page content was larger than the 
content place holder! All objects below and at the right side of the content place holder object can be 
repositioned automatically. You can also select to display scrollbars instead. 
 

 
 

Master Frame with Content Place Holder Page Content 
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Result in browser window, the master frame merged with the content of the page. 

 
Notes: 

• The objects on a master frame are cloned "AS IS", so make sure the IDs of objects on the master 
page are unique.  

• You can change the ID in the Properties Inspector. It's good practice to give them a prefix, like 
master_, this will prevent duplicated IDs on a page. 

• We do not recommend using a master frame as part of another master frame to prevent 
infinite loops. 

• The option 'Use hover state style to indicate the current page' in navigation tools will not work 
in combination with master objects, because there will be only one set of images for that 
object. The same images will be used on all pages. 

• The master frame should be in the same folder as the pages that are using it. This is especially 
important if you are using internal links, because the links will be relative to the master frame 
so if the page is in another folder, then they are not valid. 
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Page Footer 

The Page Footer can be used to add a full width footer to your website. Basically, this object is a 
simplified layer, so most settings are identical and other objects can be dragged on top of this object to 
make then part of the footer. The footer will always be displayed at the bottom of the page. 
 
Mode 
Specifies the footer mode. 

• Default 
The footer will be positioned at the bottom of page. Note that this is not necessarily the 
bottom of the browser window.  
 

• Fixed 
The footer will be fixed at the bottom of the browser window.  
 

• Fullscreen 
The footer will be hidden by default and become visible when the user moves the mouse over 
the footer. So, the footer is only visible when needed. This mode also supports animations to 
slide or fade the footer into view. The animation can be synchronized with the header 
animation so both header and footer show/hide at the same time.   
 

• Floating 
The position of the footer will depend on other floating objects (like layers), but it will always 
be at the bottom.  

 
Stack Level 
Specifies the stack level of the footer relative to the page content. The footer can either be 'In front of 
the content' or 'Behind the content'. 
 
Styling, alignment, and other options are the same as for the Layer object. 
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Page Header 

The Page Header can be used to add a full width header to your website. 
Basically, this object is a simplified layer, so most settings are identical and other objects can be dragged 
on top of this object to make then part of the header. The header will always be displayed at the top of 
the page. 
 
Mode 
Specifies the header mode. 

• Default 
The header will be positioned at the top of page. Note that this is not necessarily the top of the 
browser window.  
 

• Fixed 
The header will be fixed at the top of the browser window.  
 

• Fullscreen 
The header will be hidden by default and become visible when the user moves the mouse over 
the header. So, the header is only visible when needed. This mode also supports animations to 
slide or fade the header into view.   
 

• Floating 
The position of the header will depend on other floating objects (like layers), but it will always 
be at the top.  
 

• Hide on scroll 
Implements a popular feature where a sticky header is hidden on scroll-down and shown on 
scroll-up. Include supports for fade and slide animations with easing. 
 

 
Stack Level 
Specifies the stack level of the header relative to the page content. The header can either be 'In front of 
the content' or 'Behind the content'. 
 
Styling, alignment and other options are the same as for the Layer object. 
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Wrapping Text 

One of the most requested features is the possibility to wrap text around images and other objects. 
Unfortunately, this functionality is very complicated to implement because the size and position of text 
is usually not the same in different browsers.  
 

 
 
The results with standard HTML/CSS are unpredictable and not what-you-see-is-what-you-get. Although 
future versions of HTML/CSS will support more flexibility, we decided to simulate the wrapping 
functionality for now and when browsers are ready for it we will convert it to the official standard. 
 
'Wrapping Text' is an object container (just like a layer and form) with text. By default, the text will fill 
the entire box, but when you drag & drop objects inside the 'Wrapping Text' object then the text will 
wrap around it! 
 
All text will have the same formatting which can be configured in the Style properties. Because not all 
fonts behave the same way in different browsers, we have added a 'font fine-tune' option which allows 
you to fine-tune the size of the font for the best results. Make sure you test this in all browsers! 
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Layout 
The Layout specifies how child elements are positioned inside the container. 
 

• absolute 
the placement of child elements is done with absolute positions; they can be placed anywhere 
inside the container. In 'absolute mode' the Wrap Text object cannot be use in flexible layouts 
because all sizes/positions are fixed! 
 
Note: When this object was designed its behavior was inspired by CSS exclusions. 
Unfortunately, most browsers still do not support this functionality so WWB simulates the 
behavior by using absolute positions for text segments. 
 

• floating 
the placement of child elements is floating, starting at the top left (or top right) of the 
container. This makes it possible to wrap text around images or other objects in flexible 
layouts. In 'floating mode', the Wrap Text object can be used in layout grids or flex box. 
 

• shape 
This option adds experimental support for CSS's shape-outside. This will wrap the text around 
the outline of a single, transparent image or shape. This makes it possible to wrap text around 
complex objects rather than simple rectangular boxes.  
'shape mode' was designed to work with 1 child elements only, because there is no way in 
HTML to extract the shape from multiple elements. So, the text will only flow around the first 
element all other elements will be ignored!  
 

 
 
Threshold specifies the alpha channel threshold used to extract the shape from the image. The 
range is 0 - 255. Any pixels whose alpha component's value is greater than the threshold is part 
of the shape for the purposes of determining its boundaries.  
 
For example, a value of 128 means that the shape will enclose all the pixels that are more than 
50% opaque. The margin lets you adjust the distance between the edges of the shape (the float 
element) and the surrounding text.  
 
Note: shape-outside requires a modern browser. It currently works in Safari, Chrome and 
FireFox, but not in IE/Edge! 

 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/wrap_text.html 
 
 
. 
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Media Player 

Use this object to add media files to your page. This is the most common way to add media files to your 
web page. The Media Player now has built-in support for HTML5 audio/video! 
  
Most modern browsers support the MP4 format, so specifying alternative formats is generally no longer 
necessary. MP4 videos should work seamlessly across all current browsers. 
 
Type 
Specifies the type of media player. 
 

• Default 
If this option is selected then the browser will use the default media player as configured in the 
user's preferences. 
 

• HTML5 Audio 
Use this option if you want to use HTML5 audio. 
 

• HTML5 Video 
Use this option if you want to use HTML5 video  

 
Filename 
Specifies the filename or URL of the audio/video to play. 
 
Auto start 
To play the movie automatically when the site visitor opens the page, select Auto Start. 
Note:  Many of today's browsers (for example, Chrome and Safari) block 'auto play' when 'audio' is 
detected.  The same applies to devices such as Android / iPad / iPhone as they do not support 'auto play' 
as it is deemed annoying for visitors, it uses more bandwidth, and it can also affect battery life of the 
device. You can set the audio to 'mute' as this usually allows the browser to play the video due to 'audio' 
not being detected or remove the 'audio' from the video itself.  
 
Use Plyr 
Specifies whether to use the 'plyr' media player (https://plyr.io/) instead of the standard UI. 
 
Loop 
To replay the movie when it ends, select Loop. 
 
Show controls 
If present, controls will be displayed, such as a play button. The actual appearance of the player depends 
on the type of browser! Each browser will render the player differently!!! 
  
Preload media 
If present, the video will be loaded at page load, and ready to run. Ignored if "autoplay" is present. 
 
Mute audio (applies to HTML5 video only). 
Specifies whether the audio should be muted. 
  
Alternative formats (applies to HTML5 video only). 
Previously, not all browsers supported the same audio and video formats, which is why the option to 
specify alternative formats was introduced. However, most modern browsers now support the MP4 
format for video and MP3 for audio, making it generally unnecessary to specify alternative formats. 
  
Poster 
Specifies the filename or URL of an image representing the video.  
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YouTube 
The YouTube object provides an easy way to add YouTube videos to your pages. 
 
URL 
Specifies the URL of the YouTube video. 
The URL should look like this: https://www.youtube.com/v/TGCHtT70R8w 
You can also just enter the YouTube video ID: TGCHtT70R8w 
 
Show related videos 
Specifies whether display a list of related videos. 
 
Mute 
Specifies whether to mute the audio of the video. This can be useful if you want to automatically play 
without user interaction, because most browsers will block autoplay if the video has audio. 
 
Auto start 
To play the movie automatically when the site visitor opens the page, select Auto Start. 
 
Loop 
To replay the movie when it ends, select Loop. 
  
Use Plyr 
Specifies whether to use the 'plyr' media player (https://plyr.io/) instead of the standard UI. 
 
Enable full screen button. 
Enable the 'full screen' button in the player's control bar. 
 
Hide video control after the video starts playing. 
The video progress bar and the player controls will slide out of view a couple of seconds after the video 
starts playing. They will only reappear if the user moves her mouse over the video player or presses a 
key on her keyboard. 
 
Aspect ratio 
Keep the aspect ratio of the video fixed at 16:9 or 4:3. This is especially useful when the video is party of 
a Layout Grid, so the video resizes dynamically while keeping the original aspect ratio. 
Note: this option is also available for: Vimeo and HTML5 video. 
 
Custom parameters 
Use custom parameters to add extra features which are not implemented in WWB (yet). For a complete 
list of available options please check the YouTube API documentation: 
https://developers.google.com/youtube/player_parameters. 
 
Enable JS API 
Enables the player to be controlled via JavaScript Player API calls. Only works in modern browsers! 
https://caniuse.com/#search=postMessage 
This option should be enabled if you want to use YouTube events or if you want to control the object via 
(media) events: play, pause, stop. 
 
 

Lightbox 
The Lightbox option makes it possible to display a YouTube video in a lightbox (using FancyBox) after 
clicking on a preview image. You can specify the preview image, lightbox title and width/height of the 
lightbox. 
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TikTok Video 
TikTok is a popular social media platform for creating, sharing, and discovering short-form videos, often 
featuring music, challenges, and viral trends. 
The TikTok video object provides an easy way to add TikTok videos to your pages.  
 
TikTok post ID 
Specifies the TikTok post ID of the video. You can find the TikTok post ID on from the post URL.  
For example, 6718335390845095173 is the post ID from the URL 
https://www.tiktok.com/@scout2015/video/6718335390845095173 
 
Show controls 
Specifies whether to show/hide all elements in the player (play bar, sharing buttons, etc.).  
 
Timestamp 
Display the video's current playback time and duration. 
 
Related 
Enabled: Show recommended videos as related videos 
Disabled: Show the current video author's videos as related video. 
 
Aspect ratio 
Keep the aspect ratio of the video fixed at 16:9 or 4:3. This is especially useful when the video is party of 
a Layout Grid, so the video resizes dynamically while keeping the original aspect ratio. 
 
Lazy Loading 
The 'Lazy loading' property specifies whether a browser should load content immediately or to defer 
loading of off-screen content until for example the user scrolls near them. 
This feature requires a modern browser: https://caniuse.com/loading-lazy-attr 
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Breadcrumb 

Breadcrumbs are used to enhance the accessibility of a website by indicating the location using a 
navigational hierarchy. You can either manually configure all links for the menu or automatically 
synchronize with Site manager. The menu also supports icons (Font Awesome, Material Icons, etc.) and 
custom images. 

 
 
Symbol 
Use '>>>' for special arrow separator. You can increase the 'padding' to control the sharpness of the 
arrow.  A value of 15 gives pretty good results. 
 
Use this menu for CMS 
Enable this option to use the menu with the CMS tools. Instead of a static menu, the links will be 
dynamically generated based on the CMS database. 
Note that this only works when the page has been published! 
 
Synchronize  
Synchronize the menu with the Site Manager structure, bookmarks on the same page or with other 
menus. See also “Synchronize Navigation” later in this document. 
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CSS Menu 

This menu is very similar to the Navigation bar with the main difference that this menu does not use any 
images or JavaScript! Still the CSS menu allows you to create fancy looking menus (glossy, glass, 
gradients etc.) using CSS3 gradients and shadows. 
 
The menu also supports icons (Font Awesome, Material Icons, etc.) and custom images. 
 

 
 
Responsive-accordion 
The menu is horizontal on desktop and becomes a vertical, expandable (accordion) list on mobile, 
switching at the screen size you set with the breakpoint property. 
 
ScrollSpy  
ScrollSpy is a navigation mechanism that automatically highlights the navigation buttons based on the 
scroll position to indicate the visitor where they are currently on the page.   
This feature works in combination with bookmarks. so, the link in your menu must point to a bookmark 
on the current page. 
 
Affix 
The Affix option is often used with navigation menus to make them "stick" at a specific area while 
scrolling up and down the page. 
 
Online demo: 
https://wysiwygwebbuilder.com/support/wb18tryouts/wb18_cssmenu.html 
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Go Menu 

You can use the Go Menu component to easily create a drop-down navigation menu, with each menu 
item corresponding to a single URL or page on your web site. When the user presses the Go button the 
select link will be activated. 
 

 
 
 
Initial Text 
This is the initial text which will be displayed in the dropdown menu. 
 
Button Text 
The text of the button 
 
Do not use button 
Select this checkbox to hide the go button. Is this case a dropdown menu selection will trigger the link. 
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Layer Menu 

Layer Menu is an advanced menu where the drop-down menus are layers. This is great for creating 
advanced mega menus with images, text, form or any other object! The drop-down layer can be 
positioned left, centered or at the right of the buttons. It is also possible to make the layer full width of 
the page. 
 
The menu also supports icons (Font Awesome, Material Icons, etc.) and custom images. 
 

 
 
Position children 

• Absolute 
The objects on the layer have a fixed position.  

• Floating 
Allows you to add floating and flexible content to layers of the menu, with support for padding 
and alignment options. 
 
Additionally, you can place a layout grid on the menu layers, making it easy to create clean, 
multi-column designs. 

 
RWD 
The 'breakpoint' properties control how the menu will be displayed on mobile devices: Accordion, Panel 
or Overlay.  
 

• Accordion, displays the layers in a stacked, accordion like layout. 

• Panel, display a slide out panel at the left side of the browser window. The hamburger icon 
supports animations and you can set icon size and offset. 

• Overlay, displays an overlay menu covering the full page with ‘drill down’ layers. 

 
 
 
 

Notes:  
Main buttons can have links, make the layer size smaller than 48 pixels to remove the layer from the 
item. 
- button modes, set spacing to 0  
- not recommended for smaller screens. 
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Mega Menu 
Mega Menus are drop down menus that contain multiple columns of links. They enable access to all 
links at once, rather than forcing the user to scroll or use sub-menus. One of the unique features of this 
Mega Menu is that you can set different drop-down styles for each button. The drop down can have 
rows, columns, just a simple menu or no menu at all! 
 

 
 
 
Menu Layout 
Specifies how the items in the submenu will be displayed. 
 

• Columns only 
All categories will be displayed in columns (1 row).  

• Rows only 
All categories will be displayed in rows (1 column)  

• 2 columns 
Categories will be displayed in 2 columns.  

• 3 columns 
Categories will be displayed in 3 columns.  

• 4 columns 
Categories will be displayed in 2 columns  

• Simple menu 
Displays a simple drop-down menu  

• Button only 
The button has no sub menu.  

 
Links are organized in categories. To add a new category, click the ‘Add category’ button and specify a 
name. To add a link to a category, first select the category name and then click ‘Add Link’. 
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Menu Bar 

The Menu bar in Web Builder is based on Heng Yuan's JSCookMenu 
(https://www.cs.ucla.edu/~heng/JSCookMenu). This is a very powerful JavaScript-based menu script 
that can mimic complex menus found in popular GUI applications.  Web Builder provides a menu builder 
so you can easily add menu items, assign the links and set the style for the menu using the style tab.  
 

 
 
Layout: The Menu Bar can be either Vertical or Horizontal. 
 
Style: To change the appearance of the menu bar either select a predefined theme of select Default to 
edit the menu bar colors and text formatting. 
 
Note the effect of the selected theme will only be visible in the browser. So, you'll have to preview or 
publish the page first. 
 
 

Tip:  
You can rearrange the items in the menu you can use drag and drop to move the items around. 

 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/menubar.html 
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Navigation bar 

Adding a Navigation Bar in WYSIWYG Web Builder is easy.  
Just add a few buttons, assign the links and set the style for the buttons. 
 

 
 
 
Resize buttons horizontally 
Enable this option to be able to resize navigation bar buttons horizontally. Instead of the original button 
width, the button will now be stretched. 
 
Layout Type 
The Navigation Bar can be either Vertical or Horizontal. 
In responsive mode, the menu now adapts automatically: it displays horizontally on desktop and 
switches to a vertical list on mobile, using the breakpoint you set.  
 
Layout Space 
This option specifies the space between 2 buttons. 
 
Synchronize  
Synchronize the menu with the Site Manager structure, bookmarks on the same page or with other 
menus. See also “Synchronize Navigation” later in this document.  
 
Style 
Select one of the available button styles from the drop-down menu. 
You can select your own images by using the 'Use Custom Image' option (the first item in the drop-down 
list). By default, Web Builder includes a few example styles, but you can easily add your own styles: Copy 
your own styles (which are basically just images) to navbar folder:  
My Documents\WYSIWYG Web Builder\system\navbar\ 
 
With the Colorize option you can change the color of a button to almost any color! 
This gives you hundreds of additional color variations to choose from! 
 
Animation 
You can choose from several animations for the mouse over effects to give your menu's a modern web 
2.0 look and feel. 
 
Use hover state style to indicate the current page. 
To give the visitors of your web site an indication of which page they currently are viewing you can give 
that page the same style as the hover state.  
Note that this option does not work when the navigation bar is on a master page, because in that case 
the images for the navigation bar will be the same for all pages! 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/navigationbar.html 
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Overlay Menu 

The Overlay Menu implements a multi-level, responsive full screen menu. With many show/hide 
animations (genie, sliding door, content push, scale etc.), social icons support and many styling options. 
 

 
 
 
Online demos: 
https://wysiwygwebbuilder.com/support/wb18tryouts/wb18_overlaymenu.html 
https://wysiwygwebbuilder.com/support/wb19tryouts/wb19_overlaymenu_popup.html 
https://wysiwygwebbuilder.com/support/wb19tryouts/wb19_overlaymenu.html 
 
 

How to add social icons? 
There is no dedicated section to configure social icons. Instead, all you will have to do is leave the 'text' 
field empty and select an icon. This will create a social icon at the bottom of the menu instead of the 
standard menu item!  
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Pagination 

If you have a web site with lots of pages, you may wish to add the pagination object for easier 
navigation. 
 

 
 
Synchronize  
Synchronize the menu with the Site Manager structure, bookmarks on the same page or with other 
menus. See also “Synchronize Navigation” later in this document. 
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Panel Menu 

A Panel Menu is initially invisible but can slide from the right or left side of the page by clicking the menu 
button. Many modern web sites use this menu type. 
 

 
 
The general menu settings are the same as for other menu types like the navigation bar. 
 
Text 
Specifies the text of the menu button. This field can also be used to configure hamburger animations! By 
using special characters, the button will display a hamburger menu symbol instead of text. When 
clicked, the bars will animation into a close symbol. 
 
12 different animations are available: 
transform: =  
one bar:  _ 
spinner:  @ 
rotate:  * 
90 degrees: | 
arrow left: < 
arrow right: > 
arrow up: ^ 
arrow down: v 
minus:  - 
plus:  + 
times:  x 
 
Icon 
Image that can be displayed on the button. The icon position can be used to control the icon position 
relative to the text. 
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Display 
Specifies the relationship of the panel to the page contents. "Push" pushes the page over and "overlay" 
displays the layer over the content.  
 
Position 
Specifies whether the panel menu will be displayed at the left or right side of the page. 
 
Dismissible 
Specifies whether the panel can be closed by clicking outside onto the page.  
 
Overlay 
Use this option to fade the page background (with the specified color and opacity) when the menu is 
active. When the opacity value is set to '0' then there will be no overlay. 
 
Width 
Specifies the width of the panel. By default, this value is in pixels, but you can also use percentage, for 
example 50%. 
 
The animation can either be ‘none’ or ‘slide’. The slide animation also supports many easing options. 
 
Overlay 
Use this option to fade the page background (with the specified color and opacity) when the menu is 
active. When the opacity value is set to '0' then there will be no overlay. 
 
Icon Font Library 
Specifies whether to use FontAwesome Icons or Material Icons in the menu items. 
The menu also supports custom images. 
 
RWD 
The breakpoint value in the Responsive Web Design (RWD) tab specifies when the menu will switch 
from panel to full width mode. 
 
Online demos: 
https://wysiwygwebbuilder.com/support/wb18tryouts/wb18_panelmenu_reveal.html 
https://wysiwygwebbuilder.com/support/wb18tryouts/wb18_panelmenu_fixed.html 
 
 

How to add social icons? 
There is no dedicated section to configure social icons. Instead, all you will have to do is leave the 'text' 
field empty and select an icon. This will create a social icon at the bottom of the menu instead of the 
standard menu item! 
 

How to add a divider? 
Set the text to '---'  (3 dashes) to insert a divider instead. 
 

How to use the Panel Menu button to trigger a Panel Layer? 
The Panel Menu buttons support cool hamburger animations (see Options -> Text). These animations 
can also be used in combination with a Panel Layer. 
Make sure the Panel Menu only has one item. Link this item to the layer (via a bookmark). The text of 
the item will be ignored. 
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Responsive Menu 

The Responsive menu is a responsive, multi-level menu optimized for desktop computers and mobile 
(touch) devices which uses CSS only (not JavaScript). On desktop computers the menu will display a 
standard drop down menu and on mobile devices it will display a multi-level stacked menu with the 
common ‘hamburger’ icon.  
 

 
 
The menu also supports icons (Font Awesome, Material Icons, etc.) and custom images. 
 
Breakpoint 
Specifies the browser width where the menu will switch from desktop to mobile mode. 
 
Most other styles and menu related properties are the same as in other menus. 
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SiteTree 

 

 
The SiteTree can display an overview of your website (a Site map) so visitors can quickly find what 
they're looking for. 
 

Tip:  
Do not confuse this object with the SiteMap option in the Tools menu, which is purely meant for search 
engines! 

 
The SiteTree will display all pages of your website, except for the pages which you have marked 'Don't 
Synchronize this Page in Navigation Objects.'. 
This object has 3 display styles, each giving a completely different overview of your site: 
 
Alphabetical 
Displays an alphabetical list of all the pages of your website. 
 
Category 
Displays all the pages of your website grouped by category. 
For this style to work correctly, you must first assign one or more categories to a page. You can either do 
this in the Page Properties (meta tags) or in the General Properties of the SiteTree itself. 
 
Treeview 
Displays all the pages of your website in a tree view based on the structure of the site in the Site 
Manager. 
 
In the General Properties of this object, you can quickly update the display name (is the same as the 
menu name property in Page Properties), the page description (Description meta tag) and the 
categories. 
You can assign one or more categories to a page (separated with a comma).  
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Snap Scroll 

Snap Scroll enhances your one page scrolling website experience by providing snapping behavior as you 
scroll up or down the page. It also adds pagination dots with hover titles to the page for easy navigation 
and displaying the currently active section.  
Unlike other navigation tools, where you link items to other pages, was this menu designed for creating 
bookmarks on the current page only where each dot links to another section (bookmark) of the page.  
 

 
 
Pagination 
The pagination dots are fully customizable and can be positioned at the left or right side of the page 
(top/middle/bottom). 
You can set the colors, size, spacing and shape. The style of the text can be set under the 'Style'. 
 
Tip:  
To make the fully transparent, set the alpha value of the fill color to '0'. 
 
Padding 
In the padding properties, you can configure the padding around the pagination dots. This is mainly 
useful if you also give the menu a background. 
 
Margin 
In the margin properties, you can configure the offset from the edges of the page. For example, if the 
menu is horizontally aligned to the left, then the left margin specifies the offset from the edge. 
 
Direction 
Specifies the scroll direction: vertical or horizontal. 
 
RWD 
In the RWD properties, you can set a breakpoint. This makes it possible to disable the snap behavior for 
smaller screens. This will also hide the pagination. 
 
 
Online tutorial:  
https://www.wysiwygwebbuilder.com/snapscroll.html 
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Table of Contents 

A Table Of Contents is a list of links that lead to different sections on a page. They're particularly useful 
for long pages, as they highlight the critical sections of a page to improve the reader experience.  You 
may know Table Of Content from websites like Wikipedia.  
 

 
 
Automatically synchronize with heading objects on the page 
Specifies whether to automatically synchronize with heading objects on the page. 
Every time you preview or publish the page, WYSIWYG Web builder will scan the page for heading 
objects (h2, h3 etc.) and update the list. Note that <h1> tags will be skipped because this is usually the 
page title (like Wikipedia). 
  
For the best result, it is important that the order of the heading objects is correct. For example, h2 
should be on top, followed by h3, h4 etc. Note that if you skip a level. For example, from h2 to h4 then 
an empty entry will be added to make sure the structure of the table is correct. You can also configure 
the list manually by unchecking this option. 
 
Bullet Style 
Specifies the style of the bullets. 
 
Line Height 
Specifies the spacing between lines. 
 
Title 
Specifies the Table of Contents title. You can also leave this empty. 
 
Indent 
Specifies the offset for different levels. 
 
Link Style 
This is used for styling the links. Styles can be added or modified via the Style Manager. 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/table_of_contents.html 
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Tab Menu 

 

 
The Tab Menu is yet another way to implement your website navigation.  
The biggest difference between the navigation bar and the tab menu (besides its appearance) is that a 
tab menu item has 3 states: 

1. Normal 
Idle state 

2. Hover 
Mouse over or Rollover state 

3. Activate 
The selected item is the current page.  

 
Tab Menu Style 
WYSIWYG Web Builder includes several themes you can choose for the appearance of the tab menu. 
The default theme is text only and does not use any images. The other themes are defined in the 
tabmenu folder (My Documents\WYSIWYG Web Builder\system\tabmenu\) and usually are made of 2 
images. If you like you can modify these themes or create your own themes. 
 
RWD 
The breakpoint value in the Responsive Web Design (RWD) tab specifies when the menu will switch 
from horizontal to vertical mode. 
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Text Menu 

The Text Menu is a text-only version of the Navigation bar. 
Text menus can speed up the navigation through your website, because no images need to be loaded 
first before the user can navigate to another page. 
 

 
 
Target 
Specifies the target window of the links when 'Synchronize with Site Manager' is enabled. 
 
Level 
This value specifies which level of the Site Manager will be used to create the items.  

• First Level  
Creates buttons that will link to the children of the root level. 

• Parent Level  
Creates buttons that will link to all pages in the level above the current page. 

• Current Level  
Creates buttons that will link to the current page and all other pages that share the same 
parent page. 

• Child Level  
Create buttons that will link to the children of the current page. 
 

Spacing 
This setting specifies the space between 2 items. 

 
Link Style 
All links in your webpage by default use the default HTML link colors (link: blue, visited: purple, active: 
red). By defining link styles (CCS) you can adjust the colors and formatting of a link. Once you have 
defined a style you can attach it to the Text Menu by selecting it from the Link Style dropdown list. Click 
the Edit Styles button to add or modify the link style sheet. 
 
Delimiters 
Specify special characters to put before and after the link text. Common characters include {, [  and (. 
 
RWD 
The breakpoint value in the Responsive Web Design (RWD) tab specifies when the menu will switch 
from horizontal to vertical mode if the layout type is set to 'Responsive'. 
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Animated Headline 

Animated Headline allows you to create eye-catching and engaging website headlines. It enables you to 
animate headline text elements that rotate or include highlighted animation.  
Additionally, this widget lets you easily customize the animation effects, speed, and styles to match your 
website’s design and branding. The animation can be started automatically on page load, on scroll or via 
events. 
 

 
 
Highlight Text 
Emphasize specific parts of your text by adding a dynamic highlight effect. This mode draws attention to 
key phrases or words, making them stand out and enhancing readability. 
 
Animate Letters 
Add dynamic movement to your text characters to capture attention and create visual interest.  
Customize the animation style, duration, and effects to enhance your website's engagement. 
 
Animated Words 
Animate complete words. Word animations work great for headlines, taglines, and phrases where you 
want each word to appear or move together. 
 
Online tutorial: 
https://wysiwygwebbuilder.com/animatedheadline.html 
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Banner 

A banner is an image that displays the title of a web page. A banner helps visitors understand what the 
page is about. A banner can be a static logo, but it is also possible to animate the text! 
 

 
 
Banner Text 
Text that will be displayed on the banner. 
 
Use page title 
This option automatically uses the title of the web page as the banner text. Uncheck this if you want to 
enter custom text. 
 
Banner Size 
The size of the banner. Select one of the predefined sizes or 'Fit to layout rectangle' if you want a 
custom size banner. 
 

 
Effects 

Enable shadow 
Specifies whether to enable the shadow effect for text. 
 
Reflection 
Specifies the amount of reflection of the text. 
 
Reflection Offset 
Specifies the offset of the reflection from the bottom of the text. This value can be negative. 
 

 
Text Animation 
The Banner object can animate the individual characters of the text using built-in CSS3 animations. This 
makes it possible to create a cool introduction to your website. You can set a different animation for 
showing and hiding the characters. If you set both animations, then both animations will be played 
continuously. If only the show animation is specified, then the animation will play only once on page 
load. 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/animate_text.html 
 
 
Output Format 
Specifies the output format of the banner. You can either publish the banner as an image or as standard 
text with CSS3 styling. 
 
Note however that older browsers do not support text shadow. Also note that reflection is currently not 
supported by CSS3, so the banner will not look exactly the same as when publish as an image. 
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ClipArt 

 

 
ClipArt uses dingbat fonts and converts them to vector shapes. It has all the features of shapes, but it 
allows you to insert any type of shape to your page! 
You can download thousands of free dingbat fonts from the Internet. Search for 'free dingbat fonts' to 
find all large collection of new shapes. After you've downloaded one or more files you can copy them to 
the 'clipart' folder in the Web Builder system folder:  
My Documents\WYSIWYG Web Builder\system\clipart\ 
 
Dingbat fonts have the file extension '.ttf'. There are also many tools available to create your own 
dingbat collections. The filename of the Dingbats font will be displayed as the category name in the 
clipart selection. 
 
For more details about the properties of the ClipArt object see Shapes. 
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Curve 

The Curve tool lets you draw curved lines. A curve can be open or closed. 
 

 
 
To draw a curved line: 

1. Click the Curve Tool on the Toolbox or click Insert -> Drawing -> Curve.  
 

2. Click and release the left mouse button where you want the Curve to start, while dragging the 
mouse press and press/release the mouse button to add points. 
 

3. To end the curve, double click the left mouse button or press the ESC-key.  
 

When the curve is selected, the individual nodes can be changed by dragging them to a new position. 
 
 
 
Description  
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled.  
 
Fill Effect (Closed Curve only) 
Specifies the fill effect of the polygon: Solid, Gradient, Texture, Hatch or Transparent. 
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Curved Text 

 

 
With the Curved Text object, you can draw text along a user defined curve. 
 
First you will have to draw a curved line: 

1. Click the Curved Text on the Toolbox or click Insert -> Drawing -> Curved Text.  
 

2. Click and release the left mouse button where you want the Curve to start, while dragging the 
mouse press and press/release the mouse button to add points. 
 

To end the curve, double click the left mouse button or press the ESC-key.  
Then double the Curved Text to edit other properties. 
 
For more information about adding, editing or removing nodes see 'Edit Points' in the Arrange Menu. 
 
All properties of the Curved Text object are the same as the Shape object. 
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Icon 

The icon object can be used to insert Font Awesome, Google Material or many other Icons fonts. The 
object supports hover, backgrounds, events, links, CSS3 animations and more. 
 

 
 
Note that the object publishes the entire Icon collection as font files. These files are shared between all 
objects that use Google Material Icons. 
 
Publish as svg 
This will output the icon as embedded SVG (scalable vector image) instead as font. This greatly reduces 
the overall size of the website if you only use a few icons. 
When the output is set to SVG then each individual part of the icon (path) can now have a different 
color via the 'Multi color' button. 
Note however that not all icons support this feature. For example, some icons may only have 
overlapping paths, in that case it's not possible to determine the 'fill' area. 
 
Custom Icon Fonts 
The default setup of WYSIWYG Web Builder includes Google Material (https://material.io/icons), which 
has more than 900 unique icons. However, there is also support for third party or custom Icon Font 
Libraries. 
 
See this online tutorial for more details: 
https://wysiwygwebbuilder.com/iconfonts.html 
 
We have created add-on packages for the following icon fonts: Drip Icons, Elusive Icons, Feather, 
Foundation Icons, Glyphicons Halflings, Ionicons, Line Awesome, Open Iconic and many more! 
The Icon Fonts add-ons can be downloaded from the website: 
https://wysiwygwebbuilder.com/free_extras.html 
 
Also, there are many third party libraries available via the forum: 
https://forum.wysiwygwebbuilder.com/viewforum.php?f=42 
 
Drop Shadow 
Unlike box shadow, which applies a shadow to the icon’s container, drop shadow applies it directly to 
the icon and follows its exact shape, creating a more natural shadow effect. 
 
User Collection 
This makes it possible to add icons to a custom collection, so you have all your favorites icons in one 
place. You can add any icon from any icon library. The icons from the user collection will be saved in SVG 
format, so you can even remove the icon library from your computer if you no longer need the other 
icons! 
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Line 

The Line tool of WYSIWYG Web Builder gives you much control over its appearance than the standard 
HTML horizontal line. The Line can be drawn using any angle, color, style and can even have arrows on 
the start or end of the line! 
 
To draw a line: 

1. Click the Line Tool on the Toolbox or click Insert -> Drawing -> Line.  
 

2. Click where you want the line to start and hold the left mouse button down as you draw. To 
end the line, release the mouse button. 

 

 
 
Size 
Specifies the thickness of the line.  
 
Style 
Specifies the style of the line (Solid, Dash, Dot, Dash Dot or Dash Dot Sor).  
 
Arrow Start 
Specifies the arrow type of the start of the line (Arrow, Circle, Square, Diamond, Stealth or Open Arrow). 
 
Arrow End 
Specifies the arrow type of the end of the line. 
 
Arrow Size 
Specify the size of the arrow. 
 
Description 
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the 
mouse over the image. 
 
Connector Type 
Specifies the connector type. Elbow and Curve connectors are commonly used in flow charts. 

• Line 
Draws a straight line. 

• Elbow 
Draws an elbow line. 

• Curve 
Draws a curved lined. 

 
Connector orientation 
Specifies the connector orientation. Horizontal, Vertical or Auto. 
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Polygon 

The Polygon tool lets you draw polygons with borders and several filling methods. 
 

 
 
To draw a polygon: 

1. Click the Polygon Tool on the Toolbox or click Insert -> Drawing -> Polygon.  
 

2. Click and release the left mouse button where you want the polygon to start, while dragging 
the mouse press and press/release the mouse button to add points.  
 

3. To end and close the polygon, double click the left mouse button or press the ESC-key.  
 

When the polygon is selected, the individual nodes can be changed by dragging them to a new position. 
 
Description  
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled.  
 
Fill Effect 
Specifies the fill effect of the polygon: Solid, Gradient, Texture, Hatch or Transparent. 
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Scribble 

The Scribble tool lets you sketch curved lines and shapes in a freeform way. 
 
To draw a freeform line: 

1. Click the Scribble Tool on the Toolbox or click Insert -> Drawing -> Scribble.  
 

2. Click where you want the line to start and hold the left mouse button down as you draw. The 
line will be drawn immediately and follows your mouse movements. Releasing the mouse 
button will draw a straight line from the point where you released the button to the current 
mouse position. 
 

3. To end the line, double click the left mouse button or press the ESC-key.  
 

When the line is selected, the individual nodes can be changed by dragging them to a new position. 
 

 
 
Description  
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled.  
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Shape 

The Shape object can be used to 'draw' a shape on your webpage. When you publish a page with 
shapes, Web Builder generates each shape as a .gif file. 
 

 
 
Type: Select the type of shape you want to display on your web page. 

• Rectangle 

• Round Rectangle 

• Ellipse 

• Diamond 

• Hexagon 

• Octagon 

• Arrows 

• Signs 

• Stars 

• Talk Bubbles  

• and many more. 
 

Some shapes have a few variants that you can choose from. 
 
To add a border to the Shape, select 'Enable Border' and specify the border width and color. 
 
You can select from several Fill Effects: 
1. Solid Color 
2. Gradient 
3. Tiled or stretched image. 
4. Transparent 
5. Pattern 
6. Vista Glass 
 
Anti Alias 
Enable this option to improve the quality of graphics. It may slow down the performance of the 
application. 
 
Inner Shadow 
This option will add a bevel effect (inner shadow) to the shape. A Blur value '0' will disable the effect. 
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Output format  
Normally shapes will be published as images, for larger shapes this may have some impact on the 
performance of your website. However modern browsers (FireFox 5, IE9, Safari, Chrome) now have 
built-in support for alternatives formats like <canvas> and <svg>. 
WYSIWYG Web Builder now enables you to convert your shapes into native HTML5 elements! 
  
Select 'Publish as <canvas> to output the shape using HTML5's <canvas> element. Basically, this 
generates a complex set of JavaScript calls to draw the shape in the browser. 
  
Select 'Publish as <svg> to output the shape using HTML5's <svg> element. This will output SVG 
instructions for the browser to draw the shape as a vector-based image. 
 
Select 'Publish as CSS3' to output the shape using CSS3 styling. This will output a standard <div> with 
CSS3 styling (border and background color). Note in this mode only rectangle, ellipse and rounded 
corner shapes are possible, because CSS does not support any other shape types! 
 
Known limitations:  
- This is a new technique and not all WYSIWYG Web Builder shape features are available yet, but we will 
continue to improve the software when browsers will catch up;) 
- Not all gradient effects are supported.  
- Text on shape is not supported.  
- Dotted and dashed border are not supported for <canvas>. 
- Shadow and other images effects are not supported. 

 
 
Add text to a Shape 
A useful feature is the ability to add formatted text to a shape. For example, to create logos or banners. 
Text can be aligned to any edge of the shape. The available space for text within the shape may vary 
depending on the type of shape you've selected. 
 

Note:  
Text will not be visible if the object is transparent! 

 

 
Rotation 
To rotate a shape: 

1. Select the Rotate tool on the Toolbox or click Edit -> Rotate. 
2. Click to select the object, hover over one of its handles until you see the rotate pointer.  
3. Hold the mouse button down and drag in the direction in which you want to rotate the object, 

then release. Use the Shift key for 15° rotation intervals. 
 
Notes: 

• Rotating large shapes can take a long time. 

• Rotating shapes may reduce the display quality of the object. 
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Morphing Shape 

Morphing Shape smoothly morphs two or more shapes to create amazing animations on your website. 
All built-in shapes, clipart and icon library are supported. You can even morph between icons of 
different libraries. Animations can be triggered automatically (slideshow), on hover, on scroll with 
anchors or based on the current scroll position (continuous). 
 

 
 
Morphing shape supports the same styling options as standard shapes, the output format is always SVG. 
 
You can select any of the available shapes or icons, but for the best results you should use shapes that 
look-a-like because the morphing process tries to map similar points to make the transition between 
shapes smoothly. There are no standard rules for what will work best, so you will have to try to find out 
what looks acceptable. 
 
Mode 
The mode property defines how the morphing shape will be rendered on the page. 
 

• animated 
The animation will play continuously. The shape will be rendered at its original position. 
 

• hover 
The animation will start when the user moves the mouse cursor over the shape. The shape will 
be rendered at its original position.  
 

• fixed 
The animation will play continuously. The shape will be rendered at a fixed position in the 
background. For example, in the center of the page. 
 

• scroll 
The animation will be triggered by anchors/bookmarks. For example, the shape can morph into 
another shape when an object scrolls into the viewport. For each shape you can define a 
different anchor. 
 

• scroll continuous 
The animation will be controlled by the position of the scrollbar. So, if you scroll down the 
page, the shape will gradually morph into the next one until the end of the page has been 
reached. 

 
 
Online tutorial: https://www.wysiwygwebbuilder.com/morphing_shape.html 
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Blog 

The word 'blog' is short for web log. A blog is a journal that's posted on the web for others to read.  
The Blog object provides an easy way to implement a blog on your website without special 
requirements on the web server. Unlike its name suggests, the Blog can be used for more than just a 
blog. It is also a quick way to display all kinds of data, such as a list or grid. 
 

 
  
Comment Text, each blog entry will have a link on the bottom to allow readers to send comments. The 
default text is 'Send Comments', but you can change this to anything you like. If you leave this field 
blank, no link will be displayed. Comment Email specifies the email address where the comments will be 
sent to. To add a new entry to your Blog, click the Add button. Give your blog entry a title and then type 
your blog's message in the text area. Optionally you can insert an image and a link to a related web 
page. 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/blog.html 
 
Order 
Specifies the order of the items on the page ('Ascending' or 'Descending'). 
 
Columns 
Specifies whether to display the blog items in columns. This option is responsive, so each breakpoint can 
have a different number of columns. 
 
Layout 
This controls the appearance of the blog items. More than 10 different layouts are currently available. 
You can also create your own layouts (with HTML/CSS templates). The templates are stored in the folder 
Documents\WYSIWYG Web Builder\system\blog\ 
 
Enable Responsive Fonts 
When this option is enabled, the text object can have different font sizes in breakpoints. This can be 
useful if you need a larger font for smaller screens. Each breakpoint can have a different text size. 
Note however that when this option is enabled, you can only use one font-family and font-size for the 
entire text object!   
  

RSS Feed 
Optionally you can generate an RSS Feed for this blog. The RSS Feed Properties are identical to those of 
the RSS Feed object. 
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Carousel 

The Carousel object (also known as horizontal sliding panels) displays images or any other objects by 
scrolling the content from right to left using a smooth sliding animation (with several optional easing 
effects).  Users can step to any specific panel on demand using the pagination icons or browse the 
carousel sequentially by using the back/next buttons. You can also think of the Carousel as a multiple 
layer slide show. It’s a very effective method to increase the web site usability and engage the user. You 
probably have seen this effect on many popular websites, such as Apple or Blackberry. 
 

 
 
When you first insert the Carousel to your page, you will see a blank area with two buttons and a 
pagination control. The buttons can be used to go to the next or previous panel. The pagination control 
displays a 'dot' for each page in the carousel. You can directly jump to a specific page by clicking the dot. 
 
Slides 
This will set the number of pages for the Carousel.  
 
Pause time 
Specify the number of milliseconds to pause before displaying the next panel in the sequence.  
 
Animation duration 
Specifies the duration of the slide animation in milliseconds. 
 
Easing 
You can select from more than 30 easing functions to control the animation process. This option can be 
used to (for example) create bounce or elastic effects. 
 
Enable navigation buttons 
Specifies whether to display the navigation buttons. 
 
Enable pagination 
Specifies whether to display the pagination controls. The pagination controls will be displayed on the 
bottom of the Carousel. The user can click the icons to quickly go to the specific panel. 
 
Online tutorials: 
https://www.wysiwygwebbuilder.com/carousel.html 
https://www.wysiwygwebbuilder.com/carousel3d.html 
https://www.wysiwygwebbuilder.com/carouselevents.html 
https://www.wysiwygwebbuilder.com/carousel_fullpage.html 
https://www.wysiwygwebbuilder.com/carouselwizard.html 
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Ferris Wheel 

The Ferris Wheel object is an interactive circular slider, inspired by the design of a Ferris wheel. Each 
item (gondola) on the wheel can display a different icon, and clicking on an item reveals more details 
(title, description, and URL) in the center of the wheel.  
 

 
 
This feature is ideal for highlighting services or specific sections on a website in an engaging manner. 
Additionally, it supports images, making it a versatile alternative to a traditional slideshow. 
 
Online tutorial: 
https://wysiwygwebbuilder.com/ferriswheel.html 
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Image Hotspots 

You can create an (client-side) image map that divides an image into different areas that each link to a 
different web page. Creating an image map is useful for images such as a floor, campus map or world 
map that you want to contain links to different pages. You can define each clickable area (hotspot) on 
the map using three shape values: rectangle, circle or polygon (irregular shape). To add images, use the 
Image map object. Drag the object to the page and a file dialog will pop up to select the image. Web 
Builder supports jpg, gif, bmp and png (XP only) files. 
 

 
 
Filename: enter the path and filename of the image/picture or select Browse to find an image on your 
local drive.  
 
Notes: 

1. This property specifies the location of the local image, when you publish the page, the image 
will automatically be copied to location as specified in Tools -> Options -> Publish -> Images Sub 
Folder. 
 

2. You can also specify absolute URLs like this 
https://www.paypalobjects.com/en_US/i/logo/paypal_logo.gif 
 

3. To make a (backup) copy of the images used in your page enable Tools -> Options -> Folders -> 
Make a copy of images to this folder when documents are saved. This will copy all images to 
the specified folder, so they are all stored in one place. It also prevents having duplicate image 
names on your web site.  

 
Online tutorial: 
https://www.wysiwygwebbuilder.com/imagehotspots.html 
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Stock Photo 
Browse thousands of free-to-use (* see license), high quality images from Unsplash or Pixabay directly 
within WYSIWYG Web Builder. 
 
Unsplash and Pixabay images can be inserted via the Insert Menu. The Stock Photo selection dialog 
supports search and the ability to set the desired size. There is also a dedicated Stock Photo browse 
button next to the standard image browse button. 
 
When you open the Stock Photo insert dialog, it will display a random selection of images.  
Enter one or more keywords in the 'Search field to display a custom selection. Each request will display 
40 images, click the 'More' button to show the next page. 
 
You can also limit the size of the image by specifying the width and height. When the specified size is 
different than the original aspect ratio then the image will be clipped. This makes it possible to create a 
square version of the image (eg 250x250). 
 
 

Notes:  
As specified in the Unplash guidelines (https://help.unsplash.com/api-guidelines/unsplash-api-
guidelines), images will be inserted as 'hot links'.  
So, the images are loaded from the Unsplash website, they are not uploaded to your website. 
 
By default, Unsplash requests will be made via WYSIWYG Web Builder's Unsplash account. The number 
of requests per hour is limited to 250 for each user. If need more than 250 requests then you can specify 
a (private) Access Key (in Tools -> Options), so the application will use your own Unsplash account 
instead. In that case, all requests will go directly to the Unsplash website instead of via WYSIWYG Web 
Builder's proxy. 
 
To get an Access Key, you will need to create a developer account on the Unsplash website: 
https://unsplash.com/oauth/applications 
 

 
 
Online tutorials: 
https://www.wysiwygwebbuilder.com/unsplash.html 
https://www.wysiwygwebbuilder.com/pixabay.html 
 
 
 
Disclaimer: 
WYSIWYG Web Web Builder uses the standard Unsplash/Pixabay API to get the information about the 
images from the Unsplash/Pixabay website. Like most third-party APIs, these APIs is regularly updated. 
This means that in the future this functionality may suddenly stop working. Of course, we will do our best 
to make sure the software is always up to date, so if Unsplash or Pixabay no longer works then please 
check the website for an update. 
 
 
* Unsplash license: 
https://unsplash.com/license 
 
* Pixabay license 
https://pixabay.com/service/license/ 
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Photo Gallery 

The Photo Gallery is a powerful tool to create amazing galleries. The gallery supports titles, descriptions, 
frames, lightboxes, polaroid mode and much more! Adding a gallery is very easy: just drag & drop the 
Photo Gallery object to the page, then double click it to add images. 
 

 
 
Source 
This option specifies where the images for the gallery are located. 

• Use Local images 
The images will be loaded from the local computer. 
 

• Get images from a folder on the server 
This loads the images form a folder on the server. This uses PHP so the file extension in Page 
Properties should be set to PHP and the page only works online! If the images have description 
meta data, then this will automatically be used for the title.  

 
Thumbnail title 
Enter the text that will be displayed under the thumbnail image. To enable titles, make sure you 
selected the 'Include title' option in the Text Page. 
 
Thumbnail size 
Specifies the size of the thumbnail images. Select 'Variable' to dynamically determine the thumbnail 
size. Select 'Responsive' to make the photo gallery responsive. When this option is selected the gallery 
can have a different number of columns in breakpoints! The images in the gallery will be responsively 
resized based on the available space. This means for example that when the gallery is inside a layout 
grid that it can be full width. 
 
Columns 
The number of images per row. 
 
Horizontal alignment 
Alignment of the thumb images. This option has no effect when the Maintain aspect ratio option is off. 
 
Vertical Alignment 
Alignment of the thumb images. This option has no effect when the Maintain aspect ratio option is off. 
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Filter 
This enables a filterable portfolio-style gallery of images.  
First, you will have to add labels via Filter -> Edit. After adding labels, you can select images and assign 
labels to images so users can choose which images will be displayed. The filter bar has many styling 
options and the transition between categories can be animated. 
 
Maintain aspect ratio 
Select this option if you want to maintain the aspect ratio of the image in the thumbnail. 
If this option is not selected the thumbnail will be resized to fit whole rectangle. 
 
Gallery Mode 
Specifies what happens if the user clicks on an image.  
 

• Open in the same browser window 
The larger version of the image will be displayed in the same browser window. 
 

• Open in a new browser window 
The larger version of the image will be displayed in a new browser window. 
 

• Open in a popup window 
The larger version of the image will be displayed in a popup browser window. The popup 
window will have the size of the full image. 
 

• Open in another window 
The larger version of the image will be displayed in another window. For example, in an inline 
frame. You can specify the name of the target window in the Name field. 
 

• Open in a jQuery Dialog 
The image will be displayed in a jQuery Dialog. Use the Settings button to modify the 
appearance of the dialog. 
 

• Light Box Gallery 
If you select this option then clicking on one of the images will start a lightbox slideshow. You 
can select one of built-in slideshows: slimbox, prettyphoto, fancybox. 
 
Additional galleries/lightbox plugins can be downloaded from the download section of the 
website: https://www.wysiwygwebbuilder.com/download.html 
 

• Use Links 
This option allows you to assign links to images, instead of opening the image. 
 
 

Generate thumbnail images 
By default, Web Builder will generate a preview window which displays the original images. 
If the size of these images is large it can take a long time before the page is loaded in the browser. 
Instead, you can enable Generate thumbnail images which will generate a smaller version 
of the images so the page will load faster.  
 
Prefix 
Prefix used for naming the thumbnail images. 
 
Include title 
Include the title of the image under the thumbnail. You can also change the font type, size, style and 
color of the title. 
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Frame 
Specifies which style of frame to use. The 'Default' type adds a simply frame where you can specify the 
width and color. WYSIWYG Web Builder includes a few predefined frame styles, but you can easily add 
your own styles. Copy your own styles (gif, jpg or png) to gallery folder, where each style has its own 
folder. My Documents\WYSIWYG Web Builder\system\gallery\yourstyle\ 
 
Frame Styles are made out of 8 images (note that you can also use the extensions jpg and png!):  
bottom.gif, bottomleft.gif, bottomright.gif, left.gif, right.gif, top.gif, topleft.gif, topright.gif 
 
 
Polaroid mode 
The Photo Gallery also has Polaroid mode' which uses CSS3 and has a few cool effects like rotated or 
variable sized polaroids. To enable Polaroid mode select (Polaroid) as the frame style. For the best effect 
set the frame width to 20 or more and use 'white' as the color. Also adding a little shadow give it a more 
realistic effect. 
 
Rotate polaroids will randomly rotate the images to simulate a photo stack. You can also give each 
photo a different size. 
 

 
 
For advanced users who want to have more control over the angles and individual scaling of the image: 
Hold down the SHIFT key while clicking the checkbox options. This will bring up a dialog where you can 
specify an array of angles or scales. If these values do not make sense to you then please don't edit 
them! 
 
Polaroids are draggable 
Adds the ability to reposition the Polaroids around the page. Just like ‘real’ Polaroids on a stack. 
 
Animate polaroids on page load 
Animates the Polaroids to a random position on the page. 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/photogallery.html 
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Photo Grid 

The photo grid makes it easy to create beautiful galleries, with just a few clicks. The photo grid can have 
mixed content, so it can contain both images and videos (mp4, youtube or vimeo).  
Clicking on a thumbnail will open a large version of the image/video in a lightbox / slideshow. You can 
select one of the 25 built-in layouts but also create your own custom layout. 
 

 
 
The Photo Grid also offers several unique layouts, often referred to as "split screens." These layouts 
enable you to display images in creative, non-traditional formats, such as dividing two images diagonally 
for a striking visual effect. 
 
Online tutorial: 
https://wysiwygwebbuilder.com/photogrid.html 
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Lightbox Gallery 

Lightbox Gallery provides an easy way to implement a fully featured lightbox with optional thumbnails, 
download buttons, rotation tools, autoplay, zoom, and more. It also supports video content, including 
YouTube, Vimeo, and MP4. 
The Gallery includes three display modes: thumbnails, justified, and carousel (inline), which determine 
how the gallery initially appears on the page. Clicking any image opens the lightbox viewer. 
 

 
 
Thumbnail 
In thumbnail mode, the gallery initially displays a grid of thumbnails, just like the Photo Gallery. You can 
adjust the spacing between images, add borders or image frames, and set the border radius. When you 
click an image, the Lightbox Gallery opens. 
 
Justified  
In Justified mode, thumbnails are automatically arranged in rows of equal height, adjusting their widths 
to create a clean, balanced gallery layout. The rest of the behavior is the same as for thumbnail mode. 
 
Carousel  
In Carousel mode, you can display an inline carousel slider. It offers the same features as the lightbox, 
but appears directly on the page rather than opening in a popup. 
 
 
Options 
The Lightbox Gallery offers many options to customize its appearance and functionality.  
For example, you can allow users to download images by enabling the download icon, add tools to 
rotate or flip images, and enable features such as zoom, maximize, or showing/hiding thumbnails. With 
autoplay enabled, the slideshow will advance automatically. 
 
You can also choose from more than 25 transition effects and customize the size, colors, and spacing of 
the thumbnails. 
 
Online Tutorial 
https://www.wysiwygwebbuilder.com/lightboxgallery.html 
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Ready to use Java Scripts 

This feature can be useful if you want to brighten up your web pages with some cool Java Scripts. Click 
'Insert JavaScript' and select one of the predefined scripts. Some of the scripts have properties to 
change the behavior of the script. To see the effect of the Java Script you will need to preview or publish 
the web page. 
 
There are many different types of scripts. For example, Text Effects, Background Effects, Social Media 
scripts (Facebook, SoundCloud, etc.), Google Maps, Redirect, Countdown, Date and Time, Typewriter 
and lots more! 
 
Notes:  

• These scripts were not created by WYSIWYG Web Builder. We’ve only made it easier to add the 
scripts to your website, so you do not have to copy/paste the code manually. Where possible 
the appropriate copyrights are displayed. 
 

• It is not recommended to use more than one Java Script per page.  
 
You can create add your own Java scripts using the JavaScript editor which is available in the download 
section of our website. 
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Rollover Image 
Rollover images change swap images on rolling over it (onMouseOver event) and reverts to the original 
image on rolling out of the object (onMouseOut event). 
 

 
 
Initial image 
Select the image that will be displayed initially. 
 
Mouseover image 
Select the image that will be displayed when the mouse is over the object. 
 
Description  
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the 
mouse over the image. 
 
Title 
In modern browsers this title appears as a ToolTip when you move the mouse over the image. 
 
Animation 
Specifies the animation effect for the rollover image: 

• None 

• Fade 

• Slide Left 

• Slide Right 

• Slide Up 

• Slide Down 

• Zoom 

• Scale uses CSS3 to display a larger version of the image. Uses transformation, CSS3 box shadow, 
a nice image caption when possible (experimental).  

• Sliding Door. This makes it looks like the image is split into half and one goes left, and the other 
one goes right.   

• Compare, can be used as a comparison slider to the images for comparing before and after 
images. For example, it could be used to compare images before and after compression or 
editing or to demonstrate the effect of a product or service etc.   

 
 
Online demo: 
https://www.wysiwygwebbuilder.com/support/wb16tryouts/wb16_rolloverimage.html 
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Rollover Text 
The RollOver Text object displays a text (title and description) banner over an image on mouse over. 
 

 
 
Filename 
Select the image that will be displayed initially. 
 
Title 
Title of image. 
 
Description 
Description of the image. 
 
Position 
Specifies the position of the text banner. 

• Top 
The banner will be displayed at the top of the image. 

• Bottom 
The banner will be displayed at the bottom of the image. 

• Full 
The banner will be displayed over the full size of the image. 

 
Animation 
Specifies the animation effect for the rollover text banner: 

• None 

• Fade 

• Slide Left 

• Slide Right 

• Slide Up 

• Slide Down 

• show always, when this option is selected, then the text will always be displayed. 

• hide on hover, when this option is selected, then the text will initially be displayed, but hides 
when the mouse hovers over the image (inverse rollover). 

 
 
Online demo: 
https://www.wysiwygwebbuilder.com/support/wb15tryouts/rollovertext.html 
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RSS Feed 
With the RSS Feed object, you can add a RSS Feed to your website in only a few mouse clicks! 
 
What does RSS mean? 
RSS stands for Really Simple Syndication and is used to describe the technology used in creating feeds. 
 
What is a feed (RSS)? 
Feeds, also known as RSS feeds, XML feeds, syndicated content, or web feeds, contain frequently 
updated content published by a website.  
They are usually used for news and blog websites but are also used for distributing other types of digital 
content, including pictures, audio files, or video.  
At its most basic, RSS generates a list of links to various resources on your site with a description of the 
content for each link. 
 
The contents of a RSS feed can be read in different ways. A variety of tools, both fee based and free, to 
read RSS feeds are available on the Internet. The latest browsers (Internet Explorer 7.0, Safari, FireFox 
2.0 and Opera) also have built-in RSS feed support. 
 
The RSS Feed extension lets you define a RSS channel with a set of headlines. When you publish the web 
page, which includes the RSS extension, a RSS (XML) file will be generated in the same folder as the 
HTML page. A small RSS icon will be displayed on your web page with a link to this file. Some browsers 
will display a special icon in the toolbar, which lets the users easily subscribe to your RSS channel. 
 
Title 
The name of the channel. It is how users refer to your service. If you have an HTML website that 
contains the same information as your RSS file, the title of your channel should be the same as the title 
of your website.  
 
Description 
Phrase or sentence describing the channel. 
 
URL 
The URL to the HTML website corresponds to the channel.  
For example: https://www.wysiwygwebbuilder.com 
 
Include publication date for headlines. 
The extension can automatically update the publication date of the headlines (based on the creation or 
modification timestamp). To include the publication date in the RSS feed, enable this option. If you leave 
this option off, the publication date will not be included. 
 
Filename 
The filename of the generated RSS xml file. By default, this file is named ‘rss.xml’, but you can rename it 
to anything you like. Common file extensions for feeds are .xml and .rss  
 
Logo 
Specifies which logo will be displayed on the webpage. 
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Add Headlines to the RSS feed 
Add  
Add a new headline.  
The Subject and Description should be written to describe the content. 
The Podcast property provides a way of attaching multimedia content to the RSS feeds, such as an MP3 
file.  The URL field should reference the webpage that contains that actual content. This can be an 
internal of external link. 
 
Edit  
Edit the selected headline. 
 
Remove  
Remove the selected headline. 
  
Optional 
Category, specify one or more categories that the channel belongs to.  
Example: Newspaper 
  
Copyright, Copyright notice for content in the channel.  
Example: Copyright 2025, Pablo Software Solutions 
 
Editor, Email address for person responsible for editorial content 
Example: yourname@yourwebsite.com (Your Name) 
 
Webmaster, Email address for person responsible for technical issues relating to channel 
Example: webmaster@yourwebsite.com (Web Master) 
 
Language, the language the channel is written in. This allows aggregators to group all Dutch language 
sites, for example, on a single page. 
  
Image, specifies a GIF, JPEG or PNG image that can be displayed with the channel. 
 
Refresh time, Specifies the number of minutes that indicates how long a channel can be cached before 
refreshing from the source. 
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News Feed Ticker 

The News Feed Ticker or Headline rotator displays RSS feeds (local or from another website), Twitter 
messages, Flickr images or other news sources on your website. You can also think of this object as a 
Slide Show for text with many different animations and display types like static, scroller, slideshow, 
paginate and ticker.  
 
Data source 
The news feed ticker supports many data source types. It uses jQuery to fetch the data. 
  

• User Defined 
This option allows you to specify the headlines manually.  
 

• RSS Feed 
Select this if the data source is a RSS feed. This can be a feed on your own website or an 
external website. Enter the location of the RSS feed in the URL field. For local feeds (like the 
one created with the RSS feed object), enter ./rss.xml  
For feeds from external websites you should enter the full URL: 
https://www.wysiwygwebbuilder.com/rss.xml 
 
To overcome security problems due to cross domain restrictions we've included several data 
retrieval options:  
Load data using a HTTP GET request 
Use this option for feeds retrieved from your own domain. This option uses AJAX 
(Asynchronous JavaScript and XML) to fetch the data and doesn't require PHP. However AJAX 
requests cannot be made to a different site than the one hosting the page being viewed. 
 
Load data through proxy  (this option requires PHP support on the server!) 
This option uses a PHP proxy script to fetch the data. This basically tricks the browser into 
thinking that the feed came from your own server. A PHP script will pull the content of the 
news feed to your server by using the PHP function file_get_contents() and then relay the data 
to the news feed ticker. This script will be automatically generated and uploaded by WYSIWYG 
Web Builder, so you do not have to worry about that.  
 
Load data through cURL (requires PHP) 
Some web-hosting providers may not allow the use of the PHP file_get_contents() function to 
fetch remote files because of security concerns. If your host supports cURL then this may be a 
good alternative. Consult the documentation of your host for more details. Note that here also 
the PHP script will be automatically generated and uploaded by WYSIWYG Web Builder.   
 

• Twitter 
Uses JSON to get the latest messages from a specific Twitter account.  
 

• Flickr 
Displays images based on the specified Flickr search query. Enter the Flickr search query in the 
Flickr Parameters field. For example: tags=vegas&tagmode=any, which will search for the latest 
images tagged with 'vegas'  
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• Facebook 
This option uses Facebook's Graph API to get status updates, photos and links from your 
Facebook account. To get data from the Graph API you need to enter your Facebook ID and an 
Access Token. You can read more about sharing Facebook data here: 
https://developers.facebook.com/docs/getting-started/graphapi/ 
 
 

Viewer type 
The viewer type specifies how the headlines will be displayed: 

• Default 
The items will be displayed as a static list. If the list is longer than the available space, scrollbars 
will be added. 
 

• Continuous Scroll 
The items will be scrolled like a (vertical) news feed ticker. The scroller will pause on mouse 
over. 
 

• SlideShow 
The items will flow into view one at a time, pause for a few seconds and then slide up to show 
the next item.  
The 'Pause for' property specifies the pause between the headlines in seconds. 
 

• Paginate 
Paginate displays a small subset of the item’s art any one time, while allowing the user to move 
through it with navigation buttons. The 'Item per page' property specifies how many items will 
be displayed per page. Click the Style button to change the appearance of the paginate buttons. 
 

• Ticker 
Uses ticker-like animations to fade and slide items into view. This effect is frequently used on 
new web sites.  

 
Max items 
Specifies the maximum number of items that will be retrieved from the data source. 
 
Sort order 
Specifies the order in which the items will be displayed. 
 
Speed 
Specifies the scroll speed of the text for Continuous Scroll mode. 
 
Animation 
Specifies the animation effect for the slide show mode: None, Fade, Slide Left, Slide Right , Slide Up or 
Slide Down  
 
Duration 
Specifies the duration of the animation. 
 
Link Target 
Specifies the target for links in the news feed ticker. For example: 
_blank,  opens the link in a new window 
_self,  open the link in the current frame 
_parent, open the link in the parent frame 
_top, loads the linked document in the topmost frame 
_lightbox, add a lightweight responsive, pure CSS (no JavaScript) and minimal lightbox to the image.  
This feature is available for Image, Picture, Photo Collage, Photo Gallery and Photo Grid. 
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Slide Show 

A powerful slideshow with many options and transition types: fade, slide, rotate, puff, and much more. 
 

 
 

• Sequence / Random 
The images will be rotated in sequence or random. 
https://www.wysiwygwebbuilder.com/support/slideshow/slideshow.html 
 

• Light Box Gallery 
Clicking the image will start a lightbox slideshow: slimbox, prettyphoto, fancybox etc.  
http://www.wysiwygwebbuilder.com/lightboxes.html 
 

• Conveyer Belt 
Create an image slideshow which scrolls the images from right to left like a "conveyor belt" 
https://www.wysiwygwebbuilder.com/support/slideshow/conveyerbelt.html 
 

• Carousel 
When this mode is selected multiple images can be displayed per slide. 
https://www.wysiwygwebbuilder.com/support/slideshow/image_carousel.html 
 

• Accordion 
Implements a horizontal image accordion, using CSS only. 
https://www.wysiwygwebbuilder.com/support/wb15tryouts/image-accordion.html 
 

• Ken Burns 
Display a slideshow of images with the Ken Burns effect. 
https://www.wysiwygwebbuilder.com/support/wb16tryouts/wb16_kenburns.html 
 

• Swiper 
Swiper is a modern mobile friendly slide (fade, slide, cube, coverflow, flip, cards, creative). 
https://www.wysiwygwebbuilder.com/support/wb19tryouts/wb19_swiper.html 
 

• Thumbnail Gallery 
A lightweight, responsive image slider accompanied by carousel-style thumbnail navigation. 
https://www.wysiwygwebbuilder.com/support/wb19tryouts/wb19_thumbnailgallery.html 
 
 

Related online tutorial: 
https://www.wysiwygwebbuilder.com/slideshow.html 
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Site Search 

 

 
 
WYSIWYG Web Builder has basic built-in 'search engine' functionality, so visitors can search for specific 
words within your website. The search option does not have any special server requirements because it 
uses JavaScript, so it's very easy to insert this component to your page(s). 
 

Note:  
Before you add this object to your page, make sure you have enabled 'Generate Search Index' in  
Menu -> Tools -> Search Index otherwise the search index will not be created, and the search will not 
work! 

` 
Place holder 
The hint (or 'cue') text will display inside the search field if it doesn't have the focus. When the user 
moves their focus to the field, the label will be hidden. 
 
No results 
Specifies the text that will be displayed if the search query has no results. 
 
Keywords 
The text for the Keyword label in the search results. 
 
Description 
The text for the Description label in the search results. 
 
Close button 
The text on the close button 
 
Padding 
Sets the amount of space between the results and the border. 
 
Display query time 
This displays the total time it took to execute the search query. 
 
Display URL 
Added option to include the URL in search results (Display URL).  
 
Display description 
Specifies whether to display the description in the search results. 
 
Display keywords 
Specifies whether to display the keywords in the search results. 
For performance reasons the keywords in the search results are the words from the search index, and 
not directly from the page content! Only unique words will be indexed. So, if a word is used multiple 
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times in the text, then it will only appear once in the keywords. 
 
Max length 
Set maximum number of characters to display in the results. The description text contains the context of 
the keyword within the text (Max. length). 
 
Results per page 
Adds pagination to the search results. 
 
Results 
The search results can be displayed on the page in several different ways: 
 

• Show results in a new Browser Window 
The results will be displayed in a new browser window. You can configure the properties of this 
windows via the 'Settings' button. 
 

• Show results in an Inline Frame 
The results will be displayed in an inline frame on the same page.  
Note that you will have to insert an inline frame object first before you select its name in the 
Frame property. 
 

• Show results in jQuery Dialog 
The results will be displayed in a jQuery Dialog. Use the Settings button to modify the 
appearance of the dialog. 
 

• Show results in another object. 
The results will the displayed inside another object (for instance a layer on the same page). It 
will replace the current content of that object. Make sure the overflow mode of that object is 
set to 'scroll' otherwise you may not see all results! 
 

• Show results in another page. 
You can use this option to display the results in another page. This can be useful if you want the 
results page to have the same design as the rest of your website. 

 
Auto Complete 
Enable auto complete 
The auto complete feature will allow users to type the beginning of a search term and be presented with 
all the possible terms that begin with the typed string (just like the Google Search engine). 
 
Mode 
Specifies what will happen when the user selects a word in the drop-down list. 

• select word 
This is the default behavior. When the user clicks a word in the drop-down list, then it will be 
copied to the search input field. 
 

• open page 
Clicking an item in the Autocomplete drop down list will immediately open the page. This 
makes it possible to implement a search field without a 'results' section. 
Note that when this mode is active, the results settings are ignored. 

 
Padding  
Set the spacing around the items in drop down list. 
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Structured Data 

Provide a better browsing experience for users on your website and in search engines and improve your 
SEO with the built-in JSON-LD generator (schema.org). 
 

 
 
The following schemes are currently supported: 

• Event 

• Music Album 

• Music Playlist 

• News Article 

• Organization 

• Person 

• Product 

• Recipe 

• Review 

• Restaurant 

• Software Application 

• Video Object 
 
Note that this is just a basic tool to help you quickly add structured data to your web pages. It does not 
validate the data you have entered! 
 
 
Online tutorial:  
https://www.wysiwygwebbuilder.com/structured_data.html 
 
 
The Google Structured Data Testing Tool can be used to validate the structure of data:  
https://search.google.com/structured-data/testing-tool/u/0/ 
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Timer 

The Timer object makes it possible to trigger actions based on timer events. For example, show or hide 
an object after x milliseconds. Timers can also start/stop other timers! All event actions are supported 
(animate, show/hide, rotate, media, JavaScript etc.).  

 
The Timer object supports the following types: 

• Interval 
Executes a function, repeatedly, at specified time intervals. 
 

• Timeout 
Executes a function, once, after waiting a specified number of milliseconds. 
 

• Visits 
This can be used to trigger a timer the after x visits. For example, to show an introduction 
dialog or a special offer for new visitors. It is also possible to use a negative number. In that 
case, the count will reset after X visits.  
 

• Days 
This can be used to trigger a timer the after x days. It is also possible to use a negative number. 
In that case, the timer will be reset for the next X days.  
 

• Date Range 
This can be used to trigger a timer for a specific date range. 
 

• Time Range 
This can be used to trigger a timer for a specific time range. 
 

• Day of the week 
Allows you to set timers that trigger based on specific days of the week. For instance, you can 
use this feature to redirect users to a different page on weekends (Saturday and Sunday). 
 

For visits, days, date range and time range, the state will be stored in local storage. If you want to reset 
the visit count state while testing, you can access this via the browser's debugger console (Application -> 
Local Storage) 
 
Interval 
Specifies the interval in milliseconds. 
 
Auto start 
Specifies whether to automatically start the timer. If this option is not enabled, you can start the timer 
through events (for example on click of a button). You can also stop the timer through events (Timer 
Stop).  
 

Events 
In Events you can configure what will happen when the timer expires. For example, you can display or 
hide an object, play a media file, animate something etc. For more information about events please read 
the chapter ‘Events’ of this document. 
 
Online tutorial: https://www.wysiwygwebbuilder.com/timers.html 
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Visibility 

Visibility is a utility for monitoring an element’s position within the viewport. The Visibility object 
provides a set of events that make it easy to trigger actions based on how an element enters or leaves 
the visible area of the screen. 
 
After dragging the Visibility object into the workspace, connect it to an element by selecting its ID from 
the Target Object dropdown. 
 
Offset 
Adjusts the element’s detected position by the specified number of pixels. Useful when content is 
positioned beneath fixed headers or other fixed elements. 
 
Trigger events once 
When set to false, events fire every time the element crosses the defined visibility threshold. 
(When true, events fire only the first time the threshold is met.) 
 
Trigger events continuously 
When set to true, events fire whenever the element meets a visibility condition, not only at the moment 
it first crosses the threshold. 
 
Check visibility on load 
Determines whether visibility conditions should be evaluated immediately when the page loads. 
 
Include margins in calculations 
Specifies whether the element’s margin should be included when calculating its visibility and position. 
 

Fixed Position 
Additionally, the Visibility object includes an option to fix an element’s position, so it remains visible in 
the viewport when it is about to scroll out of view. You can apply custom CSS to define how the element 
should appear in its fixed state. For example, repositioning it or applying alternative styles. 
 

Events 
Events can be used to build interactive experiences, such as showing or hiding elements, starting or 
stopping media playback, or applying dynamic style changes. The same actions are available as for 
standard events. 
 
onTopVisible 
Fires when the element’s top edge enters the viewport, crossing the bottom edge of the screen. 
 
onTopPassed 
Fires when the element’s top edge scrolls past the top of the viewport. 
 
onBottomVisible 
Fires when the element’s bottom edge enters the viewport, crossing the bottom edge of the screen. 
 
onBottomPassed 
Fires when the element’s bottom edge scrolls past the top of the viewport. 
 
onFixed 
Fires when the element is assigned a fixed position. 
 
onUnfixed 
Fires when the element’s fixed position is removed. 
 
Online tutorial: https://wysiwygwebbuilder.com/visibility.html  
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PayPal eCommerce Tools 
The PayPal eCommerce Tools are the quickest and easiest way to add eCommerce to your web site. You 
can easily create payment buttons and basic shopping cart functionality for your web site with only a 
few mouse clicks! Accept payments from anyone, all you need to set up a PayPal account is an email 
address! PayPal is one of the leading and more respected payment services on the Web. Best of all, it 
costs nothing to set up an account. 
  
Sign Up for a PayPal Account now: 
https://www.paypal.com/mrb/pal=6TUEY37GLM48U 
 
The following tools are available: 

• Buy Now Button 
Enable e-commerce on your website by letting customers quickly buy one item at a time. 

• Add to cart Button 
• View cart Button 

These buttons are part of PayPal's shopping cart solution. 
With the 'Add to cart' Button users can add one of more items to their shopping cart.  
The 'View Cart' button lets users check their cart whenever they'd like.  

• Subscription Button 
Useful for subscriptions and recurring payments. Accept recurring payments with flexible, 
automated billing. 

• Donation Button 
Accept credit card and bank account donations on your website or via email. 

 
 

Options  

You can attach 6 optional form controls so the buyer can select (for example) the size or color of a 
product. An option field can be either a ComboBox or an EditBox. 
The Label property can be used to assign a label to the option. If you leave this field empty, then the 
object's ID will be used. 
 
Step 1 
Insert a ComboBox or EditBox to the page. 
 
Step 2 
Select the ID of the object in the dropdown list above 
 
Notes:  
The selected options fields should not be part of another form. Web Builder will make sure they are 
attached to the PayPal button and rename the objects if necessary. 
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Buy Now Button 
When you use PayPal's Buy Now Buttons, you can sell individual items from your website.  
Buy Now Buttons is a low–cost way for you to accept bank account payments and can be fully integrated 
with your website in a few easy steps. 
 

 
 
General 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
Enable SandBox: PayPal provides a Sandbox to allow you to test your site without making payments. 
Uncheck this option when publishing the live version of your site! 
More information about the PayPal's sandbox: https://developer.paypal.com/ 
Target Window: Specifies the browser window where PayPal's website will be opened. Default: PayPal. 
Make this field empty if you want the PayPal website to open in the current window. 
 
Details 
Item name/service: Description of item. This field is optional. If omitted customers can enter an item 
name at time of purchase. 
Item ID/number: Pass-through variable for you to track purchases passed back to you at payment 
completion. This field is optional. If omitted no variable is passed back to you. 
Price: The price or amount of the purchase, not including shipping, handling, or tax. If omitted 
customers can enter an amount at time of purchase. 
Tax: Transaction-based tax override variable. Set this to a flat tax amount to apply to the transaction 
regardless of the buyer’s location. This value overrides any tax settings set in your Profile. 
Default: Profile tax settings (if any) apply. 
Currency: The currency of the payment. Defines the currency in which the monetary variables (amount, 
shipping, shipping2, handling, tax) are denoted. 
Allow customers to edit quantity: When this option is enabled it allows the buyer to specify the 
quantity. 
 
Shipping 
Base shipping: The cost of shipping this item if you have enabled item-specific shipping costs. This field 
is optional. 
Extra shipping: The cost of shipping each additional item. This field is optional. 
Handling costs: Handling charges. This is not quantity specific. The same handling cost is charged 
regardless of the number of items purchased. This field is optional. 
Require shipping information: Specifies whether to prompt the customer for a shipping address. 
Allow customer note: Specifies whether to prompt the customer to include a note with the payment. 
 
URLs 
Successful Payment URL: The URL to which the customer’s browser is returned after completing the 
payment; for example, a URL on your site that displays a “Thank you for your payment” page. If omitted 
the customer is taken to the PayPal website. 
Cancel Payment URL: A URL to which the customer’s browser is returned if payment is cancelled; for 
example, a URL on your website that displays a 
“Payment Canceled” page. If omitted the Browser is directed to the PayPal website. 
Buyer's Country: Defines the buyer’s language for the Login page only. 
  
More information: 
https://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/singleitem-intro-outside 
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PayPal Shopping Cart 
When you use PayPal's free Shopping Cart on your website, your customers can purchase multiple items 
with a single payment, browse your entire selection, and view a consolidated list of all their items before 
purchasing. The PayPal Shopping Cart is a low-cost way for you to accept credit card and bank account 
payments and can be fully integrated with your website in a few easy steps. When a buyer clicks the 
"Add to Cart" button, a new window will appear listing the contents of the buyer's PayPal Shopping Cart, 
including the item just added. To make the purchase, the buyer clicks "Checkout" from this window. 
 

Add to Cart Button 
The Add to Cart button can be used to add an item to the shopping cart. 
 
General 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
Enable SandBox: PayPal provides a Sandbox to allow you to test your site without making payments. 
Uncheck this option when publishing the live version of your site! 
More information about the PayPal's sandbox: https://developer.paypal.com/ 
Target Window: Specifies the browser window where PayPal's website will be opened. Default: PayPal. 
Make this field empty if you want the PayPal website to open in the current window. 
 
Details 
Item name/service: Description of item. This field is optional. If omitted customers can enter an item 
name at time of purchase. 
Item ID/number: Pass-through variable for you to track purchases passed back to you at payment 
completion. This field is optional. If omitted no variable is passed back to you. 
Price: The price or amount of the purchase, not including shipping, handling, or tax. If omitted 
customers can enter an amount at time of purchase. 
Tax: Transaction-based tax override variable. Set this to a flat tax amount to apply to the transaction 
regardless of the buyer’s location. This value overrides any tax settings set in your Profile. 
Default: Profile tax settings (if any) apply. 
Currency: The currency of the payment. Defines the currency in which the monetary variables (amount, 
shipping, shipping2, handling, tax) are denoted. 
Allow customers to edit quantity:  Allows the buyer to specify the quantity. 
 
URLs 
Successful Payment URL: The URL to which the customer’s browser is returned after completing the 
payment; for example, a URL on your site that displays a “Thank you for your payment” page. If omitted 
the customer is taken to the PayPal website. 
Cancel Payment URL: A URL to which the customer’s browser is returned if payment is cancelled; for 
example, a URL on your website that displays a “Payment Canceled” page. If omitted the Browser is 
directed to the PayPal website. 
 Buyer's Country: Defines the buyer’s language for the Login page only. 
 

View Cart Button 
The View Cart button can be used to view the contents of the shopping cart. 
 
General 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
 
More information: 
https://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/sc-intro-outside 
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Subscription Button 
When you use PayPal Subscriptions and Recurring Payments, your customers can purchase 
automatically recurring subscriptions from your website. 
Subscriptions and Recurring Payments is a low-cost way for you to accept credit card and bank account 
payments for content site subscriptions, newsletter fees, club dues, or recurring donations, and can be 
fully integrated with your website in a few easy steps. Subscriptions and Recurring Payments are only 
available for Business or Premier accounts. 
 
General 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
Enable SandBox: PayPal provides a Sandbox to allow you to test your site without making payments. 
Uncheck this option when publishing the live version of your site! 
More information about the PayPal's sandbox: https://developer.paypal.com/ 
Target Window: Specifies the browser window where PayPal's website will be opened. Default: PayPal. 
Make this field empty if you want the PayPal website to open in the current window. 
 
Details 
Subscription name: Enter the name of the subscription you wish to sell in the Subscription name field. If 
you do not enter anything in this field, your customers can complete it.  
Reference Item Number: If you have an ID or tracking number for your item, enter it in the Reference 
Item Number field. This field will not be displayed to your customers at the time of payment, but they 
will see it in their transaction details on the PayPal website. 
Currency: Choose the currency in which you would like this payment to be denominated. This field will 
default to the currency of your primary balance. 
Bill the subscriber for: Enter your regular subscription rate. 
Length of each billing cycle: Specifies the regular billing cycle. 
Would you like to stop the recurring payments after a certain number? 
Enable this option if you would like to end your customers’ subscriptions after a certain number of 
payments at your regular rates. This means that once a customer has made the specified number of 
payments at your regular rate, his subscription will be completed. If you disable this option for your 
customers’ subscriptions will continue unless it is cancelled manually or by payment failure. 
Trial periods (optional) 
You may enter a trial period and rates for your subscription. To create a free trial 
period, enter an amount of 0. Trial periods can be entered as a number of days, weeks, months, or 
years. 
Reattempt on Failure 
Enable this option if you would like PayPal to automatically reattempt failed 
payments. Payments will be reattempted three days after the failure date. After a second failure, PayPal 
will try once more five days later. A third failure will lead to an automatic cancellation of the 
subscription. 
Payments made with bank accounts are automatically reattempted once, three days after PayPal 
notifies the user that the payment failed. If you select No, failed payments will result in the automatic 
cancellation of the subscription. 
Require shipping information: Specifies whether to prompt the customer for a shipping address. 
 
More information: 
https://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/subscr-intro-outside 
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Donation Button 
Collect donations from a button on your website. 
PayPal Donations is a low-cost way for you to accept credit card and bank account donations. Integrate 
PayPal Donations with your website in a few easy steps. 
 
General 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
Enable SandBox: PayPal provides a Sandbox to allow you to test your site without making payments. 
Uncheck this option when publishing the live version of your site! 
More information about the PayPal's sandbox: https://developer.paypal.com/ 
Target Window: Specifies the browser window where PayPal's website will be opened. Default: PayPal. 
Make this field empty if you want the PayPal website to open in the current window. 
 
Details 
Donation name/service: Enter a description for the donation. If you do not enter anything in this field, 
your customers can complete it.  
Donation ID/number: If you have an ID or tracking number for your item, enter it in the Donation 
ID/number field. This field will not be displayed to your customers at the time of the donation, but they 
will see it in their transaction details on the PayPal website. 
Currency: Choose the currency in which you would like this payment to be denominated. This field will 
default to the currency of your primary balance. 
Require shipping information: Specifies whether to prompt the customer for a shipping address. 
Allow customer note: Specifies whether to prompt the customer to include a note with the payment. 
 
URLs 
Successful Payment URL: The URL to which the customer’s browser is returned after completing the 
payment; for example, a URL on your site that displays a “Thank you for your payment” page. If omitted 
the customer is taken to the PayPal website. 
Cancel Payment URL: A URL to which the customer’s browser is returned if payment is cancelled; for 
example, a URL on your website that displays a 
“Payment Canceled” page. If omitted the Browser is directed to the PayPal website. 
Buyer's Country: Defines the buyer’s language for the Login page only. 
 
More information: 
https://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/donate-intro-outside 
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Shopping Cart 
The Shopping Cart works in combination with the standard PayPal buttons from the Toolbox (Add to 
Cart and View Cart). But instead of redirecting the users to the PayPal website, the shopping cart will 
keep the users on your website until they checkout. The Shopping Cart will show an icon on the website 
with a badge indicating the number of items in the cart. Clicking the icon will display a popup with the 
contents of the cart and a checkout button. 
 

 
 

 
 
Note: 
While the Shopping Cart is works in combination with the PayPal Buttons, you are not limited to PayPal 
as the only checkout option. The Shopping Cart also supports additional payment gateways, including 
Stripe, Paddle, and Snipcart. You can even implement your own custom checkout script! 
 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/paypal_shoppingcart.html 
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Vibracart Pro 
Vibracart Pro is a third-party Ecommerce solution. It supports digital (downloads) and physical products.  
PayPal and / or Stripe are supported for checkout. It has support for coupons, discounts, multiple 
shipping plans, VAT and a lot of other options.  
 

 
 
Vibracart Pro is a self-hosted, which means that the cart runs on your own website. So, you will need to 
install the product on the server before you can use it. 
 

Note:  
Vibracart Pro is a third-party product. This product is not included with WYSIWYG Web Builder. 
Vibracart Pro can be purchased separately via: https://www.vibralogix.com/vibracartpro 

 
Online tutorial: 
https://www.wysiwygwebbuilder.com/vibracartpro.html 
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Ecwid Shopping Cart  
With the Ecwid Shopping Cart object you can easily integrate the Ecwid Ecommerce platform into your 
WYSIWYG Web Builder website. Ecwid is an awesome e-commerce software platform that allows you to 
add shopping cart functionality to any current site and get a mobile and Facebook store in one package.   
Ecwid Shopping Cart is a hosted Ecommerce solution. This means that the cart runs on the Ecwid 
website. So, you do not have to install anything on your own server. Creating a basic account is free. 
Upgrade options available for advanced functionality (discount coupons, product downloads, Enhanced 
SEO capabilities and much more). 
 
All functionality is based on standard Ecwid scripts, so your web shop will run on the Ecwid servers. You 
can setup products (like name, description, categories pricing, styling) via the Ecwid dashboard. 
The following Ecwid widgets are supported: 
 
ECWID - Search Box 
Search for products. The results will be displayed inside the Product Browser widget. 
 
ECWID - Product Browser  
This is the main container, and it is mandatory; this will contain your products, categories, search 
results, the checkout options etc. 
 
ECWID - Shopping Bag 
This widget contains the Shopping Bag; when viewing products, you can Drag & Drop them to the 
shopping your basket. 
 
ECWID - Category Browser  
Display a list of categories. This controls the content of the Product Browser widget. 
 
ECWID - Single Product 
This makes it possible to display a single product. This can be used instead of the Product Browser 
widget. 
 
Note: for performance and security reasons the workspace does not display a live preview of the web 
shop. The workspace will display a place holder. So, you will have to preview or publish the page to see 
the result.  
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/ecwid_shoppingcart.html 
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PHP Login Tools 
 

Important Note:  
The login tools are a set of advanced PHP forms and scripts. Please take your time to become familiar 
with tools. First read all available documentation and study the demo template before using them in 
your own project. 

 
Web Builder has a complete built-in (PHP) login system to password protect one or more pages. 
 

Key features: 
• Protect a page simply by dragging the Protect Page object to the page.  

• Login and Logout forms.  

• An Administrator section to add, edit or remove user accounts.  

• A Signup form to allow users to sign up for an account.  

• A Change Password form so users can change their password.  

• A Password Recovery form, to reset the user's password.  

• Custom profile fields. 

• Supports both MySQL and a plain text database.   

• No custom coding needed; everything is 'drag & drop'!  
 

Requirements: 
• The login tools require a web server with PHP support, so the first step to start using the login 

tools of WYSIWYG Web Builder is to check whether your web host supports PHP! 

• The extension of the page should be set the ‘php’, otherwise the web server cannot run the 
script. 

 
Convert to Form 
All login forms include an option to convert the predefined/fixed form to a standard form (right click on 
the login form to display the context menu). This allows you to convert the static form into native Web 
builder objects so you can fully customize the layout and code if you like. 
Note that customizing the PHP code requires knowledge of PHP. Making changes to the code without 
knowing what you're doing will result in undefined behavior! 
 

Demo Template 

A fully functional example template is included in the 'Demo' category of the standard Templates. 
This template demonstrates how to use the Login tools of WYSIWYG Web Builder. 
 
Please first take your time to study the demo template before including the login tools in your own 
project. The most common reason for the login tools not to work on a website is due to configuration 
mistakes of the user! 
 
To open the demo template: 
1. Select Menu -> New Website from Template 
2. Select the 'Demo' category 
3. Click 'Login' and then press the OK button. 
4. Save the newly generated project to a folder of your choice. 
 
Start by reading the information on the 'Getting started' page in template. 
To test the completely working example you must publish all pages to a web server with PHP support. 
Also, don't forget to create the user database first!!! 
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User database 
The login tools use a database file on the server to store the user information. The data will be stored in 
a semicolon separated text file or in a MySQL table. The passwords will be hashed using md5 so they will 
be securely saved. 
  
The following login tools will use this database file: 

• Admin  

• Change Password  

• Login  

• Password Recovery  

• Signup  

• Edit Profile 
 

Tip:  
You should set the same database name for all login tools! 

 
 
How do I automatically create a user database on the server? 
All objects mentioned above do have a button in their properties window called 'Create database'. 
 
1. Click the 'Create database'  
2. Enter a name for the database, for example 'usersdb.php'. Click Next.  
3. Select the publish location where you are going to publish this website to. Click Next. 
 

Note: 
If you do not see any publish locations, then you should add them first in the Publish window! 

 
4. The wizard will make a connection with the server and show the folder structure.  
5. Select the folder where the database should be created.  
6. Click 'Finish' to create the file. 
WYSIWYG Web Builder will automatically change the permission of the file so that it's write enabled, so 
new users can be added.  
 
How do I manually create a user database on the server? 
A user database is basically just a text file on the server. So, if for whatever reason the instructions 
above fail, you can try to upload the file manually yourself. 

1. Open notepad or any other plain text editor and create an empty file named 'usersdb.php'. 
2. Upload the file to the same folder as your protected pages. To upload the file, you can use then 

built-in FTP tool or any other FTP application. 
3. After the file has been uploaded you must modify the permissions so that the PHP script can 

write data to it. The correct permissions are 757 or 777. 
4. Alternatively, you can use the file transfer tool of your host's control panel. There should be an 

option in your web hosting control panel to set write permissions. If it's not present, you may 
contact your web hosting service and request the write permissions for the file. 

 
How do I prevent that user can view or download the user database from the server? 
By default, the user database of the login tools can be accessed by anyone that knows the file name. 
And although the passwords are encoded the email addresses are not hidden.  
 
So, the first thing you should do is to make sure you give the user database a unique name that cannot 
easily be guessed. For example: A6gr8JDaTa.php 
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To make the user database completely inaccessible you can create a .htaccess file in the folder on the 
server with the following content:  
 
<Files "usersdb.php">  

Order deny,allow  

Allow from xxx.xxx.xxx.xxx  

Deny from all  

</Files>  

 
where usersdb.php is the name of the database and xxx.xxx.xxx.xxx is your IP address.  
 
See also:  
https://www.javascriptkit.com/howto/htaccess.shtml 
 
 
Using a MySQL database to store the user information (for advanced users only!) 
As alternative for the plain text user database you can also choose to store the users in a MySQL 
database. Each object has a special MySQL Database category, where you can configure the properties 
of the MySQL database. Before you can use this option, you must create the table on the server. 
Log in to your MySQL administrator utility. Create the USERS table using this SQL query: 
 
CREATE TABLE `USERS` ( 

  `id` int(10) NOT NULL auto_increment, 

  `username` varchar(50) NOT NULL, 

  `fullname` varchar(75) NOT NULL, 

  `password` varchar(50) NOT NULL, 

  `email` varchar(75) NOT NULL, 

  `active` tinyint(1) NOT NULL, 

  `code` varchar(75), 

  `role` varchar(50), 

  `avatar` varchar(50), 

  PRIMARY KEY  (`id`)); 

 
If you have added custom profile fields to any (or all) of the login objects, then you must also create 
these fields in the database. Custom profile fields must be named extra1, extra2, extra3 etc! 
The following SQL query generates a table with 5 extra custom profile fields: 
 
CREATE TABLE `USERS` ( 

  `id` int(10) NOT NULL auto_increment, 

  `username` varchar(50) NOT NULL, 

  `fullname` varchar(75) NOT NULL, 

  `password` varchar(50) NOT NULL, 

  `email` varchar(75) NOT NULL, 

  `active` tinyint(1) NOT NULL, 

  `code` varchar(75), 

  `role` varchar(50), 

  `avatar` varchar(50), 

  `extra1` varchar(100), 

  `extra2` varchar(100), 

  `extra3` varchar(100), 

  `extra4` varchar(100), 

  `extra5` varchar(100), 

  PRIMARY KEY  (`id`) 

);; 
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Login Admin 
The Administrator object allows you to add, edit or remove users from the user database online. 
To enable scrolling for a large list of users, the administrator form will be displayed inside an inline 
frame. 
 

 
  
Admin Password 
Specifies the administrator's password. 
 
Avatar folder 
Specifies the folder where avatar images for users will be stored. 
Note that this folder should exist on the server and must be writable! 
 
Custom Profile Fields 
This option can be used to add additional fields to the signup form. New fields can be of type' text' or 
'option'. A text field adds a standard editbox, while the option fields add a combo box to give the user 
multiple choices. You can also mark a field as 'Required'. 
 
Enable Avatars 
Adds the ability to set an avatar image. The image can be displayed on the page with the "Login Name' 
object. 
 
Enable Error Reporting 
If you enable this option, the script will activate detailed PHP error reporting. This may be helpful if you 
are experiencing problems with the login scripts on the server. If PHP Error Reporting is enabled more 
details about the error will be displayed. 
 
Items per page 
Specifies how many users will be displayed per page. This enables pagination navigation. 
 
Session timeout 
The administrator will be logged out automatically if the session is idle (based on the specified timeout). 
 
User Roles 
User’s roles are used to create different types of users. These users will only have access to the pages 
that have configured this role. 
 
Hash Algorithm 
This adds support for improved password hashing use bcrypt (as alternative for md5). Passwords will be 
upgraded automatically when the user logs in. Note that you may need to increase the length of the 
database field (to 127 or 255). 
 
Database Type 
Specifies the database format that will be used for the login tools. 
The default database format is flat text file. This file must be created on the server. See User Database 
for more details. As alternative for the plain text user database, you can also choose to store the users in 
a MySQL database. This requires you to create a new table on the MySQL Server. See User Database for 
more details. 
 



WYSIWYG Web Builder 21   

230 

Change Password  
The Change Password object allows users to change their password. The user must be logged in to be 
able to change the password. 
 

 
 
 
Layout 

• Fixed 
All form input fields will have a fixed size. This is the layout as used in previous versions of the 
software. 

• Responsive 
In this mode form input fields have 100% width (instead of a fixed size), so the form can have a 
different size in breakpoints. 

 
Title Text 
Specifies the text shown for the title. 
 
Database 
Specifies the user database. This value will be ignored if you are using MySQL! 
 
Destination Page 
Specifies the page that the user is directed to upon successful login. 
 
MySQL Database 
As an alternative for the plain text user database, you can also choose to store the users in a MySQL 
database. This requires you to create a new table on the MySQL Server. See User Database for more 
details. 
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Login  
The Login object provides a standard form to login to the protected pages. 
 

 
 
Password Label 
Specifies the text that identifies the password text box. 
 
Remember Me 
Specifies the text to be shown for the remember me checkbox. 
 
Layout 

• Fixed 
All form input fields will have a fixed size. This is the layout as used in previous versions of the 
software. 

• Responsive 
In this mode form input fields have 100% width (instead of a fixed size), so the form can have a 
different size in breakpoints. 

 
Title Text 
Specifies the text shown for the title. 
 
Database 
Specifies the user database. This value will be ignored if you are using MySQL! 
 
Destination Page 
Specifies the page that the user is directed to upon successful login. 
 
Redirect to previous page 
After a successful login, the user will be redirected to the previous page. This is the page that triggered 
login page (stored in PHP's $_SESSION['referrer']). 
 
Error Page 
Specifies the page that the user is directed to upon failed login. 
 
Display Remember Me 
True if the remember me checkbox is displayed. 



WYSIWYG Web Builder 21   

232 

Logout 
The Logout object gives the user the option to logout. 
 

 
 
Logout Page 
Specifies the page that the user is directed to upon log out. 
 
 
 

Delete Account 
Users can delete their account, which is alternatively known as "unsubscribe" or "opt-out." To initiate 
the account deletion process, the user must be logged in. 
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Password Recovery 
The Password Recovery object allows users to reset their password. An email message will be sent with 
the new (random) password. If the user wants to change the password, he can use the Change Password 
form. 
 

 
 
Layout 

• Fixed 
All form input fields will have a fixed size. This is the layout as used in previous versions of the 
software. 

• Responsive 
In this mode form input fields have 100% width (instead of a fixed size), so the form can have a 
different size in breakpoints. 

 
Title Text 
Specifies the text shown for the title. 
 
Email Label 
Specifies the text that identifies the username textbox. 
 
Database 
Specifies the user database. This value will be ignored if you are using MySQL! 
 
Success Page 
Specifies the page that the user is directed to after the action has succeeded. 
 
Email From 
Specify the ‘from’ email address. 
 
Email Message 
Specifies the email message. 
 
Email Subject 
Specifies the email subject. 
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Protected Page 
To protect any page from your website, simply drag & drop the 'Protected Page' object to the page.  
If the user is not logged in, he will be redirected to the 'Access Denied Page'. 
 

 
 
Access Denied Page 
Specifies the page that the user is directed to if not logged on. 
 
Allow Users 
Specifies the users who can access the page. You can enter a list of comma-delimited users: Bill, Steve, 
Gary. 
If you leave this property empty, then all registered users can access the page. 
 
User Roles 
User’s roles are used to create different types of users. These users will only have access to the pages 
that have configured this role.  
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Protected Content 
WYSIWYG Web Builder has supported protected pages for a long time. However, sometimes you do not 
want to 'protect' the entire page, but just a small section of a page. With Protected Content it is possible 
to show/hide elements based on the login status of users.  
 

 
 
The available options are:  
 

• show for all users 
Show the content for all users. This works the same as when no login tools are used. 
 

• show for login in users only 
Only users who are logged in can see the content.  
 

• show for logged out users only 
Only users who are logged out will see the content.  
 

• show for specific user groups (user roles). 
Only users who are logged in with the specified user roles can see the content. This option 
works together with the login tools and the page extension must be set to PHP! 
 

For example, you can show a login button for users that are not logged in and a logout button for logged 
in users.  
 
Online tutorial: 
https://wysiwygwebbuilder.com/protected_content.html 
 
 

Protected Menu Items 
Protected Menu Items makes it possible to show/hide menus items based on the login status (logged in, 
logged out, group/user role). 
The options are the same as for Protected Content.  
 
This feature is available for: Breadcrumb, CSS Menu, Dropdown Menu, Go Menu, Mega Menu, 
Menubar, Overlay Menu, Pagination, Panel Menu, Responsive Menu, Slide Menu, Tab menu and Text 
menu. 
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Signup  
The Signup object allows users to sign up for a new user account. The new account will be created 
immediately after the user has completed the form. An email message will be sent to the specified email 
address with the login details. 
 

 
 
Note that anyone can create an account, so use this object only for public pages! 
 
Captcha Enabled 
Specifies whether CAPTCHA should be enabled.  
 
Layout 

• Fixed 
All form input fields will have a fixed size. This is the layout as used in previous versions of the 
software. 

• Responsive 
In this mode form input fields have 100% width (instead of a fixed size), so the form can have a 
different size in breakpoints. 

 
Title Text 
Specifies the text shown for the title. 
 
Account activation 
Specifies whether to enable account activation by the administrator. If this option is 'Administrator', 
new accounts will not be activated until the administrator enables them. 
If this option is "Automatic' then the account will be enabled immediately after the user has completed 
the form. If the ‘Email’ verification option is selected, then the user must activate the account via a link 
in the confirmation email before it will be activated. This makes sure the specified email is valid. 
 

Tip: 
If you enable email verification then you probably want to include some instructions in the email 
message to tell the user to use the activation link in the message to activate the account! 
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Custom Profile Fields 
This option can be used to add additional fields to the signup form. 
New fields can be of type' text' or 'option'. A text field adds a standard editbox, while the option fields 
add a combobox to give the user multiple choices. You can also mark a field as 'Required'. 
 
The 'Apply to All' button can be used to apply the custom profile fields to all Login tools within the 
project, so you do not have to manually synchronize them. 
 

Important Notes: 
All login tool objects in the project should have the same custom profile fields!  
When adding custom profile fields and you use a MySQL database then you must also add these fields to 
the database!  

   
Database 
Specifies the user database. This value will be ignored if you are using MySQL! 
 
Success Page 
Specifies the page that the user is directed to after the action has succeeded. 
 
Verificated Page 
Specifies the page that the user is directed to after email verification. This value will only be used if 
Account activation is set to 'Email'! 
 
Enable Avatars 
Adds the ability for the user to set an avatar image. The image can be displayed on the page with the 
"Login Name' object. 
 

Email  
Admin Email Address 
Specifies the email address of the administrator. This can be left empty. 
A copy of the signup confirmation email will be sent to this address. 
 
Email From 
Specify the ‘from’ email address. 
  
Email Message 
Specifies the email message. 
 
Email Subject 
Specifies the email subject. 
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Edit Profile 
The Edit Profile object allows a user to edit his/her account settings. The user must be logged on to be 
able to access the profile. 
 
This object is very similar to the Sign-Up object and most properties are the same. 
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Social Login  
A trend in many of today’s websites is a feature that allows users to sign in via their social network 
accounts. For example, some websites have the option to use their Facebook, Twitter, Google or 
Instagram account to log in without having to register an account. 
 

 
 
With "Social Login", users can sign-on to password protected pages using existing information from a 
social networking service. 
When the user clicks the login button they will be redirected to the website of the provider (Facebook, 
Twitter etc.). Here they are asked to authorize the website.  After a successful login the user will be 
redirected back to your website. 
 
WYSIWYG Web Builder can store the information about the user in a database such as email, name, 
website etc. Note however that not all providers (like Twitter) do return an email address, but they all 
include a identification number. 
 
Besides standard information like email and name, you can also store other information specific to each 
social provider. For example, for Facebook you can store the user's Facebook page or avatar. 
 
Online tutorial: https://www.wysiwygwebbuilder.com/social_login.html 
 
Button Text 
Specifies the text to be shown for the button. 
 
Destination Page 
Specifies the page that the user is directed to upon successful login. 
 
Enable Error Reporting 
If you enable this option, the script will activate detailed PHP error reporting. This may be helpful is you 
are experiencing problems with the login scripts on the server. If PHP Error Reporting is enabled more 
details about the error will be displayed. 
 
Error Page 
Specifies the page that the user is directed to upon failed login. 
 
Key 
Specifies the application consumer key or application id. 
 
Secret 
Specifies the application consumer secret. 
 
Provider 
Specifies the social network to use for the sign in. 
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User Role 
Specifies the role for users signed in via a social network. 
This makes it possible to restrict access to specific pages only. For example, by adding a 'sociallogin' role. 
 
 

Notes: 
User roles can be configured in the Login Admin object. 
In the 'Protected Page' object you can select which user roles have access to the page.    

 
 
Database 
The Social Login object can store data from social networks in a MySQL database. 
The of the table should have the following structure: 
 
CREATE TABLE `USERS` ( 

  `id` int(10) NOT NULL, 

  `username` varchar(50) NOT NULL, 

  `fullname` varchar(75) NOT NULL, 

  `password` varchar(50) NOT NULL, 

  `email` varchar(75) NOT NULL, 

  `active` tinyint(1) NOT NULL, 

  `code` varchar(75) NOT NULL, 

  `avatar` varchar(128) NOT NULL, 

  `role` varchar(16) NOT NULL, 

  `provider_name` varchar(25) NOT NULL, 

  `provider_uid` varchar(255) NOT NULL 

) 

 
Note that this is the same structure as the Login tools, but we have added 2 extra fields to store 
information about the social networks: 'provider_name' and 'provider_uid'. These are used to store the 
name of the provider (e.g. Facebook, Twitter) and a unique identification number. 
 
If you would like to store more data, then you can also add extra fields. For example, profileURL, 
`photoURL etc. 
 
CREATE TABLE `USERS` ( 

  `id` int(10) NOT NULL, 

  `username` varchar(50) NOT NULL, 

  `fullname` varchar(75) NOT NULL, 

  `password` varchar(50) NOT NULL, 

  `email` varchar(75) NOT NULL, 

  `active` tinyint(1) NOT NULL, 

  `code` varchar(75) NOT NULL, 

  `avatar` varchar(128) NOT NULL, 

  `role` varchar(16) NOT NULL, 

  `provider_name` varchar(25) NOT NULL, 

  `provider_uid` varchar(255) NOT NULL, 

  `profileURL` varchar(255) NOT NULL, 

  `photoURL` varchar(255) NOT NULL 

) 

 
A complete list of the available fields can be found here: 
https://hybridauth.github.io/hybridauth/userguide/Profile_Data_User_Profile.html 
 
Note: you will also need to configure these fields in the 'Custom profile fields' property! 
 
Custom Profile Fields 
This is a list of commas separated values to control which extra fields should be stored in the MySQL 
database. For example, profileURL, photoURL 
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Email 
When a new account successfully has been created an email can be sent to the administrator of the 
website.  
 
Admin Email Address 
Specifies the email address of the administrator. This can be left empty; in which case no email will be 
sent. 
 
From 
Specify the from email address. 
 
Message 
Specifies the email message. 
 
Subject 
Specifies the email subject. 
 
Note: When the web host does not support standard PHP mail, or you need SMTP authentication then 
PHP Mailer is available for advanced mail server configuration. 
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Content Management System  
 

Important Note:  
The Content Management System tools are a set of advanced PHP forms and scripts. Please take your 
time to become familiar with tools. First read all available documentation and study the demo template 
before you start using them in your own project! 

 
WYSIWYG Web Builder has a complete built-in (PHP based) content management system to allow you or 
your customers to manage content online. The basic idea is that the content of the page will be 
displayed inside a fixed area on the page, this is the CMS View. You can think of this as an inline frame or 
content place holder, although the content will be dynamically merge with the rest of the page when 
the page is requested from the server. Basically, this means that you can have only one page for the 
whole website and the rest of the content is managed on the server. Although you can mix dynamic and 
fixed content! The layout of the page (also called the master border) can be designed with the standard 
WYSIWYG Web Builder tools. The navigation (CMS Menu) will be automatically generated based on the 
site structure on the server, so you don't have to fill the menus manually. 
 

Note: 
It's important to understand that this Content Management System is not a replacement for online 
solutions like Joomla, Drupal or WordPress. The CMS was designed as a supplement, not a replacement 
for WYSIWYG Web Builder websites. So, you will create the layout in the software and the content 
online. Also a CMS is not an online HTML editor. You do not edit the entire page, only the content area! 

 
Key features: 

• Online administrator panel to add/edit/copy and remove pages.  

• The administrator panel supports several popular editors like CKEditor, TinyMCE and CLEditor. 
It also has a simple built-in editor.  

• You can hide pages from the menu structure which is currently under construction.  

• CMS has several individual 'design blocks' to give you as much flexibly as possible, so you can 
easily integrate the tools into your existing layouts.  

• A CMS View object, which is a place holder for the online content.  

• A CMS Menu object, which can be used to navigate between online pages. The menu has many 
customizable options.  

• A CMS search object, which can be used to search online content. The search index will 
automatically be created/updated by the CMS.  

• A CMS label object can be used to display the title of the page, the creation date, author, page 
views etc. anywhere on the page.  

• CMS integrates with the login tools so you can assign different users to the CMS but also have a 
global admin.  

• The CMS supports external pages, so you can mix online content with standard pages. Or even 
pages from other websites.  

• Includes a simple File Manager which can be used to upload and manage online files (like 
images).  

• Supports plug-ins to extend the functionally of the CMS with (for example a guestbook, 
comments, password protection, a web shop etc.). 

 
Requirements: 
The login tools require a web server with PHP support and MySQL, so the first step before you start 
using the CMS tools of WYSIWYG Web Builder is to check whether your web host supports PHP/MySQL!  
 
A fully functional example template is included in the 'Demo' category of the standard Templates. 



WYSIWYG Web Builder 21   

243 

CMS Database 

The Content Management System requires a database to store the page data and other related 
information. This system uses MySQL, so your hosting account must have access to a MySQL database. 
Most paid hosting accounts do have database support included. And otherwise please contact your host 
to upgrade your existing hosting plan. 
 
After checking if your website supports MySQL, you should either create a new database or write down 
the details of an existing database. Please consult the documentation of your host for more details on 
how to create a database. This is different for each host so there are no generic instructions we can give 
you for that. To be able to use the CMS tools you will need to following information: 
 

• Server, specifies the MySQL database server.  

• Database, specifies the MySQL database name.  

• UserName, specifies the MySQL username.  

• Password, specifies the MySQL password.  
 
 The CMS will automatically create the required tables if they do not exist, so you do not have to create 
the tables manually. The following tables will be created (note that the table prefix 'CMS_' is 
configurable): 
  
CMS_PAGES 
This table contains the page information like page title, content, created/updated date, view count etc. 
 
CMS_SEARCH_WORDS  
This table is part of the search index and contains all unique words. 
 
CMS_SEARCH_WORDMATCH  
This table is part of the search index and contains the word to page relationship. 
  
Although these tables will be automatically created the first time you log in to the CMS Admin, you can 
also create them manually. 
 
CREATE TABLE `CMS_PAGES` ( 

`id` int(10) unsigned NOT NULL auto_increment, 

`category_id` int(11) NOT NULL, 

`name` varchar(255) NOT NULL, 

`content` text NOT NULL, 

`home` tinyint(1) NOT NULL default '0', 

`visible` tinyint(1) NOT NULL, 

`create_date` timestamp NOT NULL default CURRENT_TIMESTAMP on update CURRENT_TIMESTAMP, 

`created_by` varchar(255) NOT NULL, 

`last_update_date` timestamp NOT NULL default '0000-00-00 00:00:00', 

`last_update_by` varchar(255) NOT NULL, 

`views` int(11) NOT NULL, 

`menu_index` smallint(4) NOT NULL, 

`url` varchar(255) NULL, 

`extra_data` varchar(255) NULL, 

`title` VARCHAR(100),  

`description` VARCHAR(255),  

`keywords` VARCHAR(255),  

`seo_friendly_url` VARCHAR(100),  

PRIMARY KEY  (`id`));  

 
CREATE TABLE `CMS_SEARCH_WORDMATCH` ( 

`page_id` int(10) unsigned NOT NULL, 

`word_id` int(10) unsigned NOT NULL, 

PRIMARY KEY  (`page_id`,`word_id`)); 

  

 

CREATE TABLE `CMS_SEARCH_WORDS` ( 

`id` int(10) unsigned NOT NULL auto_increment, 

`word` varchar(50) NOT NULL, 

PRIMARY KEY  (`id`)) ; 
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CMS Admin  
 

Important Note:  
The Content Management System tools are a set of advanced PHP forms and scripts. Please take your 
time to become familiar with tools. First read all available documentation and study the demo template 
before you start using them in your own project! 

 
The CMS Administrator object allows you to add, edit or remove pages online. 
You can (optional) install your favorite online HTML editor (like CKEditor, TinyMCE and CLEditor) to 
make the CMS tools even more powerful! 
 

 
  
Admin Password 
Specifies the administrator's password. 
 
Allow Users 
Specifies the users who can access the admin section. You can enter a list of comma-delimited users: 
Bill,Steve,Gary. These users should exist in your Login Tools configuration! If you leave this property 
empty, then only the administrator can login (using the password specified under AdminPassword). 
  
Asset Folder 
Specifies the (online) folder where new files will be uploaded to. 
If you specify ./files then a folder with the name 'files' should exist in the current folder on the server 
and it should have write permissions. The folder can/will not be automatically created so you must 
create this yourself on the server. 
 
Frame Name 
To enable scrolling for a large list of pages, the CMS administrator will be displayed inside an inline 
frame. The 'FrameName' property specifies the name of this inline frame. Normally you do not have to 
edit this. 
 
You can 'breakout' of the frame by directly linking to the script file like this: 
./cmsadmin.php 
or using the full URL: 
https://www.yourwebsite.com/cmsadmin.php 
 
In that case the full browser window will be used. 
 
Disable Page Management for users 
Enable this option to hide "Create new page", "Copy", "Delete", "Set homepage" and "Order" for 
standard users. The options will still be available for the administrator. 
 
Enable Error Reporting 
If you enable this option, the script will activate detailed PHP error reporting. This may be helpful is you 
are experiencing problems with the CMS scripts on the server. If PHP Error Reporting is enabled more 
details about the error will be displayed. 
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Session timeout 
The administrator will be logged out automatically if the session is idle (based on the specified timeout). 
 
MySQL Database 
Please read CMS Database section for more details. 

 
Editor 
WYSIWYG Web Builder supports several popular editors like CKEditor, TinyMCE and SumerNote and 
SunEditor. It also has a simple built-in editor.  
 

 
 
Note: Due to license restrictions, we are not allowed to distribute some of these editors with WYSIWYG 
Web Builder so you will have to manually install them on your computer before you will be able to use 
them! However once installed on your computer, WWB will take care of publishing and configuring the 
editors. 
  
Supported editor include: 

• Text Area 
Standard plain text editor. No special requirements.  

• WWB Editor 
A simple online WYSIWYG text editor created by the WYSIWYG Web Builder team.  
Supports basic text formatting and has configurable toolbar.  

• TinyMCE 
https://www.tinymce.com 

• CK Editor 
https://ckeditor.com 

• SCEditor 
http://www.sceditor.com 

• Summernote 
https://summernote.org 

• Trumbowyg  
http://alex-d.github.io/Trumbowyg 

• SunEditor  
https://github.com/JiHong88/SunEditor 
 

 

Disclaimer:  
Although we've added support for third party online editors, we do not and cannot give support on their 
functionality. Most online editors make use of the built-in HTML edit functionality of the browser, so 
you may notice different behavior between browsers. Unfortunately, we have no control over that.  
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The editors must be installed in the My Documents\WYSIWYG Web Builder\system\cms folder. 
 
Each editor has its own folder: 
My Documents\WYSIWYG Web Builder\system\cms\ckeditor 
My Documents\WYSIWYG Web Builder\system\cms\cleditor 
My Documents\WYSIWYG Web Builder\system\cms\tinymce 
My Documents\WYSIWYG Web Builder\system\cms\wwbeditor 
 
Editor Settings 
Specifies additional editor settings. 
 
Most editors have many configuration options. To keep this solution as generic as possible we added 
this option so you can fine-tune the editor if you wish. 
Consult the documentation of the specific editor for more details. 
 
Here's an example for the WWB Editor which allows you to modify the toolbar. 
For the full toolbar you can use the following settings: 
 
buttons:  

{ 

 'undo': false, 

 'redo': false, 

 'bold': true, 

 'italic': true, 

 'underline': true, 

 'strikethrough' : true, 

 'justifyleft':true, 

 'justifycenter':true, 

 'justifyright':true, 

 'justifyfull':true, 

 'insertorderedlist':true, 

 'insertunorderedlist':true, 

 'indent':true, 

 'outdent': true, 

 'createLink': true, 

 'unlink' :true, 

 'insertimage' : true, 

 'inserthorizontalrule': false, 

 'cut': false, 

 'copy': false, 

 'paste': false, 

 'forecolor': true, 

 'hilitecolor': true, 

 'br': true, 

 'formatblock': true, 

 'fontname': true, 

 'fontsize': true 

} 
 
Multiple options must be separated by commas (the last item does not have a comma! at the end): 
option1 : "string_value", 

option2: true, 

option3 : numeric_value 

 
 
Publish editor files 
Specifies whether to publish the editor files. If this option is enabled, then WWB will publish/upload all 
files from the editor to your website. Note that some editors use a lot of files so this may take a while. 
In general, you enable this option the first time you published your website and after that disable it so 
the files will not be published the second time. If you are an advanced user, you can also upload the 
editor manually by using your favorite FTP client. 
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How to add a new page? 
1. Log into the admin section online. Either use the AdminPassword or log in by using a 

username/password from the login tools (in that case you must login using the login form). 
2. Add a new page by clicking the 'New page' option. 
3. In the Name field enter the name of the page. This name will be displayed in the CMS Menu. 
4. The Content field contains the content of the page. If you have setup one of the editors, then you will 

see a What-You-See-Is-What-You-Get editor. Otherwise, you will see the standard text input which 
allows you to either enter plain text or HTML code. 

5. The External URL field can be used to specify a link to an external page. This field should empty for 
standard pages! See 'How to include external pages' for more details. 

6. The Extra data field can be used to assign extra data to a page and make it part of the layout. See 
'How to assign extra data and display it on the page?' for more details. 

7. Visible specifies whether the page should be displayed in the CMS Menu. 
8. Click Save to save the new page. 
 

Content scheduling 
You can also set optional start and end dates/times for each article or page. This allows you to 
automatically publish content at a future date and unpublish it when it expires, without manual 
intervention. 

 
How to include external pages in the CMS? 
1. Add a new page by clicking the 'New page' option in the Administrator.  
2. Give the new page a name for example 'External page'.  
3. Leave the content area empty.  
4. Enter the URL of the external page in the URL field. This can either be an external page: 

https://www.wysiywgwebbuilder.com/ or an internal page: ./internalpage.html  
 

How to assign extra data and display it on the page? 
You can assign extra data to a page and make it part of the layout. 
While in page editor mode of the administrator you will notice the 'Extra data' field, here you can write 
some text like a slogan which applies to the page. 
In your page layout you can then use the CMS label object to display this text anywhere in the layout by 
using the $cms_extra_data variable. 
 
 

CMS Plug-ins 
Plug-ins can add new commands to the plug-in menu (like the User Manager and File Manager). Or add 
new functionality to the page. For instance, the ‘Comments’ plug-in adds the ability for users to post 
comments on a page.   
 
Plug-ins for the CMS are stored in the folder  
My Documents\WYSIWYG Web Builder\system\plugins\ 
Advanced users can modify the standard plug-ins to suit them to their needs or create new plug-ins. We 
have created a few plug-ins to demonstrate the new functionality, and we will improve them in a future 
release if users find them useful. 
 
Here's a list of plug-ins that are currently available. They can be enabled through the 'plugins' property 
of the CMS Admin object. Enabled plug-ins will be uploaded to the server and placed in a sub folder 
(plugins) of the current folder. You can enable/disable plug-ins online with the plug-in manager or by 
renaming the folder name (insert an underscore in front of the folder name. For example, rename 
filemanager to _filemanager). Or simply remove the entire folder from the server. 
 
 

Important:  
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Only publish the plug-ins you really need because all plug-ins will be loaded/processed by all pages even 
if they are not enabled for the page. So having too many plug-ins on the server may slow down the 
performance of the CMS.  

 
 
 
 
User Manager plug-in 
Add/Edit/Remove users online. This makes it possible to manage users without the need to integrate 
with WWB’s login tools. Added users will be able to add or edit their own pages. 
 
Comments plug-in  
Adds the ability to post comments on a page. 
 
Discussion plug-in 
The Discussion plug-in enables you to add comments functionality to the page.  
 
Downloads plug-in 
Automatically creates a list of links from files in a folder. 
 
FAQ plug-in 
Create a simple Frequently Asked Questions (FAQ) page. 
 
Password plug-in 
Protect the CMS page with a password. Each page can have its own password. 
 
File Manager plug-in 
Implements a basic file manager to upload files to the CMS. 
 
Form plug-in 
Dynamically create forms online. Supports basic form validation (based on the selected input type) and 
reCAPTCHA. Submitted data can be sent in email and/or stored in a database and exported to CSV later. 
 
Guestbook plug-in 
Basic guestbook that can be integrated in the CMS. 
 
Mailing list plug-in 
Collect and manage email addresses in a mailing list. Users can subscribe to the mailing list by 
submitting their email address in the standard form. A confirmation email is sent to verify the email 
address. The admin can send messages to the subscribed users.  
 
Photo album plug-in 
The Photo Album plug-in is a basic online photo album. It will display images from a folder on the server. 
 
Slideshow plug-in 
The Slide Show plug-in adds a slideshow to the CMS page.  
 
Plug-in Manager 
The plug-in manager can be used to enable/disable CMS plug-ins online. 
 
Poll plug-in 
A simple poll plug-in. 
 
Tell-a-friend plug-in 
Adds a basic tell-a-friend form to the CMS page. 
 

Notes about plug-ins:  
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Each plug-in will automatically generate one or more database tables on the MySQL server! Tables will 
not be removed when you remove the plug-in! 
 
The generated tables contain the plug-in configuration and other data (for example the guestbook plug-
in will store messages). So, you should only install the plug-ins you need otherwise you will end up with 
a lot of (unused) database tables.  
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CMS Label 

The CMS label object must be on the same page as the CMS View object! 
This object can be used to display the title of the current page, the creation date, author, page views etc 
anywhere on the page. It's a standalone object so you can position it individually of the CMS view 
object, for example as a page header or side bar. 
 
Text 
Specifies the text to be displayed in the label. The following variables are available: 
 

• $cms_views 
The number of times the page has been viewed.  

• $cms_name 
The name of the page.  

• $cms_created_by 
The name of the creator of the page.  

• $cms_create_date 
Displays the creation date of the page.  

• $cms_last_update_date 
Displays the date the page was last modified.  

• $cms_extra_data 
Displays the 'extra data' field of the page, which you can assign in the administer tool.  

 
These variables will be replaced by the actual data from the CMS database and are directly related the 
the currently displayed pages inside the CMS View. 
Note that the variables can be mixed with standard text, so for example you can use: 
This page was last modified on $cms_last_update_date by $cms_created_by 
 
Alignment 
Specifies horizontal alignment of the text. 
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CMS Menu 

The CMS Menu object must be on the same page as the CMS View object! 
This object can be used to navigate between pages which are displayed inside the CMS View object. The 
CMS menu has many styling options. The items in the menu are driven by the CMS database, so you 
don't have to configure the links manually. 
 
Layout mode 
The menu can be either vertical or horizontal. 
  
Button size 
Specifies whether the button size is fixed or variable. 
If fixed is selected, you can specify the width/height of the buttons through the width and height 
properties. If variable is selected, then the size of the button depends on the text size in combination 
with the padding settings. 
 
Spacing 
Specifies the spacing between 2 buttons. 
 
Use SEO friendly links 
If you enable this option, the menu will use SEO (Search Engine Optimization) friendly links in the 
navigation: 
https://www.website.com/cms.php?page=my-seo-friendly-page-name 
instead of  
https://www.website.com/cms.php?page=8 
 
Note that the link names are based on the page title as specified in the CMS Admin. So, you must specify 
a title in the administrator before this option can be used. 
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CMS Search 

The CMS Search object must be on the same page as the CMS View object! 
 
This object can be used to search online content. WYSIWYG Web Builder's CMS will automatically add 
search words to the search index every time a page is created or updated. 
The search index table keeps track of all unique words within the system and stores references to the 
pages containing these words for fast search results. The results of the search query will be displayed 
inside the CMS view object. 
  
Hint text 
The hint (or 'cue') text will display inside the search field if it doesn't have the focus. When the user 
moves their focus to the field, the label will be hidden. 
  
Results 
Defines the appearance of the result inside the CMS view object. 
 
No results 
Specifies the text that will be displayed if the search query has no results. 
  



WYSIWYG Web Builder 21   

253 

CMS View 

The CMS View object is a place holder for the online content. This is the most important part of the 
Content Management System because all page content will be displayed inside this area. You will 
navigation between pages by using the CMS Menu object. The CMS View object will also be used to 
display the result of a search query of the CMS Search Object. Normally your website will have only one 
CMS View object and there will be only one page in the Site Manager used for the system (or two if you 
have a separate page for the CMS Admin).  
 

MySQL Database 
Please read CMS Database section for more details. 
 
Mode 
Specifies the mode of the CMS view. 

• Variable Content (default) 
The content of the CMS View will be controlled by the navigation. The visitor of the website 
decides which page will be displayed (via the CMS Menu). A page can only contain one CMS 
View that is set to 'Variable'! 
 

• Fixed Content 
The content of the view is fixed and is not controlled by the visitor through navigation. The 
view will always display the same page (as specified by the page id property).  This option can 
be useful if you want to display a fixed header or footer where the content is loaded from the 
CMS database. You can use multiple "Fixed content' CMS views per page. For instance, for a 
header text, footer or other content. 
Since this option requires you to specify a (valid) page ID, you must first create the content of 
the page in the online CMS Admin. You always may want to set the visible option of the page to 
'hidden'. So that it will not be displayed in the menu, but only will be used for the fixed view. 

 
Note: You can view the page id in the admin section. For instance: hover with your mouse over the 'edit' 
link (or any of the other actions) and note the page id in the status bar of the browser.  
 
Overflow 
The overflow property can be used to control the overflow behavior of the view. 

• None 
The content of the view is fully visible. No clipping will occur.  

• Hidden 
The content is clipped, but the browser does not display a scrollbar to see the rest of the 
content. 

• Scroll 
The content is clipped, but the browser displays a scrollbar to see the rest of the content.  

• Auto 
If the content is clipped, the browser will display a scrollbar to see the rest of the content.  

 
Use AJAX to load content 
Allow the user to quickly navigate between pages without have to reload the whole page! Only the 
content will be refreshed. Note that this uses jQuery in the background, so JavaScript must be enabled. 
 
Use title and meta tags from database for Search Engine Optimization. 
Enable this option to use the title, description and keywords from the CMS database (specified in CMS 
Admin) instead of the title/meta tags configured in Page Properties.  
This makes it possible to optimize the pages for SEO, because now each page will have its own title and 
metatags. 
 
Online tutorial:  
https://www.wysiwygwebbuilder.com/cms_tools.html 
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Editable Content 

The Editable Content can be used to define an editable section on the page. This section can later be 
modified online with the 'Editable Content Admin' tool. No database setup is required, it uses flat file 
storage (no MySQL). The page with editable sections does not need to be PHP, because the content is 
dynamically loaded via javascript/ajax. 
 
During design time, the Editable Content object works just like a standard text object, with the same 
editing tools available. This allows you to setup the initial text in your layout. 
 
In the properties of the Editable Content object, you can set a label, which will be displayed in the admin 
tool, so it's easier to identify the section. 
 
Online tutorial: https://www.wysiwygwebbuilder.com/editable_content.html 
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Editable Content Admin 

The Editable Content Admin object is the online management tool to update the content. 
Once published, it will display a list of all the Editable Content objects in the project. 
 

 
 
Online tutorial: https://www.wysiwygwebbuilder.com/editable_content.html 
 
 
Admin Password 
Specifies the administrator's password to access the online content editor. 
 
Enable Error Reporting 
If you enable this option, the script will activate detailed PHP error reporting. This may be helpful is you 
are experiencing problems with the scripts on the server. 
 
Frame Name 
To enable scrolling for a large list of pages, the administrator will be displayed inside an inline frame. 
The 'Frame Name' property specifies the name of this inline frame. Normally you do not have to edit 
this. 
 
You can 'breakout' of the frame by directly linking to the script file like this: 
./editablecontentadmin.php or using the full URL: 
https://www.yourwebsite.com/editablecontentadmin.php 
 
In that case the full browser window will be used. 
 
Session timeout 
The administrator will be logged out automatically if the session is idle (based on the specified timeout). 
 
Editor 
Clicking 'Edit' in the online admin tool will open the content editor where you can update the text or add 
mages, videos or tables. 
The admin tool can be configured to use one of the supported third-party editors like tinyMCS or 
Summernote. Each editor has different options so you can choose the one that best suits your needs.  
 
Please see the 'Editor' section of the CMS admin for more information: CMS Admin 
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Accordion 
The Accordion object is named after the musical instrument, in the way the expansion of one area leads 
to the contraction of another. Typically, accordions are fixed so that only of the areas is be visible at 
same time.  
 

 
 
Adding objects to the Accordion's Panels 
You can easily add objects to the accordion panels by dragging them on the component. This works the 
same way as for layers or forms. To be able to drag & drop objects to the accordion first make sure it's 
large enough so the objects can be dragged on it (the accordion object should be larger than the object 
you're adding!). 
 
A blue border around the panel will indicate that the dragged object will become part of the accordion. 
To add items to another panel simply click the header to make it active. 
 

Note:  
Removing a panel will also remove all objects that are part of this panel! 
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Auto Complete 

AutoComplete can replace a standard editbox. It enables users to quickly find and select from a pre-
populated list of values as they type. The list can be either local or from a remote location (AJAX). 
 

 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/autocomplete.html 
 
Type 
The Autocomplete object supports two types: jQuery UI (https://jquery.com/) and Bootstrap. 
 
Data Source 
Specifies the source for the auto complete items. 

• Local 
Uses an local array as the data source. The items can be added, edited or removed by using the 
'Add', 'Edit and Remove' buttons. 

• Remote 
Select this option if you want to get the data from an external data source, like a database. You 
must also specify the URL in this case. This option is for advanced user only! 

 
Delay 
The delay in milliseconds the Autocomplete waits after a keystroke to activate itself. A zero-delay makes 
sense for local data (more responsive) but can produce a lot of loads for remote data, while being less 
responsive. 
 
Min Length 
The minimum number of characters a user must type before auto complete activates. Zero is useful for 
local data with just a few items. It should be increased when there are a lot of items, where a single 
character would match a few thousand items. 
 
Data 
If the data source is local, then you must specify the auto complete data in this list. Use the 'Import' 
button to select from a predefined list of items or import the items from an external file where each 
item must be on a new line. 
 
URL 
When a remote data source is used, the Autocomplete object expects that the page returns JSON data.  
It can be on the same host or on a different one (must provide JSONP).  
The request parameter "term" gets added to that URL. More details are available on the jQuery website: 
https://jqueryui.com/demos/autocomplete/ 
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Themeable Button 

This object enhances standard button (normal, submit, reset or anchor/link) to themeable buttons with 
appropriate mouseover and active styles. The button can be used as a submit button on a form or as a 
stand-alone button for navigation.  
 

 
 
Name 
Name of the button. 
 
Value/Label 
Caption of the button. 
 
Button Type 

• Submit 
When activated, a submit button submits a form.  

• Reset 
When activated, a reset button resets all controls to their initial values.  

• Normal 
Normal (Push) buttons have no default behavior. Each push button may have client-side scripts 
associated with the element's event attributes. When an event occurs (e.g., the user presses 
the button, releases it, etc.), the associated script is triggered.  

• Link Button 
If this button type is selected the button will act as a navigation button/link. You can specify the 
link properties in the 'Link' page. 

• Checkbox 
The button will act as a checkbox, so it can be used as a replacement for the standard checkbox 
element in forms.  

• Radio Button 
The button will act as a radio button, so it can be used as a replacement for the standard radio 
button element in forms. Give multiple buttons the same name to make them part of a group. 

• Split Button 
Adds a drop-down menu to the button. Each sub menu can have its own link. 

• Button Set 
Adds the ability to define multiple buttons to create a themed navigation menu. 

 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Disabled 
The disabled option disables the control for user input.  
 
Tab Index 
Specifies the tab index of the button (in a form). 
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Badge 

A "badge" is a small graphic, text or symbol used to show or tell something about a specific item on a 
webpage. Badges are often used to catch your eye and give more details to users. For example, showing 
if a product is available, promoting a discount, displaying a user's achievements, or indicating how 
popular a product is. Badges can be applied to almost any object. Badges can include both text and 
icons, and they can also incorporate animations to capture the visitor's attention. 
 

 
 
There are several types of badges: 
 

• Arrow 

• Bookmark 

• Bootstrap-like badge 

• Certificate 

• Flag 

• Folded 

• Image 

• Stripe 

• Tag 

• Tooltip 

• Triangle 

• Ribbon 

• Ribbon Glossy 

• Shape (with more than 200 shape types).  
 
Online tutorial: 
https://wysiwygwebbuilder.com/badges.html 
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Cards 

A card is a lightweight, flexible content container. It includes options for headers and footers, a wide 
variety of content, styling, and powerful display options. The Card object was inspired by Bootstrap's v4 
Card component. 
 

 
 
Button 
Buttons support many styling options like background, border, font, padding. 
Buttons can be used as a link or trigger an action via events. If you leave the text field empty and set an 
icon, then it can be used as a 'social icon'. If multiple buttons are added sequentially then they will be 
displayed in one row. To display buttons on a different row, they must be separated with a divider. 
Set the border-radius to 500 to create a round button/icon. 
 
Column Break 
This can be used to implement horizontal layout in cards. This allows you to divide card items into 
multiple columns. There are 2 ways to configure columns: Specify each column, where the value can 
either be in pixels or percentages or specify column break(s) only. 
 
Divider 
A divider can be used to insert a line.  
 
Header / Footer 
Add an optional header or footer within a card. The header/footer can be configured as heading (h1..) 
A header will always be added as the first item. A footer will always be added as the last item, at the 
bottom of the card. 
 
Image 
Add an image to the card. By default, the image will be full width, but you can optionally set a width and 
height. These values are responsive and can be different in breakpoints. An image can either be inline or 
overlay. When set as overlay it will be rendered behind all other items. You can only use one overlay 
image per card. 
 
Text 
Add text to the card. Text will always be full width. Use padding to add spacing around the text. 
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eCommerce 
Add checkboxes, radio buttons, select /dropdown lists, price and quantity fields to the card. These items 
can then be used to adjust the price. For example, the size of a t-shirt, gift wrapping, glossy printing 
paper etc. 
Extra options can increase or decrease the final price. Calculations are done automatically so there is no 
need to implement events or conditions! 
 
Online tutorial:  
https://wysiwygwebbuilder.com/ecommerce_cards.html 
 
Video 
Add a video to the card. This can be used to add a YouTube or Vimeo video. The video will be embedded 
in an inline frame, so basically this can be a reference to any valid URL. 
 
Examples:  
https://www.youtube.com/embed/ojocCQpHLh4  
https://player.vimeo.com/video/76979871 
https://www.yourwebsite.com/video.mp4 
 
 

Popover 
Cards can also be used as Popovers; this basically uses the Card as an advanced tooltip/pop-up box that 
appears when the user clicks or hovers on an element. Popovers can be placed at the top, right, bottom 
of left of the container object and can be activated via click, hover or focus. 
 
 

Cards Management Tools 
When you select a Card in the workspace, the Ribbon displays a context tab with tools specific to that 
card. From here, you can quickly access and adjust properties for the entire card or its individual items. 
You’ll also find shortcuts to add new card items, edit, delete, or move items up or down. If the card is 
part of a Card Repeater, any edits you make will apply to all cards generated by the repeater. 
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Card Container 

The Card Container is a dedicated container for Cards to simplify laying out a series of cards. 
Just layout grid and flex box container, the card container is a full-width, floating element. So, it cannot 
have a absolute position. The Arrange Tools can be used to move the container up or down the page. 
 

 
 
Card Container has the following layout options: 

• card deck 
automatically aligns the cards horizontally with equal width and height. Even with different 
content lengths! Basically, card deck is just a simplified version of a Flex Container where the 
flexbox properties of the Card will be forced to flexgrow: 1, flexshrink: 1, flexbasis: 0% 

• card columns 
organize the cards into Masonry-like columns. Cards are ordered from top to bottom and left to 
right. 

• carousel 
displays the cards in an animated. The number of cards per slide and spacing is configurable per 
breakpoint. It is also possible to set how many cards will be scrolled per page. The card carousel 
can be controlled via events: media play, media stop, slideshow next, slideshow previous 

• masonry 
Cards will be dynamically rearranged based on the available space in the browser window. 
Masonry measures all the items and rearranges them in the best way with what is spatially 
available. You can configure different column counts in breakpoints. It is also possible to set a 
‘column span’ for each card via the flex grow property. 

• grid 
Easily create a grid (columns / rows) with cards. 

• Portlets 
In portlets mode, the visitor of the website can rearrange cards via drag & drop. Also, cards can 
be hidden or expanded/collapsed. The state of the portlets will be saved for the next time the 
user visits the website (via web storage).  

• coverflow 
Display the cards in a 3D cover flow carousel. 

• stack 
Display the cards stacked on top of each other. 

• cube  
Display the cards in a 3D cube. 

• flip 
One card is visible at a time. A 'flip' transition will be used to switch between cards. 
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Maximum Width 
Specifies the maximum width of the Card Container's content in the browser window. This can be useful 
to prevent items from being stretched too wide. If the browser window is wider than the specified 
width, then the grid content will be centered. 
 
Column Count 
Specifies the number of columns. This value can be different in breakpoints. Applies 'card columns' and 
'carousel' modes. 
 
Column Gap 
Specifies the spacing between the columns. This value can be different in breakpoints. 
Applies 'card columns' and 'carousel' modes. 
 
Pause Time 
Specifies the pause time for each cycle in milliseconds. 
When you set a negative pause time, the carousel will scroll continuously (like a Conveyer Belt). For 
example: -3000 
 
Slide By 
Specifies how many cards will slide in each cycle. The default '1' will slide card at a time. 
 
Auto Start 
Specifies whether to automatically start the carousel animation. When set to 'false' the carousel can be 
controlled via events. 
 
 

Card Repeater 

A Card Repeater operates similarly to a Card Container, with a key distinction: all cards within it share 
the same layout and style. This means that any modification made to one card will automatically 
propagate to all other cards within the same container. For instance, if you add a button to one card, it 
will simultaneously appear in all the other cards. Removing an item will have the same effect, as it will 
be removed from every card within the repeater. Similarly, adjustments to the style attributes, such as 
font size, background color, or borders, will be uniformly applied to all cards. Furthermore, duplicating a 
selected card is a breeze – simply click the clone button to create an identical copy. 
 
Please note that due to the uniformity in layout and structure, you cannot drag and drop a card into a 
Card Repeater if it possesses a different configuration.  
 
Online tutorial:  
https://wysiwygwebbuilder.com/cards.html 
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Section 

A Section works the same as a Card, but the main difference is that elements can be freely positioned 
(layered).  

 
 
Items 
For a description of the available items (button, text, divider, etc), please see Cards. 
 

Layout 
Each element can be positioned/anchored without affecting other elements in the same section.  
 
The alignment (horizontal/vertical) of an element can be left, center, right or stretched. Images and 
videos automatically maintain their aspect ratio. Just like a card, Sections support dividers, 
animations/transitions, events and much more! 
 
Horizontal 
Specifies the horizontal alignment of the item relative to the section container left, center, right or 
stretched. When centered, the item will always be in the horizontal center of the section. This means 
that you cannot move it horizontally with the mouse. When stretched, the item will automatically resize 
when the object becomes smaller or larger. 
 
Vertical 
Specifies the vertical alignment of the item relative to the section container: top, middle, bottom or 
stretched. When centered, the item will always be in the vertical center of the section. This means that 
you cannot move it vertically with the mouse. When stretched, the item will automatically resize when 
the object becomes smaller or larger. 
 
 
Online tutorial: 
https://wysiwygwebbuilder.com/section.html 



WYSIWYG Web Builder 21   

265 

Date Picker 
The Date Picker offers a sophisticated and feature-rich UI component for inputting dates into a form. 
The object provides a graphical calendar that pops up if you click inside the form field. 
 

 
 
Use current date 
This will automatically set the initial value to the current date. 
 
Date format 
The format for parsed and displayed dates.  For a full list of the possible formats see the formatDate 
function: 
https://docs.jquery.com/UI/Datepicker/formatDate 
 
Change month 
Specifies whether the user can change the month by selecting from a drop-down list. 
 
Change year 
Specifies whether the user can change the year by selecting from a drop-down list. 
 
Show button panel 
Specifies whether to show the button panel. 
 
Custom options (for advanced users only) 
The Date Picker has many other options.  The custom options field allows you to include one or more of 
these options. Check the jQuery documentation for more details.  
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Dialog 

A dialog is a floating window that contains a title bar and a content area. You can easily add objects to 
the dialog by dragging them on the component. This works the same way as for layers or forms. 
 

 
 
Title 
Specifies the title of the dialog. 
 
Show / Hide animation 
Specifies the effect to be used when the dialog is opened or closed. 
 
Modal  
If enabled, the dialog will have modal behavior; other items on the page will be disabled (i.e. cannot be 
interacted with). Modal dialogs create an overlay below the dialog but above other page elements. 
 
Resizable  
If enabled, the dialog will be resizable. 
 
Draggable  
If enabled, the dialog will be draggable by the title bar. 
 
Close on escape  
Specifies whether the dialog should close when it has focus and the user presses the escape (ESC) key. 
 
Show dialog automatically 
When this option is enabled, the dialog will open automatically when dialog is called. Otherwise it will 
stay hidden until .dialog("open") is called on it. 
 
Cookie Expire Days 
This can be used to implement 'one-time popup' functionality. A cookie is stored on the visitor’s browser 
to only show the dialog once across multiple visits. Use '0' to disable cookie functionality. 
 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/dialog.html 
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ListView 

Create beautiful styled (themable) lists with title, description and image. Two modes are supported: 
listview and droplist. Also supports dividers to group items. 
 
Listview mode: 
 

 
 
Droplist mode: 
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Dropdown Menu 
Multi-level responsive menu. It displays a hamburger menu in mobile mode. The 'Breakpoint' property 
in the RWD settings specifies when the menu will switch from desktop to mobile menu. 
It is also possible to configure a logo on the left or right side of the menu. 
 

 
 
Layout 
The Menu Bar can be either Vertical or Horizontal. 
 
Orientation 
Identifies the position of submenus in relation to the associated parent menu item.  
 
Menu mode 
In 'Standard menu' mode the menu will be displayed at the same position as in design mode. 
In 'Context menu' mode the menu will behave as a context menu. The menu will be displayed on right 
click at the current mouse position. 
 
Overflow  
There are times when the drop down has many menu items, and they begin to wrap (undesirable) as the 
page width decreases. Using overflow mode, you can automatically collapse the extra menu items into a 
dropdown menu on the right. When the viewport is wide enough, the menu items return to the 
horizontal menu. When there are no overflowing items, the dropdown menu is hidden. 
Overflow menus are represented by a 'kebab' button, as the user clicks on the kebab, a horizontal list 
will appear with additional options to click. 
 
Synchronize  
Synchronize the menu with the Site Manager structure, bookmarks on the same page or with other 
menus. See also “Synchronize Navigation” later in this document. 
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Tabs 
Tabs can be used to break content into multiple sections that can be swapped to save space, much like 
the accordion.  
 
You can easily add objects to the tab panels by dragging them on the component. This works the same 
way as for layers or forms. To add items to another panel simply click on the tab header to make it 
active. 
 

 
 
Tab Width 
Tab Width specifies the width of the tabs. Use ‘0’ for a variable tab width. 
 
Sortable 
If the Sortable property is enabled then the user can sort the tabs dynamically using drag & drop, a cool 
feature of jQuery;) 
 
Activate On Mouseover 
Enable this option to change the active tab on mouse over instead of the standard mouse click. 
 
Use fade transition effect 
The Use fade transition effect property enables the fade animation for hiding and showing tab panels. 
 
Collapsable 
Enable Collapsable to allow an already selected tab to become unselected again upon reselection.  
 
Enable automatic rotation through tabs 
This enables automatic rotation through tabs with configurable duration. 
  
Continue the rotation after a tab has been selected by a user. 
Specified whether or not to continue the rotation after a tab has been selected by a user.  
  
Duration 
The amount of time in milliseconds until the next tab in the cycle gets activated. 
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Toast 
Toasts are lightweight notifications designed to mimic the push notifications that have been popularized 
by mobile and desktop operating systems. They can be displayed at page load or with delay. Multiple 
Toasts will automatically stack vertically.  
 

 
 
Text 
The text can be edited just like standard text. So, the same formatting and edit tools are available, 
including styles, line spacing, letter spacing, bullets, find/replace, lorem ipsum, responsive fonts and link 
support. 
 
Show Delay 
Specifies the delay (in milliseconds) before the Toast is shown. Set to '-1' to initially hide the Toast, so 
you can control it via events (show/hide). 
 
Hide Delay 
Delay hiding the toast in milliseconds. Set to '0' to disable auto hide. 
 
Title 
Specifies the title of the toast. 
 
Sub Title 
Specifies the (optional) subtitle.  
 
Position 
Specifies the placement of the Toast.  
This is a global property. This means that it will affect the placement of all Toasts on the current page! 
 
Header Style 
Specifies the style of the header. 
 
Icon 
The header can also include an icon from one of the available icon libraries. 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/toasts.html 
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Progressbar 

The progress bar is designed to simply display the current % complete for a process. For example, as 
part of a customized upload script or to display the status of an Online Survey. 
The range of the progress bar is from 0 to 100. 
 

 
 
 

 
 
 

Note:  
The value of the progress bar is usually updated through JavaScript. It does not do anything by itself! 

 
Initial Value 
Specifies the initial value of the progress bar. Typically, this is '0'. 
 
Type 
The Progressbar object supports the jQuery UI Progress bar Widget : https://jquery.com/ 
And Bootstrap's Progressbar: https://getbootstrap.com/docs/5.2/components/progress/ 
It is also possible to show the progress bar as a circle. 
 
 
Online tutorial: 
https://wysiwygwebbuilder.com/progressbar.html 
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Slider 

The slider widget represents a value that is selected by dragging the thumb along the background. 
It's a simple widget, comprised of two main elements: the slider handle (also called the thumb) and the 
slider background. 
 

 
 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/using_sliders.html 
 
 
Orientation 
Specifies whether the slider has the min at the left, the max at the right (= horizontal) or the min at the 
bottom, the max at the top (= vertical). 
 
Animation 
Specifies whether to slide handle smoothly when user click outside handle on the bar.  
 
Initial Value 
Specifies the initial value of the slider. 
 
Minimum Value 
Specifies the minimum value of the slider.  
 
Maximum Value 
Specifies the maximum value of the slider. 
 
Range 
Changes the appearance of the slider. A min range goes from the minimum value to the handle. A max 
range goes from the handle to the maximum value.  
 
Height/Width 
Specifies the height (if the orientation is horizontal) or width (if the orientation is vertical) of the slider 
background. 
 
Handle Width 
Specifies the width of the slider handle. 
 
Handle Height 
Specifies the height of the slider handle. 
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Slider Events 
Events can be used to update other parts of the page based on the current state of the slider. 
 
The following events are supported: 
 
slidestart 
This event is triggered when the user starts sliding. 
 
slide 
This event is triggered on every mouse move during slide.  
Use ui.value to obtain the value of the current handle.  
 
slidechange 
This event is triggered on slide stop, or if the value is changed programmatically (by the value method).  
 
slidestop 
This event is triggered when the user stops sliding. 
 
action 
Specifies the action to be taken when the event is triggered. 

• Set value, sets the value of a form element (for example editbox, button or textaera)  

• Custom code. Here you can implement your own code that will be inserted inside the callback 
function. 
 
function(event, ui)  

{ 

 // your custom code will be inserted here... 

}); 

 
Use ui.value to obtain the value of the handle. 
 
Example: 
$("#Editbox1").val(ui.value); 

 
 

Example 
Here is an example of how to update the value of an editbox. 
 
1. Add an Editbox to the page.  
2. Take note of the ID. The default value is ‘Editbox1’.  
3. Add the slider widget to your page.  
4. Open the properties of the Slider and select the ‘Events’ tab.  
5. Click ‘Add’ to insert a new event.  
6. Select ‘Event’: slidechange and set the ‘Action’ to Set Value.  
7. In Target select the editbox ('Editbox1'). 
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Spinner 

Enhance text input for entering numeric values, with up/down buttons and arrow key handling. 
Note that this object is normally used on a form as a replacement for the standard editbox. 
 
The jQuery Spinner object is based on the Spinner Widget of the jQuery UI library: https://jquery.com/ 
 

 
 
 
Name 
Enter an identifier for the field. 
 
Initial Value 
Value that is initially displayed in the field. 
 
Minimum Value 
The minimum allowed value. 
 
Maximum Value 
The maximum allowed value. 
 
Steps 
The size of the step to take when spinning via buttons. 
 
Incremental 
Controls the number of steps taken when holding down a spin button. 
When set to true, the stepping delta will increase when spun incessantly. When set to false, all steps are 
equal (as defined by the step option). 
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
that the elements appear in the HTML code.  
However, sometimes you want the tab order to flow a little differently. In that case, you can number the 
fields using tabindex attribute. 
Usually, the first tabindex starts with value '1'. To exclude an element from the tab order, set the value 
of tabindex to 0. In that case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser. 



WYSIWYG Web Builder 21   

275 

Wizard 

This implements a wizard-like component, which can be used (for example) to create a multi-page form.  
The wizard can either be modal (popup) or used as a standard element. 
 

 
 
The Wizard object is based on the Dialog object and has the same properties. The main difference with 
the Dialog is that you can add multiple pages (steps). Adding objects works the same as with other 
containers, simply drag & drop the objects inside the drop area. 
Click the 'Next or 'Previous' button to go to another step.  
 

Note:  
If the Wizard is used as a form, then the 'Finish' button will act as a submit button, otherwise it will 
simply close the Wizard. 

 



WYSIWYG Web Builder 21   

276 

Tooltips 

Customizable, themeable tooltips, replacing native tooltips. The tooltip supports text formatting and can 
be assigned to any WWB object. 
 

 
 
Object ID 
Specifies the ID of the associated object. The tool tip will be displayed when the user hovers over the 
specified object. 
 
Type 
The Tooltip object supports two Tooltip Widgets: jQuery UI (https://jquery.com) and Bootstrap 
(https://getbootstrap.com/docs/5.2/components/tooltips/) 
 
Animation 
Specifies the animation that is used to show/hide the tooltip: None, Fade or Slide. 
 
Track the mouse 
Specifies whether the tooltip should track (follow) the mouse. 
 
Content 
Specify the context (text) of the tooltip. The text can be formatted by using the style tools. 
 
Position 
Identifies the position of the tooltip in relation to the associated parent object. 
 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/tooltip.html 
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Publish a website 
You can publish your web pages using the built-in Publish tool. 
Select File -> Publish to launch the publish dialog. 
 
There are two ways to publish your pages: 

1. Publish to a local folder. 
2. Publish to a remote FTP server. 

  

Publish to a local folder 
Click Add to add a new location to the list. 
Enter a name for the location a select Local as type.  
 

 
 
Enter the folder where you want to publish the active document. 
Click OK to save the data and then click Publish to save the files to the specified folder. 
If you do not want, to copy images or other components along with the HTML file,  
select the Only publish HTML files option. Otherwise, all images, ActiveX controls, java applets etc. will 
be copied the same folder. 
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Publish to a remote FTP server. 
Click Add to add a new location to the list. 
 

 
 
Enter a name for the location a select Remote/FTP Server as type and fill in the following fields: 
 
Host 
The Host Address field contains the location of the FTP server. 
You can either specify a URL or IP address. 
 
Port 
The default Port of an FTP connection is 21, but if necessary you can configure something else. 
 
PASV mode 
PASV mode is useful for certain types of firewalls that do not allow FTP servers to initiate data 
connections back to the connected client.  
 
Username 
This is where you enter the username of the FTP account that allows you to logon to the FTP Server (also 
see anonymous setting). 
 
Password 
Enter the password of the FTP account. 
 
Remote Folder 
Specifies the folder on the FTP server where the files are uploaded. The default is your root directory. 
Common remote folder’s locations are: /www and /public_html 
 

Important note: Unfortunately, this value is different for each webhost, so consult your webhost's 
documentation for more details. 

 
Test Connection 
This command can help you determine if the specified hostname, username and password are correct. 
It also verifies if your firewall allows the connection to the server. 
 
The 'Explore' button in publish settings give you access to your published files. Clicking this button will 
launch the Built-in FTP Client to manage your online files.  The built-in FTP client also introduces an easy 
way to find the remote publish folder. Simply login to your account, browse to the folder and click 
‘Make Home’. WYSIWYG Web Builder will now use that folder as the root of your website! 
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Pages to Publish 
Select which page or pages you want to publish. 
Entire Web Site, publishes all pages of the web site (except the pages which have enabled 'Don't Publish 
this Page' in Page Properties) 
Select Page Only, publishes the select page, click Select to specify the page to be published. 
Select Page and Sub Pages, publishes the selected page and all its subpages (if any). 
 

Files 
Specifies which files will be published. 

• Publish all files 
All files of the selected page(s) will be published  
 

• Publish HTML files only 
Select this option if you do not want to upload images or other components along with the 
HTML file. 
 

• Publish files of modified objects only 
Select this option if you only want to publish files of objects that were modified since the last 
time you published your web site. What exactly gets published depends on the changes you've 
made. For example, if you've only changed the position of an object, then only the HTML file 
was changed, but if you've changed the size of a shape, then the shape image needs to be 
regenerated and therefore the HTML and the image file will be published. 
Note that this option does not compare local files and files on the server, because that would 
take too long. Instead, it checks whether an object was modified since the last publish. If you 
changed one or more properties of an object, then all files for that object will be published. 
For small changes this will reduce the number of publish/uploaded files. 

 

• Publish all files except sitemap.xml/robots.txt 
This allows you to publish all files with exception of sitemap.xml/robots.txt 

 

• Publish only specific files. This option can be used to publish only specific file types, like 
images, video, zip files etc. You can select one of more files type via the 'Filter' button. 

 
 

Backup 
Specifies whether to make a backup of the project on the server. 

• None 
No backup 
 

• Make a backup of the project file (.wbs only) 
This will publish/upload the project file to the server. Images and other files will not be 
included! 
 

• Make a complete backup of the project file in zip format. 
This will publish/upload the project, images and other file to the server in one zip file.   
Note: images and other files will only be included if they are stored in the project folder. There 
for, the option "Let WYSIWYG Web Builder manage images and other files used by a project' 
should be enabled. 
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More information about publishing 
To make your web pages available for other users you must publish them to a web server. There are lots 
of hosting companies available, for example: 
https://www.1and1.com  
https://www.godaddy.com/ 
 
Make sure you choose a web host, which supports FTP, which makes it much easier to publish your 
pages from Web Builder. Once you have registered to a web host, you will receive a server address, 
username and password.  Enter this information into Web Builder by selecting: File->Publish. Click Add 
and select Type Remote. Sometimes you also need to specify a remote folder like 'public_html'.  if you 
have a firewall/router select 'Use passive mode for transfers'.  Click OK to save.  Now you can publish 
each page simply by selecting Publish. If you want to view the results of the file transfer, you can view 
the log file via: Tools -> Options -> Publish -> View Log.  
 
 

How to publish on a host that offers free web hosting that do not support FTP?  
Instead of publishing your web pages directly via FTP, you can also publish your pages to a local folder.  

• Click Add and select Type Local.  

• Enter a Name and specify a location using the browse (..) button.  

• Click OK to save.  

• Now if you press the Publish button, the files will be generated to the local folder.  

• Next select all the files in the local publish folder and upload them using the File Manager of 
your web host.  

 
Publish to a Secure FTP server 
WYSIWYG Web Builder has built-in support for Secure FTP server (SFTP or FTPS). 
The following protocols are supported:  

• FTP with TLS/SSL (Port 990 - Implicit)  

• FTP with TLS/SSL (AUTH TLS - Explicit)  

• SFTP using SSH2 (Secure Shell)  
 

What to do in case of publishing errors?  
Please see the publish FAQ, for solutions to common publishing problems: 
https://www.wysiwygwebbuilder.com/forum/viewtopic.php?f=10&t=36493 
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Links 
Links are text or images that can be clicked to bring the user to another web file such as a web page, 
images or any other file. They are the essence of the World Wide Web as they link pages within sites 
and web sites to other web sites.  
 

 
Highlight the text or image that will be the link and select Insert -> Link from the menu bar or press 
CTRL+K. This will display the Edit Link window. 
 

Link to a page on another web site 
Set the Link To option to External Web Address. Enter the full URL (Internet Address) of the destination 
page in the URL box. External URLs MUST begin with "https://" or they will not work.  
For example, to link to the Pablo Software Solutions home page, type 
"https://www.pablosoftwaresolutions.com/" instead of "www.pablosoftwaresolutions.com". 
 

Link to a page on your own web site 
Set the Link To option to Page in this project. 
Click 'Select' to choose a page. This will list all pages which are part of the current project. Select one of 
the pages and a relative link will automatically be created (eg ./products.html).  

• You must publish all pages you have linked to be able to test relative links. 

• Internal links do not work in Preview mode, unless you have set the Preview Scope to Entire 
Web Site (Tools -> Options -> Preview) 

 

Link to an email address 
Select Email Address from the Link To dropdown list. 
The URL box will automatically be updated with the mailto: prefix. Now enter the destination email 
address. For example: 
mailto:webmaster@yourdomain.com 
or  
mailto:webmaster@yourdomain.com?subject=Website Feedback 
 

Link to a file 
Set the Link To option to File. Browse for the file you wish to create a link for. WYSIWYG Web Builder 
will automatically upload the local file to your website, when you publish your page. 
 

Note: When linking to large files, it may take a while a while before the file is transferred to your 
website! 
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Smart Links 
Smart links can be used to link to the next, previous, parent or child of the current page. If you change 
the structure of your website, these links will automatically update to represent the current state.  
 
The following smart link options are available: 

• Parent Page; Link to the parent of the current page. 

• Child Page; Link to the first child of the current page. 

• Next Page; Link to the sibling to the right of this page.  

• Previous Page; Link to the sibling to the left of this page.  

• Back; Go back to the previous page in the browser's history. 

• Close the current browser window; Close the current browser window, this feature is not 
supported by all browsers! 

• Print the current page; Clicking the link will print the current page. 

• Reload Page; Clicking the link will reload/refresh the current page. 
   

Other link types 
• FaceTime 

Launch the FaceTime app and initiate a call to the specified user. Example: 
facetime:14085551234 or facetime:user@example.com  

• Phone Number 
Call the specified number. Example:  tel:+1200229933  

• SMS 
Send an SMS. Example: sms:+3290322111  

• Skype 
Launch the Skype app and initiate a call to the specified user. Example: skype:skype_user 

 

Target Window or Frame  
Open in the same browser window, this option will set the target of the link to _self 
Open in a new browser window, this option will set the target of the link to _blank 
Open in another window or frame, this option lets you specify a custom target.  
  
Examples: 
_parent 
open the link in the parent frame 
_top 
loads the linked page in the topmost frame 
iframe1 
specify the name of an inline frame, to open the linked page in an inline frame. 
 
Open in a popup window, this option will open the linked page in a (JavaScript) popup window. 
Click 'Settings' to specify the properties of the popup window: 
Left, Specifies the left position, in pixels. This value is relative to the upper-left corner of the screen. The 
value must be greater than or equal to 0. 
Top, Specifies the top position, in pixels. This value is relative to the upper-left corner of the screen. The 
value must be greater than or equal to 0. 
Height, Sets the height of the window in pixels. The minimum value is 150 for Internet Explorer!  
Width, Sets the width of the window in pixels. The minimum value is 250 for Internet Explorer!  
Status Bar, Enable the status bar at the bottom of the window.  
Tool Bar, Enable the standard browser toolbar, with buttons such as Back and Forward.  
Location Bar, Enable the Location entry field where you enter the URL.  
Menu Bar, Enable the menu bar of the window.  
Resizable, Allow/Disallow the user to resize the window.  
Scrollbars, Enable the scrollbars if the document is bigger than the window  
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Bookmarks (Jump to another part of the page) 
Text and images can be set as bookmarks (also called "anchors") that can be linked to within a page. For 
example, if a page has several new items, the news titles for each item can be set as bookmarks and a 
row of links can be added to the top of the page that will each skip down to those bookmarked sections. 
This method of using bookmarks allows visitors to your site to quickly access information by not having 
to scroll down the page to view the information they want. 
 
Step 1 
You can create a Bookmark by using the Bookmark tool from the Insert menu 
 

 
 
Step 2 
Move the bookmark icon to the position where you want the page to jump to if the user clicks the link.  
 
Step 3 
Make sure you give the bookmark a unique ID. 
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Step 4 
Once you have placed the bookmark on your page, it can be selected from the Bookmark dropdown. 
 

 
 

Appearance 
All links in your webpage by default use the default HTML link colors (link: blue, visited: purple, active: 
red). By defining link Styles (CCS) you can adjust the colors and formatting of a link. Once you have 
defined a style you can attach it to the link by selecting it from the Style dropdown list. Click the Edit 
Styles button to add or modify the link style sheet. 
 

Link Style Sheet 
By default, all text links on a page use the default HTML link colors (link: blue, visited: purple, active: 
red). However, by using link styles it’s possible to use different colors and other effects. 
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Click Add to add a new link style. Each link style allows you to customize the colors for all four link 
states: 
Linked (default: blue, underlined) 
Visited (default: purple, underlined) 
Active (default: red, underlined) 
Hover (default: blue, underlined) 
Besides the colors, you can also change the bold, underline and italic formatting. 
 

 
 
Each style must be saved with a unique name.  
In the Link Properties window, you can attach this name to a link. 
 
Click Edit to modify an existing style and Remove to delete it from the list. 
 
Example: Removing the underlining from a link. 

1. Create a new style and clear the underline checkbox for all four states. 
2. Name the style 'no_underline' 
3. Click OK to save. 
4. Select a link and change the Style from the dropdown list to 'no_underline' 
5. Publish or preview the page to view the effect. 

 
 

Note: The link style becomes active when you publish or preview your page. Web Builder will always 
show links in blue. 

 
Transition 
Specifies transition duration to go from one state to another. This makes it possible to animate the link 
state change. Read more about transitions here: CSS3 Animations and Transitions. 
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Site Manager 
The Site Manager can be used to manage the structure of your web site.  
When your web site has more than one page, they must all be part of the same Web Builder project file. 
The Site Manager can be used to add, edit, remove pages and organize your web site. There is also a 
button to open the properties of the selected page. The New Folder command gives you the possibility 
to organize your pages in folders. 
 

 
 
In the picture above, you see an example of a web site structure. The filename of this example web site 
is called 'mywebsite.wbs', this name is always displayed at the root of web site tree. The root can have 
one or more pages and each page can also have subpages. Web sites always have a home page, which is 
often called index, so for this reason Web builders automatically add this page to each new project. The 
names of the items (pages) in the site tree are the actual file names of the target HTML files, so if you 
named a page 'index' will publish as index.html. 
 
At the bottom of the Site Manager there is another toolbar. This makes it possible to switch between 
different modes: 
 

• Site Tree 
Display the Site Tree. This is the default view 
 

• Pinned 
This option displays a list of pinned pages, so you mark the pages you are currently working or 
pin pages that you frequently update. You can add a page to the pinned list via the context 
menu (right click). 
 

• Recently modified 
Displays a list of recently modified pages. This may be useful to quickly continue where you left 
off, the next time you open the project. 
 

• Needs review 
Displays a list of responsive pages where one or more breakpoints need to be reviewed due to 
changes to the page or master page. 
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Adding a new page 
1. Select the position where you want to insert the page, for example select the root (the top-

level item) to insert the page to the first level. 
2. Click the first button on the toolbar (New Page) 
3. Web Builder adds the new page to your project and will automatically open it, so you can start 

building the page. 
 
To insert a new page as child of an existing page or folder, first select the parent and click 'New Page' 
 

Tip:  
You can also use the context menu (right mouse click) to add new pages to the web site or you can 
select Page -> New Page from the Web Builder menu. 

 

 
 

Adding a new folder 
1. Select the position where you want to insert the folder, for example select the root (the top-

level item) to insert the page to the first level. 
2. Click the second button on the toolbar (New Folder) 
3. Web Builder adds the new folder to your project.  

 

Open an existing page 
1. Select the item (page name) you want to edit 
2. Click the third button (from the left) on the toolbar (Edit Page). 

 

Inserting an external file 
This option can be useful if you want to make an external file part of the project, so you can easily link it 
or make it part of the sitemap. And although this option was designed to include HTML files, it can 
basically use for any type of file. Note however that it will only be a link to the file. You will not be able 
to edit the file directly in WYSIWYG Web Builder. 
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Cloning an existing page 
To make an exact copy of an existing page, select the item (page name) you want to clone and click the 
fourth button (from the left) on the toolbar to insert a copy of that page. 
 

Remove a page/folder 
Select the item (page or folder name) you want to remove and click the remove button on the toolbar or 
press the Delete key on the keyboard. You cannot remove the last page in your web site. 
 

Rename a page/folder 
Select the item (page or folder name) and press F2 to enter the new name.  
You can also use the context menu (right mouse click) to select and rename a page/folder. 
When you have linked to the page, you are renaming (from any page within the web site), Web Builder 
automatically updates all the links for you, so you don't have to redo all the internal links. 

 
Notes about page names 
While building your web site, Web Builder saves the project file with the .wbs extension. This is a project 
file used by Web Builder to simplify the building process. One project file can contain multiple web 
pages. Once your pages are ready you must export or publish them as HTML.  
The name of the output HTML file is taken from the name you have specified in the Site Manager. 
So if you named the page index then the output file will be called index.html. If the page needs another 
extension like .php, you can configure this in the Page Properties. 
 
Here are some guidelines how to name your web pages: 

6. Do not add .html or .htm extension to the page name. Web Builder will automatically add the 
.html extension (or .php, .asp) when it publishes (or exports) the HTML code. 

7. Always name your homepage: "index", this is the most common name for a homepage. 
8. Always use lowercase filenames, most web servers are case sensitive and might fail to find your 

page if you have called it "Index" or "INDEX" 
9. Do not use space or other special characters in the name, keep them simple like: 

"page1" 
or 
"my_products" 

10. Use underscores to connect words. 
 
 

Edit Page Properties 
To edit the page properties without having to open the page: 

1. Select the item (page name) 
2. Click the Properties button on the toolbar or right click for the context menu and select Page 

Properties. 

 
Arrange Items 
You can arrange items by using drag and drop, select the item and drag it to the position where you 
want to move it to. Dropping an item on another item will automatically make it a child of this item. To 
prevent this, you can hold down the CTRL key, this will move the item below the drop item. 
Another way to arrange items is using the context menu: 

1. Select an item 
2. Right click to display the menu. 
3. Select Arrange and one of the available items: Move Up, Move Down, Move Left or Move Right. 
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Import HTML Page 
Although Web Builder is NOT an HTML editor, you can import existing HTML pages. 
Select Page -> Import -> Import HTML Page from the menu to display the Import HTML page window. 
You can either select an HTML page from your local drive or specify a URL of an online website. 
Click OK to start importing the page. Web Builder will automatically copy all images to your local drive. 
 
Important notes about importing HTML: 

• WYSIWYG Web Builder is not an HTML editor, but an HTML generator! Web Builder imports the 
HTML by rendering the contents of an existing page and then attempts to convert the layout to 
Web Builder's internal object format. 
 

• The import feature currently only imports text, images, form elements and body attributes (link 
colors, background images, meta tags). Tables, scripts, style sheets and multimedia 
components are not imported. But in most cases, this is good enough to get you started. 
 

• Web Builder does not parse style sheets, so in some cases the text may look different than the 
original page.  
 

• Web Builder currently doesn't support framesets. If you want to import a web page that uses 
frames, you'll have to import all individual pages separately. 
 

• It is very difficult to support all different types of HTML. Even the popular browsers will 
interpret HTML differently, so don't expect miracles. If a page fails to be imported it probably 
contains code that Web Builder doesn't understand, and you still must start from scratch. 
 

Importing web pages created with WYSIWYG Web Builder will give the best results! 
 
 

Import a page from another project 
This option makes it possible to import page from another WYSIWYG Web Builder project. 
 
 

Position and size of the Site Manager 
You can place the Site Manager anywhere you like (docked or floating): 

1. 'Grab' the title bar of the site manager with your mouse to move the window to another 
location. 
 

2. To make the Site Manager auto hide, click the pushpin in the top-right corner. When you move 
the mouse away from the window it will auto hide, only display a small tab where the windows 
hide. Move the mouse to that tab to make the window visible again. 
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Object Manager 
The Object Manager displays an overview of all objects in the current page, you can change the order or 
remove objects. 
It is also possible to drag & drop an object to change its position (z-order): if you drop an object on 
another object then it will be moved after this object. Double click an object in the list to select it in the 
workspace.  
 

 
 
The Object Manager also provides some advanced features through the context menu (right click on an 
object in the list): 
 
 
Lock/Unlock 
This will 'lock' the selected objects, so that they can not be moved or resized accidentally. 
 
Clone and Hide 
This option can be useful if you want to create a copy of an object and hide the original object. For 
example, if an object is not responsive and it needs different properties in another breakpoint. 
 
Hide 
Hide the object in the current breakpoint 
 
Hide in other breakpoints 
Hide the selected object in other breakpoints (but not in the current view) . 
 
Unhide in all breakpoints 
Unhide the selected object in all breakpoints (including the current view) . 
 
Rename ID 
Allows you to modify the ID property of the object. Note that you can also modify the ID in the Property 
Inspector or by clicking the ID in the statusbar. 
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Remove from Layer 
Removes the object from the layer, so it will no longer be part of that layer. 
 
Reset position 
This option can be useful in breakpoints when you have ‘lost’ an object because it’s outside the 
viewport. ‘Reset Position’ moves the object to the upper left corner of its container. 
 
Restore position 
This option resets the size and position of the selected object so it is the same as in the Default 
viewport. 
 
Scale 
When you create a new breakpoint then sometimes it can be a lot of work to scale and reposition 
objects for smaller (or larger) viewports. 
The Scale tool may be useful for optimizing the layout in breakpoints. Basically it takes the size and 
position of the selected object(s) on the default view and scales it to the current breakpoint width. 
See the help for more details and known limitations. 
 
Don't Publish Assets 
If this option is enabled then Web Builder will not publish the assets (images, scripts, movies) for this 
object. For example, a media player will not publish the associated media file(s).  
This can be useful if a file already exists on the server, so it does not need to be published again. 
Note that it will still publish the HTML code for the object! 
 
Include Visibility (only available in Responsive Web Design) 
In Responsive Web Design, the software will automatically generate code for controlling the position, 
size and visibility of objects (with CSS3 media queries). However in some cases controlling the visibility 
can conflict with other features on the page (like events that show or hide objects).  This option makes it 
possible to exclude the visibility attribute from the media query, so it will not affect the state of the 
object when using events. See the Responsive Web Design FAQ for more details. 
 
Sort 
You can change the display order of objects through the context menu: Sort ascending/sort descending 
 
Display All 
Displays all (visible and hidden) objects in the Object Manager list. 
 
Display Hidden Only 
Displays only hidden objects in the Object Manager list. 
 
Display Visible Only 
Displays only visible objects in the Object Manager list. 
 
Asset Management -> Internal Filenames 
Many objects dynamically generate images. For example, shapes, navigationbars, but also images with 
effects (like shadows, resample, filters etc). In some cases WYSIWYG Web Builder will automatically 
generate unique filenames for these images, to make sure there are no conflicts. Automatically 
generated names are determined by the settings in the Publish options. To view or edit the 
automatically generated filenames for an object you can select Allocated Filenames from the context 
menu. 
 
Note: Not all objects do support this option. It's only useful for objects that dynamically generate 
images! 
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More about the z-order of objects 
WYSIWYG Web Builder uses CSS positioning to create pixel perfect layouts in HTML. CSS operates in 
three dimensions - height, width and depth. In Web Builder each object (element) of your web page is 
placed on a separate layer, which makes it possible to overlap these objects something which cannot be 
done using standard HTML/dynamic page layout). For that purpose, you can assign each element a 
number (z-index).  Elements with a higher z-index overlap an element with a lower z-index. The z-order 
is the order in which objects will be displayed by the browser. 
 
WB automatically generates the z-index for each object you add to your page. So the first element will 
have z-index '0', the next object '1' etc. To change the z-index of objects you can use the arrange tools 
(Layout -> Arrange) or the Object Manager. The following arrange tools are available: 
 
Move To Front   
Move object to front of the page 
 
Move To Back   
Move object to back of the page 
 
Move Forward   
Move object to next position in z-order 
 
Move Back   
Move object to previous position in z-order 
 
Let's say you want to display the objects in a particular order. 

1. Select all objects one by one in the order you want them to be displayed. 
2. After you have selected an object, click Layout -> Arrange -> Move to Front 
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Properties Inspector 
Use the Properties Inspector window to view and change the properties of selected objects.  
You can also use the Properties Inspector window to modify page properties. The changes will be visible 
immediately in the workspace. 
  

 
 
To display the Properties Inspector window, click Properties Inspector on the View menu. The Properties 
window typically displays in the bottom right corner of WYSIWYG Web Builder, under the Site Manager, 
but you can move and resize the window.  
 
Object name (Drop-down box) 
Lists the currently selected object or 'Page' if no object is selected. Only objects from the active page are 
visible. When you select multiple objects, only properties of the first selected object appear.  
 
Categorized (Toolbar Button) 
Lists all properties and property values for the selected object, by category. You can collapse a category 
to reduce the number of visible properties. When you expand or collapse a category, you see a plus (+) 
or minus (-) to the left of the category name. Categories are listed alphabetically. 
 
Alphabetic (Toolbar Button) 
Alphabetically sorts all properties for selected objects.  
 
Property Page (Toolbar Button) 
Displays the Property Pages dialog box for the selected item.  Property Pages displays a subset, the same 
or a superset of the properties available in the Properties window.  
 
Properties/Values 
Displays the properties and their values of the selected object.  
 
Description pane  
Shows the property type and a short description of the property.  
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Style Manager 
The Style Manager (Menu -> Format -> Styles) is a central place to add, edit or remove style definitions 
for the entire website. Updating a specific style will affect all objects using that style. For example, you 
can update all fonts of your website in one operation.  
 

 
  
There are six standard heading styles (H1, H2, H3, H4, H5, H6), which normally are used for text headers 
only. Other styles can be used for all other objects that support them, like form elements and tables. 
  
When you add a new style all attributes of the style are empty (= default). You do not have to specify 
values for all attributes. It's also possible to define custom style attributes. You may have noticed that 
we did this for the header styles (CustomStyle is display: inline;), to make sure it is displayed correct in 
all browsers. 
 
Online tutorial: 
https://wysiwygwebbuilder.com/style_manager.html 
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Gradient Style Manager 
In the Gradient Style Manager, you can add, edit and remove global (multi-color) gradients effects. 
These effects can be used by shapes, cliparts, textart and drawing tools. 
 

 
 
The definitions of the gradient styles are stored in a XML file 'gradients.dat' in the program folder. 
If you have defined custom styles and want to use the same styles on another computer, then you 
should copy this file. 
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Events 
In WYSIWYG Web Builder images, shapes and form controls have an Events Property Page, to easily add 
actions to object events, like OnClick, OnMouseOver etc.  
 

 
 
In the help, you will find an overview of all available events. 
 

 
 
Predefined actions include: Show, Hide, Move, Set Image, Play, Pause, Stop and JavaScript Function. 
Multiple events can be assigned to a single object. 
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Overview of available event actions: 
 
Show    
Show the object as specified in the Target field 
 
Hide    
Hide the object as specified in the Target field 
 
Move    
Move the object as specified in the Target field to position Left, Top. 
 
Set Image   
Set the image of object 'Target' as specified in Filename 
 
JavaScript Function   
Execute a custom JavaScript function (eg. alert('enter your message');) 
 
Play    
Start the audio / video file. 
 
Pause    
Pause the audio /video file. 
 
Stop    
Stop the audio / video file. 
 
SlideShow Next   
Display the next image of a slide show or carousel. 
 
SlideShow Previous  
Display the previous image of a slide show or carousel. 
 
Show with Effects 
Show the object as specified in the Target field while using one of the cool effects like fading, sliding, 
blinds, explode, puff drop etc.... 
 
Hide with Effects 
Hide the object as specified in the Target field. 
 
Set Class 
The SetStyle action can be used to dynamically set a new style for an object. The style must have been 
created in the Style Manager. 
 
Toggle 
Toggle the visible state (show/hide) of an object. Triggering the event again will restore the previous 
state. Supports animations/easing. 
 
Toggle Class 
Toggle between the current style and another style while animating the style changes. Triggering the 
event again will restore the previous style. 
The style must have been created in the Style Manager. Note that the object must also have a current 
(predefined) style. 
 
CSS3 Animate 
This will trigger a CSS3 animation from the Animation Manager.  
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Rotate 
Rotates an object by specifying the angle (in a range between 0 - 359). Works only in modern browsers 
because it uses CSS3 transforms. 
 
Timer Start/Stop 
Activates or deactivates the specified Timer object. The target must be a Timer object! 
 
Copy Text / Paste Text 
This can be used to copy/paste text to/from text and form input elements. 
 
Animation Pause (CSS3) 
Pauses a running CSS3 animation. 
 
Animation Resume (CSS3) 
Resumes a paused CSS3 animation. It's not possible to resume an animation that has ended (when the 
iteration count has reached the end). 
 
Animate 
Perform a custom animation of a set of CSS properties. 
 
Ecommerce 
WYSIWYG Web Builder has built-in support for several third-party shopping cart checkouts and/or 
payment providers:  Ecwid, Stripe, Snipcart, Paddle, PayPal, Gumroad, WebMoney, Vibracart Pro 
This means that any image, button, text or menu item that supports events can be turned into a 
checkout button for the supported Payment gateways. There is also a dedicated 'Ecommerce' button, so 
you can quickly add ecommerce functionality to a button, image, shape, etc. For the Ecommerce events 
to work, you first will need to set the store ID, API key or account name in  
Tools -> Options -> Ecommerce. You only need to enter the account details for the shop(s) you are using 
on your website. 
 
See this online tutorial for more information: https://www.wysiwygwebbuilder.com/ecommerce.html 
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CSS3 Animations and Transitions 
WYSIWYG Web Builder has built-in support for CSS3 animations and transitions. Animations and 
transitions are supported by all modern browsers (FireFox/Safari/Opera/Chrome/IE10), but NOT by 
Internet Explorer 9 or older! 
 

 
 

Animation 
A CSS3 animation is an effect that lets an element gradually change from one style to another without 
using JavaScript or Flash. Animation effects can be applied to a wide variety of CSS properties, including 
background-color, width, height, opacity, transforms (rotate, skew, scale, translate) and many more. The 
Animation Manager can be used to define animations. These animations can be assigned to an object in 
the CSS3 Animation section of the object's properties.  
 
Note that not all animations are useful for all objects. For instance, animating the background color of 
an image or shape will not do anything because there is no background in that case. 
 
You can also associate animations with a style in the Style Manager. This makes it possible to 
dynamically assign an animation to an object (through events -> set style). 
 

Animation Properties 
Animation 
Specifies the animation (as created in the Animation Manager) to use for the object. 
 
Duration 
Specifies the duration of the animation in milliseconds. 
 
Delay 
Delay causes the very first run of the animation to wait for the specified amount of time (in milliseconds) 
before beginning to execute. Note that the delay will not occur during animation repeats. It will only be 
used for the first iteration of the animation. 
 
Iteration count 
You can configure how many times you would like the animation to play, or you can even make it repeat 
infinitely by using -1. 
 
Direction 
Set this to normal to play the animation from start to finish. Or use alternate to play it forward and then 
backwards. 
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Timing 
The animation-timing-function specifies the speed curve of the animation. 
The speed curve defines the time an animation uses to change from one set of CSS styles to another. 
The speed curve is used to make the changes smoothly. 
The animation-timing-function uses a mathematical function, called the Cubic Bèzier curve, to make the 
speed curve. 
 

• linear 
The animation has the same speed from start to end 
 

• ease 
The animation has a slow start, then fast, before it ends slowly 
 

• ease-in 
The animation has a slow start. 
 

• ease-out 
The animation has a slow end 
 

• ease-in-out 
The animation has both a slow start and a slow end 

 

Transition 
A CSS3 transition is an animation that moves a property between two states. Transitions are an implicit 
animation, which means they are triggered by a state change like ‘hover’ or ‘focus’, unlike an animation 
which runs continuously.  
You can add multiple transitions to an object. This makes it possible to animate multiple properties at 
the same time. 
 
Trigger 
Specify which state change will trigger the transition. Commonly used triggers are 'hover' and 'focus'. 
 
Scroll transitions 
Set the trigger to 'scroll' to implement scroll transitions. The anchor (in combination with the offset) 
specifies when the animation should start and finish in relation to the defined target element. 
Scroll transitions should at least have two 'key frames'.  
For more information, please visit the online tutorial: 
https://www.wysiwygwebbuilder.com/scroll_transitions.html 
 
Duration 
Specifies the duration of the transition in milliseconds. 
 
Delay 
Specify when the transition will start. 
 
Timing 
The timing function specifies the speed curve of the animation. See 'animation properties' for more 
details. 
 
Property 
Specifies the name of the CSS property to which the transition is applied. 
 
Value 
Specifies the new value of the CSS property. 
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Animation Manager 
The Animation Manager can be used to define animations (with key frames).  
 

 
 
 

Important:  
Not all animations are useful for all objects. For instance, animating the background color of an image or 
shape will not do anything because there is no background in that case.   

 
The first step in creating animations is to define 'key frames'. A key frame is a point that defines the start 
and end of a transition. The simplest animation will have two key frames - one at the start (0%) and one 
at the end (100%) - whereas more complex animations will have more key frames in between. 
In the key frame, you set the position (in percentages) along the duration of the animation. You must 
specify at least two key frames (0% and 100%), but you can have as many as you like. 
Each key frame defines a property (and value) that is applied to the element at the specified stage of the 
animation. 
 
Example: 
First key frame: 0% -> background color #000000 
Last key frame: 100% -> background color #FFFFFF 
This will smoothly animate the background color of an object from black to white. 
Note that the timing is defined in the animation properties of the object, not in the animation itself. This 
way you can reuse an animation in different objects with different timing settings. 
 
Oline tutorials: 
https://www.wysiwygwebbuilder.com/animation.html 
https://www.wysiwygwebbuilder.com/transitions.html 
https://www.wysiwygwebbuilder.com/transform.html 
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Animation Timeline 
The Animation Timeline option is available in the Page menu. The Animation Timeline displays all 
animations on the page, you can also add, edit and remove animations. It's also possible to drag & 
drop/move animations on the timeline, so you can easily control the timing of the animations. 
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Motion Effects 
Motion Effects introduces a quicker and easier way to implement scroll effects and entrance animations. 
It provides a simplified interface without having to deal with events and transitions.  

 

 
 
Online tutorial: https://wysiwygwebbuilder.com/motion_effects.html 
 

Scroll Effects 
Use Scroll Effects to create amazing animations and interactions when the user scrolls through the page. 
The state of the animation depends on the position of the scrollbar. 
 
In previous versions, WYSIWYG Web Builder supported motion effects through scroll transitions. Here 
you had to define multiple steps to implement scroll effects. We have now simplified this process so you 
can implement some frequently used effects with just a few clicks. 
 

• Scroll Vertical 
Move the object vertically when the user scrolls through the page. This can be used as a 
parallax effect where the object moves at a different speed than the rest of the page. 
 

• Scroll Horizontal 
Move the object horizontally when the user scrolls through the page. 
 

• Scale 
Scales the object when the user scrolls through the page. 
 

• Rotate 
Rotate the object move when the user scrolls through the page. 
 

• Transparency 
Make objects more transparent or opaquer in correlation to the user’s scroll. 
 

• Blur 
Make objects more (or less) blurred in correlation to the user’s scroll. 
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Start / End Anchor 
Specifies when the effect starts or ends: 
• When object starts entering/exiting the viewport. 
• When object is fully visible/invisible. 
• When object is at the center of the viewport. 
 
Start / End Anchor offset 
Specifies the offset from the start/end position. 
 
Start / End Value 
Specifies the start/end value of the selected effect. 
• 'scroll vertical' sets the movement (in pixels) in vertical direction. 
• 'scroll horizontal' sets the movement (in pixels) in horizontal direction. 
• 'scale' sets the zoom level. For example, 1.0 is 100% and 2.0 is 200% 
• 'rotate' sets the angle in degrees between 0 and 360.  
• 'transparency' sets the opacity between 0.0 and 1.0 
• 'blur' sets the blur radius in pixels. 
 

Notes about Scroll Effects 
scroll vertical, scroll horizontal, scale and rotate always have the same start and end anchor because 
transforms cannot be set individually in HTML. 
 
In the background, 'scroll effects' uses standard transitions. So, if you activate one of the options then 
this will automatically add new transition items in the 'Animations/Transitions' properties of the object. 
It's not recommended to update these values manually unless you know what you are doing. 

 
Mouse Effects 
There are two types of mouse effects: Mouse Track and 3D tilt.  
 
Mouse Track 
"Mouse Track" creates a sense of depth by making objects move in relation to the visitor’s mouse 
movement. The speed property controls the level of the effect. By using a different speed for multiple 
objects, you can liven up your website. The 'Direction" property can be used to reverse the track 
direction. 
 
3D Tilt 
"3d tilt' tilts the object according to the movement of the mouse. The angle sets the maximum tilt 
rotation (degrees). The 'Direction" property can be used to reverse the tilt direction. 
 
Online tutorial: https://wysiwygwebbuilder.com/mouseeffects.html 

 
Entrance Animations 
Entrance Animations lets you trigger an animation when the user scrolls down the page, like fade, slide 
or scale. You can choose from more than 30 animations. Duration specifies the duration of the 
animation (slow, normal or fast) and Delay can be used to wait for x milliseconds before the animation 
starts. Play specifies when the animation starts. 

 
Note about Entrance Animations 
In the background, 'entrance animations' use onscrollreveal events. So, if you select one of the entrance 
animations then this will automatically add new items in the 'Events' properties of the object. It's not 
recommended to update these values manually unless you know what you are doing. 
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Filters 
Filter properties allow you to apply visual effects, such as blur, grayscale, brightness, contrast, and more 
directly to an element. 
 
In previous versions, filters were only accessible through the Transitions properties. In WWB21, we’ve 
added a dedicated section that lets you adjust filter values more easily and intuitively. 

 

 
 
There are two types of filters: Filter and Backdrop Filter.  
Filter affects the element itself, Backdrop filter affects what you see through the element (the 
background). 

 

 
 
Online tutorial 
https://www.wysiwygwebbuilder.com/filters.html  
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Glassmorphism 
Glassmorphism in CSS is a design style that creates a frosted-glass look using transparency, blur, and 
layered backgrounds. In earlier versions of WYSIWYG Web Builder, achieving this effect required 
adjusting settings in several different property sections. Now, all glass-morphism controls are 
conveniently grouped in one place. These options let you configure the background color, transparency, 
outline, and backdrop blur to create the desired glass effect. 

 

 
 
Color 
Choose the base background color for the glass effect. This color is typically semi-transparent and 
blends with the blurred background behind the object. 
 
Transparency 
Controls how transparent the glass surface is. 
A lower value makes the element more opaque. 
A higher value makes it more see-through. 
In the screenshot, the transparency is set to 74, which creates a fairly translucent appearance. 
 
Blur 
Defines the intensity of the backdrop blur, the amount of “frosted glass” effect applied to whatever is 
behind the element. 
The screenshot shows a blur value of 4, giving a subtle softening effect. 
 
Outline 
Controls the strength of the outline or border around the glass element. 
A value of 100 (as shown) creates a fully visible outline, which helps define the edges of the glass shape. 
 
Online tutorial 
https://www.wysiwygwebbuilder.com/glassmorphism.html 
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Mix Blend Mode 
mix-blend-mode is a CSS property that controls how an element’s content blends with the background 
behind it. 
 

 
 
Instead of simply sitting on top of other elements, it uses blending formulas (similar to those in 
Photoshop or design tools) to combine colors in creative ways. 
 
This allows you to create effects such as: 

• Lightening or darkening based on background colors 

• Making text or shapes interact visually with images behind them 

• Creating layered, artistic, or glowing effects 
 
Common blend modes include multiply, screen, overlay, darken, lighten, and more. 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/mixblendmode.html 
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Blocks  
With Blocks you can easily drag & drop predefined blocks (like headers/ footers, text blocks, forms) to 
the page, so you have the basic layout ready in just a few minutes.  
 

 
 
Blocks are basically just groups of standard WWB objects so once dragged to the page you can fully 
customize the behavior and appearance of the content. The application includes a dozen standard 
blocks to help you get started, but you can also create your own blocks, so you can reuse them in other 
pages or projects.  To show or hide the Blocks Manager go to View -> Blocks. 
 

Adding a Block to the page 
To add a Block to the page, simply drag & drop it from the Blocks Manager to the workspace. It is also 
possible to double click the item to add it.  
 

Creating your own blocks 
You can also create your own Blocks. To create a Block, select all the objects you want to be part of the 
block and then choose 'Save As Block' in the Arrange menu. 
 

 
 

 
Note: 
Most Blocks were designed to be used as part of a pages with Layout Grids, so they are 
flexible/responsive. This means that the layout will be 'floating' (from the top of the page). And because 
these Blocks use Layout Grids, they can be re-arranged with the Arrange tools (move forward/back etc.) 

 
 
Online tutorial: 
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https://wysiwygwebbuilder.com/blocks.html 
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Dark Color Scheme  
"Dark mode" is a color scheme that uses light-colored text, icons, and graphical user interface elements 
on a dark background. Many modern websites and operating systems offer the user an optional dark 
color scheme. 
 
In WYSIWYG Web Builder, you can create a different color scheme for web site visitors who prefer dark 
mode. There are two ways to implement dark mode: via the Style Manager, where you can specify dark 
colors or by automatically inverting the colors of an object, so light colors become dark and dark colors 
become light.  
 

Dark Color Scheme - Style Manager 
In the Style Manager, each color also has an (optional) dark color property, where you can set a 
different color for the background, text, border when the browser runs in dark mode. WWB, will 
automatically use the dark color when the dark color scheme is active.  
To learn more about using styles please see this tutorial: Using the Style Manager 
 

Dark Color Scheme - Invert Colors 
Besides dark mode styles, WWB also has the possibility to invert the colors of an object for the dark 
color scheme. In that case, you do not have to use styles, but all colors will be inverted (negative). This 
property can be set for each object individually. 
 
The 'Dark Color Scheme" options are available via the context menu (right click). 
The option 'invert all objects' inverts all objects on the page. Images are not included because using 
inverted colors on an image will usually not look good, but you can always use 'Invert' on individual 
images, if you really want to use this effect on images too.  
 
Objects which are part of a layer/layout grid will not be inverted because the layer itself is already 
inverted. The option 'invert child elements' inverts all objects on the selected layer. 
 

How to toggle dark mode? 
Normally, the dark color scheme is activated by the browser based on the user's preference. In that 
case, dark colors will automatically be used. But it is also possible to switch between dark / light mode 
manually.  
This behavior can be set in Tools -> Options -> HTML -> Dark Color Scheme 
 
prefers-color-scheme, the user's preferences determined when the color scheme will be used. 
manual, dark/light color scheme can be controlled via events. 
 
During design time, you can switch between light and dark color scheme via “Dark Color Scheme 
Simulation” button in the toolbar. 
 
Online tutorial: 
https://wysiwygwebbuilder.com/darkcolorscheme.html 
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Responsive Web Design 
WYSIWYG Web Builder supports several ways to create responsive web sites and make your website 
"mobile friendly". So, what is the best way? There is not really a 'best way', it depends on your personal 
(or your customer's) preference. For example, do you want to have full control over the layout or do you 
want objects to automatically scale? 
 
Here is an overview of the different design methods that are available in the software: 
 
Fixed / Absolute Layouts (Adaptive Web Design) 
By default, layouts are fixed using absolute positions. This means that you can place objects anywhere 
you like, so you have complete control over the layout. The downside of this layout mode is that it will 
be harder to make the page responsive because the layout will only look perfect on the screen size it 
was designed for. And because there is no 'structure' in the layout (objects can be placed anywhere in 
random order), there is no way for the browser to automatically re-position and/or scale the content 
based on the view port. So, to make sure the page content looks good for different viewports/screen 
sizes, you will have to implement breakpoints (different layout variations) of the same page. This design 
technique is also known as "Adaptive Web Design". 
 

 
 
Related tutorials: 
https://www.wysiwygwebbuilder.com/responsivewebdesign.html 
https://www.wysiwygwebbuilder.com/rwd_basics.html 
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Flexible / Floating Layouts (Re-flow) 
You can implement flexible layouts by using Layout Grids and/or Flexbox. This makes it possible to 
create Bootstrap-like layouts. When using layout grids, the layout is controlled by the grids. Objects will 
automatically resize based on the available space in the viewport and the grid column size. The 
downside of using layout grids is that you have less control over the layout. All objects will be positioned 
and resized automatically. So, you are forced into a structured layout. 
 

 
 
Related tutorials: 
https://www.wysiwygwebbuilder.com/layoutgrid_part1.html 
https://www.wysiwygwebbuilder.com/layoutgrid_part2.html 
https://www.wysiwygwebbuilder.com/layoutgrid_advanced.html 
https://www.wysiwygwebbuilder.com/flexbox.html 
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Flex Grid 
The Flex Grid is a new way of creating flexible layouts based on CSS Grid Layout. The CSS grid layout 
allows web developers to create complex responsive web layouts more easily and consistently across 
browsers. The idea behind the Flex Grid is to divide a web page into columns and rows.  The columns 
and rows have named areas where you can drag & drop objects to. The layout can be different in 
breakpoints. Each grid area supports its own padding, (flexbox) alignment, border and background 
styling. 
 

 
 
Related tutorials 
https://www.wysiwygwebbuilder.com/flexgrid_part1.html 
https://www.wysiwygwebbuilder.com/flexgrid_part2.html 
 
 
More information about responsive layout modes is available in this online tutorial: 
https://www.wysiwygwebbuilder.com/layout_modes.html 
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Easy Breakpoints 
WYSIWYG Web Builder offers many tools to help make your website responsive and mobile-friendly, 
such as layout grids, flexbox, flex grids, and fixed layouts with breakpoints. Even when using layout grids 
or flexbox, you may sometimes want to fine-tune the font size, hide or show specific objects, or adjust 
margins for smaller (mobile) screens. In these cases, adding a breakpoint is necessary. However, adding 
multiple breakpoints can be time-consuming and difficult to maintain. That’s where Easy Breakpoint 
becomes useful! 
 
With Easy Breakpoint, most objects now support a simplified, single-breakpoint approach. You can set 
key responsive properties, such as visibility, font size, margins, padding, and alignment, specifically for 
that object, without creating additional full breakpoints. 
 

Setup an Easy Breakpoint 
To set up an Easy Breakpoint, select an object and click Easy Breakpoint in the Ribbon or menu. This will 
open the Easy Breakpoint properties for that object. 
 

 
 
Note: when the value is empty or 'default' then it will not be affected. 
 
Breakpoint 
In the Breakpoint dropdown list, you can select the screen width at which the specified properties will 
become active. For example, if you choose 768, the settings will be applied to all screen sizes smaller 
than 768 pixels. 
 
Visibility 
Here you can specify whether the object should be hidden or shown. 
Note that you can initially hide an object via the Object Manager 
 
Alignment 
Adjust the alignment for the selected breakpoint—left, center, or right. This option is most commonly 
used for text-related objects. 
 
Font Size 
Adjust the font size for the selected breakpoint. 
 
Margin 
Often, you may want to add extra spacing between objects on smaller screens. The margin properties 
let you adjust the left, top, right, and bottom margins specifically for the breakpoint. If you leave all 
values empty, the default (desktop) margins will be used. 
 
Extra 
There are also a few special options available for certain objects. For example, in the Photo Gallery you 
can set a different number of columns for the selected breakpoint. 
 
Online tutorial 
https://wysiwygwebbuilder.com/easybreakpoints.html 
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Form Validation 
WYSIWYG Web Builder has some very powerful validation tools to validate the user input for the 
EditBox, Combobox, Radio Button, Checkbox, CAPTCHA and TextArea before it's submitted in a Form. 
Besides JavaScript based validation, there is also native HTML5 validation support built-in! 
 

• Default 
Displays a standard JavaScript message.  

• Info bubble (real-time) 
Select this option to enable real-time validation. The input field will be validated as soon as it 
loses focus without the need for the user to press the submit button first. Real-time validation 
uses info balloons instead of the standard message box, this gives your forms a professional 
look and feel. To configure the style of the balloons, click the 'Settings' button. You can 
configure the colors, font, bubble type, position and animation effect. 

 
• HTML5 

Select this option to use native HTML5 form validation. Note that this feature is not available in 
all browsers yet. 
 

• Bootstrap 
Use Bootstrap-like input validation. This adds a green (OK) or red (error) border and icon to the 
control. It also display the error message below the control. 
 

 
 

• Bootstrap Tooltips 
Instead of displaying standard inline Bootstrap validation messages, this mode shows tooltips 
positioned beneath the input fields. These tooltips are absolutely positioned, ensuring they 
don’t disrupt or shift the surrounding layout. 
 

 
 
 

Online tutorial: 
https://www.wysiwygwebbuilder.com/validation.html 
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CAPTCHA validation 
Error message   
This message will be displayed if the user did not enter a value in the CAPTCHA field. 
 
Enable Real-Time Validation through AJAX 
If you enable this option then the value of the CAPTCHA field will be validated on the server as soon as 
the field loses focus, without the need to submit the form. 
 

 
Checkbox validation 
Error message   
This message will be displayed when the user enters the wrong data. 
 
Selection required   
Enable this option if the checkbox must be checked before the user can submit the form. 
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Editbox and TextArea validation 
Date Type 
 

• No Constraints 
All input is accepted 

• Text 
The input field is a text field. Use Text Format to specify which characters are allowed 

• Number  
The input field is a number field. Use Numeric Format to specify which numbers are allowed. 

• Email Address 
The input field is an email address field.  

• All Major Creditcards 

• Creditcard - American Express 

• Creditcard – Dinersclub 

• Creditcard – Discover 

• Creditcard – Mastercard 

• Creditcard – Visa 
These options verify common credit card formats. 

• Date – ddmmyyyy 

• Date - mmddyyyy  

• Date – yyyymmdd 
These options verify common date formats. 

• IP Address 
The input field is an IP address. 

• URL 
The input field is an URL. 

• AJAX 
This option is for advanced users(!) who wish to validate a value on the server, for example in a 
database. Use the URL field to specify the validation script on the server. For example: 
https://www.yourwebsite.com/validate.php 
 
The validate.php script in its simplest form could look something like this: 
 
<?php 

$username = $_POST['data']; 

 

// TODO: lookup username in database... 

if ($username == 'user') 

{ 

   echo "true"; 

} 

else 

{ 

   echo "false"; 

} 

?> 

 

• Custom 
Select the Custom option to specify your own regular (JavaScript) expression.  

 
Error message                 
This message will be displayed when the user enters the wrong data. 
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Text Format 
Select the types of characters to allow in the field Letters, Digits, Whitespace (spaces, tabs, carriage 
returns, and line feeds), or Other (different characters, such as commas and hyphens).  
 
Numeric Format 
Specify to use a comma or period for Decimal points. 
 
Data Length 
Required; require the user to type an entry in a edit box or text area field. 
Minimum; specifies the minimum number of characters to allow in the text box. 
Maximum; specifies the maximum number of characters to allow in the text box.  
 
Data Value 
This option can be used to specify a value limitation. In the Field must be list, select a constraint: Don't 
care, Less than, Greater than, Less than or equal to, Greater than or equal to, Equal to or Not equal to. 
In the Value box, type the value for the constraint. To specify a second constraint, select And must be, 
click a condition, and then type a value.  
 
Match 
This option allows you to specify another form field of which the contents will be checked against the 
current field to see if they're the same. This can be useful for validating email or password fields. 

 
 
 

Input Mask 
An input mask helps the user with the input by ensuring a predefined format. This can be useful for 
dates, numeric, phone numbers etc. 
The drop-down menu includes several predefined masks. 
This feature is based on Input mask by Robin Herbots (https://github.com/RobinHerbots/Inputmask) 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/inputmask.html 
 
 
What’s the difference of input masks and validation rules? 
input masks are about formatting; validation rules are about correctness of values.  
Note: there is no direct link between validation and input mask, so you wil need to make sure that the 
combination masking and validation makes sense. 
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Combobox validation 
Error message                 
This message will be displayed when the user enters the wrong data. 
 
Selection required 
Require users to select from the combobox. 
 
Disallow first choice 
If you use the first option to display instructions, such as "Select an option," you can make the that first 
option unavailable by enabling this option. 

 
 
File Upload validation 
Error message                 
This message will be displayed when the user enters the wrong data. 
 
Data required  
If this option is enabled then the user must specify a filename. 
 
Valid extensions 
Specifies which extension will be accepted by the form.   
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Form Conditions and Calculations 
Form conditions make it possible to show/hide/enable/disable other objects based on the value or 
selection of a form input field.  For example, you can disable the form's submit button until the user 
checks a box. 
 
It is also possible to do calculations in form fields. Calculations are available in the 'Conditions' section of 
input fields.  They can be used to calculate a value based on values or selections of other input fields. 
For example, to calculate the total price of an item in a web shop based on the selected options. 
Conditions/calculations options are available for Editbox, TextArea, Combobox, Checkbox and Radio 
Button.  You can add multiple conditions to an object, they will be processed all. 
 
Target 
The Target property specifies the object where the action will be applied to. For example, the object 
that will be hidden or disabled. 
 
Conditions 
The following conditions are available: 

• change 
The action will be processed when the value of the object has been changed. 
 

• equal to 
The action will be processed when the input is equal to the specified value. 
 

• equal to (choice) 
The action is specific for the combo box and will be processed when the input is equal to the 
specified value. Unlike 'equal to', this will create a unique condition for the specified value. 
 

• is empty 
The action will be processed when the input is empty. 
 

• is not empty 
The action will be processed when the input is not empty. 
 

• not equal to 
The action will be processed when the input is not equal to the specified value. 
 

• not equal to (choice) 
The action is specific for the combo box and will be processed when the input is not equal to 
the specified value. Unlike 'not equal to', this will create a unique condition for the specified 
value. 
 

• less than 
The action will be processed when the input is less to the specified value.  This can be used in 
combination with 'greater than' to create a range. 
 

• greater than 
The action will be processed when the input is greater to the specified value. This can be used 
in combination with 'less than' to create a range. 
 

• else 
This can be used in combination with 'equal to', 'not equal to', 'greater than' and 'less than'. 
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Actions 
The following actions are available: 

• show 
Show the target object. 
 

• hide 
Hide the target object. 
 

• enable 
Enable the target object. Note that this is only useful for form input fields like an editbox, 
textarea or combobox. 
 

• disable 
Disable the target object. Note that this is only useful for form input fields like an editbox, 
textarea or combobox. 
 

• calculate 
Perform a calculation. For example, if you want to calculate the price of the product selected 
on a radio button multiplied to a quantity field. Or calculate the sum of two or more form 
fields. Calculations use the standard Javascript syntax: 
1 + 1 
10 - (3*2) 
Math.max(10, 20) + Math.abs('-1') 
 
To insert the value of another input field, place the ID of that object between square brackets: 
[Editbox1] * [RadioButton1] 

 
Note that WWB will automatically convert this to $('#Editbox1').val() in the publish page. 
Fields can be inserted with the <Insert Field> option. 

 

• javascript 
Execute a custom javascript function. Usually this is a reference to a function that has been 
defined somewhere else on the page. 

 
 
Online tutorial: 
https://www.wysiwygwebbuilder.com/conditions.html  
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Flexbox Properties 
Each object has its own flexbox options. They can be set via Arrange -> Flexbox. 
Flexbox options are only used when the object is inside a Flex Container. 
 

 
 
Flex grow 
The flex-grow property specifies how much the object will grow relative to the rest of the flexible items 
inside the same flex container. 
If all objects have flex-grow set to 1 then the remaining space in the container will be distributed equally 
to all objects. If one of the objects has a value of 2 then the remaining space will take up twice as much 
space as the other objects (if possible). 
 
Flex shrink 
The flex-shrink property specifies how the object will shrink relative to the rest of the flexible items 
inside the same flex container. 
 
Flex basis 
The flex-basis property specifies the initial size of an object before the remaining space is distributed. 
The length can be in percentages or pixels. If set to 'auto', the extra space is distributed based on the 
flex-grow value. 
 
Align self 
The align-self property of flex items overrides the flex containers align-items property for that object.  

• flex-start 
Items are positioned at the top of the container. 

• flex-end 
Items are positioned at the bottom of the container. 

• center 
Items are positioned at the center of the container (vertically). 

• stretch 
Items are stretched to fit the container. 

• auto 
Use the default alignment of the flex container. 

 
 
Related tutorial: 
https://www.wysiwygwebbuilder.com/flexbox.html  
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Artificial Intelligence 
Improve your online presence easily with the help of WYSIWYG Web Builder's AI-powered tools. Make 
your website content better, reach a global audience by translating it, create eye-catching visuals to 
impress your visitors, and generate custom code for your web projects with ease.  
WYSIWYG Web Builder AI combines all these important features in one place, giving you a complete 
platform to take your web design projects to new levels. 
 
Text Generation and Enhancement 
Create text, headings, articles, and more by entering custom prompts or choosing predefined ones. You 
have the flexibility to modify text length, tone (casual, professional, confident, friendly), grammar, and 
overall style to suit your needs. 
 
Multilingual Translation 
Translate text into over 25 languages, such as English, Spanish, French, German, and Italian, making it a 
valuable resource for communication across language barriers. 
 
Image Generation and Manipulation 
Generate new images based on text input, create variations of existing images, and enhance images 
using in-painting techniques. You can specify desired changes, such as adding objects, replacing screen 
content, or altering hairstyles. Anything of which you can think! 
 
Image Expansion 
Expand images beyond their original borders by providing descriptions of the desired changes. Also 
known as out-painting. The zoom slider allows you to adjust the frame size according to your 
preferences. 
 
Custom Code Writing 
For web development and coding tasks, you can utilize AI functionality within HTML objects, Object 
HTML, and Page HTML. This includes adding scripts, HTML, CSS, PHP, and more, making it a useful tool 
for developers. 
 
The Prompt Manager can be used to add, edit or remove prompts from the 'suggestions' lists. You can 
access the Prompt Manager via the link at the bottom of the suggestions list. Each category (text, 
images, code) has its own prompt list.  
 
 
IMPORTANT NOTE: 
The AI tools in WYSIWYG Web Builder are implemented using the OpenAI API. You will need an OpenAI 
API key to use this functionality. If you do not already have an OpenAI account, then you can create it 
here: https://platform.openai.com/signup 
 
You can create an OpenAI API key for free. New users get free $5 worth of free tokens. These tokens 
expire in 3 months. After the quota has passed, you can choose to enter billing information to upgrade 
to a paid plan and continue your use of the API on pay-as-you-go basis. 
 
The API key can be entered in Tools -> Options -> Artificial Intelligence 
 
 
Online tutorial: 
https://wysiwygwebbuilder.com/ai.html 
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Synchronize Navigation 
WYSIWYG Web Builder seamlessly integrates navigation synchronization with the Site Manager 
structure, enabling you to effortlessly sync bookmarks on the same page or with other menus. 
 
Synchronize with Site Manager 
Choose this option to enable automatic synchronization of menu items with the Site Manager's 
structure. For instance, when you add a new page, an item will be automatically appended to the menu, 
and if you rename a page, the corresponding menu item text will be updated accordingly. 
 
Synchronize with another menu 
Choose option to synchronize the menu items of the current menu with the items of another menu. This 
may be useful when you have multiple menus on the page, for example a desktop and mobile menu. So, 
you will have to change the link(s) only once. 
 
Synchronize with bookmarks 
This feature can dynamically update the menu based on bookmarks on the same page. This can be 
useful for 'single page' websites where menu items link to sections on the page. The menu text can be 
set via the 'menu name' property available for all objects that can be used as bookmark: Bookmark, 
Layer, Layout Grid, Flex Grid, Flex Container and Heading. 
 
Sync with  
Specifies which level of the Site Manager will be used to create the buttons.  
 

• First level 
Creates menu items that will link to the children of the root level. 
 

• Parent level 
Creates menu items that will link to all pages in the level above the current page in the Site 
Manager. 
 

• Current level 
Creates menu items that will link to the current page and all other pages that share the same 
parent page. 
 

• Child level 
Create menu items that will link to the children of the current page. 

 
Target 
Specifies the target window of the links when 'Synchronize with Site Manager' is enabled. 
 
Text Transform 
Many built-in navigation objects have a 'text-transform' property to control the capitalization of text. 
When employing synchronization with the Site Manager, the text can automatically be made uppercase, 
lowercase or capitalize, streamlining the process further. 
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What is the difference between Bootstrap and jQuery UI? 
Bootstrap is a modern UI framework based on modern browser functionality.  
jQuery UI is an older UI framework based on JavaScript, uses themes. jQuery UI relies on jQuery, and 
jQuery UI themes and uses JavaScript for animation, so it has more impact on the performance of the 
page. Bootstrap is lightweight and only uses JavaScript, when necessary, it uses CSS styling and for 
animation. 
 
jQuery UI size: 424 KB (jQuery, jQuery UI and theme files) 
Bootstrap size: 77 KB (bootstrap.min.js, popper.min.js) 
 
Also note that Bootstrap is actively maintained, jQuery UI is no longer under development. 
 
jQuery UI website: https://jqueryui.com/ 
Bootstrap website: https://getbootstrap.com/ 
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Exit, 24 
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Meta Tags, 48 
Modal, 142 
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N 
Navigation bar, 172 
New Page, 30 
New Web Site, 22 
New Web Site From Template, 22 
News Feed Ticker, 210 

O 
Object Manager, 290 
Object Outlines, 28 
Open Graph Meta Tags, 48 
Open Web Site, 23 
Overlay Menu, 173 

P 
Page Footer, 159 
Page Header, 160 
Page Height, 40 
Page HTML, 32 
Page Language, 42 
Page Properties, 34 
Page Weight, 65 
Page Width, 40 
Pagination, 174 
Panel, 142 
Panel Menu, 175 
Paste, 25 
Paste in Place, 25 
PayPal Donations, 222 
PayPal eCommerce Tools, 218 
PayPal Shopping Cart, 220 
Photo Gallery, 200 
Photo Grid, 203 
PHP Login Tools, 226 
Polygon, 190 
Preview, 18 
Preview Folder, 75 
Preview in Browser, 24 
Preview Scope, 75 
Progressbar, 271 
Properties Inspector, 13, 292 
Publish, 19 
Publish Options, 75 
Publish to a local folder, 20 
Publish your website, 277 

R 
Radio button, 129 
Ready to use Java Scripts, 205 
Redo, 26 
Reflection, 97 
Remove formatting, 55 
Remove link, 55 
Remove Page, 30 

Rename Page, 31 
Replace, 26 
Resample, 98 
Responsive Menu, 177 
Responsive Text, 103 
Responsive Web Design Options, 71 
Restore Original Size, 27 
Rive Animation, 134 
robots.txt, 68 
Rollover Image, 206, 207 
Rollover Layer, 144 
Rollover Text, 207 
Rotate, 15, 98 
RSS Feed, 208 
Rulers, 28 

S 
Save, 23 
Scribble, 191 
Search in Google, 55 
Search Index, 83 
Section, 264 
Select, 53, 120 
Select All, 25 
Select Multi, 122 
SEO Assistant, 66 
Shape, 192 
Shopping Cart, 223 
Show Grid, 62 
Sign Up for a PayPal Account, 218 
Site Manager, 12, 286 
Site Map, 67 
Site Search, 213 
Site variables, 35 
SiteTree, 178 
Slide Show, 212 
Slider, 272 
Smart Content, 38 
Snap Scroll, 179 
Snap to grid, 28 
Spinner, 274 
Split Cell, 57 
Sticky, 142 
Stock Photo, 199 
Structured Data, 215 
Style Manager, 293 
Subscriptions and Recurring Payments, 221 
Swatch Colors, 38 
Symbol, 53 
Synchronize Navigation, 323 

T 
Tab Menu, 181 
Table HTML, 58 
Table Menu, 57 
Table Of Contents, 180 
Tables, 57 
Tabs, 11, 269 
Target screen size, 40 
Templates, 22 
Text, 101 
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Text Menu, 182 
TextArea, 131 
Theme Manager, 85 
Themeable Button, 258 
TikTok Video, 165 
Timer, 216 
Title, 40 
Toast, 270 
Toolbox, 11, 89 
Tools Menu, 64 
Tooltips, 276 
Transition, 299 
Translate Text, 69 
Twitter Cards, 49 

U 
Undo, 26 
Unlock, 61 
Unlock All, 61 
User database, 227 
User defined variables, 35 
User Interface, 77 

V 
Vibracart Pro, 224, 225 

Video Player, 136 
View Cart button, 220 
View Menu, 28 
Visibility, 217 
Visited Link Color, 47 

W 
Web safe fonts, 56 
Wizard, 275 
Workspace, 11 
Wrapping Text, 161 

X 
XHTML 1.0 Transitional, 41 

Y 
You Tube, 164 

Z 
z-index, 291 
Zoom, 28 
z-order, 291 

 


